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Safety Information 
Calibration systems may generate or measure dangerous voltages as required by 
the instrument calibration process. Both the operator and the procedure writer 
must be aware of possible hazards. To avoid electrical shock and fire hazards, 
follow the instructions below. 

XWWarning 
To avoid hiding the high voltage safety symbol: 

Never use a screen saver when using the Run Time or 
Procedure Editor applications. These programs control 
the test instruments and can cause them to output 
dangerous voltage levels. The high voltage symbol 
indicates when dangerous voltage is present. 

XWWarning 
To avoid electric shock: 

•  Use interconnect wiring and adapters rated for the 
highest voltage and current levels carried. 

•  Never touch exposed conductive portions of signal 
interconnect wiring, even after instruments have been 
turned off. 

•  Only touch the insulated portion of a connector. First 
disconnect the interconnect wiring at the source, then 
at the measurement side. 

•  Always use insulated adjustment tools. 

•  If the calibration program is abnormally terminated 
verify that the front panels of source instruments 
indicate standby mode. 

•  When writing procedures, make sure that procedures 
minimize the time during which dangerous voltages 
are applied. 
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Introduction 
This chapter is necessary reading for those new to Fluke Metrology Software as 
well as those currently using Fluke Metrology Software. 
The upgrade will be more efficient for current users who understand the reasoning 
behind certain changes made. Taking time to understand product philosophy will 
improve implementation by new users. This chapter explains how the software 
operates, what tasks it is designed to accomplish and what problems it is designed 
to solve. 
Beginning with Version 5.0, Fluke Metrology Software fully incorporated all 
previous products into a cohesive set of applications. After installing the 
MET/BASE package, licenses are applied to enable necessary programs. 

About This Manual 
This is the Fluke Metrology Software Users Manual; its purpose is to assist users 
who have already installed the base package and one or more licenses. There is no 
installation information in this manual. It provides specific information about the 
calibration of instruments and management of metrology assets. 
The users manual was developed for two types of users: those who set up, 
administer, and maintain the system and those who use the software to perform 
calibrations or tracking. 
Chapter 1 provides a look into the design considerations and ideas behind the 
software. Fluke's long-standing experience with calibration and metrology 
management software has proven that a solid conceptual model of the product 
gives users many advantages. Those who develop a clear picture of how the 
product works are better equipped to answer many of their own questions once 
they begin working with it. 
Installation should be completed according to the Installation and Upgrade Guide 
prior to using this manual. The MET/CAL Getting Started Guide is used as a quick 
introduction to operation. 
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Terminology Clarification 
•  The 5500/CAL product is a subset of MET/CAL. Occasionally, the term 

MET/CAL is used when the text is applicable to both. When the term 
MET/CAL is used it is assumed that 5500/CAL operates identically. When 
there are differences between MET/CAL and 5500/CAL operation, the 
difference is clearly stated. 

•  This manual was not designed for cover-to-cover reading, but for random 
access use. Some unfamiliar terms may be used in early chapters. Further use 
of the software will increase terminology familiarity. It is recommended that 
terms or concepts be researched through use of help files or other sources to 
supplement information found in this manual. 
Several resources are available: the Glossary, the online help files, the Sybase 
online manuals and the README file 

This Manual Describes Only Database Mode 
Some older versions of MET/CAL and 5500/CAL could be operated in one of two 
modes, either Legacy Mode or Database Mode. Legacy mode is no longer 
available or supported. All upgraded installations will operate only in Database 
mode. 

Intended Product Usage 
The software application was designed to provide time-saving functions and 
features to the calibration laboratory environment. The traceability documentation 
requirements defined by current quality standards are making software solutions 
necessary for daily operation, regardless of the lab size. 
Documentation may include: 
•  Lists of instruments due for calibration. 
•  Traceability reports for instruments used to calibrate other instruments. 
•  Calibration certificates for use in an ISO-9000 compliant organization. 
•  Calibration results reports and calibration summary reports as defined by 

ISO/IEC 17025. 

Traceability 
Proof of traceability of calibration may be required, for example, to maintain ISO-
9000 certification. For a metrology lab, this means that the calibration 
documentation must be able to demonstrate an unbroken chain of comparisons. 
These comparisons must be traceable between a given asset and a certified 
standard, such as one maintained by a national standards body. 
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When a calibration event is entered into the database, information about one link 
in the traceability chain is recorded. When a traceability report is printed, the 
entire chain of comparisons is documented in one of two specified directions. 
A forward traceability report provides information about a particular asset and a 
particular calibration event. It is a listing of all the standards in the chain used to 
calibrate that asset relative to a specific cal event. The standards used in the 
current calibration are called the first tier. The standards used to calibrate those 
standards are the second tier. Those standards used to calibrate the second tier are 
in the third tier, and so on. The depth of the chain is selected when the report is 
run. 
A reverse traceability report documents all the assets calibrated directly or 
indirectly by a specified standard asset during a specified period. Again, the 
standard asset is the first tier. Instruments that the standard asset calibrated are the 
second tier. Instruments that the second tier calibrated are in the third tier, and so 
on. Traceability reports are discussed in more detail later in this manual. 

Software Components 
Two major components make up the Fluke Metrology Software product offering:  
1. MET/BASE is the core product. However, MET/BASE is not functional until 

a second component is in place.  
2. The User License is the second component. A License enables particular 

applications. The licenses available are called MET/CAL, 5500/CAL, and 
MET/TRACK. Which license or licenses applied determines which 
applications can be accessed. Client software can be installed on an unlimited 
number of workstations. However, the database keeps track of how many 
applications that can be started at any given time, depending upon the number 
of applied licenses. This type of license is called a �floating license.� 

 



 Theory of Operation 
 Software Components 1 

  1-7 

Applications Available to the Licenses 
The following table lists the names of the applications enabled by each different 
license.  

 Licenses 

Application Name MET/CAL 5500/CAL MET/TRACK 

MET/CAL Run Time !   

5500/CAL Run Time  !  

MET/CAL Procedure Editor !   

5500/CAL Procedure Editor  !  

MET/TRACK ! ! ! 

This chapter introduces these applications (and others that are not subject to 
license management). Details are provided later in this manual. 

The Fluke Metrology Software Applications 
The software is designed to assist users in conforming with ISO/IEC 17025, 
ISO-9000, ISO/IECEN 17025, ANSI/NCSL Z540-1 and other requirements. ISO 
and other standards bodies have defined a structured process flow for metrology. 
Adhering to that flow is the only way to ensure calibration traceability. 
This software is designed to integrate into the traceable environment. It is 
important that managers, administrators and technicians read this chapter. All 
Metrology/Calibration personnel benefit from an understanding of these processes 
and requirements. Later, this chapter illustrates process flow. 
MET/CAL Plus Software is a set of Windows-based applications that automate 
the asset calibration and management process. This includes procedure execution, 
instrument control, results storage, report generation, and asset management. 
Software automation improves test consistency, reduces error and cuts the amount 
of time required to calibrate an instrument. MET/CAL Plus software also provides 
information storage and retrieval. 
The Run Time and Procedure Editor applications allow a user to control 
calibration equipment on the IEEE-488 bus or RS-232 serial port. This provides a 
way to verify and adjust a Unit Under Test (UUT) either through IEEE-488 or 
serial interfaces. The Run Time and Procedure Editor applications can also be 
used in manual applications to ensure consistency of testing from technician to 
technician. 
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The following table shows the icons for all applications available for installation. 
Note that the icons are in two groups: those representing Fluke programs, and 
those provided as third-party software. Applications that are subject to license 
management include a large check mark beside the description. 
With the exception of Crystal Reports, all of these programs are members of the 
Fluke Metrology Software program group that the installation program creates on 
the administrator�s workstation.  

Table 1-1. The Fluke Metrology Software Tool Set: Fluke-Developed Applications 

 

MET/CAL and 5500/CAL Run Time 

As the primary MET/CAL and 5500/CAL application, the Run Time 
executes calibration procedures and saves the results. 

Procedure Writers and Operators can access this application. 
!

 

MET/CAL and 5500/CAL Editor 
The Editor helps create, edit, and compile MET/CAL or 5500/CAL 
procedures. Procedures are the programs that control the automated 
calibration of instruments. 

 

!

 

MET/TRACK II  

This application provides access to the database for configuration, 
customization and data entry. 

This is the interface used by administrators to configure the system, 
manage users and security levels, customize data entry forms and field 
entries. In addition, it is used by data entry personnel to add assets to 
inventory, and record events like calibration, location changes and repair 
information. It Provides the mechanism for viewing and browsing data and 
has utilities for adding, editing, and running reports. 

!

! Check mark indicates applications that are subject to license management. 

 

 

 

 

 

 
 



 Theory of Operation 
 Software Components 1 

  1-9 

Table 1-2. The Fluke Metrology Software Tool Set: Third Party Software 

 

 

Database server 

The server is part of the Sybase SQL Anywhere product. 

The server must be running before any client (application program) is started. 
The icon is seen only in a standalone installation, or in network installation, on 
the administrator’s workstation. 

 

Network requester client.  

The network requester client is part of the Sybase SQL Anywhere package. 

The data engine must be running on the server before the network requester 
on the client machine is started. Once the requester is running, several 
applications can use it to connect to a database servers. 

 

ODBC Administrator  
The ODBC Administrator is part of Windows. 

This tool configures the data sources. 

 

ISQL  
Interactive SQL is a part of the Sybase SQL Anywhere package. 

ISQL is an interactive tool for issuing commands in the Structured Query 
Language. 

 

Crystal Reports 

Crystal Reports is the report writer program used for generating reports. All 
Sample Reports were created with this application. 

For compatibility reasons, Fluke recommends using Crystal Reports to create 
any additional reports that may be required. 
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MET/CAL License 
When applied, a MET/CAL license grants access to the entire suite of applicable 
software programs available with MET/CAL Plus. These programs allow a 
metrology lab to calibrate, maintain and track equipment in conformance with 
various standards requirements, such as ISO-9000. 5500/CAL Run Time and 
Editor Programs, a subset of MET/CAL Runtime and Editor are not accessible 
with a MET/CAL license. 

5500/CAL License 
The 5500/CAL License limits the automated calibration programs to serial 
instrument interface only. 5500/Cal has its own Editor and Run Time programs 
and IEEE-488 cannot be used. However, the remaining suite of programs is 
accessible with this license.  

MET/TRACK License 
A MET/TRACK License also provides limited access to programs. The data entry, 
database customization and system configuration applications are the same as 
those enabled by MET/CAL or 5500/CAL licenses, however there is no access to 
automated calibration applications with a MET/TRACK license.  

Calibration Process Flow 
As shipped, Fluke Metrology software is an effective tool for automation. 
Alternatively, it can be customized to better meet specific corporate guidelines for 
process flow and documentation.  
The application design is based on the typical path of an instrument as it arrives, 
undergoes repair, maintenance or calibration, and finally is sent back out to the 
use location. Since this process may vary from company to company, 
customization tools are provided.  

New Asset 
Each piece of equipment or asset receives a unique identification number when 
first entered into the system. This asset number is used to create links between 
each section of the database relative to that specific instrument. 
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Figure 1-1. Process Flow 1: New Asset 
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The following numbered paragraphs discuss the path an asset follows through the 
calibration process. The process is charted in Figure 1-1. 
1 The new asset arrives on site. 
2 Vital information, like the unique asset number, is recorded on an inventory 

form by using MET/TRACK or MET/CAL Run Time. 
MET/TRACK is used to manually record data on the inventory form. In 
addition to identification details, this data will include arrival status, (or 
condition of instrument) and the desired calibration interval. Additional 
asset information can be recorded at this time, including database segregate, 
required calibration procedure, purchase date and cost. The amount of 
information entered depends on the amount of database customization done. 
MET/CAL Run Time is used to calibrate an instrument. However, if the 
instrument has not been entered into the database by the time it is calibrated, 
required information is entered from Run Time. During the customization 
process, certain data fields may be designated as required fields. A dialog 
box will prompt the operator to enter this required information before the 
procedure runs. This process will create an inventory record for the asset 
being calibrated. Again, the amount of information entered depends on the 
amount of database customization done 

3 If necessary, the new asset is calibrated. This is done manually or by using 
Run Time. 

4 Calibration data is recorded in the database. This is done automatically with 
Run Time or manually, using the MET/TRACK application. At the end of 
the automated calibration procedure, the operator may be prompted to either 
save or discard calibration data. Selecting �save� will record the calibration 
event in the database. 
If the asset is calibrated manually, or by an outside source, a calibration 
record can be added manually to the database. The MET/TRACK 
application will allow a user to add a calibration event and record applicable 
results data. 

5 If the asset does not pass calibration, it might be necessary to adjust or repair 
it. (see step 9). If the asset does pass calibration, it continues through the 
process. 

6 Most instrument calibrations must be documented. The easiest way to 
document a calibration event is to print a calibration report. If a calibration 
report is not required the unit can proceed to shipping.  

7 If a report is required, the desired report is selected and printed. Again, this 
can be done from Run Time or MET/TRACK.  
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 If reports are printed from Run Time, they are selected at the end of the 
procedure. At the conclusion of the calibration, a Post Run Results window 
will appear. It is from this window that reports are selected and printed. 

 If reports are printed from MET/TRACK, they are selected from a toolbar 
menu on the calibration record pertinent to the specific calibration incident. 

8 Whether documentation is printed or not the asset is now ready to leave the 
calibration lab for its final destination. 

9 At Step 5, if the asset did not pass calibration, it leaves the normal flow so it 
can be adjusted or repaired. 

10 Repair or calibration adjustment results are recorded in the database as 
described previously, using either MET/TRACK or Run Time. Another 
attempt is made at calibration (back to Step 3). The asset will either proceed 
to the next step or continue in a loop until it passes or is removed from 
inventory. 

Asset Recalled: Due for Calibration 
The following chart follows the path of an instrument called out of inventory to be 
calibrated. While the process is similar to what a new instrument undergoes, the 
results are more critical. It is crucial that an instrument used as a standard to 
calibrate other instruments be found in tolerance when it is called up for 
calibration. If it is found out of tolerance then all calibrations that it has performed 
since the prior calibration date are suspect. In this situation all those suspect 
instruments may have to be recalled for calibration. 
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Figure 1-2. Process Flow 2: Asset Recalled, Due For Calibration 

1 Assets are assigned a calibration interval when they are entered into 
inventory. A Due for Calibration Report looks at this data to identify when 
an asset needs to be calibrated.  

2 The assets identified in the report are retrieved and brought to the lab. 
3 The asset is calibrated, either automatically using MET/CAL Run Time, or 

manually. 
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4 Calibration data is recorded in the database. This is done automatically with 
Run Time or manually. At the end of an automated calibration procedure, the 
operator may be prompted either to save or to discard calibration data. If the 
save option is selected the calibration event is recorded in the database. 
If the asset is calibrated manually, a calibration record can be added to the 
database. The MET/TRACK application allows a user to add a calibration 
event and record applicable results data. 

5 If the asset passes calibration, it continues through the process as described 
in steps 6 through 8. 

 If the asset does not pass calibration additional data must be collected before 
it continues through the process loop. A unit under test that is not used as a 
standard to calibrate other instruments can go through the repair and 
recalibrate loop represented by steps 12, 13 and 3. If the unit under test is 
used as a standard to calibrate other instruments a recall may be necessary. A 
traceability report can be run to determine if a UUT has calibrated other 
instruments.  

6 If an instrument used as a standard is found to be significantly out of 
tolerance a decision to recall or not must be made. Since the only data 
available is the last calibration record, it is assumed that the subject 
instrument has been out of tolerance since it was last calibrated. 
Note, however, that the definition of �significantly out of tolerance� varies 
from site to site. Tolerance is based on quality definitions and practices 
employed by different companies. Reports generated by Fluke Metrology 
Software cannot be used alone to make asset recall decisions.  

7 A reverse traceability report is run to determine which other assets may have 
been affected by the subject asset as shown in step 10. 

8 The owners of affected instruments are notified of the results so a recall 
decision can be made as shown in step 11. 

9 The subject instrument is adjusted or repaired as shown in step 12. 
10 Adjustment or repair data is entered into the database as shown in step 13 

and calibration is again attempted. 
11 Once the instrument can be successfully calibrated a report is generated and 

the instrument is shipped back to the user. 
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Asset Recalled: Due for Maintenance 
Some asset recall systems schedule periodic maintenance, A Due For Maintenance 
Report is used to locate all the assets due for maintenance. As assets reach their 
Maintenance Due dates, Fluke Metrology software helps manage their flow 
through the lab. The process is charted in Figure 1-3.  
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?
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Enter Repair Data

Yes

No
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Ship Instrument

1

2

3

5

6

4

7
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Figure 1-3. Process Flow 3: Asset Recalled, Due For Maintenance 

The following paragraphs describe the activities that normally take place in the 
calibration laboratory when an asset is due for maintenance. 
1 Periodically, the laboratory runs a report designed to locate all assets due for 

maintenance. This may be a part of a formal preventive maintenance 
program, or a routine cleaning and inspection process. 

2 Based on the results of the Due for Maintenance Report, assets are recalled 
for maintenance. As assets reach their maintenance due dates, Fluke software 
helps manage their flow through the lab. Reports create work schedules 
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while the MET/TRACK or Run Time applications create or update 
associated asset records. 

3 The required repair or scheduled maintenance is performed on the subject 
asset. 

4 Details of all work done is entered into the database. Maintenance records 
keep a complete history of every repair or maintenance that has been 
performed. The first record is created after the asset is entered into the 
database and a new record is added with each subsequent repair or 
maintenance event. The maintenance record is created from a form that can 
be used to track repair work, including parts used and related part and labor 
costs. The same form is used to track routine preventive maintenance 
requirements, such as cleaning a filter or changing fluids  

5 After the records are updated, need for a documenting report is assessed. 
6 The necessary documentation is printed. 
7 The asset is returned (shipped) to the required location 

Software Operation 
When MET/BASE is installed according to the client/server (network)or stand-
alone model, the installation program creates two key directories, Metcal and 
Metdata.  
The Metcal directory must be sharable by all clients. In a network installation, the 
directory is on a designated drive on the server. All of the client workstations on 
the network use the executable programs and other files stored in this shared 
directory. Which files are accessed depends on the applications chosen during the 
client installation. However, all users must have the ability to read from and write 
to the Metcal directory to ensure access to applications. In a stand-alone 
installation the Metcal directory is installed on a designated hard drive. The 
directory is usually not shared because the stand-alone system probably has a 
single user.  
The Metdata directory is not shared. The database file, called mtrack.db and the 
log file, called mtrack.log reside in the Metdata directory. Only the database 
engine can read and write to this file. No other programs access the database file 
in any way when the database is in use. The data engine must run on the machine 
that has access to the database file. In a network installation, this machine is 
usually the server. Due to the importance of the database file to correct operation 
of the software, it is recommended that only administrative tasks are performed on 
the machine running the data engine. In a stand-alone installation, the data engine 
resides locally, on the designated hard drive and directory sharing is not an issue. 
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Database Communication 
In network installations, database requests come from client computers that send 
and receive information to and from the data engine, via the data requester. The 
messages for the data requester come from the client applications. Client 
applications include MET/TRACK, Run Time, Procedure Editor, Crystal Reports, 
ISQL, and other programs.  
The data engine and the data requester communicate using the Open Database 
Connectivity standard (ODBC). The data requester icon is visible to the user from 
the client machine. The data engine in turn sends and receives that same 
information to and from the actual database file. Any changes made to the 
database file are tracked as key strokes in the log file.  
A similar process is followed in a standalone installation, but the data requester 
functionality and the data requester icon are not visible to the user. The data 
engine still communicates with the database file through ODBC and the log file 
still tracks database changes. 

Example 
If the MET/TRACK application is being used to search for all assets where the 
manufacturer is FLUKE, Search is selected then FLUKE is entered in the 
manufacturer field and the Enter key is pressed. The MET/TRACK application 
sends a message to ODBC, which in turn sends it on to the requester, to find all 
assets where the manufacturer is FLUKE. The requester then sends this message 
to the data engine according to the network protocol. The data engine receives the 
message, searches the database file, and sends the answer back to the requester, 
again using the network protocol. The requester receives the answer, sends it to 
the MET/TRACK application using ODBC, and MET/TRACK displays the 
results on the screen for the operator. 

Software Operation Summary 
Every transaction between a Fluke Metrology application and the database 
involves the interaction of many programs. This is true for either stand-alone or 
client-server installations. Data is stored in the database file called mtrack.db. 
Keystrokes used to enter and edit data are recorded in a log file called mtrack.log. 
Both of these files are in the unshared Metdata directory. Program executables and 
other necessary files like procedures and reports are in the shared Metcal 
directory. 
As discussed previously, all communication for data travels from the client 
applications to the data requester and between the requester and the data engine 
via ODBC. The data engine is the only application that writes directly to the 
database files.  
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User Profiles 
Fluke Metrology Software is designed for several different types of users: 
•  System Administrator 
•  Sr. Technician/Metrologist  
•  Operator/Technician  
•  Operator / Data Entry 
•  Manager 
At some sites, one person may perform all the functions. At other sites tasks may 
be divided among separate individuals or groups.  
The following paragraphs give general descriptions of tasks the various user types 
perform and to which applications they should have access,.  

System Administrator 
The System Administrator is the person who. understands the processes and 
documentation required for lab operation. In addition, this person should be very 
familiar with computer operation and database functions. It is the responsibility of 
the System Administrator to make any customization necessary to ensure 
integration of the software into existing lab practices. Once the integration process 
is complete, the System Administrator must maintain system operation. The 
System Administrator must be aware of every aspect of the system, from adding 
users to editing forms and fields to database backup. Some common 
Administrative tasks are listed below: 
•  Install Software and upgrade releases as required.  
•  Install computer interface hardware as needed (IEEE interface cards). 
•  Add and configure users, assign passwords, security access levels and 

segregate designations. Customize user desktops.  
•  Customize database fields, forms and reports to integrate software into 

established lab practices. 
•  Create and implement a backup plan for the database and crucial shared 

directories. 
The System Administrator understands lab practices, defines data flow through 
the calibration process, maintains user access, and customizes data fields and 
forms. He also installs software and software upgrades, installs IEEE interface 
hardware and performs data backup to maintain data integrity. 
Fluke software ships with a format designed for out-of-the-box use, with little or 
no customization required. This enables the System Administrator to concentrate 
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on installation, data importation and training, before implementing desired 
customization. 
The System Administrator is assigned the highest user security level. 

Sr. Technician/Metrologist  
The Sr. Technician who also may be a metrologist creates and modifies 
procedures. A Sr. Technician has an understanding of basic metrology principals 
and is familiar with calibration procedure structure. Responsibilities of this user 
may include:: 
•  Writing and testing calibration procedures  
•  Maintaining procedure library, adding, editing or deleting procedures as 

necessary 
•  Generating Test Uncertainty Ratio reports 
•  Adding and editing calibration standards 
•  Configuring the Run Time application including Measurement Uncertainty  
The Sr. Technician will use the Editor, and Run Time applications as well as some 
MET/TRACK functions. 
For specific information on the tasks of the Sr. Technician, see Chapters, 4, 6, 7 
and 8 of this manual (Running Calibration Procedures, Procedure Editor, and 
Customizing the Run Time Application, Configuring the System.) 

Operator/Technician 
Operator/Technicians run procedures to perform verification and/or adjustment of 
a Unit Under Test (UUT). The operator has the following responsibilities: 
•  Calibrating UUTs using the Run Time application. 
•  Saving, viewing and printing results. 
The operator uses the Run Time and MET/TRACK applications. For specific 
information, refer to Chapter, 4 of this manual. 

Operator/Data Entry 
Some sites have a workload heavy enough to support a separate individual just to 
input data. Typically, a data entry person enters new asset, maintenance or 
location information. If all the assets in a system are labeled with barcodes, a data 
entry workstation may include a bar code reader to assist with automated data 
entry. 



 Theory of Operation 
 The User Interface 1 

  1-21 

If manual calibrations are performed, the data entry operator might transcribe hard 
copy calibration results into the database. This user may also print cal certificates 
and calibration data reports. 

Manager 
The Manager is mainly interested in looking at data and uses the MET/TRACK 
tool to review data and run reports. Reports run by the manager may include 
calibration due, calibrations overdue, workload by technician and anything else 
that will help schedule the lab employees time. Some managers may want to 
develop custom reports as well. They should have a good understanding of the 
database and report writing programs. 

The User Interface 
Fluke Metrology Software is implemented as a group of Windows applications. 
MET/TRACK uses the same standards and conventions as other Windows 
applications and MET/CAL uses a similar menu structure. Experience with 
Windows will help a user become comfortable with the user interface. Pull-down 
menus, Hotkeys and fill-in dialog boxes are standard elements of this interface, 
and they operate in much the same manner from one application to the next. 

Getting Data into the Database 
When entering or updating information in the database, the user enters data into 
fields on the applicable form. The exception to this is the process used by the Run 
Time application to automatically create calibration and results records at the end 
of the calibration process. In this instance, the user does not create records 
manually. 
A field is the smallest piece of data within the database. An example of a field is 
the Asset Number field. The Asset Number field is a part of the Inventory Table. 
Other fields in the Inventory Table can be assembled together to make the 
Inventory Form. Users will enter data on to the form. When that data is saved it 
creates a record that is now a part of the database.  
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The Database Tables 
The software records asset information and calibration results in tables within the 
database. A form displays only one record of a table. For example, each asset has 
a unique entry in the Inventory table. The information saved on the Inventory 
Form for an asset is just one of the many records contained in the Inventory table.  
The main tables and their forms are listed below. 
Inventory Contains information about an asset, including asset number, 

model, manufacturer, and serial number. 
Calibration Each record contains information about a single calibration 

event, such as the calibration due date, the date calibration was 
performed, the environmental conditions at the time of 
calibration, what standards were used, and additional 
information about the calibration event. 

Calibration 
Results 

Contains information about the results of a calibration. When a 
MET/CAL or 5500/CAL Calibration Procedure is running, 
Function Selection Codes (FSCs) that generate results 
automatically store the results in the database. Refer to the 
MET/CAL Reference Manual for detailed information on FSCs. 

Location Location information includes the department and station where 
the instrument is being used and the name of the current user. It 
can be used also to assign the instrument to another department 
or user. 

Maintenance/
Repair 

Records contain information about a single repair or 
maintenance procedure performed on an asset. It may also 
include the parts used in the repair or maintenance, part and 
labor costs and failure description. 

Customers Contains information about customers such as name, address, 
shipping, tax and contract status.  

User Created The User Tables are created by the user (usually the system 
administrator). They can contain any information in table form. 
They are an optional-use table. 
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Vitally Important Information! 
Backing up data is of vital importance, and this chapter describes a minimum 
recommended plan. 
Performing a backup of the database is not complicated, nor difficult. Provided 
tools make the process fairly simple. However, backing up data is of paramount 
importance. Here�s why: 
Calibration data recorded to a database provides proof of the traceability of a labs 
calibrations. If data becomes lost or damaged that proof may be gone and a lab 
may have difficulty reconstructing important traceability information. 
A database can be corrupted either by media failure or system failure. Both types 
of failure can make data irretrievable. Since the risk is unknown, it is best to be 
prepared for the worst-case scenario. 

Backup and Recovery Plan 
Most companies will have a plan and schedule for backing up crucial data. The 
backup of the data base file (mtrack.db) and the data log file (mtrack.log) as well 
as any custom report files (found in the METCAL directory) and any custom 
procedures (found in the PROC sub directory of METCAL) should be included in 
the corporate backup process.  
If no corporate standard exists it is highly recommended that a plan be 
implemented. Backup media that can be used includes writeable CDs and zip disks 
used with a zip drive. The frequency of backups depends on the maximum amount 
of data recoverable without a backup. For example: If a company can safely 
recover a weeks worth of data, the backup frequency could be weekly. The 
Administrator should be actively involved in backup plan decisions.  
The following schedule can be used as a guide to establishing a backup plan. 
Daily Every day, make a backup of the log files. (The database automatically 

creates files describing its activity. See the Glossary for a more 
detailed description). 
The transaction log file does not contain the entire database, but a 
record of the transactions that have occurred since the last time a new 
log file was started. 

Weekly One day of the week can be designated for a weekly backup. A weekly 
backup includes backing up the entire METDATA directory, including 
the log files and the database files, and also report and procedure files 
contained in the METCAL directory. At the same time, restart the 
transaction log file. This is the file that records, on a daily basis, the 
full set of transactions that have occurred since the last backup was 
done. 
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Monthly On a designated day every month, do a monthly backup. This is a 
backup of the entire METDATA directory plus the METCAL directory 
on the server.  

Annually On a designated day each year, remove the newest monthly backup 
disk, or CD. Archive it permanently, and replace it with a new disk or 
CD. 

Each piece of backup media should be labeled correctly to assist with data 
recovery in case of a catastrophic event. 
This basic system can be modified to suit the workload at a specific site. For 
example, if the workload is heavy, it may be appropriate to do full backups daily, 
in which case the transaction log file is reset  each day. In a very light workload 
situation, full backups may be performed only once per month, with transaction 
log files being backed up weekly. 

Preliminary Checks 
Before backing up data its integrity should be verified. From the Sybase folder 
browse to Sybase Central and run scjview.exe to bring up the program. Under 
Adaptive Server Anywhere, open up the Utilities folder. Select the Tools menu 
and select Connect to log in to the database. After database has started, Select the 
Validate Database utility by double clicking with the mouse. Follow the 
instructions generated by the Validate Database wizard.  
At this point, the database can be backed up manually by selecting the Backup 
Database utility. Instructions for a more automated backup routine are provided 
later in this chapter. 

Copying the Backup Files to Archive Media 
Regardless of the operating system, once you have created the backup files, the 
final step is to copy them to the archival media. In a very strictly controlled 
environment, two copies may be necessary, one for storage off-site. 
The nightly backup is called incremental because it contains only a record of the 
day�s transactions, and it grows incrementally as the week goes on. If the plan 
described in this chapter is followed, each morning after a backup is done a fresh 
log file is started. That evening, the backup contains the day�s transactions, then 
the next day another day�s transactions are added and so on. This will allow 
recovery�s to be done from any necessary starting point. One of the utilities 
provided by Sybase Central allows the transaction log file to be translated to SQL. 
Log file changes can be applied to the most recent full backup taken, eliminating 
data losses. Full backups are defined as a backup of everything in the METCAL 
and METDATA directories. 
After backups are done, backup files should be copied onto archive media as soon 
as possible and the archive media should be properly labeled and stored. 
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Some important points to execution of a good backup plan are: 
•  If magnetic media like floppy disks are being used, continuous overwriting 

can damage the disk. A limited number of overwrites should be chosen, and a 
tally maintained either on the label or in a backup log. When the media has 
been used the planned number of times it should be replaced. 

•  Backups should be stored safely. A good plan is to store all the backup media 
off-site.  

•  If time and space permit, duplicate copies of the monthly and annual backups. 
can be made to store on site. This allows quicker access to backup media in 
case of crashes. 

•  There are many commercial backup software packages available. Make sure 
your backup software works! Several times a year you should restore from 
your backup system to verify its operation. 

•  Be sure to explore the Adaptive Server Utilities included in Sybase Central. It 
provides features that can aid both the backup and recovery operations that 
may be necessary. 

The database engine makes both backup and recovery as minimally stressful as 
possible. It automatically recovers from many failures. If other types of failures 
occur, recovery can be done quickly, but only if backups are done on a regular 
basis. 
The Sybase SQL Anywhere online manual has detailed information about built-in 
features of the database engine. These features assist with backup and recovery 
processes. 

Backing up MET/TRACK Data from an Icon 
An icon can be created easily to perform backup of the database. Backup is 
accomplished using the DBBACKUP.EXE program. The first step is to create a 
shortcut on your desktop for the file DBBACKUP.EXE. This backup utility is 
found in the SQLANY50/WIN32 directory. Update the required target line 
information by right-clicking the newly created icon, then choose Properties from 
the menu and enter the following information on the target line:  
•  Path to the backup program, c:\Sybase\SQL Anywhere 

8\win32\dbbackup.exe, for example, if this is a stand alone system. 
•  -x, the flag to reset the log file 
•  -y, the flag to proceed without confirmation (this can be safely omitted if a 

confirming user prompt is desired) 
•  -c, the flag denoting that commands follow 
•  uid=mt, the required user login 
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•  pwd=mt, the required administrator password or user defined mt level 
password. 

•  dbf=the path to the data base, for example, 
dbf=c:\metdata\mtrack.db 

•  c:\ the path to the back up directory, for example, c:\backup 
The finished target line will look something like this: 
C:\Sybase\SQL Anywhere 8\win32\dbbackup.exe� -x -y �-cuid=mt; pwd=mt; 
dbf=c:\metdata\mtrack.db� c:\backup 
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Scheduling Backups Using a Service 

For Windows NT Users 
The first step in setting up a system to make automatic backups is to make sure 
that the scheduling services of Windows NT are running. At the server, press 
Start, Settings and Control Panel then double click the Services Icon and scroll 
through the list of available services to determine server status. If it is not running, 
double-click on Schedule Services to bring up a service edit window. Set the 
Startup Type to Automatic, and make sure that under the Log On As section the 
System Account radio button and the Allow Service To Interact with Desktop 
box is checked. Click OK to close the window and select Start to start the 
service.  

For Windows 2000 Users 
The first step in setting up a system to make automatic backups is to make sure 
that the scheduling services of Windows 2000 are running. At the server, press 
Start, Settings and Control Panel then double-click the Administrative Tools 
Icon. Next, double-click the Services Icon and scroll through the list of available 
services. Status will show as Started if it is running. If it is not running, double-
click on Schedule Services to bring up a service edit window. Set the Startup 
Type to Automatic, make sure that under the Log On As section the System 
Account radio button and the Allow Service To Interact with Desktop box is 
checked. Click OK to close the window and select Start to start the service. 

Setting up the Backup 
Now an event is entered into the Administrative Tools scheduling service. The 
DOS Prompt must be accessed for this process. Click Start, Run then type 
CMD.EXE and press the Enter key. At the DOS prompt, type the AT command: 
The AT command displays a list of scheduled activities that the server is currently 
using and is used to create a new event. You can modify the command line syntax 
shown below to meet individual system requirements. 
AT 01:00 /interactive/every:m,t,w,th,f,s,su 
c:sqlany80\win32\dbbackup.exe –x –y –
cuid=mt;pwd=mt;dbf=database-name d:\backup 
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where:  
01:00 Time of the day, in 24-hour format to perform 

the event. 
/interactive Allow display to show on the desktop 

(recommended). 
/every:m,t,w,th,f,s,su Days of the week to perform the event, every 

day in this example. 
c:\sqlany80\win32\dbbackup.exe The Sybase utility that does the backup. This 

should be modified to show the correct path 
according to the server setup. 

-x Truncate the transaction log. 
-y Allow overwrites and answer �yes� to prompts. 
-cuid =mt;pwd=mt Login user id (uid) is mt (system administrator) 

and the password (pwd) is mt, or the user 
defined mt level password. The dbbackup 
utility must have Database Administrator 
Authority (DBA or MT level) to work 
correctly. The -c portion of the line means 
commands are to follow. 

d:\backup Drive and path where the backup files are 
going. 

If you change anything in the statement, delete the event and add a new one with 
any necessary changes.  
At the DOS prompt, type AT to list the event and the Job ID. AT ^xx^/del xx is 
replaced with the job ID. This will delete the old event. A new event is added as 
shown in the example above. 

Scheduling the Time 
Some labs set up a separate event for each day of the week and have the data 
copied to a different directory each day. A lab needs to evaluate their needs and 
worst-case recovery scenario to determine a back up plan. Time should be set to 
coincide with the least amount of server traffic. The Sybase system does not 
require all users to log off while the backup occurs and the backup process is 
invisible to the users. 

Important Notes 
•  The program, DBBACKUP.EXE creates a mirror image of the database and 

puts it into the designated backup directory. This mirror image can be used to 
recover the database files in case of a corruption by replacing the corrupted 
mtrack.db file with the backup file. 
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•  The date/time stamp on the mtrack.db file may be confusing. It is only updated 
when Sybase allocates drive space. The true date/time stamp can be read off 
of the mtrack.log file in the backup directory. 

•  The purpose of making backup files is to have a good copy with which to 
make an archiveable print onto a CD or other media. Due to the Sybase 
properties, you must use the Sybase backup program to make the initial 
backup of the actual database. Other backup software can then be used to 
transfer the data from files created by DBBACKUP.EXE onto selected 
archive media. 

•  Backup systems should always be tested at regular intervals. This is done by 
restoring the database files with a backup and testing software operation. 

•  METCAL directory files should be backed up on a regular basis to ensure that 
custom written procedures and reports are protected. This may not be done as 
often, but should be included in the backup schedule. 

The following is an example of a METCAL directory backup using the xcopy 
command: 
AT 20:00/interactive/every:m,t,w,th,f,s,su 
c:\winnt\system32\xcopy /E /V /I D:\METCAL\*.* f:\METCAL 

This command backs up the METCAL directory and subdirectories at 10:00 P.M. 
and copies them to the METCAL directory on the F: drive. This might be a ZIP or 
JAZZ drive. For NT systems, this must be a local drive if the console is logged 
out. See the Sybase Help File for more details on the DBBACKUP.EXE and other 
database tools. 
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Introduction 
This chapter describes the asset management functions included in Fluke 
Metrology software. All the other applications that make up the software are 
dependant of the inventory and event records about each asset stored in the 
database  
When an automated calibration is done, the Run Time application automatically 
records the event in the database. However, MET/TRACK can be used to record 
calibration or maintenance events manually. Many companies send instruments 
out to third party calibration service providers, but still need to track their 
calibration, repair and location status. MET/TRACK is designed to accommodate 
this type of customer as well as the customer that calibrates all instruments in 
house. 

Basic Database Operations 
Data entry tasks are usually performed by operators, but the administrator should 
be familiar with these applications, too. Becoming expert in all of the applications 
and utilities can help administrators perform any needed customization more 
efficiently, and better prepare them to provide training and guidance to data entry 
and managerial users. 
This chapter covers tasks related to entering all data. Note that any interaction 
with the database requires the database engine to be running. 

Starting an Application 
To connect to the database, proceed as follows: 
1. Make certain that the Calibration Data Engine is running. On networked 

systems, the Data Engine runs on the server. 
2. On a single workstation system (not networked), the data engine icon should 

be minimized on the task bar. It is not necessary to start a Requester on a 
standalone workstation. 
If the Data Engine is not running, start it. Go to the Start menu, open Fluke 
Metrology Software, and select Calibration Data Engine. 

3. On a network Workstation, or Client, start the Calibration Data Requester, 
then start up the MET/TRACK application. A dialog box appears and 
prompts you for a user ID and password. If no user names or passwords have 
been assigned, use the default user name fluke and the password fluke and 
press ENTER. If a user name and password have been assigned use those. 

4. As shipped, the database has three valid user names, FLUKE, FLUKE3 and 
MT. The FLUKE user name has a password �FLUKE�, FLUKE3 has a 
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password of �FLUKE3� these are USER passwords. The MT password is 
�MT�, it is the SYSTEM ADMINISTRATOR Password. The only default 
passwords allowed for data entry are USER passwords. See chapter 8 of this 
manual for instructions and additional information on password changes and 
management. 

Setting User Preferences 
Prior to adding any records, the User Preferences need to be addressed. 
1. From the Tools menu, select Preferences . 
2. Set user Preferences or place/remove a checkmark next to the screens that 

will be needed to enter complete records. You can set the following 
Preferences: 
•  Position of the Toolbar 
•  Viewing or Hiding the Status Bar which details the User Name, Desktop 

selection, Data Source Name, Date and Time as well as the program 
status. 

•  Regional Settings, allows you to change PC settings like Time, Date, 
Language, Number and Currency settings. 

•  Enable Search Browse toolbar. 
•  Enable Customer Menus. The customer screens may not be used by all 

companies and are therefore hidden by default. Enabling will make 
Customer screens accessible and will allow the user to assign customers to 
inventory items. 

•  Enable Maintenance Menus. Maintenance menus are also hidden by 
default. Enabling will make the Maintenance screens accessible by the 
end user. 
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Entry Tools and Screen Navigation 

Toolbar Definitions 
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Add Record Toolbar 

Use these tools to: 
•  Add Inventory Records 
•  Add Calibration Records 
•  Add Location Records 
•  Add Maintenance/Repair Records 
•  Add Customer Records 
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Edit Record Toolbar 

Use these tools to: 
•  Edit Inventory Records 
•  Edit Add Calibration Records 
•  Edit Add Location Records 
•  Edit Add Maintenance/Repair Records 
•  Edit Add Customer Records 
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Search Toolbar 

Use the Search Toolbar to find an asset using a single search field. 
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Navigating Browse Screens 
A Browse screen is displayed when a search is done. The browse screens contain 
basic information about an asset and its related history. Browse screens act as 
paths to the entry screens as well. 

The Core Section 
is where the vital
statistics about the 
assets are kept.

The Plus  Sign Icon will allow 
a new record to be added.

The X Icon is used to 
delete a record.

The Printer Icon prints
the active screen.

The Twin Meter
Icon is used to 
clone or duplicate 
an asset record.

The Pencil Point Icon is used
to edit records. Select the 
record tab and click on the 
pencil to edit that record.

The tabbed sections 
contain more information
about the instrument 
and the instrument’s history, 
like calibration history. Browse 
screens are just an overview, 
but they are an important 
path to entering, editing, 
and viewing data 
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Figure 3-1. Parts of a Browse Screen 
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Navigating Entry/Edit Screens 
Entry and Edit Screens can be customized by the System Administrator so the 
appearance will vary from installation to installation. There are many types of 
special fields in MET/TRACK. Most special fields are designated by a color 
either in the field background, or the title or in an adjacent line. This is an over 
view of a typical Inventory add/edit screen. The remainder of the chapter will 
explain fields and records in more detail. 

Print 
Report
Icon

An instrument can be assigned
to a customer using this field.
The down arrow pulls up the 
customer list.

Some fields may have a red
title. This means they have a 
list of valid entries that must
go into the field. Click the 
down arrow to find the list.
Other fields may have a 
blue or red solid or dashed 
line. See the section called
"Understanding Entry Fields"
for more information.

A menu field can contain
formatted data and objects.

Some fields may have a 
different color background 
which means they must contain 
a value or that they have a 
default or preset value. 
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Figure 3-2. Parts of an Entry/Edit Screen 
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Adding a New Asset to the Database 

Creating the Inventory Record 
1. Log into the MET/TRACK application using the instructions found earlier in 

this chapter. 
2. From the menu, select Add, then Inventory Record or use the toolbar. There 

are two main toolbar sections, Add and Edit. The Add tools are preceded by a 
plus sign. The tool tip or function of each tool will be displayed if the cursor 
is passed over it. 

3. The next dialog box asks for a new asset number. Type in a unique number or 
alpha-numeric combination that is not already in use as an asset number. The 
systems will not take a number that is already in use. To search for asset 
numbers there are some different methods to use. 
•  Select the down arrow to browse through the list. 
•  Type ? to bring up the whole list. 
•  Select the Last+ to find the last asset added. 
•  Select the Max+ button to find the highest number, or alpha-numeric 

value added. Then select the Increment+ button to go to the next, unused 
number. 

•  Once the value is entered, select the green check box to save the number 
and continue adding the record. 
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Assigning a New Asset to a Customer 
4. If the asset belongs to a customer it can be assigned to that customer from the 

entry screen. The Customer selection box will be visible on the toolbar if the 
customer screen view has been enabled. If not, it can be enabled now. If this 
step is not applicable, proceed to step 7. 

5. Select the Tools menu. Select the Preferences menu item and put a check 
mark next to Enable Customer Menus. The entry form must be closed and 
re-opened to enable changes. 

6. When the Customer selection box is visible, click the scroll arrow and select 
the appropriate customer from the list. 

7. Select the Save button when all of the required fields are populated, or at least 
those with a different colored background. The Save button looks like a 
floppy disk. 

8. Once the asset has been saved the Clone button  appears. 

Using the Clone Feature 
9. If the asset just entered is one of two or more of the exact same type, click the 

Clone button. The Clone button is easily identifiable by its twin meter icon.  
10. Assign a new asset number in the dialog box and click the green checkmark. 

 
zv304s.bmp 

11. The New Instrument screen will reappear with the same information that was 
entered for the previous instrument, with two exceptions: 
•  The Asset Number will be the new one entered in the Clone Asset 

Number dialog box. 
•  The serial number field is blank and ready to accept a new value. 

12. Type in a new serial number and Select the Save button again. The clone 
feature allows you to duplicate like inventory records easily and quickly. 
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Understanding Entry Fields 
By default some of the fields in the Inventory Screen, and the various History 
Screens, are Required. A Required field must contain an entry. These fields will 
be a different color from the non-required fields. Fields with Default values are 
designated also by a different color. A field with a Default is often, but not always 
a required field as well. The Default Value is one set by the System 
Administrator and is usually the most logical entry for the field. The field colors 
and default values are set when the System Administrator creates or customizes 
the user Desktops. For more information, see Chapter 8 under Set-Up Menu 
section.  
There can be other specially designated fields on forms. These fields usually 
require the user to choose an entry from a prefabricated list. These lists can be 
simple Pick Lists, which have a list of suggested, but not required values or 
Required simple Validation or Linked Validation lists. A Pick List is marked 
with a solid blue line and scroll arrow. A user can make an entry in this field that 
is not on the Pick List or choose a value from the list. Those fields that require a 
value from a Required Validation List have a red field title and a scroll bar. An 
example of a Required Validation Field is shown in the next figure. These fields 
must contain a value that is on the Required Validation List. 
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If the field is the Root field of a Linked Validation it too will look like the 
previous figure. The Root Field is the main field which determines the value of 
all other fields in the Link. It also requires an entry that is on the list. If marked by 
a dashed red line to the far right of the field, it is a Secondary Field in a Linked 
Validation whose value relies entirely on that of the Root field to which it is 
linked. No data can be entered directly into this field from the MET/TRACK user 
entry screens. A Merge field is also designated by a red title.(see Chapter 8 for 
linked validation configuration and User Table configuration). 
This sounds like a lot of information to remember. But the use of special types of 
entry fields actually automates the entry process by providing lists of preselected 
values or default values. Their use also ensures Consistent Data which is much 
easier to manage and maintain 

Recording Events 
Each time an asset is calibrated, repaired, or relocated, information is gathered and 
entered into the database by way of the Calibration, Maintenance, and Location 
forms. For calibration and repair events, the Results form may also need to be 
updated. 
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Every event must be unique. Because the event�s date and time are core fields 
their function cannot be customized. The system assigns unique ID tags based on 
the date, time and event type. To ensure the uniqueness of these ID tags, the 
system will not allow their duplication. See the Glossary or Chapter 8 for more 
information about Core fields. 

Recording Location Events 
1. Log into the MET/TRACK application using the instructions found earlier in 

this chapter. Select Add then Location Record or use the toolbar. The 
Toolbar definitions are provided earlier in this Chapter.  

2. By default, the Asset Number dialog box will display the number of the asset 
currently being entered. Accept the default by selecting the Okay button, or 
type in a new value.  

3. The New Location Record screen will appear. As in the Inventory Screen, 
there are some required fields. Enter data into the fields, paying close 
attention to those that require values and save the record. 

Recording Maintenance and Repair Events 
1. Follow the steps above to add a Maintenance or Repair event. Note that the 

maintenance date automatically defaults to the current date and that the 
Interval and Interval Units fields default to the same values as those set-up 
in the Inventory Record. The Interval and Interval Units can be changed in 
this screen to calculate the desired Due Date. The Due-Date and Due Time 
fields are calculated and cannot be changed by directly typing a new date into 
the field. 

2. Use the Tab key to jump from field to field. 
3. The Maintenance Type field is a validated field. The valid entries are 

configured in the System Configuration Menu by the System Administrator as 
described in Chapter 8. 

4. Enter or select a value for all required fields that do not have a default value 
and save the record. 

Recording a Calibration Event 
Each time an asset is calibrated, information can be gathered and entered into the 
database either automatically (as a direct consequence of running a MET/CAL 
procedure), or manually. See Chapter 4, �Running Calibration Procedures,� for 
information on the automatic recording of events. 
1. Log into the MET/TRACK application using the instructions found earlier in 

this chapter. Select Add then Calibration Record or use the toolbar. 
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2. Use the default asset number in the Asset Number dialog box or type in a 
new one or select the scroll arrow to search for the correct asset number. 

3. Click the Okay button and the New Calibration Record screen appears. Note 
that some of the fields are already populated, the Cal-date field displays the 
current date and the Pass field has a default value of Y for �Yes�. The Temp 
and Humidity fields and the Cal-Time field may also be populated. Again, 
this varies by installation since default values are set by the Administrator. 

4. There are some tool buttons to the right of the Calibration Procedure Used 
field. The button with three horizontal dots will take the user to the Met/Cal 
Procedure List so an appropriate Procedure Name can be selected. The 
second button has a lightening bolt. This selection will take the user to the 
Run-Time Application to run the calibration procedure for this instrument. 
(see Chapter 4, Running Calibration Procedures) If this selection is made 
the remainder of the Calibration Record will be completed by the Run-Time 
application. 
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5. To complete the entry of the Calibration Record the Standards Used 
information needs to be provided. Tab or click in to the field below the 
Standards Used description box. This field is marked by a scroll arrow. Select 
the arrow to bring up a list of all instruments in the system. Select the 
appropriate one, or choose one of the following. 

6. The choices for Standards Used are: Selection (from step 5), Last Used, Any 
Used, Choices only from the Standards (STD) Segregate or anything from 
the Standards Table. The Standards Table is a compilation of all the 
instruments that have ever been used as a Standard in a procedure, or any that 
have been listed in a manually-entered Calibration Record. 

 
zv307s.bmp 

The Standards Used, must be in the database and must have a current 
Calibration Record. Note also that an Asset by the name of Fluke 
Corporation was added to the database shipped with the software. This, no-
cal-required asset can be used as the designated standard if instruments are 
being sent back to a Fluke service center for calibration. Any Calibration 
Service Provider can be added in this manner to use as a standard. This leaves 
a somewhat better audit trail than a field left blank. 

 
zv308s.bmp 
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7. Note that the Due-Date, calculated with the Cal-Date, Interval and Interval 
Type (12 M for 12 Months, for example) is filled in, automatically. Note that 
the Cal-Date defaults to today�s date. The Cal Date can be changed in most 
cases. The system administrator can set the maximum age a cal record can 
have to be added by certain user levels. In other words, a calibration that was 
done 3 months ago cannot be entered into the system by a level 3 user if the 
maximum age of the record is 30 days and the only user that has override 
permissions is a level 5 user. The Cal-Due Date is calculated and cannot be 
changed by directly typing into the field. 

8. When the Calibration Record is complete, select the Save button. 

Additional Notes on Validating Standards 
The application validates a standard for the event only if that standard�s 
calibration due date has not yet arrived. In the case of assets that require 
calibration according to number of uses, a calibration due date is not assigned 
until that number of uses has elapsed. Then, that date becomes its due date. In 
other words, it becomes immediately due for calibration on the date that it exceeds 
its number of uses setting. 
If calibration time has been suppressed as a core field, it means that a given asset 
would not be able to be re-calibrated on the same day. Doing so would violate the 
rule that each calibration event must be uniquely identified, since the database 
uses Asset Number, Cal Date, and Cal Time as the unique identifier for each cal 
event. 
This may be completely appropriate in some situations, or it may be a hindrance. 
Only the individual administrator can make that determination, because conditions 
and requirements vary. For additional information on this topic, see Chapter 8, 
�Configuring the System.� 

Entering Calibration Results Into the Database 
There are two methods that can be used to enter calibration results data into the 
database.  
•  The Text Editor method will store the results data in a single field, C2501. 

Text can be copied and pasted into the results field from any text editor or text 
document. 

•  New with version 7, MET/CAL software has the ability to store each piece of 
data in a separate field. This method of recording results, called Full Results, 
provides a grid entry format with pre-set column headings for each type of 
results data. 
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Entering Results Using a Text Editor 
The Results Form is tied to each unique Calibration event. The form can only be 
edited when the corresponding calibration record is open for editing. The Results 
Form is used as a plain text editor like Notepad. All test results and other 
applicable data are typed free form into the record. 
Using the Results form in this way will store all results in a single database field, 
C2501. Since this is a text field, text documents can be pasted in from other 
applications. The standard Windows Copy (Ctrl+ C) and Paste (Ctrl+ V) 
commands will work in this application. 
To enter calibration results from the New Calibration Record entry screen, select 
the Enter Calibration Results button from the toolbar on the record being 
entered. Enter the information by typing or using Copy and Paste functions. When 
the cal record to which the results information is being added is saved, the results 
will be saved as well. 
To enter calibration results on a Calibration Record that has already been created, 
access the Calibration Results editor from a Browse Screen, Menu or Toolbar. 
Select the Enter Calibration Results button from the toolbar and follow the same 
procedure as shown above. Again, saving the main Calibration Record will save 
the results. 
When a MET/CAL or 5500/CAL Runtime Procedure stores calibration results, it 
can generate a line of results data for each test. The file named RSLT_DB.FRM 
formats these lines and stores them into the database field C2501 as well. 
To understand more about how RSLT_DB.FRM is formatted, look in the 
MET/CAL help files in the MET/CAL help directory, under �Overview of 
Tolerance Computations�. 
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Entering Results using the Full Results Grid. 
The Full Results Grid is a series of fields that contain detailed test information. 
Unlike the data stored in C2501, data stored using the Full Results Editor stores 
each critical piece of data in a separate field. The specific details make up the 
columns and the individual tests make up the rows of the grid. 
To access the Full Results editor from a New Calibration Record, a Browse 
Screen or an Edit Screen, select the Full Results button from the toolbar on the 
record. 
For information on the field headings, their intended use and acceptable values, 
refer to Results Table documentation in the Manuals Folder under the METCAL 
directory. 
When the editing or adding is complete, select OK. 
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Editing Records 
Records can also be edited from the Edit tools on the Toolbar. Note that the Edit 
tools are nearly identical to the Add tools. Where the Add tools have a plus sign, 
the Edit tools have a pencil point. See the beginning of this chapter for a 
definition of all the Edit Tools. 
1. Select the tool for the type of record to be edited. The Edit Inventory, 

Calibration or Location screen will display, depending upon selection. 
2. Select the default asset number in the Asset Number Selection box or browse 

with the scroll arrow, or simply type in the asset number to be edited. 
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3. Make any desired changes, by selecting the field to change and typing in the 
changes. If the field is grayed out, it cannot be edited by the user. The Entry 
and Edit (or update) permissions for each field are set by the Administrator 
when configuring field properties.  

4. If the field being edited is specially designated by a solid or dashed line, scroll 
arrow or red title, it is a specially configured field that may have to be edited 
in another way. A field with a Required Validation List, or the Root Field in a 
Linked Validation has a red field title and a scroll arrow. A suggested Pick 
List is marked with a solid blue line and scroll arrow. If a field is marked by a 
dashed red line to the far right of the field, it is a member of a Linked 
validation that cannot be edited by typing in the field from this edit screen. A 
Merge field is also designated by a red title, but no scroll bar. 

Editing Validated Fields or Merge Data in Records 
5. With the record open, select the Tools menu. The additional editing choices 

are Edit User Validation List and Edit Merge Data. User Tables can also be 
edited from the Tools menu. 

6. The Validation Editor appears if you have sufficient editing permissions set 
by the System Administrator. If you do not have sufficient permission, the 
Edit choices will not be available from the Tools menu. 

7. Select the Validation field or the Merge field. Note that the only field the edit 
function can be accessed from is the Root field. The Selected Validation list, 
Linked Validation grid, or Merge Table will be displayed.  

8. Make any necessary changes and close the Validation editor. Save the record. 
Saving the record will save any changes made to Validation or Merge data. 
Only an Administrator can choose to drop Linked Validation Tables, Merge 
Tables or simple Validation lists from the database. 

Browsing the Data 

Using the Search Screen 
The MET/TRACK application allows users to view information in the database 
and reports. 
1. Log in to the MET/TRACK application. 
2. Select Search and then select the Search Engine. The Search Engine Screen 

will be displayed. Note the scroll arrows next to each field. 
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3. Choose the Asset Number field to browse and click the scroll arrow. Select 
an asset number to look for. Any field or combination of fields can be 
searched. The search can be very general or very specific. 

4. When an asset number has been selected click the Search button, represented 
by the pair of binoculars. 

5. If an asset meets the selected criteria, the Browse Screen will display the 
basic information about the asset. 
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The Browse Screens 
Note when the Browse Screen is displayed it is divided into sections. The Core 
section displays the vital statistics of the asset. The tabbed sections will display 
Inventory data, Calibration data and Location data when selected. All of the 
sections of the Browse Screen can be individually customized by the System 
Administrator. Fields can be added or suppressed. Field Headings, Font type and 
field lengths can be changed. Screens should be customized to meet the 
requirements of each different company. 
The Inventory data is unique for each asset. The Calibration and Location data 
is historic and since it changes with each event, a new record is created each time. 
For this reason the Calibration and Location Screens have back and forward 
arrows to make finding a specific record easier. The following figure is the 
Calibration Browse Screen. Play close attention to the tool bar. The tool bar 
functions allow records to be added and edited from the Browse Screen. 
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Using the Browse Toolbar. 
The browse toolbar can be used to do a very simple search on a single Field and 
Value. A user may want to find an asset from a group of assets just entered. 
Maybe that group of assets all had the same Manufacturer. 
1. From the Browse toolbar select I4202, Manufacturer. 
2. Locate and select a Value from the pull-down list by selecting the scroll arrow 

and highlighting a specific Manufacturer or by typing the name of a 
Manufacturer to locate. Note that the system will search based on the first few 
characters typed. For instance, Typing F followed by L will bring up the name 
Fluke.  
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3. When the Field and Value browse fields are populated, select the Search tool, 
(the pair of binoculars). 
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4. The system will bring up all assets in the database that meet the selected 
criteria. If more than one item meets the criteria there will be search arrow 
keys in the Core Browse Screen. When in the data browser screen, the left & 
right arrow keys move one record at a time. But, if the CTRL is held down, 
each click moves 10% of the number of records per click.  

5. Scroll through until the right record is found. 
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1. Click the Search menu to access the Search Engine. 
2. Choose the manufacturer field to browse and click the scroll arrow. Select a 

manufacturer from the list. Any field or combination of fields can be searched. 
The search can be very general or very specific. 

3. When the Manufacturer has been selected, click the Search button, 
represented by a pair of binoculars. 

4. If an asset meets the selected criteria, the Browse Screen will display the 
basic information about the asset.  
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5. If more than one asset meets the specified criteria, scroll through the records 
using the right and left arrow keys, or scroll 10 records at a time by holding 
down the Ctrl key and using the right and left arrows. 

6. For this exercise, assume that none of the assets found under the search 
manufacturer meets the criteria.and a new asset record must be created. 

7. Select the Inventory record tab. 
8. Click the Plus sign to add a record. 
9. The system will prompt for a new asset number. Enter a new number and click 

the save button. 
10. The Add Inventory screen will now be displayed and a record can be added. 
11. Complete the Inventory form and save the record as described earlier in the 

chapter.  

Editing a Record from the Browse Screen 
1. Locate an asset using the Search engine. As mentioned earlier, the types of 

screens available for editing with the Instrument Browser are seen as tabs on 
the Browse Screen.  

2. Select the tab that corresponds with the record to be edited. 
3. Select the Edit tool from the toolbar, the button that looks like a pencil. The 

Edit Inventory or Calibration, Location, Maintenance or Customer screen 
will display, depending on the record type selected and the record types 
enabled in the Preferences settings. Make any desired changes, by selecting 
the field to change and typing in the changes.  

4. When the changes are complete, Save the record. 

Deleting a Calibration Record 

WCAUTION 
Deleting a calibration irretrievably removes information 
from the database. 

Only level 4 and 5 operators can delete records from the database. 
•  To delete a calibration event, view it on the Calibration Form and click the 

Delete button. 
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Purging an Asset 

WCAUTION 
Purging an asset irretrievably removes information from 
the database. 

Only level 4 and 5 operators can purge records from the database. It is not 
possible to purge an asset that is used as a standard. 

•  To purge an asset, view it on the Inventory form and click the Delete button  

 . If the asset you want to remove from the system has been used as a 
standard for the calibration of another instrument, then the application will not 
permit purging the asset. 

Special Functions of the MET/TRACK Tools Menu 
Additional special functions are accessed within the Tools menu. These special 
functions allow the user to Edit User Tables, Combine Calibrations, Change 
Asset Number, Change Password and access additional Fluke Metrology 
Software applications. 

Editing User Tables 
Even if one of the forms is not being edited, the function that allows User Tables 
to be edited can be accessed from the Tools menu.  
1. Select the Tools menu. The Edit User Tables is the only editing choice a user 

has when no record is open for editing. The user tables are not tied to a record 
in the database, but are stand-alone tables. For this reason no record needs to 
be open for editing. 

2. If the user has sufficient editing permissions set by the System Administrator 
the User Table list will be displayed. If the user does not have sufficient 
permission, the Edit choices will not be available from the Tools menu. 
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3. Select the User Table to be edited. An example is shown below. 
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4. Make any necessary changes and close the User Table editor. Changes are 
saved automatically. 

Combining Calibration Events 
MET/CAL offers and advanced feature to combine calibration events. This feature 
is useful when a calibration event is split into several parts or over more than one 
day. 
1. From the Tools Menu in the MET/TRACK application, select Combine 

Calibrations. 
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2. Enter the Asset Number of the calibration events being combined and how 
many days old the calibration events can be. Click the Update List button. 
Decide which record is the first in the series, second, etc. Number them in the 
boxes provided by clicking into the box, in order, or highlighting the entire 
record and typing in the correct number. To change the order click the Clear 
Order button and start over.  
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3. Click the Combine button. Tell the system to Re-Assign the Pass Field or not 
to do so. Follow the on-screen prompts. 

4. Click the Commit button to make the changes in the Database or the 
Rollback button to undo the changes 

5. If the changes have been committed and the combination is finished click OK 
to exit the program. 

6. There will now be another record in the database that is a combination of the 
selected records. One Calibration Certificate and one Calibration Report can 
now be printed reflecting data from all the combined records. 
•  The asset�s most recent calibration even is used as the root summary for 

creating the new event, even if it was not selected in the order. The feature 
assumes it will be selected. 

•  If any one of the calibration events is a FAIL, the new combined record is 
a FAIL.  

•  In general, all of the values from the most recent calibration are used as 
the values in the new summary. 
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•  The following fields are summed up from all the selected calibration 
events: 2350, 2351, 2352, 2353, 2324 and 2328. 

•  Standards are combined from all events. 
•  All standards must be in cal on the date of the most recent calibration 

event. 
•  The results are combined in the order specified. 
•  The operator has the option of deleting the original individual calibrations 

from the database. 

Changing an Asset Number 
From time to time an asset is created with a non-conforming, or simply incorrect 
number. Possibly the asset numbering system within a company is changed. The 
Asset Number entered when initial record is created follows the instrument 
always, through each event. Changing the Asset Number on the Inventory record 
will affect all other records. 
For this reason a tool was created to simplify the process. The Change Asset 
Number tool ensures that all history reflects the Asset Number change.  
1. From the Tools menu select Change Asset Number. Type in the asset 

number being changed, or select it from the list by clicking on the scroll arrow 
with the mouse. The asset list also shows the Manufacturer and Model number 
for confirmation that the right asset is being selected.  

2. Type in the new asset number and click OK. 
3. A confirmation dialog box will appear. Click OK to make changes or Cancel 

to stop the process. 

Changing a User Password. 

WCaution 
Once a user password is changed by the user it cannot be 
recovered if lost.  

In the Initial User Setup, the Administrator can give a user permission to change 
his or her own user password at will. If this permission is granted the Change 
Password tool can be accessed from the Tools menu. If the choice is grayed-out on 
the Tools menu, no such permission was granted. 
1. Select the Change Password item from the Tools menu. 
2. Type in the password being changed. 
3. Type in the new password, slowly, to avoid errors. 
4. Type in the new password again and click the Change button. 
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Accessing Other Applications from the Tools Menu 
To go to another application directly from MET/TRACK use the Tools menu. 
Select the application with a single click of the mouse or use the directional 
arrows to select the application and press the Enter key. 
What applications are available from the Tools menu will vary. This feature is 
configurable from the MET/CAL initialization file (metcal.ini, by default) in the 
windows directory. It can be configured differently at each station. See Chapter 7 
for more details.  

Automated Data Entry 
You can enter information into the database by manual entry, or you can speed 
things up by automating the data entry. This section describes how to prepare 
information for automated entry, and the steps to follow to bring the information 
into your database. 
For adding small amounts of information to your database, such as a single 
calibration or repair event, or a couple of assets, the most appropriate handling is 
by way of manual entry using the forms. But, for large amounts of data, or for 
routine, scheduled transfer of information to or from some other program, the 
automated data entry option is probably better. It takes less time, and avoids 
typographical errors. 
Using the automated method of getting information into the database is identical 
to typing the information into the forms; it just happens very quickly.  The source 
of data for importation is an ASCII text file. Importing from a file is faster and 
more reliable than manual entry. Importation behavior is identical to manual entry. 
That is, all the rules for manual entry and the customization of fields apply. 
Two situations call for importing data: 

•  Database downloading, a one-time importation of your existing database after 
you first install the Fluke Metrology software. 

•  Routine data entry, such as importing calibration history records after they 
have been collected in a file. 

A one-time importation from another computer system requires some knowledge 
of the database structures. Give some serious thought to how your database system 
will integrate with the Fluke database before you start downloading data. 

Importing an Existing Database 
If you have an existing database of metrology information, you may only be 
interested in doing a one-time importation of your historical data. The next few 
paragraphs describe the major steps to prepare the data and bring it into the Fluke 
Metrology database. 
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Step 1: Get The Data To The PC In ASCII Text Form 
To import data from another computer, you must first place the data in a format 
that the PC can read. The data must be ASCII text, written to MS-DOS compatible 
floppy disks or to the hard disk. 
Your current system may be able to save your data to a file in ASCII text format. 
ASCII text is just alphanumeric text with no special control or hidden characters.  
Most systems can output ASCII text, but if your current system cannot, or if you 
are not sure how to do it, consult with your local experts (usually your MIS or 
Data Processing group or perhaps a PC/Microcomputer Support group). Fluke 
Product Support may be able to help. 
Once you have created the ASCII files, record them to a DOS-formatted disk. 

Step 2: Decide if You Will Import History 
You need to decide how much of your old data to migrate into the new database.  
Importing your entire database is more involved if you want to include all history 
records. 
If possible, it is recommended that you make a clean break with your old system.  
You can do this by importing only inventory data and the most recent calibration 
history record for each asset. That greatly simplifies the importation process.  
Additionally, your old data may have erroneous entries that will not be accepted, 
or that may present problems later. For example, traceability may not be 
guaranteed for older calibration records. 
If you choose to include data older than the most recent record in the importation, 
more than one text file is required. Import inventory data first, separate from 
calibration or other history data. Create a separate text file for calibration and 
history data. The files containing old historical records must also include the asset 
number. 
The actual format of the text file is covered later in this section. 

Files Used In Importation 
The following types of files are associated with data importation: 
Source The Source file contains your data. This is the text file that has already 
been discussed. The fields can appear in any sequence.  Definition The Definition 
file specifies the format of the data in the Source file. This is a file that you must 
create. More information on this topic follows in this section. 
Error The Error Log file, IMP_LOG.TXT, contains a list of any errors (and the 
offending records) that occur during importation. The importation program 
generates the Error Log in the directory with the executable program. The 
importation program also produces a second Error Log file that contains the 



Metrology Software 
Users Manual 

3-28 

rejected lines for reimportation after you have corrected the errors. The first of 
these will be named IMP_REDO1.TXT. Rejected lines from subsequent 
importations will be named IMP_REDO2.TXT, IMP_REDO3.TXT, etc., unless 
you delete these files as soon as you correct and reimport them. 
Initialization The Initialization file, METCAL.INI, located in the Windows 
directory, contains entries that control the default Definition and Source file 
names and the default field separators. These can be modified if necessary. 

Speed of Importation 
Importation of large files can take a long time, especially if you have many 
validation files. Validation is active during importation. While it may occasionally 
seem to be an inefficient process, automated data importation is much faster and 
more accurate than manual entry. 

Data Importation Procedure 
1. To start the import process, first make sure the SQL Database Engine is 

running, then select the Import icon from the Fluke Metrology Software 
programs and double click. 

2. After you login, the Import screen will appear. Select IMPORT and the prompt 
screen will appear, as shown in the following figure. 
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3. Enter the filename of the definition file and the source file into the prompt 
screen. 
a. If you plan to delete the source file after import, select the �Remove 

source file after entry� check box. This is useful for keeping historical 
data current if you are importing data on a recurring basis. 

b. The �Allow out-of-cal standards� checkbox is used during initial 
importation of data. This selection turns off the automatic standards 
checking feature. This feature would cause errors if calibration histories 
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of standards should be imported after the history of a UUT using that 
standard. This selection can be used only by level 5 operators. 

4. After entering the filenames and (if desired) enabling one or both of the 
options, click OK to begin the import. 

5. If errors occur during import, an error screen will appear. If this happens, open 
the error log to view the errors. 

Specifying the Definition File 
When you type in the name of the Definition file, include the path if the file is not 
located in the current (default) directory. 
You can specify a default entry for the Definition file in the import section of the 
METCAL.INI file (located in the Windows directory): 
import_def = <filename> 
EXAMPLE: 
import_def=C:\METCAL\DEFILE27.DEF 
The line above in the METCAL.INI file specifies �DEFILE27.DEF� as the 
filename for the import Definition file. When the operator performs an import, 
that filename is displayed in the prompt. If a different Definition file is required, 
the operator can simply type over the displayed value.  No error checking is 
performed on this value at start-up time. Thus, if the file does not exist when the 
Automatic Data Entry application starts, the operator will not get an error message 
until the Definition file is used. Examples of valid filenames are �import.def�, 
�c:\a\b\c\d\abc.xyz�, or �\cal\metcal.def.� The default could also be just a path to 
which you would add the filename at import time. 

Specifying the Source File 
In the box for the Source Data file, be sure to include the path if the file is not 
located in the current directory. 
Again, you can specify a default Source filename entry in the METCAL.INI file: 
import_src = <filename> 
EXAMPLE: 
import_src=C:\METCAL\SOURCE27.SRC 
This line in the METCAL.INI file specifies �source27.src� as the filename for the 
import Source file. When the operator performs an import, the prompt box 
displays that filename. If a different Source file is required, the operator can 
simply type over the displayed value. No error checking is performed on this value 
at start-up time. Thus, if the file does not exist, the operator will not get an error 
message until the Source file is used. 
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The Error Log File 
The Automatic Data Entry application creates an Error Log file assigned the 
default name IMP_LOG.TXT. 
If the application encounters any errors during import, it displays screen messages 
and may copy bad records to the Error Log file. 
More information about these files and the importation process follows. 

The METCAL.INI Initialization File 
The file METCAL.INI contains a section used by the Automatic Data Entry 
program. This portion of the file can be identified by the heading �IMPORT.� 

[IMPORT] 
import_src=C:\METCAL\SOURCE27.SRC 
import_def=C:\METDATA\DEFILE27.DEF 
delimiter = � 
separator = , 
 

The last two lines indicate the default field delimiter and field separator. These 
can be modified if these characters are used within the data to be imported, such 
as in a note or comment field. More information on the use of these fields follows. 

The Definition File 
The Definition file contains information to tell the importation program how to 
read the Source file(s). The Definition file is an ASCII file that you create. In its 
simplest form, it is just a list of the fields to be imported and keywords.  Normally, 
you will create a particular Definition file only once. Once you have it, you use it 
once to download your data, or you use a different one repeatedly to import data 
generated by ongoing operations. The latter typically deals with data in a specific 
format, which in turn allows the continued reuse of a single Definition file. 
A Definition file contains the following: 
1. One or more keyword(s). 
2. Field number lines in the order the fields appear in the Source file. 
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Creating a Definition File 
To create a definition file, you must first understand a few simple rules about the 
data to be imported. 
1. Use an ASCII text editor such as Notepad to create or modify the definition 

file. 
2. The beginning of the file must contain the keyword(s) identifying the type of 

data to be imported. 
3. The first field must be the asset number field, 4201. 
4. The field numbers must match the data fields to be imported. That is, if the 

second field in the data source file is Manufacturer, the matching definition 
file entry must be 4202. 

The remaining lines consist of matching field number, comments or the SKIP key 
word. 

Key Words Used in Definition Files 
Key words are special words used in the Definition file to control the flow of the 
import. 

Data Type Keywords 
You must enter key words at the beginning of the Definition file. Only one key 
word is allowed per line. 
INVENTORY  Specifies that the source file contains data to be imported 

into the Inventory table. 
CALIBRATION  Specifies that the source file contains data to be imported 

into the Calibration table. 
REPAIR  Specifies that the source file contains data to be imported 

into the Repair table. 
MAINTENANCE  Equivalent to the REPAIR keyword.  Specifies that the 

source file contains data to be imported into the Repair 
table. 

LOCATION  Specifies that the source file contains data to be imported 
into the Location table. 

CUSTOMER  Specifies that the source file contains data to be imported 
into the Customer table. 

FULLRESULTS Specifies that the source file contains data to be imported 
into the Results table. 
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UNCERT Specifies that the source file contains data to be imported 
into the ResultsRaw table. 

 

Special Key Words 
SKIP  Specifies that the matching field in the data file contains 

data that is not to be imported. This keyword can be used in 
combination with any of the above keywords and multiple 
times in a definition file. 

Comments Any line beginning with a semicolon (;) or pound sign (#) is 
a comment line and is ignored. Do not use the �;� or �#� in 
place of the SKIP key word. 

Example Definition Files 
The following sample Source file contains several records, one per line. As you 
can see, the fields are separated by commas (the default character). 

645878,Function Generator,2123,,Philips,PM5134 
758400,Oscilloscope,5634,403,Philips,PM3350 
589538,DMM,7384,02A,Fluke,8506A 
993743,DMM,6587,059,Fluke,8842A 

Notice that the preceding data belongs in Inventory, and that the nature of this data 
means that this example importation creates new assets. A Definition file to 
import the above Source file would appear as follows: 

INVENTORY 
4201 
4204 
4218 
4207 
4202 
4203 

The keyword �INVENTORY� is associated with all of the fields of the Inventory 
screen. Other keywords are necessary for importation to the Calibration, 
Maintenance, and Location screens. 

The Source File 
The Source file is the ASCII text file that contains the data you wish to import to 
the database. Source files are in a free (not fixed) format.  Source files are 
character-delimited fields. That is, the data is simply listed with commas (or some 
other character) separating each field. This is the easiest format to use, and is one 
that most systems can output. The Definition file (the file that the Importation 
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application uses to understand the format) can then be as simple as a list of the 
fields. 
In the following example, each asset is described in one record and each record is 
on its own line. Note the varying record length (line length) in this example of a 
free format file delimited by commas: 

645878,Function Generator,2123,,Philips,PM5134 
758400,Oscilloscope,5634,403,Philips,PM3350 
589538,DMM,7384,02A,Fluke,8506A 
993743,DMM,6587,059,Fluke,8842A 

The Source file must also meet the following requirements: 
1. There can be only one record per line. 
2. A record or line may be a maximum of 2,000 characters in length. 
3. The Asset Number is a required field regardless of the type of data to be 

imported, even though Asset Number is only found in Inventory. For example, 
a Source file containing Location history data would also need the asset 
number to identify the assets in order for them to be properly recorded into the 
database. The Asset Number field must be the first field in a record. 

The SKIP Keyword 
The file shown in the previous example consists only of a list of the field numbers.  
Ordinarily, nothing more is needed. An import could be performed with those 
files. 
However, you can use the keyword SKIP to bypass the data item. You can use this 
keyword for initial import of historical calibration records from an existing 
database, where the standards� existence, record sequence, and due-dates may 
prevent normal importation. 

Creating the Data Source File 
The data source file is an ASCII file with comma-separated fields. Quotation 
marks are used to delimit data within a field. For example, if a note or comment 
field contains a comma or quotation mark, the entire field can be framed with 
quotation marks to preserve the contents of that field. 
Example: 

1234,10/10/1995,”In spec, .001” OK” 
A matching definition file might be: 

CALIBRATION 
4201 
2301 
2326 
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The line would be interpreted thus: 

ASSET NUMBER:   1234 
CALIBRATION DATE:  10/10/1995 
CAL NOTE:   In spec, .001” OK 

Data Source Conversion 
The data to be imported must meet the format, type and field length specifications 
of the Fluke Metrology database. In this example the source data file contains the 
words �PASS� and �FAIL to indicate a calibration status. The other applications 
expect this data to be a �Y� or �N� in field 2323 to indicate a pass or fail 
condition. The source data input might look like this: 

1234,10/10/1995,PASS 

The third field must be converted to a �Y� in order to be imported into field 2323.  
The following Basic program can perform translation of an ASCII file to prepare 
it for importation to the Fluke database. 
CLS 
REM The next two lines prompt for input and output file names 
INPUT “Enter filename for filtering”; filename$ 
INPUT “Enter filename for output”; filename2$ 
REM the next two lines open the input and output files 
OPEN filename$ FOR INPUT AS #1 
OPEN filename2$ FOR OUTPUT AS #2 
REM Beginning of a “do” loop, the other end is the “loop 
while” 
DO 
REM Take data in from the input file 
INPUT #1, data1$ REM Gets Asset number 
INPUT #1, data2$ REM Gets Cal Date 
INPUT #1, data3$ REM Gets Pass/Fail 
IF data3$ = “PASS” THEN data4$ = “Y” REM Translate Pass 
IF data3$ = “FAIL” THEN data4$ = “N” REM Translate Fail 
REM Print data back to a new file and replace comma field 
separators 
PRINT #2, data1$; “,”;data2$;”,”;data4$ 
LOOP WHILE NOT EOF(1) 
REM Close the files before ending 
CLOSE #1 
CLOSE #2 
This program would produce the following output: 
1234,10/10/1995,Y 
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A BASIC program could also add a required field that is 
missing from a source file. In this case the Trace code, 
field 4209, is missing. The field can be added 
CLS 
REM The next two lines prompt for input and output file names 
INPUT “Enter filename for filtering”; filename$ 
INPUT “Enter filename for output”; filename2$ 
REM The next two lines open the input and output files 
OPEN filename$ FOR INPUT AS #1 
OPEN filename2$ FOR OUTPUT AS #2 
REM Beginning of a “do” loop, the other end is the “loop 
while” 
DO 
LINE INPUT #1, data$ 
REM Take in a line from the input file 
REM Print the line back to output file. DO NOT add line feed 
REM or CR (this is done by adding “;” at the end of the line) 
PRINT #2, data$; “,”; 
REM Add a “5” to the line, could be a “TRACE” code. 
PRINT #2, “5”; “,”; 
REM Add an “M” to the line, could be an interval type. 
REM No “;” at the end of this command terminates the line 
PRINT #2, “M” 
LOOP WHILE NOT EOF(1) 
REM Close the files before ending 
CLOSE #1 
CLOSE #2 

Testing the Importation 
You may use testing when you initially import the database. Testing is useful 
when creating new Definition files for use with standard Source files generated by 
your calibration system. 
Because importation can take a long time if there are very many records, it is a 
good idea to first run a test. Choose a reasonable number of records, small enough 
for quick importation, but large enough to catch structural and systematic errors.  
This way you can identify and correct errors that would otherwise cause the Error 
Log file to become large and waste valuable time. 
After you have run a test import, examine the Error Log file with a text editor.  
Check it for any errors that may have occurred, and make any corrections to the 
Definition or Source files as necessary. 
Also, be sure to look at the test data using the Manual Entry application after 
testing the importation. If you specified the wrong field sequence or column 
numbers, data placement or truncation errors might have occurred. These are logic 
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errors that would not necessarily be caught by import error checking.  After you 
make the necessary corrections, perform the full importation. 

Database Reports 

Running Reports 
Any report can be run from the MET/TRACK application once it has been added 
into the metcal directory and added to the report list. From the Reports Menu 
Run Reports will bring up a list of available reports. Select a report from the list 
by clicking on it with the mouse. Select the print preview button or printer icon 
from the toolbar and enter any prompts the dialog box asks for. The report will 
either preview on the screen or print to a printer. It is that simple. 
Fluke Metrology Software comes loaded with many of the standard reports 
generally used by a cal lab. Reports can be custom written or modified from 
Crystal Reports, (see Chapter 5) or quickly created using Quick Reports. 

Quick Reports 

Creating a New Report 
The quickest way learn to use Quick Reports is to build a report. Select Quick 
Reports from the Reports menu. 
1. Click on the Report Title and type a new Title for the report. 
2. Click on the Report Caption to add a caption. 
3. Select the Columns tab. 
4. Choose fields to add to the report by clicking on the plus sign next to the table 

and then double clicking the desired field. Watch as the report starts to 
materialize. By default, the outline only lists columns that are visible on 
MET/CAL forms. This means that fields that have been suppressed are not 
listed. To show all columns, suppressed or not, click the All Fields check box. 
This will reset the report and list all MET/CAL columns in the outline.  

5. Continue adding columns until all the necessary fields are displayed on the 
report. 

6. Select the Limits tab to choose the type of data to print. Select data that falls 
within a certain date or a certain department or calibrated by a certain 
technician. Up to three sets of limits can be set. For example, only print those 
records where the manufacturer�s name is equal to Fluke, or print all records 
except those in a particular department. Set limits to provide just necessary 
information. 
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7. Choose the field, (column), then the limit type, then the limit value. There are 
lots of possibilities. Here are the limit types and their corresponding symbols, 
as well as some examples of limiting record selection. 

Symbol Definition 

= Equal to 

<> Is not equal to 

> Is greater than 

>= Is greater than or equal to 

< Is less than 

<= Is less than or equal to 

Begins with  Begins with the criteria entered 

Ends with Ends with criteria entered 

Is Nothing The field is blank 

Is Something The field contains a value, any value 

Setting Multiple Conditions 
In this example, two manufacturers are included in the limiting criteria. With these 
settings, the report will print a record if the manufacturer�s name is equal to Fluke 
or if the manufacturer is equal to Hewlett Packard. The limit value is not case 
sensitive. FLUKE, fluke or Fluke will all return the same report information. 

 
zv317s.bmp 

Selecting the Limit Value From a List 
Quick Reports generates a list of database information automatically that may be 
used to set a limit. This is helpful if the exact spelling or value is unknown. 
Selecting from a list is easy and keeps errors to a minimum. There is a down 
arrow to the right of the Limit Value list box. When it is clicked, Visual Reports 
generates a list of values for that column and adds them to the list. Scroll through 
the list to find the value to use to limit the report. Then press Enter. In the 
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example to the right, a list of manufacturer�s names from the database has added 
to the list. 

 
zv318s.bmp 

The date control feature makes date selection easy. Use the arrow keys to select a 
date or click the down arrow to display a calendar. Select a date from the calendar 
by clicking it with the mouse. 

 
zv319s.bmp 
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In the next example, the report prints if the due-date is between two dates. The 
report includes assets due for calibration during the month of May in the year 
2000. This is how the dates for a recall report are set. 

 
zv320s.bmp 

8. Continue selecting Limit criteria until it is as narrow or broad a selection as 
desired. 

9. Check the Most Recent Records Only check box for the last Calibration done 
and the current Location, or leave it unchecked for all records. 

10. Check the Active Assets Only check box to select only active assets, or leave 
it unchecked for all records. 

11. Select the Sorting tab. A large report would be hard to understand if it lacked 
organization. To make reports more meaningful and easier to read, the report 
may be sorted. As columns are added to the report, each column name is 
added to the list of columns available for sorting. In this example, the report 
will be sorted first by the manufacturer�s name and then by the model name. 

 
zv321s.bmp 
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12. Choose the field to sort the report by and how to sort it. To sort, highlight a 
column in the top box. Then click the A-Z for an ascending sort or the Z-A 
button for a descending sort.  

13. Double click to add fields to sort by. Click one of the up arrow keys   
to remove a field from the sorting criteria. The single arrow button un-selects 
a column name in the sort. The triple arrow button clears all column names 
from the selected list. 

14. Select the Options tab to print, preview and export a report. The  check boxes 
determine the appearance of the report. 

 
zv323s.bmp 

Choices are: 
Equal Column Widths � Sets widths equal so they fit on a single page 
Border � Adds a border around the report. 
Group Columns � Groups like fields together as one. 

Column Dividers � Places a dividing line between report columns. 

Row Dividers - Places a dividing line between report rows.  
Alternate Row Colors � If checked, the odd and even rows are a different 
color. The foreground and background colors of the rows can be set. Left-
mouse click for foreground colors. Right-mouse click for background colors. 
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The page setup button  displays the setup window. Set the printer, 
margins and orientation.  

15. Click the preview icon  to see what the finished report will look like. 

16. Print the report by choosing the printer icon  to print the report. 

Exporting A Report 
Quick Reports can export a report to a computer file. This powerful capability 
then makes MET/CAL data available to other computer programs.  

Export to a Data File 
1. To export to a data file select a delimiter character from the list box. 
2. Select an optional text qualifier to surround the data (if necessary). 

3. Click on the Save button. A report saved with comma delimiters and 
double quote qualifiers would look like this:  
�1000�,�Fluke�,�5520A�,�Multi-Product Calibrator�  
This standard format is easily imported into database or spreadsheet 
programs. 

 
zv327s.bmp 

Export to HTML 

Click HTML export icon  to export to an HTML file. This allows viewing in 
Netscape, Internet Explorer or other Web browsers or for enhancement Web page 
editors. This feature greatly expands the ability to get meaningful reports to others 
easily and quickly. A report exported in this manner can be posted on an intranet 
site for public viewing or quickly e-mailed. 
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Additional Viewing Capability 

This section explains the grid icon  on the Report Builder screen. The grid 
icon displays the report in a data grid. It is similar to the Print Preview feature, but 
permits columns to be moved and rows grouped, sorted and organized.  

1. Each column has a header at the top of the column. To reorganize the display, 
select the column header and then with the left-mouse button pressed, drag the 
header into the dark gray area above the column header. 

2. When this is done the grid groups like information into a single cell. 
In this example, a report containing Asset number, Manufacturer, Model and 
Description was constructed and displayed in the grid. The �Description� column 
was clicked, and dragged onto the gray area. Next, the �Manufacturer� and 
�Model� columns were also dragged in. 
The grid is reorganized to display the data. This new view of the data can be 
printed or viewed by clicking the icons at the top of the screen. 

 
zv330s.bmp 
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1. If the grid is not grouped the columns can be sorted. Select a column by 
clicking its name at the top of a column. 

2. Click the A to Z button  to sort the highlighted column in ascending 
order.  

3. Click the Z to A button  to sort the highlighted column in descending 
order. 

 
zv336s.bmp 

4. Adjust the view using the Pivot, Group and Filter radio buttons, if 
desired. 

5. Preview or Print the report. 
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Table of Hot Keys 

MET/TRACK 
F1 Help 
Ctrl+S Save 

Adding Records 
F2 Add Inventory 
F3 Add Calibration 
F4 Add Location 
F5 Add Maintenance 
F6 Add Customer 

Editing Records 
Shift+F2 Edit Inventory 
Shift+F3 Edit Calibration 
Shift+F4 Edit Location 
Shift+F5 Edit Maintenance/ Repair 
Shift+F6 Edit Customer 
Ctrl+V Edit Validation 
Ctrl+M Edit Merge 

General Functions 
Ctrl+A Assign Asset to a customer 
Ctrl+L Log-on as a new user 
Ctrl+O Log-off 
Ctrl+D Select a new desktop 
Ctrl+F Search 

Accessing other Applications 
Ctrl+R MET/CAL Runtime 
Ctrl+E MET/CAL Editor 
Ctrl+Q Quick Reports 

 

MET/CAL Editor 
F1 Help 

File Commands 
Ctrl+N New 
Ctrl+O Open Procedure 
Ctrl+S Save Procedure 
Alt+S Save to Default Directory 
Ctrl+D Change Default Directory 
Ctrl+F Open Text File 
Ctrl+J Save Text File 
Ctrl+F4 Close 
Ctrl+P Print 
Alt+F4 Exit 

Edit Commands 
Ctrl+X Cut 
Ctrl+C Copy 
Ctrl+W Copy to 
Ctrl+V Paste 
Ctrl+G  Insert File 
Del  Delete 
Alt+F3 Find 
F3 Find Next 
Ctrl+F3 Replace 
Ctrl+A  Adjust 
Ctrl+Enter Break 

Compile Commands 
F8   Check Line 
F9  Next Error 
Shift+F9 Previous Error 
Ctrl+F9 Re-warn 
Ctrl+T  TUR Report 

Test Run Commands 
F2 Restart 
Alt+F2 Go 
Ctrl+F2 Show  

Configure 
Ctrl+M  Text Mode Toggle 
F12 Instruments 
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Safety Considerations  
Calibration systems may generate or measure dangerous voltages. Both the 
operator and procedure editor must be aware of possible hazards. 
To avoid electrical shock and fire hazards, follow the instructions listed below. 

XWWarning 
Never use a screen saver with MET/CAL or 5500/CAL Run 
Time Applications. The Fluke software has been designed 
to promote safety by displaying a high-voltage safety 
symbol when dangerous voltage is present. 

A screen saver program hides this symbol, so should 
never be used on workstations where calibrations are 
performed. 

XWWarning 
Avoid electric shock by always following these rules: 

•  Use interconnect wiring and adapters rated for the 
highest voltage and current levels carried. 

•  Never touch exposed conductive portions of signal 
interconnect wiring (even after instruments have been 
turned off.) 

•  Only touch the insulated portion of a connector. First 
disconnect the interconnect wiring at the source, then 
at the measurement side. 

•  Always use insulated adjustment tools. 

•  If the calibration program terminates abnormally, 
verify that front panels of the source instrument 
indicate standby mode.  
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Introduction  
This chapter describes how to use the Run Time application. 
You can skip this chapter if you have only MET/TRACK licenses. 
The Run Time application is the central tool provided by the MET/CAL and 
5500/CAL licenses, because this application executes procedures to actually 
calibrate instruments. 
Each time a calibration begins, the procedure can present prompts for the operator 
to provide needed information, such as the asset number of the instrument being 
calibrated, or the temperature or other environmental factors. During the 
calibration, the screen might display illustrations showing test points, or forms 
providing an opportunity to enter a value, such as a UUT reading. 
At the conclusion of a Calibration Procedure, you may see other prompts or 
displays, and you may be able to direct the system regarding how to deal with the 
output of the tests. You may be able to generate a Calibration Certificate or other 
report, or you may even be given the opportunity to discard the results if the test 
failed. All these possibilities depend on the particular way your system 
administrator has configured and customized the Fluke Metrology applications for 
your site. If you are not the administrator, be sure to speak with that individual 
before beginning any calibrations, so you know what to expect and how to 
respond appropriately. 
This chapter can be helpful whether this is your first experience with the Run 
Time, or whether you have previously worked with Fluke Calibration software. 
You need a basic knowledge of the Windows graphical interface; for example, 
how to operate pull-down menus and dialog boxes, how to make selections from 
list boxes, and so on. This chapter does not provide any instruction in these topics. 
This chapter assumes that your system is completely configured, and that you have 
installed some Calibration Procedures.  
It is helpful if at least one person at your site has gone through all the exercises in 
the Getting Started Guide. If you are not the same individual who did the Getting 
Started exercises, consult with that individual or with your system administrator to 
find out any configuration details you may need, and to learn which Calibration 
Procedures and reports are available to you. 
The remainder of this chapter discusses the following major topics: 
•  Overview of the Run Time Application 
•  Selecting a Calibration Procedure 
•  Executing a Calibration Procedure 
•  Post Run Results 
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Overview of the Run Time Application 
The Run Time application allows you to select a procedure and run a calibration 
on a Unit Under Test (UUT). Figure 4-1 gives a high-level overview of how the 
Run Time application works when you run a procedure. 

Select
Procedure

Post
Calibration

Results

Precalibration
Instrument

Check
Test

Steps Done
Y

N

 
il401f.eps 

Figure 4-1. High-Level Overview of Run Time 

The purpose of the Run Time application is to execute Calibration Procedures and 
save calibration results. Some of the information in this chapter requires an 
understanding of the Fluke procedure language. Therefore, this chapter includes 
some information about the MET/CAL procedure language. 
Note that, while it is not necessary to understand the procedure language in order 
to use the Run Time application, an understanding of the basics of the language 
helps you understand how the Run Time application functions and, in particular, 
how its operation may vary depending on the procedure being executed. Refer to 
the MET/CAL Reference Manual for additional information about the MET/CAL 
procedure language. 
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Sequence of Events 
This section presents a sequential outline of the major steps performed by the Run 
Time. Most of these steps are described in more detail later in the chapter. 
To execute the sequence of steps outlined below, start the Run Time and choose 
Calibrate in the top-level menu. It may be helpful to actually run a procedure 
while reading this information to obtain a full understanding of the process. 

Note 
The first step in the process, selecting a procedure, is initiated by the 
operator. All the remaining steps are done by the Run Time 
application, although some of the steps require operator 
involvement. 

Step 1  -  Select Procedure 
There are two ways to select the procedure: by name, by asset. The procedure 
selection method is configurable (by going to the Run Time menu and selecting 
Configure, then Procedure Selection Method). 
For more information refer to the heading later in this chapter titled, �Run Time 
Menu.� 

Step 2  -  Check User Permissions for Required Database Fields 
The Run Time verifies that the user has permission to write to all required fields 
in the Calibration and Inventory database tables. 

Step 3  -  Load Procedure 
The selected procedure and all required subprocedures, if any, are loaded into 
memory. No operator interaction is required in this step, but the Run Time 
displays a sequence of one or more pop-ups that trace the loading of the 
procedure. 

Step 4  -  Load Pictures 
If there are any picture (.bmp) files required, the Run Time verifies that the 
specified files exist. 

Step 5  -  Check Instrument Configuration 
Next, the Run Time verifies that the system instruments required by the selected 
procedure are configured.  
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If a required instrument isn't configured, it can be added to the configuration by 
choosing Instruments in the Configure menu. Verifying that required 
instruments are configured does not involve any communication with the actual 
instruments.  

Step 6  -  Check Traceability 
For each required system instrument, user-configured system instrument, or 
manual standard, a traceability check is done to make sure the instrument is in cal. 
ALL the instruments used in a calibration are considered to be �standards�, and 
therefore all of them must meet the following rules: 
1. The standard must be in calibration before the instrument that is the current 

UUT. For each standard, only the most recent record meeting this criteria is 
used. 

2. Every standard must have passed its most recent calibration. (Field C2323 = Y.) 
3. The standard�s due date + due time must be in the future, beyond the due date 

and time of the current UUT. If the standard�s due date + due time is blank, 
then due date + due time is assumed to be infinity; it is never due for 
calibration.  

Step 7  -  Prompt for UUT Asset Number  
Now the Run Time prompts for the asset number of the UUT.  
For more information refer to the heading later in this chapter titled, �Asset 
Number Prompt.�  

Step 8  -  Check User Permissions for Database Asset Information  
The Run Time verifies that the currently logged-in user has permission to write to 
those database fields that the Run Time automatically updates for the specified 
asset. This verification is needed because MET/CAL automatically writes to the 
database at the conclusion of the calibration. 

Step 9  -  Pre-Prompt Dialog  
A dialog prompts the user for associated information before procedure execution 
starts. This dialog is often used to prompt for temperature, humidity, and work 
order number. The dialog is configurable, however, and can be customized for 
each site.  
If you do not want to use the pre-prompt dialog, it can be turned off.  
For more information, refer to the heading later in this chapter titled, �Prompt 
Dialog.� 
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Step 10  -  Create Test Results Window 
The Test Results window is a separate window that shows a one-line, color-coded 
result line for each test step in the Calibration Procedure.  
For more information refer to the heading later in this chapter titled, �Test Results 
Window.� 

Step 11  -  Reset Internal Data  
This step prepares the system to execute the selected procedure. No interaction 
with the user is involved.  

Step 12  -  Initialize IEEE-488 Boards  
This step is skipped for 5500/CAL, since it does not support IEEE-488 interfaces. 

Step 13  -  Open Required Serial Ports  
The Run Time next opens all serial ports referenced by the selected procedure.  

Step 14  -  Test Required System Instruments  
The Run Time performs an instrument-specific test for each required system 
instrument. 
If a system instrument fails its test, it is probably because it isn�t turned on or is 
not set to the configured address. In some cases, however, a system instrument 
may be broken, or the PC�s IEEE-488 bus or serial ports may be locked up or 
otherwise malfunctioning. If the instrument is turned on and set to the correct 
address, you may wish to reboot the PC before concluding that the instrument is 
malfunctioning.  
For system instruments configured on serial ports, the port configuration 
(specified using the Windows Control Panel) must agree with the instrument 
settings, and the cable must be of the correct type and pinout.  
No test is done for the UUT, for user-configured instruments, or for manual 
standards.  

Note 
A user-configured instrument is an instrument used as a calibration 
standard, and remotely controlled by MET/CAL, but for which there 
is no built-in driver. 

Step 15  -  Clear Required System Instruments 
This step returns all required system instruments to a known, reset state prior to 
procedure execution.  
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Step 16  -  Execute Procedure  
After performing the foregoing preliminary steps, the Run Time now executes the 
selected Calibration Procedure. 
A Calibration Procedure is a sequence of calibration test steps. Each test step 
involves setup steps followed by an evaluation. In many cases the setup steps 
involve prompts to the operator, and the evaluation may also involve an operator 
prompt.  
The sequence of steps executed and the types of prompts displayed to the operator 
are controlled by the MET/CAL procedure.  
To execute a procedure, MET/CAL starts at the first procedure statement and 
executes statements in the order they occur, except when one of the following two 
things occurs:  
•  the procedure jumps to a different step, or 
•  the operator uses the Post Test dialog to alter the execution sequence. 
The operator�s ability to alter the execution sequence of the procedure can be 
disabled by the procedure writer.  
Each test step generates a test result. By default, the results of each test step are 
shown to the operator in the Post Test dialog. However, it is common for 
procedures to be written so that the Post Test dialog appears only after a test step 
fails.  
More information on procedure execution, including descriptions of the different 
types of tests and operator prompts, is provided later in this chapter. Refer to the 
heading titled, �Procedure Execution.�  

Step 17  -  Clear Required System Instruments  
This step returns all required system instruments to a known, reset state following 
procedure execution.  

Step 18  -  Close Required Serial Ports  
All serial ports referenced by the selected procedure are closed.  

Step 19  -  Automatic Prompt to Operator: Remove All Connections  
An operator prompt display reminds the operator to remove all connections. You 
cannot configure or inhibit this prompt. It is a built-in feature of the Run Time 
application. 

Step 20  -  Post-Prompt Dialog  
A dialog display prompts the user for associated information after procedure 
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execution ends. This dialog is often used for displaying status information (such 
as the number of marginal PASS results, elapsed time, and so on), as well as to 
prompt for a remark that will be stored with the calibration results.  
You can configure the post-prompt dialog, and customize it for each site. It can be 
configured independently, based on whether the overall result of the calibration is 
PASS or FAIL.  
If you do not want to use the post-prompt dialog, it can be turned off.  
For more information, refer to the heading later in this chapter titled, �Prompt 
Dialogs.� 

Step 21  -  Post Run Results  
The Post Run Results dialog allows the operator to view or print the test results.  
Test results are normally saved automatically, and no operator intervention is 
required. The dialog includes three buttons which offer the following choices: 
•  Save Calibration Data 
•  Discard Calibration Data 
•  Discard All Data for UUT 
The following aspects of the Post Run dialog can be configured using the 
MET/CAL Run Time application:  
•  The dialog can be turned off.  
•  A macro can be set up to view and/or print specified reports.  

Up to 8 different calibration reports can be set up for viewing or printing. By 
default, the following reports are provided:  
1. Certificate of Calibration 
2. Calibration Results 
3. Calibration Summary 

•  Users can add new reports or modify existing reports as needed. 
•  Users can selectively disable the software�s ability to save test results, discard 

test results and discard all information for the UUT.  
After the operator chooses Close to exit from the Post Run Results dialog, the Run 
Time returns to its top-level menu and waits for further input from the user.  
At this point, the Run Time has completed the sequence for running one 
procedure, and the user can execute a different procedure, re-execute the same 
procedure, or exit from the application.  
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Run Time Menu 
This section provides information about the Run Time application�s menu items. 
When investigating the menu, it may be useful to open the Run Time and actually 
view the various items available. 

File 
Choosing File in the top-level menu causes a drop-down submenu to display. The 
menu has only one item, Exit. Choosing Exit closes the MET/CAL Run Time 
application.  
There are three other, equivalent ways to close the application:  
1. Choose Close in the system menu. The system menu drop-down can be seen 

by clicking in the upper-left hand corner of the window. 
2. Type Alt + F4. 
3. Click on the X in the upper, right-hand corner of the window. 
The Run Time application cannot be closed during procedure execution. 

Calibrate 
Choosing calibrate initiates the sequence of steps described under the heading 
above titled, �Run Time Overview.� 
The first thing the user sees after choosing Calibrate is a dialog that allows the 
procedure to be selected.  
Actually, one of two different dialogs will be seen, depending on the procedure 
selection method. The Options menu item allows you to select procedures. A 
description of the Options menu appears a few paragraphs forward. 

 Selection By Procedure Name  
If the procedure selection method is By Procedure Name, choosing Calibrate 
causes the Run Time to display the Procedure Selection dialog. This dialog 
presents a directory of available MET/CAL procedures, listed by name.  
You can add, delete, or modify procedures using the Editor. Open the Tools menu 
and select Administrator. The Run Time application does not provide a way to 
add, delete or modify procedures. It only allows the operator to select a procedure 
to be executed.  
The Procedure Selection dialog includes OK, Cancel and Search buttons.  
•  OK selects the highlighted procedure. If no procedure is highlighted, an error 

message displays, and you can try again.  
•  Cancel returns to the top-level menu without doing anything.  
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•  Search allows searching for any substring contained in a procedure name. 
The Procedure Selection dialog does not list hidden or non-executable procedures. 
Hidden procedures are usually subprocedures that are not selected directly. Use 
the Editor to work on hidden or non-executable procedures.  

Selection By Asset Number  
If the procedure selection method is By Asset Number, choosing Calibrate causes 
a prompt for the UUT asset number to appear. The number you type into the 
dialog box must be a valid asset number. 
After the user enters the asset number of the UUT, the Run Time queries the 
database to find the procedure associated with the specified asset.  

Options  
Choosing Options causes a drop-down submenu to display. The submenu contains 
the following items:  

Demo Mode  
The Run Time can operate in two modes: demo mode and real mode.  
If the Demo Mode menu item is checked, the Run Time is in demo mode; 
otherwise, the application is in real mode. 
In demo mode, the Run Time application does not communicate with instruments. 
Also, in demo mode, the application doesn�t open or close serial ports, doesn�t 
initialize the IEEE-488 bus, and doesn�t read from or write to serial or IEEE-488 
instruments.  
In all other respects demo mode is the same as real mode, including the saving of 
results. In general, results generated when running in demo mode should be 
discarded, since demo mode is provided for testing and debugging only, and is not 
intended for use in calibrating real UUTs. Note that you can debug procedures by 
using the Editor�s Test Run capability. The Run Time�s demo mode may be 
useful, however, in testing prompt screens, Run Time reports, and so on.  
When the Run Time is in demo mode, it appends � - Demo Mode � to the 
application name in the window title.  
It is not possible to change modes during procedure execution.  



 Running Calibration Procedures 
 Run Time Menu 4 

  4-13 

Procedure Selection Method  
Highlighting Procedure Selection Method in the Options menu causes an 
associated menu containing the following choices to be displayed:  
•  By Procedure Name 
•  By Asset Number 
At any given time, one and only one of these items will be checked. You can click 
on a different item to change the selection method. The Run Time remembers the 
selected method until you change it. Choosing a different procedure selection 
method has no effect until you choose Calibrate, in the top-level Run Time menu. 
Refer to the heading above titled, �Calibrate� for a description of how the 
procedure selection method affects the Run Time operation.  

Instruments  
This selection lists the current configured instruments in your system and allows 
you to add new instruments as the need arises. It also provides a means for editing 
or deleting instruments. 

IEEE-488 Boards  
This selection allows you to configure the number of IEEE-488 boards that are in 
the computer and lists their manufacturer model name. 

Default Serial Port  
This selection allows you to configure a default serial port for serial controlled 
UUTs. 

Default Font 
This selection allows you to determine the font used in the Editor application, and 
the Run Time application�s Post Test - List option. To maintain column alignment 
when procedure listings are viewed, the default font must be a fixed-point font 
(one in which every character consumes the same amount of space on the line). 

Display Font 
You may configure the font in some of the prompts and messages Run Time 
operators see during procedure execution. The Display font may or may not be a 
fixed point font. Verify that the fonts you select display correctly with the monitor 
used on the calibration system. 
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Post Run Reports 
Configuration of Post Run Reports permits choosing those reports in MET/CAL�s 
RPT directory that you wish to make available to the Post Run or Autosave 
Macros which run at the conclusion of a calibration. 

Post Run Dialog 
The Configure Post Run Dialog selection allows the restriction of an operator�s 
options after the procedure is complete. For example, if you want an operator to 
have only the option of viewing a report, select View and click OK. After the 
UUT is tested, an operator can only view the report, not print it. If none of the 
options are enabled, the Post Run dialog box does not display at the end of each 
procedure.  
The Post Run dialog can be set up so the results of a calibration are NOT stored 
automatically, and even to initially select �Discard Data on Close.� These may be 
useful features during development or testing of new calibration procedures, or 
when you are first getting MET/CAL set up. 

Autosave Pass / Autosave Fail Macros 
The Autosave pass and Autosave Fail macros let you determine which reports are 
displayed or printed automatically when the procedure completes. The list is the 
same one as for the Post Run Macro, created from those reports you select using 
Configure Post Run Reports. 

Post Run Macro 
Configuring the Post Run Macro lets you set up a macro for the operator to use at 
the end of each calibration procedure. The operator executes the post Run Macro 
by choosing the MACRO button on the Run Time Post Run dialog box. For 
example, if you want the operator to be able to both view and print the reports, 
select both Print and View for each of the listed reports. The list is the same one 
as for the Autosave Pass and Autosave Fail macros, created from the reports you 
select using Configure Post Run Reports. 

Break  
Break has only one purpose: it aborts the operation of a closed-loop procedure. A 
closed-loop procedure runs without operator intervention. Break is normally 
disabled (grayed out) except during procedure execution. 

Tools  
You can configure the Tools menu to contain any other applications you want to 
start from the Run Time. By default, the menu includes other MET/CAL 
applications.  
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When you select an application in the Tools menu, the Run Time attempts to start 
that application. If the selection is another MET/CAL application that requires 
logging into the database, you do not need to re-enter the login information 
(database, name, and password). The other application starts using the same 
database, login name and password as the user who is currently logged in to the 
Run Time. 
There is no automated way to modify the contents of the Tools menu using the 
MET/CAL applications. To add, change, or delete items in the Tools menu you 
must edit the MET/CAL initialization file, metcal.ini. The Run Time Tools 
menu items are in the [Run Time Tools] section. Use Notepad or a similar text 
editor to modify the initialization file. 

Security  
Choosing Security in the top-level Run Time menu causes a drop-down submenu 
to appear. The submenu has only one item, Password. 

Password  
Choosing Password causes the Change Password dialog to be displayed.  
This dialog allows the currently logged-in user to change his or her password.  

About  
Choosing About causes a dialog to display that shows:  
a) Company Name 
b) Copyright Message  
c) Application Name 
d) Product Name and Version  
e) Current User  

This is the full name (not the login name) of the currently logged in user.  
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Run Time Window 
The top-level window of the Run Time application consists of a title, a menu 
(described above), and information displayed in the window below the menu. The 
information displayed in the window usually changes as the procedure runs.  
The information described in this section is not the only information presented to 
the operator during procedure execution. Other information, however, is not 
written directly on the Run Time�s main window. Rather, it appears in various 
pop-up dialogs and windows that appear and disappear as the procedure runs. 
Most, but not all, of these pop-ups require a response from the operator.  
Refer to Figure 4-2 as you review the following information about the Run Time 
display. 
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Menu Title

Operator Name

Revision Number

Indicates whether you 
are running Demo mode
or Real mode. 

Header Message
Part of Running
Procedure

Test Results WindowProcedure Name  

 
il402c.eps 

Figure 4-2. Run Time Window 
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Title  
The window title shows the name of the application (MET/CAL Run Time). If the 
Run Time is in demo mode, �- Demo Mode� is appended to the application name 
in the title.  

Menu  
See preceding discussion, under the heading, �Run Time Menu� above.  

Run Time Window Information  
In the upper portion of the window, below the menu, the Run Time shows the 
operator�s name, the procedure revision, and the procedure name.  

Operator Name  
The name shown is the full name of the currently logged in user.  

Procedure Name and Revision Number 
The procedure name and revision are not shown unless a procedure is running.  
If the main procedure calls a subprocedure, the name and revision of the 
subprocedure are shown while the subprocedure is executing. After the 
subprocedure returns to the main procedure, the main procedure�s name and 
revision are displayed again. 

Header Message  
Below the procedure name, space is reserved for a header message. This message 
is generated whenever a HEAD statement in a procedure is executed. A HEAD 
message remains on the screen until a subsequent HEAD statement changes it, or 
the procedure terminates.  
An empty HEAD statement in the procedure can be used to clear the message.  
The header message can be used to provide a descriptive header that groups the 
individual test steps of a procedure into functional groups. For example, a procedure to 
calibrate a handheld DMM might divide its test steps into AC voltage tests, DC voltage 
tests, AC current tests, DC current tests, and resistance tests. The procedure could 
include a corresponding HEAD statement for each group of tests. The operator 
will then see, for example, �AC Voltage Tests� displayed in the header message 
area during the ACV tests, �DC Voltage Tests� during the DCV tests, and so on.  

System Stimulus/Measurement Information  
Below the area reserved for the header message, a line is reserved for information 
about the current output stimulus or current measurement. This area is not seen on 
the illustration, since it is hidden at the moment by the Test Information dialog. 
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For example, if you write and execute a procedure containing the lines:  

5700 1V S 
DISP Pause 

you will see the text: Stimulus:  1V appear in the Run Time screen when the 1V 
stimulus is present. The stimulus is present from the time the setup statement 
executes until the 5700A is reset. 
If you write and execute a procedure containing the line:  

8508 1V S  

you will see text similar to Measurement: 1.001V. This text is shown until the 
operator responds to the prompt that instructs him to adjust the UUT for a reading 
of 1V. The 1.001V here is just an example. If you actually do this and run the 
procedure in real mode you would see the actual Fluke 8508A measurement here. 

Asset Number Prompt 
Each MET/CAL Calibration Procedure verifies or adjusts a particular Unit Under 
Test (UUT). The asset number of the UUT is required by the Run Time because 
calibration results generated during procedure execution are stored in a database 
in which all information is organized by asset number.  
If the asset number does not exist in the database, a separate dialog prompts for all 
required fields in the Inventory Table. The Run Time application then writes the 
new asset and all required inventory table data to the database. 
If the procedure selection method is By Asset, then, when the operator enters an 
asset number, MET/CAL retrieves the name of the associated procedure from the 
database.  
If the specified asset is new to the database, no information exists for the asset in 
the database, so the associated procedure name cannot be retrieved. In this case, 
MET/CAL displays the procedure selection dialog to allow the procedure to be 
selected by name. If the procedure name field in the inventory table is configured 
as a required field, the specified procedure name is pre-loaded into the subsequent 
prompt for required inventory data. This mechanism allows the association 
between asset number and procedure name to be initially set up using the Run 
Time application when the asset is first added to the database. The other way to do 
this is to use the manual Entry application to add the asset, including the 
associated procedure name, before using the Run Time application to run a 
procedure to calibrate the asset. 
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If the specified asset is not new to the database, inventory table information for 
the asset already exists in the database. In this case, as stated above, MET/CAL 
attempts to retrieve the name of the associated procedure from the database. If 
there is no associated procedure name, MET/CAL displays the procedure 
selection dialog to allow you to select the procedure by name. The Run Time 
application cannot, however, modify an existing inventory table entry, so the 
selected procedure is executed by the Run Time, but the name is not saved in the 
inventory table for the specified asset. The only way to permanently associate a 
specified procedure name with an existing asset is to use the Manual Entry 
application. 

Prompt Dialogs 
There are two configurable dialogs that normally are presented to the operator 
each time a procedure is executed. These dialogs are referred to as the pre-prompt 
dialog and the post-prompt dialog. The pre-prompt dialog displays after you select 
a procedure, but before procedure execution begins. The post-prompt dialog 
displays after procedure execution terminates. 

Pre-Prompt Dialog 
You can configure the pre-prompt dialog that appears after a procedure has been 
selected, but before the start of procedure execution. 
Used the pre-prompt dialog to display read-only information, or to prompt the 
operator for information that will be written to the results or, in some cases, used 
during procedure execution. 
The pre-prompt dialog is controlled by the parameter named prompt in the 
[startup] section of the MET/CAL initialization file, metcal.ini. The prompt 
parameter specifies the name of the file that controls the pre-prompt dialog.  
The default initialization file contains the line: 

prompt = promptdb.txt 

This indicates that the name of the file that controls the pre-prompt dialog is 
promptdb.txt.  
To turn off the pre-prompt dialog, the system administrator can change the 
initialization file to read, �prompt = none.�  
An equivalent way to turn off the pre-prompt dialog is to edit the prompt file 
(default name promptdb.txt) and change it so that it contains no lines other 
than comments and blank lines. Any line that begins with a pound sign (#) or a 
semicolon (;) is a comment line. 
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The default pre-prompt dialog prompts the operator for the temperature, the 
humidity, the work order number, and asks whether the calibration seal on the 
UUT is intact. By modifying the pre-prompt file the administrator of the system 
can prompt for any desired information.  
If the value entered by the operator for a data item is to be written to the database, 
the value must be written to one of the fields of the calibration table, and it must 
not be a field that is automatically updated by the MET/CAL Run Time.  
Normally all fields in the pre-prompt dialog are displayed in a single dialog. 
However, if the system is set up to prompt for a large number of items, a sequence 
of separate dialogs will appear until all necessary prompts have been shown.  
Refer to the heading �Customizing Prompts for the Operator� in Chapter 7 for 
additional information, including a detailed description of the format of the 
pre-prompt file, and other information about customizing the pre-prompt file.  

Post-Prompt Dialogs  
There are two post-prompt dialogs: the pass-prompt dialog and the fail-prompt 
dialog. After each procedure execution one or the other, but not both, of these 
dialogs is displayed. 
If the overall result of the procedure is PASS, the pass-prompt dialog is displayed. 
If the overall result is FAIL, the fail-prompt dialog is displayed. The condition that 
determines an overall result of FAIL is that one or more of the individual tests has 
failed because the UUT is out of tolerance at that test point. 
The pass-prompt and fail-prompt dialogs are separately configurable.  
Use the post-prompt dialogs to display read-only information, or to prompt the 
operator for information that will be written to the results.  
The pass-prompt dialog is controlled by the parameter named pass_prompt in the 
[startup] section of the MET/CAL initialization file, metcal.ini. The 
pass_prompt parameter specifies the name of the file that controls the pass-prompt 
dialog.  
Similarly, the fail-prompt dialog is controlled by the parameter named fail_prompt 
in the [startup] section of the MET/CAL initialization file, metcal.ini. The 
fail_prompt parameter specifies the name of the file that controls the fail-prompt 
dialog.  
The default initialization file contains the following two lines: 

pass_prompt = pass_db.txt 
fail_prompt = fail_db.txt 

These indicate that the names of the files that control the pass-prompt and 
fail-prompt dialogs are pass_db.txt and fail_db.txt, respectively.  
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To turn off the pass- or fail-prompt dialogs, you can change the initialization file 
to read, �pass_prompt = none�, or �fail_prompt = none.� Since the two dialogs are 
independently configurable, it�s possible (for example) to set up the system so that 
a post-prompt dialog appears when the overall result is FAIL, but not when the 
overall result is PASS.  
As with the pre-prompt dialog, an equivalent way to turn off the post-prompt 
dialog is to edit the appropriate prompt file (default names are pass_db.txt 
and fail_db.txt), and change it so that it contains no lines other than 
comments and blank lines. Any line that begins with a pound sign (#) or a 
semicolon (;) is a comment line. 
The default pass-prompt dialog shows the operator the number of marginal tests, 
the time it took to calibrate the UUT, the overall test result (PASS, FAIL, etc.), 
and asks the operator to indicate that the results are either �As Found� or �As 
Left�, and to enter an optional comment. 
Note that a �marginal test� is one where the test passed, but the error expressed as 
a percentage of the test tolerance is greater than the adjustment threshold. The 
adjustment threshold is a configurable parameter set in the procedure. It is 
typically set to 70%. 
The default fail-prompt dialog is the same as the pass-prompt dialog, except that it 
also shows the total number of tests that failed.  
However, as with the pre-prompt dialog, the post-prompt dialogs can be 
configured by the person who sets up the system. When you run a procedure, you 
may or may not see the information and prompts described for the default prompt 
dialogs.  
If the value entered by the operator for a data item is to be written to the database, 
the value must be written to one of the fields of the calibration table, and it must 
not be a field that is automatically updated by the MET/CAL Run Time.  
Normally all fields in the post-prompt dialog are displayed in a single dialog. 
However, if the system is set up to prompt for a large number of items, a sequence 
of separate dialogs will appear until all the prompts have been shown.  
Refer to the section �Customizing Prompts for the Operator� in Chapter 7 for 
additional information. There, you will find a detailed description of the format of 
pass-prompt and fail-prompt files, and other information about customizing them. 
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Procedure Execution 
This section describes how the Run Time application executes a MET/CAL 
procedure. The information following is mainly intended for the person who will 
be writing those procedures, or modifying a supplied procedure. 
Some of the information in this section is repeated in the MET/CAL Reference 
Manual. In fact, as you prepare procedures for your site, refer to that manual for 
complete reference information about the FSCs that make up the MET/CAL 
procedure language. The descriptions that follow are provided to assist in giving 
an overview of the Run Time�s procedure execution process. 

Procedure Statements 
Each MET/CAL procedure consists of a header followed by a sequence of 
procedure statements. 
An individual procedure statement begins with a step number, followed by a 
Function Select Code (FSC). The FSC is a keyword that identifies the type of 
procedure statement. 
Example: 
1.001  5500   40   35.00V      0.72U      5kH      SI     2W 

In this statement the FSC is 5500, which identifies the statement as one that 
controls a Fluke 5500A calibrator. 

Example: 
1.001  DISP         Set the Capacitance Decade to 4.70nF. 

In this statement the FSC is DISP, which identifies the statement as one that 
issues a prompt to the operator. 
For a detailed description of the procedure header, see the MET/CAL Reference 
Manual under the heading, �MET/CAL Procedure Header.� 

Step Numbers 
As mentioned above, each procedure statement begins with a step number. The 
step number has two parts, as follows: 
•  The major step number is the test number. 
•  The minor step number defines the sequential position of the statement within 

that test. 
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You can see step numbers in a procedure by using the Editor application, or 
looking at the currently executing procedure using the Post Test List option. 

Example: 
3.020  5500       3.513V               50H       SI    S  2W 

The above example is the 20th statement in test number 3. 

Tests 
Statements in a procedure are grouped by major step number into blocks that 
comprise individual tests. 
A typical test has three parts: 
1. Connections 
2. Setups 
3. Evaluation 
In a simple case, a single procedure statement performs all three parts of the test. 
For example: 
STEP  FSC  RANGE NOMINAL   TOLERANCE   MOD1   MOD2  3  4 CON 
1.001 5700 400   350.0mV   2.9U        60H               2W 

This single statement (assuming the default state of the ASK flags), performs the 
following operations: 
1. Connection - An automatic connection message displays that prompts the 

operator to connect the UUT to the 5700A Output Terminals. 
2. Setup - An automatic range message displays that prompts the operator to set 

the UUT to the 400mV AC Range. 
3. Setup - The 5700A is programmed to output 350mV, 60Hz with internal 

sense. 
4. Setup - The Slew dialog displays that prompts the operator to Adjust stimulus 

for a UUT reading of 350mV at 60Hz. When slewing is complete, System 
Actual is set to the final 5700A output voltage, and UUT Indicated is set to the 
value in the Nominal field. 

5. Evaluation - UUT Indicated is compared to System Actual, according to the 
specification in the Tolerance field, and test results are generated. 

In many cases, however, a test is made up of multiple procedure statements. More 
information about the three parts of a test (connections, setups, and evaluation) is 
given below. 
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Connections 
The operator performs connections under the direction of prompts that the 
procedure generates. Connection message prompts can be automatically generated 
by an instrument FSC or the connection (CON) FSC, or the person who writes the 
procedure can create the message prompts using the display (DISP) or picture 
(PIC) FSC. 
Connection messages instruct the operator, or, in the case of the PIC FSC, show 
the operator graphically how to interconnect the UUT and the calibration 
standards. See Automatic Connections, Operator Information Prompt, and 
Pictorial Information Prompt in the section on run time prompts later in this 
chapter. 
For a complete descriptions of the DISP, PIC, and CON FSCs see the FSC 
Reference chapter of the MET/CAL Reference Manual. 

Setup 
Once the connections are made, a test typically requires one or more setups to be 
performed. Setups fall into one of three categories: 
1. Setting up the UUT. 
2. Setting up the standards required for the test. 
3. Setting up the memory registers containing UUT Indicated and System Actual, 

which are used to perform the test evaluation. 

Setting up the UUT 
The UUT is set up either manually by the operator or automatically by MET/CAL 
if it has remote control capability. Prompts to the operator to set up the UUT can 
be automatically generated by an instrument FSC or RNG FSC or by using the 
DISP, MESS, PIC, or SET FSCs. For example, the following statements would all 
generate the operator prompt Set UUT to the 10 MOhm range. 
1.001  RNG          10MZ 

1.001  5700   10    10.00000MZ     0.00410U              2W 

1.001  DISP         Set UUT to the 10 MOhm range. 

See the headings, Automatic Range Message, Automatic Test Setup Prompts, 
Automatic UUT Setup Prompts, and Operator Information Prompt in the section 
on run time prompts later on in this chapter. For a complete description of 
instrument FSCs, RNG, DISP, MESS, PIC, and SET see the FSC Reference 
chapter of the MET/CAL Reference Manual. 
The IEEE FSC is used to set up UUTs with an IEEE-488 interface and the PORT 
FSC is used to set up UUTs with an RS-232 interface. The statement below uses 
the SCPI remote protocol to program a UUT with an IEEE-488 interface. 
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The UUT is a DMM. The SCPI commands select 2-wire Ohms and the 10 MOhm 
range. The IEEE-488.2 *OPC? (Operation Complete query) command is also sent 
to determine when the setup is complete. 
When the setup is complete, the DMM returns a �1� which MET/CAL 
subsequently reads using the [I] special construction. The programming string is 
automatically terminated by MET/CAL using the IEEE-488 EOI (End or Identify) 
line. 
1.025  IEEE         FUNC "RES";:RES:RANG 10e+6;*OPC?[I] 

If the UUT has a RS-232 interface, the same command could be sent using the 
PORT FSC. For serial UUTs the terminator must be specified. The terminator can 
be included at the end of the output string or declared globally using the 
[OTERM] special construction (see Port FSC in FSC references). In this case a 
carriage return is specified at the end of the output string using the [13] special 
construction. 

1.025  PORT         FUNC "RES";:RES:RANG 10e+6;*OPC?[13][I] 

For a complete description of IEEE and PORT see the FSC Reference chapter of 
the MET/CAL Reference Manual. 

Setting up Standards 
MET/CAL can set up remotely programmable and manual standards. An 
instrument FSC is used to set up a standard for which there is a built-in MET/CAL 
driver. A device for which MET/CAL has a built-in driver is referred to as a 
System Instrument. 
Example, Setting up a System Instrument:  
STEP  FSC  RANGE NOMINAL  TOLERANCE   MOD1    MOD2  3  4 CON 
1.001 5700 400   350.0mV  2.9U        60H                2W 
 
2.001 5700       350.0mV              60H              S 2W 

The above statements set up the 5700A to output 350mV at 60Hz with internal 
sense (2-wire). Statement 1.001 will also set up the UUT range and perform an 
evaluation. Statement 2.001 only sets up the standard (MOD4 = S). Both 
statements will generate an automatic connection message unless otherwise 
inhibited using the ASK- FSC. 
Remotely programmable standards for which there is no built-in driver are 
referred to as User-configured Instruments. 
The IEEE and PORT FSCs are used to set up IEEE-488 and RS-232 controlled 
user-configured instruments, respectively. The IEEE and PORT FSCs must 
contain the correct protocol for controlling the standard, as described in the 
remote programming section of the instrument�s operating manual.  
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Example, Setting up a User-configured Instrument: 
1.001  IEEE         [@2812]:INST:NSEL 1;:VOLT 2;:CURR 1 

The above statement sets up the PM 2812 DCV power supply channel 1 to 2V 
with a current limit of 1A. 
Manual standards are set up by the operator under the direction of prompts 
generated by the DISP, MESS, and PIC FSCs. 
Example, Setting up a manual standard: 
1.001  DISP         Set the 792A to the 220mV range. 

Setting up Memory Registers 
The correct memory registers must be set up with the values of UUT Indicated and 
System Actual for the test evaluation to be properly performed. These registers are 
automatically set up by instrument FSCs that perform an evaluation (MOD4 = 
blank) as shown in the simple 5700A example earlier in this section. However, 
there are many tests where an instrument FSC evaluation cannot be used. For 
these tests, one or more additional FSCs must be used to set up the UUT Indicated 
and System Actual values in the correct memory registers. This is the case for 
closed-loop tests and tests where the UUT units are not the same as the units of 
the applied standard. 
Example, closed-loop test: 
STEP  FSC   RANGE NOMINAL   TOLERANCE   MOD1   MOD2  3  4 CON 
1.001 5700        10.0000V                              S  2W 
1.002 IEEE        ?[I] 
1.003 MEMCX 20    10.000V   0.0005U 

The action of each test step in the above example is detailed below: 
1. Setup - The 5700A is programmed to output 10V DC and a value of 10 is 

stored in memory register MEM1. 
2. Setup - The UUT reading is read via the IEEE-488 bus and stored in memory 

register MEM. 
3. Setup - Swap the contents of registers MEM and MEM1. This is necessary so 

System Actual, the 5700 output, and UUT indicated, the UUT reading, are in 
the correct registers for the MEMC (memory compare) evaluation FSC. 

4. Evaluation - Compare the UUT Indicated to System Actual against the UUT 
specification in the Tolerance field. 
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Example, units of UUT parameter and applied parameter differ: 
STEP   FSC   RANGE NOMINAL  TOLERANCE   MOD1  MOD2  3  4 CON 
1.001  5700        2V                   60H            S 2W 
# Get the 5700 accuracy at 2Vrms 
1.002  MATH        M[1] = ACCV2(“Fluke 5700A”, “Volts”, 2.0, 60.0) 
# Convert to Vp 
1.003  MATH        M[1] = M[1] * 2 * SQRT(2) 
1.004  ACC         2.828Vp  M1U 
1.005  IEEE        ?[I] 
1.006  MEMCX 2.0   2.828Vp  0.045U 

The action of each test step in the above example is detailed below: 
1. Setup - The 5700A is programmed to output 2Vrms at 60Hz and store a value 

of 2 in memory register MEM1. 
2. Setup - Retrieve the voltage accuracy of the 5700A at 2Vrms, 60Hz from the 

5700A accuracy file. 
3. Setup � Convert the accuracy in Vrms to Vp. 
4. Setup � Establish the system accuracy in volts peak for the 5700A output. 

2.828 is stored in memory register MEM1, overwriting the value of 2 stored 
there in Step 1. 

5. Setup - Obtain the UUT reading and store it in memory register MEM. 
6. Evaluation - Compare the UUT Indicated (MEM) to the System Actual 

(MEMCX Nominal Value) against the UUT specification in the Tolerance 
field. 

A number of FSCs can be used to set up memory registers. For a complete 
description of these FSCs, see ACC, MATH, MEM2, MEME, MEMI, and 
OPBR in the FSC Reference chapter of the MET/CAL Reference Manual.  
The IEEE and PORT FSCs can be used to set up memory registers MEM and 
MEM2 by using the [I] and [I$] special constructions respectively. Also see �Use 
of Standard Memory Registers� in the chapter covering General Rules for FSCs in 
the MET/CAL Reference Manual. 

Evaluation 
Each test ends with a test evaluation. The basic result of an evaluation is that the 
test passed or failed. Evaluations can be either numeric or Go-NoGo. Numeric 
evaluations save numeric data in the results for the test. Go-NoGo evaluations 
only save a pass or fail indication for the test. 

Numeric Evaluation 
A numeric evaluation is performed by the following FSCs: 
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•  An instrument FSC evaluation test where the standard is sourcing an output to 
the UUT and slew or keyboard entry mode is specified. 

•  An instrument FSC evaluation test where the standard is measuring an output 
of the UUT. 

•  The MEMC FSC. 
•  The DOSE FSC when the user-written program appends the percent error for 

the test to dosdose.dat. 
A numeric evaluation may have additional qualifiers that can be added to the 
evaluation result. For example, a marginal pass is an evaluation in which the 
error, expressed as a percentage of the test tolerance, is less than or equal to 100% 
(a configurable value), but greater than the threshold value (also configurable, but 
usually 70%). 

Instrument FSC Evaluation Test 
Instrument FSCs are FSCs that refer directly to system standards for which 
MET/CAL provides a built in driver. An evaluation test is specified for an 
instrument FSC when the MOD4 field is blank. An Instrument FSC Evaluation 
Test compares the System Actual to the UUT Indicated value for the test against 
the UUT specification in the Tolerance field.  
Example, standard sourcing an output to the UUT: 
STEP  FSC   RANGE NOMINAL   TOLERANCE  MOD1   MOD2  3  4 CON 
1.001 5700  400   350.0mV   3.9U       60H               2W 
The above statement will use the slew mode to obtain the UUT reading unless 
otherwise specified. When slew mode is used, the UUT Indicated value is taken 
from the Nominal field and the System Actual is the final slew value. See �Slew 
Dialog� under Run Time Prompts later in this chapter. 
The keyboard entry mode is used if the K-flag is set when the statement is 
executed or the B-flag is set and the operator chooses keyboard when the Test 
Evaluation dialog is displayed. The K-flag and B-flag are set using the ASK+ 
FSC. For keyboard entry mode, the System Actual is the Nominal field value and 
the UUT Indicated is the value entered from the keyboard. See Keyboard Entry 
Operator Prompt also under Run Time Prompts. 
For a complete description of enabling and disabling keyboard entry and slew 
modes, refer to ASK+ and ASK- in the FSC Reference chapter of the MET/CAL 
Reference Manual. 
Example, standard measuring an output of the UUT: 
STEP  FSC   RANGE NOMINAL   TOLERANCE   MOD1  MOD2  3  4 CON 
1.001 34401 400   350.0mV   3.9U        60H              2W 
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In this example, where the standard is measuring an output of the UUT, the 
Nominal field is taken as the UUT Indicated output. The value measured by the 
standard is used as the System Actual. 

MEMC/MEMCX FSCs 
The MEMC and MEMCX FSCs perform a numeric evaluation similar to an 
instrument FSC evaluation test. However, unlike an instrument FSC, MEMC and 
MEMCX cannot measure the UUT output or obtain the UUT reading via slew or 
keyboard entry mode. The UUT data must be obtained prior to execution of the 
MEMC statement. The MEMC and MEMCX FSCs are typically used in closed-
loop tests and tests where the UUT units are not the same as the units of the 
applied standard. They are also used for to perform the evaluation when the 
reference is a user-configured instrument or manual standard. 
Example, closed-loop test: 
STEP  FSC   RANGE NOMINAL   TOLERANCE  MOD1   MOD2  3  4 CON 
1.001 5700        10.0000V                             S 2W 
1.002 IEEE        ?[I] 
1.004 MEMCX 20    10.0000V  0.0005U 

The action of each test step in the above example is detailed below: 
1. Setup - The 5700A is programmed to output 10V DC and a value of 10 is 

stored in memory register MEM1. 
2. Setup - The UUT reading is read via the IEEE-488 bus and stored in memory 

register MEM. 
3. Evaluation - Uses the UUT Indicated, the System Actual, and the UUT 

specification in the Tolerance field to determine whether the test passed or 
failed. 

Example, units of UUT parameter and applied parameter differ: 
STEP  FSC  RANGE NOMINAL   TOLERANCE   MOD1   MOD2  3  4 CON 
 
1.001 5700       2V                   60H            S 2W 
# Get the 5700 accuracy at 2Vrms 
1.002 MATH       M[1] = ACCV2(“Fluke 5700A”, “Volts”, 2.0, 60.0) 
# Convert to Vp 
1.003 MATH       M[1] = M[1] * 2 * SQRT(2) 
1.004 ACC        2.828Vp  M1U 
1.005 IEEE       ?[I] 
1.006 MEMCX 2.0  2.828Vp  0.045U 
 



 Running Calibration Procedures 
 Procedure Execution 4 

  4-31 

The action of each test step in the above example is detailed below: 
1. Setup - The 5700A is programmed to output 2Vrms at 60Hz and store a value 

of 2 in memory register MEM1. 
2. Setup - Retrieve the voltage accuracy of the 5700A at 2Vrms, 60Hz from the 

5700A accuracy file. 
3. Setup � Convert the accuracy in Vrms to Vp. 
4. Setup � Establish the system accuracy in volts peak for the 5700A output. 

2.828 is stored in memory register MEM1, overwriting the value of 2 stored 
there in Step 1. 

5. Setup - Obtain the UUT reading and store it in memory register MEM. 
6. Evaluation - Compare the UUT Indicated (MEM) to the System Actual 

(MEMCX Nominal Value) against the UUT specification in the Tolerance 
field. 

Example, User-configured Measurement Instrument 
STEP  FSC  RANGE NOMINAL   TOLERANCE   MOD1   MOD2  3  4 CON 
1.001 IEEE       [@3458]DCV 10;ARANGE ON;TRIG HOLD 
1.002 IEEE       OUT 10V;OPER;*OPC?[I!] 
1.003 IEEE       [@3458]TRIG SGL[I] 
1.004 ACC        V         2.6P% 2e-6U 
1.005 MEMC 22    10.00V    0.01U 
 
1. Setup � The User-configured DMM (in this case a 3458A) to DCV, 

autorange, and trigger  hold. 
2. Setup � The UUT is set to 10V DC and operate. 
3. Setup � Obtain the reading from the User-configured DMM and store it in 

memory register MEM. 
4. Setup � Establish the system accuracy as 2.6ppm of reading plus 2uV. The 

ACC statement takes the Nominal value from MEM when the ACC Nominal 
field does not contain a value. In this case MEM is the User-configured DMM 
reading from step 3. 

5. Evaluation - Compare the UUT Indicated (MEMCX Nominal Value) to the 
System Actual (MEM) against the UUT specification in the Tolerance field. 

DOSE FSC (Numeric Evaluation) 
The DOSE FSC runs a user-provided program or batch file. The DOSE FSC 
behaves like a numeric evaluation when the user-written program or batch file 
appends the percent error for the test to dosdose.dat. 
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For a complete description of this FSC, see DOSE in the FSC Reference chapter 
of the MET/CAL Reference Manual. 

Go-NoGo Evaluation 
A Go-NoGo evaluation is performed by the following FSCs: 
•  An instrument FSC evaluation test where the standard is sourcing an output to 

the UUT and Go-NoGo mode is specified. 
•  The EVAL FSC. 
•  The PICE FSC. 
•  The DOSE FSC when the user-written program does not append the percent 

error for the test to dosdose.dat. 

Instrument FSC Evaluation Test 
Instrument FSCs are FSCs that refer directly to system standards for which 
MET/CAL provides a built in driver. An evaluation test is specified for an 
instrument FSC when the MOD4 field is blank. An Instrument FSC Evaluation 
Test uses the System Actual, the UUT Indicated value for the test, and the UUT 
specification in the Tolerance field to determine whether the test passed or failed. 
Example, Go-NoGo Instrument Evaluation Test. 
STEP  FSC  RANGE NOMINAL   TOLERANCE   MOD1   MOD2  3  4 CON 
1.001 ASK+       G 
1.002 5700 400   350.0mV   3.9U        60H               2W 

The above statement will use the Go-NoGo evaluation if the G-flag is set when the 
statement is executed or the B-flag is set and the operator does not choose 
keyboard or slew when the Test Evaluation dialog is displayed. The G-flag and B-
flag are set using the ASK+ FSC. When Go-NoGo mode is used, no numeric data 
for the test is stored in the results. 
For a complete description of enabling and disabling Go-NoGo mode, refer to 
ASK+ and ASK- in the FSC Reference chapter of the MET/CAL Reference 
Manual. 

EVAL FSC 
The EVAL FSC presents a message to the operator and typically waits for a YES 
or NO response. The operator�s response determines the result of the test (PASS 
or FAIL). See Test Evaluation Prompt under Run Time Prompts later in this 
section. 
Example 
1.009  EVAL   Did the UUT display test pass? 
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For a complete description of this FSC, see EVAL in the FSC Reference chapter 
of the MET/CAL Reference Manual. 

PICE FSC 
The PICE FSC displays a picture to the operator and waits for a YES or NO 
response. The operator�s response determines the result of the test (PASS or 
FAIL). See Pictorial Information Prompt under Run Time Prompts later in this 
section. 
For a complete description of this FSC, see PICE in the FSC Reference chapter of 
the MET/CAL Reference Manual. 

DOSE FSC (Go-NoGo Evaluation) 
The DOSE FSC runs a user-provided program or batch file. The DOSE FSC 
behaves like a Go-NoGo evaluation when the user-written program or batch file 
appends PASS or FAIL for the test to dosdose.dat. 
If neither PASS nor FAIL is appended, a pass condition is assumed.  
For a complete description of this FSC, see DOSE in the FSC Reference chapter 
of the MET/CAL Reference Manual. 

Procedure Flow Control 
When MET/CAL executes a procedure, it starts on the first line after the header 
and executes the lines in order until one of the following occur: 
1. The end of the procedure is reached. 
2. An END statement is executed. 
3. A JMP, JMPF, JMPT, JMPL, or JMPZ statement transfers control to a 

different procedure statement. 
4. A repeat statement (RPT) transfers control to Step 1 of the test. 
5. A CALL statement transfers control to a subprocedure. 
6. The operator alters the normal procedure execution sequence using the Post 

Test List, Repeat, Cancel, or Terminate options. 
The OPBR (Operator Branch) FSC can be used with the JMPF, JMPT, or JMPL 
FSCs to perform a jump based on the operator�s response to a Yes/No prompt. See 
Test Decision Prompt under Run Time Prompts later in this section. 
For a complete description of these FSCs, see the FSC Reference chapter of the 
MET/CAL Reference Manual. 
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Run Time Prompts 

Automatic Connection and Disconnection Message Prompts 
Automatic connection and disconnection message prompts are generated by 
instrument FSCs and the CON (connection) FSC. Automatic connection messages 
generally have limited utility, because MET/CAL builds them with only the 
information contained in the CON (UUT connection) field of an instrument FSC. 
For example, the following statements would generate the subsequent automatic 
connection and disconnection messages: 
1.001  5500   4   3.500V     0.034U      60H     SI       2W 
2.001  5500       100.0mA    1.2U                         2W 

 
The automatic disconnection message prompt is displayed when the UUT 
connection changes. In this case, the 5500A NORMAL outputs are used for 
voltage, however, the AUX outputs are used for current. 

 
Statement 1.001 specifies an AC voltage with a 2-wire connection to the UUT. 
This is enough information for MET/CAL to determine that the 5500A NORMAL 
output terminals must be used. However, this is not enough information to 
determine exactly which UUT terminals must be connected to the 5500A 
NORMAL output terminals. Typically, a procedure writer inhibits automatic 
connection and disconnection messages using the ASK- FSC, and instead uses a 
more descriptive prompt using the DISP or PIC FSCs. See the headings titled, 
�Operator Information Prompt� and �Pictorial Information Prompt� later in this 
chapter. 
Example: 
1.003  DISP      Connect the 5500A to the UUT as follows: 
1.003  DISP      5500A NORMAL Output Hi to UUT V-Ohm-Diode 
1.003  DISP      5500A NORMAL Output Lo to UUT Common 

For a complete description of enabling and disabling automatic connection and 
disconnection messages, refer to ASK+ and ASK- in the FSC Reference chapter 
of the MET/CAL Reference Manual. 
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Automatic Range Message Prompt 
Automatic range message prompts are generated by instrument FSCs and the RNG 
(range) FSCs. Automatic range messages are built by MET/CAL using the 
information contained in the RANGE field of the instrument FSC and the 
NOMINAL and MOD1 fields of the RNG FSC. For example, the following 5500 
and RNG statements would generate the same automatic range message (shown 
immediately after the fragment): 
13.001  5500   4     3.500V     0.056U      1kH     SI    2W 
2.001   RNG          4V                     AC 

 

For more information on UUT range messages, see the following sections in the 
MET/CAL Reference Manual: 
•  RANGE Field under �Instrument FSCs� in General Rules for FSCs 
•  UUT Range Message under �Automatic Messages�, also in General Rules for 

FSCs 
•  RNG in the FSC Reference. 
For a complete description of enabling and disabling automatic range messages 
refer to ASK+ and ASK- in the FSC Reference chapter of the MET/CAL 
Reference Manual. 

Automatic Test Setup Prompts 
Automatic test setup prompts are generated by an instrument FSC evaluation test, 
nominal setup test, or comparison test that is measuring an output of the UUT. For 
example the following 34401 statement would generate the subsequent automatic 
test setup prompts: 
1.002  34401        1.00V                              N  2W 
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After the 34401A takes the measurement, the following automatic test setup 
prompt is generated: 

 
For a complete description of enabling and disabling automatic test setup prompts 
refer to ASK+ and ASK- in the MET/CAL Reference Manual. 

Automatic UUT Setup Prompt 
An automatic UUT setup prompt is generated by an instrument FSC setup test that 
is monitoring an output of the UUT. For example the following 34401 statement 
would generate the following automatic UUT setup prompt: 
1.002  34401        1.00V                              S  2W 

 
For a complete description of enabling and disabling the automatic test setup 
prompt, refer to ASK+ and ASK- in the FSC Reference chapter of the MET/CAL 
Reference Manual. For an explanation of how to create a message to annotate or 
replace the automatic UUT setup message, see MESS in the same chapter.  

Slew Dialog 
The slew dialog is a popup screen that is created by an instrument FSC evaluation 
test, nominal setup test, or comparison test when the calibration instrument is 
applying an output to the UUT. The slew dialog is the default mode for evaluation 
tests and comparison tests. The slew dialog is always displayed for nominal setup 
tests. When the slew dialog is displayed, it is used to perform one of the two 
functions enumerated below: 

1. Slewing the Calibrator Output 

If the calibration instrument allows incremental changes of its output around the 
nominal value, then, as the operator changes the displayed value of the slew 
screen, the number shown reflects the actual calibrator output. The operator slews 
(adjusts) the display until the UUT is reading the nominal value as closely as 
possible. If the statement is an evaluation test or comparison test, MET/CAL can 
then calculate the deviation from the nominal required to make the UUT read the 
desired value and report the error of the UUT. 
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Example: 
1.002  5700      1.00V         0.01U                      2W 

 
2. Matching the UUT Display 
If the calibration instrument cannot incrementally change its value, like 5700A 
resistance, slew acts differently. The operator adjusts the displayed value in the 
slew screen to match the reading shown on the UUT�s display. MET/CAL uses 
this information to calculate the UUT error. 
Example: 
1.002  5700     1.00kZ       0.01U                        4W 

 
For more information on the slew dialog, see the following sections in the 
MET/CAL Reference Manual: 
•  Stimulus Function under �Evaluation Test� 
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•  Stimulus Function under �Nominal Setup Test� 
For information on configuring the slew message, see the following sections in the 
MET/CAL Reference Manual: 
•  Slew Message under �Automatic Messages� in General Rules for FSCs 
•  MESS in the FSC Reference. 
Keyboard entry or Go-NoGo mode can be selected in lieu of slew mode using the 
appropriate ASK flags (see Keyboard Entry Operator Prompt and Test Evaluation 
Prompt in this section). 
For a complete description of enabling and disabling slew mode refer to the ASK+ 
and ASK- FSCs in the MET/CAL Reference Manual. 

Keyboard Entry Operator Prompt 
The keyboard entry operator prompt is a popup screen that is created by an 
instrument FSC evaluation test, nominal setup test, or comparison test to enter the 
UUT reading. The operator prompt is used when the keyboard entry evaluation 
mode is selected. The following is an example instrument evaluation test with 
keyboard entry mode selected: 
1.002  ASK+         K 
1.003  5700         1.00V          0.01U                  2W 

The ASK+ K statement specifies keyboard entry mode for the 5700 evaluation 
test. This causes the following dialog to be displayed, prompting the operator for 
the UUT reading: 

 

For more information about the Keyboard Entry Operator prompt, see Instrument 
FSCs in the chapter �General Rules for FSCs� of the MET/CAL Reference 
Manual. 
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Memory Register Operator Prompts 
Memory register prompts are popup screens that prompt the operator to enter data 
for the MEM and MEM2 registers. The MEMI FSC is used to display a prompt 
for the value of MEM. The MEM2 FSC is used to display a prompt for the value 
of the MEM2 register. 
The MEMI FSC can be used to prompt for the UUT reading, like the keyboard 
entry prompt does for instrument FSC. Specifically, the MEMI FSC must be used 
to obtain the UUT reading when its units are not the same as those of the standard. 
This situation is illustrated in the following procedure fragment: 
1.001   5700   2V                     60H              S  2W 
1.002   DISP   Press the MIN MAX button. 
1.002   DISP   Press BEEPER button to display maximum values. 
1.003   MATH   MEM = ACCV2(“Fluke 5700A”, “Volts”, 2.0, 60.0) 
1.004   MATH   M[1] = 2 * SQRT(2) * MEM 
1.005   ACC    2.828Vp        M1U 
1.006   MEMI   Enter UUT reading in volts peak: 
1.007   MEMCX  2.828Vp        0.045U 

Note that the UUT reading is in volts peak even though the setup of the standard is 
specified in volts RMS. If a 5700 evaluation test had been used instead of a 5700 
setup test, the UUT reading would have been incorrectly entered in volts RMS. 
The following shows the MEMI prompt that would be generated by the above 
procedure fragment: 

 
For a complete description of creating memory register prompts, see MEMI and 
MEM2 in the FSC Reference chapter of the MET/CAL Reference Manual. 
Descriptions of the other FSCs used in the above example can also be found in the 
FSC Reference. 

Test Decision Prompt 
The test decision prompt is a popup screen that is created by the OPBR FSC. The 
test decision prompt is used for yes/no conditional prompts. The OPBR FSC does 
not perform an evaluation. The following example OPBR statements create the 
example dialog immediately following: 
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1.001  OPBR    Have any components been replaced? 
1.001  OPBR    (Note: the hardware adjustments may be skipped 
1.001  OPBR    unless the ScopeMeter test tool has been repaired. 
1.001  OPBR    If adjustments S6, S7, S8 or S9 fail, also 
1.001  OPBR    restart the MET/CAL procedure and perform H1..H4.) 
1.002  JMPT    1.003 

 
For a complete description of creating the test decision prompt, see OPBR in the 
FSC Reference chapter of the MET/CAL Reference Manual. A Description of the 
JMPT FSC can also be found in the FSC Reference. 

Test Evaluation Prompt 
The test evaluation prompt is a popup screen that is created by an instrument FSC 
evaluation test or the EVAL FSC. In the case of an instrument FSC, the test 
evaluation prompt is generated only when the Go-NoGo evaluation of the UUT 
reading is selected. The following is an example instrument evaluation test with 
Go-NoGo mode selected: 
1.002  ASK+       G 
1.003  5700       1.00V        0.01U                      2W 

The ASK+ G statement specifies Go-NoGo mode for the 5700 evaluation Test. 

 

Following is another example instrument evaluation test with Go-NoGo mode 
selected: 
1.002  ASK+         B 
1.003  5700         1.00V          0.01U                  2W 

The ASK+ B statement also specifies Go-NoGo evaluation of the UUT reading, 
but allows the operator to optionally select either keyboard entry or slew 
evaluation mode. 
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The EVAL FSC is used for Go-NoGo evaluations that cannot otherwise be 
performed using an instrument FSC Go-NoGo evaluation. 
Example EVAL FSC: 
1.002  DISP  Plug a test lead into the V Ohm Diode terminal, 
1.002  DISP  and touch the probe to the 10A terminal. 
1.003  EVAL  Does UUT indicate between 0.1 and 0.5? 

 

For more information about the test evaluation prompt, see Instrument FSCs in 
General Rules for FSCs and EVAL and MESS in the FSC Reference chapter of 
the MET/CAL Reference Manual. A Description of the DISP FSC can also be 
found in the FSC Reference. 

Test Information Prompt 
The test information prompt is a popup screen created by the DISP FSC. The test 
information prompt is used to present the operator with textual information that 
does not require a Yes or No response. 
43.004  DISP   Press the MIN MAX button. 
43.004  DISP   Press the BEEPER button to display maximum values. 

 
For a complete description of creating the test information prompt, see DISP in 
the FSC Reference chapter of the MET/CAL Reference Manual. 

Pictorial Information Prompt 
The pictorial information prompt is a popup screen that contains a picture and is 
created by the PIC and PICE FSCs. Pictorial information is used instead of text. 
The pictorial-style prompt is normally only used in those cases when instructions 
to the operator would require a detailed description of a required calibration step 
that would be difficult to present in text-only form. 
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The PIC FSC is used for connections and setups, whereas the PICE FSC also 
performs a test evaluation. 
Example PIC FSC: 
2.003  PIC          55_s3_cw 

 

Example PICE FSC: 
1.007  PICE         7x-3_dsp 

 
zv405s.bmp 



 Running Calibration Procedures 
 Procedure Execution 4 

  4-43 

For a complete description of creating the pictorial information prompt, see PIC 
and PICE in the FSC Reference chapter of the MET/CAL Reference Manual. 

UUT Setting Prompt 
The UUT setting prompt is a popup screen that contains a list of UUT setups. The 
prompt is generated by the SET FSC and is typically used in procedures for 
oscilloscopes when a large number of setups is required, or the steps are unusually 
complex. 
Example: 
1.001  SET          VOLTS/DIV CH 1 : 1V 
1.001  SET          VOLTS/DIV CH 2 : 1V 
1.001  SET          TIME/DIV : 10us 
1.001  SET          Input Coupling CH 1 : 1 MOhm GND 
1.001  SET          Input Coupling CH 2 : 1 MOhm GND 
1.001  SET          ADD : Off 
1.001  SET          INVERT : Off 
1.001  SET          ALT/CHOP : ALT 

 

For a complete description of creating the UUT setting prompt, see SET in the 
FSC Reference chapter of the MET/CAL Reference Manual. 
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Post Test Module 
When a MET/CAL procedure executes, a series of calibration tests is performed. 
As described earlier, each calibration test is made up of connection messages, 
setup steps, and an evaluation step. The evaluation step is always the last part of a 
test. 
The Run Time application calls the Post Test module after each evaluation step. It 
also calls the Post Test Module after a system error, whether or not the error 
occurred in an evaluation step.  
The Post Test module has three main functions:  
1. It resets the system instruments. 
2. It generates results for the test that has just completed.  
3. It displays the Post Test dialog. 

System Instrument Reset  
Whenever the Post Test module is called, whether because an error occurred, or 
because an evaluation step has been completed, one of the first things it does is 
reset the system instruments that are in use.  
A system instrument is in use if the main procedure that is being executed, or any 
subprocedure it has called or may call, contains a reference to that system 
instrument. A reference is a use of an FSC that invokes the built-in driver for that 
instrument. For example, the Fluke 5700A is used by procedures that contain 
�5700� FSC statements. The statement need not have been executed in order for 
the instrument to be �in use.�  
It is possible to inhibit the normal resetting of the system instruments. To do this, 
clear the ASK 'Q' flag. Certain other ASK flags must be also clear (not set) in 
order to inhibit resetting of system instruments. Refer to the Reference Manual 
sections on the ASK+ and ASK- FSCs for details.  
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Post Test Dialog  
This section describes the Post Test Dialog as shown in the following figure. 

 
zv401s.tif 

On the left-hand side, the Post-Test Summary dialog shows the following 
information:  
Test Field 
The test field shows the test number and the test result. The test number is the 
major step number of the test. For example, test number 7 might look like the 
following: 

7.001 DISP  Connect... 
7.002 5700  1V     1% 

The test result is shown on the right-hand side of the Test field, and will be one of 
the following values: 
•  PASS 

A test result value of PASS indicates that the UUT is within the test tolerance 
at this test point, and is also within the adjustment threshold.  
The adjustment threshold is specified in the header of the main procedure 
being executed. The default value is 70%. If the error, expressed as a 
percentage of the tolerance, is less than the adjustment threshold the test result 
will be PASS.  
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•  MARGINAL PASS  
MARGINAL PASS indicates that the UUT is within the test tolerance at this 
test point, but not within the adjustment threshold.  
At some sites, the standard policy is to run the calibration adjustment 
procedure for a UUT if the UUT passes the verification procedure, but one or 
more test points generate a MARGINAL PASS result.  

•  FAIL 
FAIL indicates that the UUT is not within the test tolerance at the current test 
point, but is within the �significantly out of tolerance limit.� See the 
description of this limit in the FAIL NOTIFY USER section below.  
The [startup] section of the MET/CAL initialization file metcal.ini 
contains a parameter named pass100 that allows the system to be configured 
with respect to whether or not a test is a PASS or a FAIL when the error is 
exactly equal to 100% of the test tolerance.  
If pass100 = yes in metcal.ini, then the test result is MARGINAL PASS 
if the error is exactly equal to the test tolerance.  
If pass100 = no in metcal.ini, then the test result is FAIL if the error is 
exactly equal to the test tolerance.  
The default value of pass100 (as distributed) is yes. 

•  FAIL NOTIFY USER 
FAIL NOTIFY USER indicates that the UUT is not within the test tolerance at 
the current test point, and also not within the �significantly out of tolerance 
limit.� 
This limit is specified using the oot_lim parameter in the [startup] section of 
the MET/CAL initialization file metcal.ini. Legal values for the oot_lim 
parameter are between 99.9 and 500.0.  
The purpose of the oot_lim (out of tolerance limit) parameter is to allow a site 
to specify a limit above which a failing UUT is considered to be significantly 
out of tolerance, potentially requiring the recall of instruments recently 
calibrated or adjusted using the UUT in question. 
The default value of oot_lim (as MET/CAL is distributed) is 100.0. This is a 
conservative setting, indicating that any UUT that fails at any test point will 
generate the FAIL NOTIFY USER test result.  

Error Field 
The error is calculated as:  
 error = UUT Indicated � System Actual  
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If the NOMINAL units are dBm, the Nominal value is zero, the UUT Indicated 
value is zero, or the System Actual value is zero, the error is formatted as an 
absolute number.  
Otherwise, the error is formatted as a percentage of either the UUT Indicated or 
the NOMINAL value, depending on the value of the tol_ref_nominal parameter in 
the MET/CAL initialization file.  
For a Go/NoGo test the Error field is blank.  
Error % Tol Field 
For a numeric evaluation, this field shows the error expressed as a percentage of 
the test tolerance.  
For a Go/NoGo evaluation the Error % Tol field is blank. This applies to 
instrument evaluations with ASK+ �G� set, to EVAL statements, PICE statements, 
and to some DOSE statements.  
Range Field  
The Range field shows the UUT range, as indicated in the RANGE field of the 
procedure statement just executed. The Range field shows �A� to indicate auto-
range.  
UUT Indicated Field  
The UUT Indicated field shows the UUT Indicated value for the test. For a test in 
which the calibration standard is a stimulus device (like a Fluke 5700A), and the 
UUT is a measurement device (such as a Fluke 77), the UUT Indicated value is 
the reading taken by the UUT. If the test is a Go/NoGo test, the UUT Indicated 
field is blank on the Post Test dialog.  
For a test in which the calibration standard is a measurement device (such as an 
HP 3458A), and the UUT is a stimulus device, the UUT Indicated value is the 
expected reading, as indicated in the NOMINAL field of the procedure statement 
that performed the evaluation step.  
System Actual Field  
The System Actual field shows the System Actual value for the test.  
If the UUT is a measurement device, the System Actual is the true value applied to 
the UUT by the calibrator being used as a calibration standard.  
If the UUT is a stimulus device, the System Actual is the measurement taken by 
the measurement device being used as the calibration standard.  
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MOD1 Field  
The Post Test MOD1 field shows the information in the MOD1 field of the 
procedure evaluation step just executed. If you execute an evaluation step such as 
the following:  

STEP NOMINAL MOD1 TOLERANCE 

5700 10kH    1V   1%  

the evaluation is based on frequency (NOMINAL field), so you will see that 
MOD1 shows the voltage (1V in this example). 
Test Tolerance Field  
The Test Tolerance field shows the test tolerance in units of the NOMINAL field.  
For example, suppose you execute the procedure evaluation step:  

5700 100V         1% 

The test tolerance displayed in the Post Test dialog will be 1V, because 1V is 1% 
of 100V.  
System Accuracy Field  
The System Accuracy field shows the accuracy of the system instrument 
(calibration standard) used for the test.  
For example, suppose you execute the following procedure evaluation step:  
 5700 200V          1% 

If the 90-day accuracy file for the 5700A is used, the system accuracy will be 
shown as 1.3mV.  
This is because in the accuracy file, for the 220V range, the tolerance is given as 
6e-4 and the floor is 100e-6V. Note that the tolerance value in the accuracy file is 
a percentage.  
The calculation is therefore:  
 system accuracy = 6e-4 * .01 * 200V + 100e-6V 
... which is equal to 1.3mV, as shown in the Post Test dialog.  
If the test in the procedure is a MEMC test in which the system accuracy is 
specified using an ACC statement, MET/CAL uses the value from the ACC 
statement and does not look up the system accuracy in one of the FSC-specific 
system accuracy files. 
T.U.R. Field  
The T.U.R. field shows the test uncertainty ratio for the test.  
The test uncertainty ratio is the ratio of the test tolerance to the system accuracy.  
If the test tolerance or the system accuracy are specified in decibels (dBm), the 
quantity is converted to volts before it is used to calculate the T.U.R.  
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If the T.U.R. exceeds the T.U.R. limit specified in the MET/CAL initialization 
file, the Post Test dialog does not show the T.U.R. Rather, the dialog indicates 
that that the T.U.R. is greater than the limit, and shows the limit.  
The T.U.R. limit is specified by the tur_lim parameter in the [startup] section of 
the MET/CAL initialization file, metcal.ini. The default value for the limit is 
4.0. Any value between 0 and 10 can be specified. It is also legal to set tur_lim to 
none, which disables the calculation of the T.U.R. by the Run Time and Editor 
applications. If tur_lim is none, the Post Test dialog does not show values in the 
Test Tolerance, System Accuracy, or T.U.R. fields.  

Post Test Summary Dialog Buttons 
On the right-hand side of the Post-Test Summary dialog are 8 buttons. These have 
the following functions:  
Advance 
Choosing Advance causes procedure execution to resume at the next step.  
Repeat  
The basic function of Repeat is to repeat the current step. The precise operation 
of Repeat depends on the current setting of the ASK 'P' flag in the procedure.  
If the �P�flag is set, the procedure is re-started at the current procedure line when 
the operator selects the Post Test Repeat option.  
If the �P� flag is not set, the procedure is re-started at the first statement of the 
current test. The step number of the first statement of the test has the form 
XX.001. 
Note that when a test is repeated more than once (that is, executed more than 
twice), MET/CAL saves only the first and last results for that test step. 
Cancel 
Selecting Cancel is the same as Repeat (see above) except that when the operator 
chooses Cancel, the result of the canceled test is not saved.  
As with Repeat, the procedure step on which execution resumes is controlled by 
the current setting of the ASK �P� flag.  
The Post Test Cancel button can be disabled (grayed out) by not setting the ASK 
�X� flag in the procedure.  
A parameter ask_x_default in the [startup] section of the MET/CAL initialization 
file metcal.ini controls the default state of the ASK �X� flag.  
•  If ask_x_default is set to yes (or +), then the ASK �X� flag will be set by 

default in a procedure that does not specify otherwise. This means that the 
Post Test Cancel button is enabled by default.  
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•  If ask_x_default is set to no (or �), then the ASK �X� flag will not be set by 
default in a procedure that does not specify otherwise. This means that the 
Post Test Cancel button is disabled by default.  

 As distributed, ask_x_default is set to yes in metcal.ini.  
Adjust 
The Adjust button is enabled only if the error for the test just completed exceeds 
the adjustment threshold, and the procedure being executed contains an 
adjustment block for the current test step, and the ASK �J� flag is set.  
There is some interaction between the ASK �J�, �A�, and �F� flags. Refer to the 
description of the �ASK+� and �ASK-� FSCs in the MET/CAL Reference Manual 
for details.  
Procedures distributed by Fluke do not make use of in-line adjustment blocks. 
Separate verification and adjustment procedures are provided. When these 
procedures are used, the Adjust button will never be enabled.  
Remark 
Choosing Remark allows a remark of up to 32-characters to be entered. The 
entered remark is written to the results. Multiple remarks can be entered for one 
test step.  
List  
Choosing List causes a read-only listing of the current procedure to be displayed. 
When the listing is displayed, the current line (that is, the line just executed) is 
highlighted.  
The highlighted line can be changed using the Up Arrow, Down Arrow, Page Up, 
and Page Down keys, or by using the mouse to click on the desired line. 
Note that when the Run Time first displays the listing, the input focus is on the 
Advance button. The Up Arrow, Down Arrow, Page Up, and Page Down keys will 
not work as expected until the focus has been moved to the list box that shows the 
procedure. This can be done using the Tab key, or by clicking on the list box. 
The Procedure Listing window includes Advance and Terminate buttons. These 
are not the same as the Advance and Terminate buttons in the Post-Test Summary 
dialog. Choosing Advance in the Procedure Listing causes procedure execution to 
resume by executing the highlighted line.  
It is important to realize that if you choose the Post Test List button, and then 
immediately choose Advance in the Procedure Listing window, you will re-
execute the step that just completed. If you really just wanted to look at the 
procedure, and would like to resume execution as if you hadn't chosen List at all, 
you can choose Terminate in the Procedure Listing window, followed by 
Advance in the Post-Test Summary dialog, or you can move the highlighted line 
down one line in the Procedure Listing window, and then choose Advance there. 
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The ASK �L� flag can be used to enable or disable the List option in the Post-Test 
Summary dialog.  
Settings  
Choosing the Settings button causes the Run Time to display the last 18 settings 
created by the SET FSC. This allows the operator to verify that the UUT is set up 
correctly for the current test. This capability is used primarily in conjunction with 
calibration oscilloscopes. Refer to the SET FSC section in the MET/CAL 
Reference Manual for details.  
The Settings button is disabled unless one or more stored settings are available to 
be viewed.  
Terminate 
Choosing Terminate stops the execution of the procedure. Results generated 
before the procedure is terminated are not discarded, unless the operator 
subsequently chooses to discard them.  
The Terminate button can be enabled or disabled by setting or clearing, 
respectively, the ASK �T� flag. By disabling the Terminate and List options, a 
procedure writer can write a procedure that, barring errors, forces the operator to 
execute all of the tests in the procedure. Such a procedure should be carefully 
tested, however, because it can be difficult to terminate.  

Test Results Window 
As mentioned in the Run Time outline at the beginning of this chapter, the Test 
Results window is a separate window that shows a one-line, color-coded result for 
each test step in the Calibration Procedure.  
The Test Result window initially appears in minimized form. It can be opened, 
moved, re-sized, or minimized at any time during procedure execution.  
The contents of the Test Results window are not cleared until a subsequent 
Calibration Procedure is started. That is, after you finish a Calibration Procedure 
and return to the top-level Run Time menu, you can still look at the results of the 
procedure in the Test Results window. However, as soon as you start another 
procedure, or start to re-execute the same procedure, the Test Results window is 
cleared.  
The lines in the Test Results window are color coded as follows:  
•  GREEN indicates the test result is PASS. 
•  YELLOW indicates the test result is MARGINAL PASS. 
•  RED indicates the test result is FAIL. 
A PASS is a test in which the error, expressed as a percentage of the test 
tolerance, is less than or equal to the adjustment threshold. 
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A MARGINAL PASS is normally a test where the error, expressed as a 
percentage of the tolerance, is greater than the adjustment threshold, and less than 
or equal to 100%. The adjustment threshold is set in the header of the main 
procedure and is, by default, 70%.  
A FAIL is normally a test in which the error, expressed as a percentage of the test 
tolerance, is greater than 100%.  
The reason the above descriptions of MARGINAL PASS and FAIL say 
�normally� is that MET/CAL is configurable with respect to whether a test at 
exactly 100% of tolerance is considered a MARGINAL PASS or a FAIL.  
If the parameter pass100 in the [startup] section of the MET/CAL initialization 
file metcal.ini is set to yes, then exactly 100% of tolerance is regarded as a 
MARGINAL PASS, and the error must be strictly greater than 100% in order for 
the test to be a FAIL. If pass100 is set to no, then exactly 100% of tolerance is a 
FAIL, and the error must be strictly less than 100% in order for the test to be 
considered a PASS or MARGINAL PASS.  
However, note that there may be cases when the value displayed in the %Tol field 
does not appear to agree with the PASS/FAIL result of the test. This happens 
when the actual error, expressed as a percentage of the tolerance, is rounded up or 
down and displayed as 100%. For example, if the error as a percentage of the 
tolerance is 99.9999%, it will be displayed as 100%, but the test will be a PASS 
(actually a MARGINAL PASS), even if pass100 is set to no. This consideration is 
not specific to the Test Results window. It also applies to the Post Test dialog 
(discussed elsewhere in this chapter), and to the formatted results that MET/CAL 
writes to the database.  
If the operator terminates a test manually, the Test Results window displays a one-
line message in red indicating that the statement was terminated by the operator. 
The Test Result window can display a maximum of about 900 result lines from a 
single procedure run. If this limit is exceeded, the display functions as a 
first-in/first-out queue, always showing approximately the last 900 result lines.  
The content and format of the lines displayed in the Test Results window are fixed 
and cannot be customized by the user. 
For a normal instrument evaluation test, the Test Results window shows: 
No.........................test step number  
Range...................UUT range (if specified)  
UUT Indicated ....value indicated by UUT for test  
System Actual .....actual stimulus or measured value for test  
C...........................Y if System Actual correct using a correction file, otherwise N 
Modifier...............MOD1 value from test, if any, -- often shows frequency  
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Error ................... absolute error (UUT Indicated - System Actual)  
%Tol.................... error as a percentage of test tolerance  
For evaluation steps based on EVAL, PICE, DOSE statements, or instrument 
Go/No Go evaluation steps, some of the information is not available, and the field 
will be blank in the Test Results window.  
For example, in a Go / No Go test the operator is simply asked if the UUT 
Indicated value is between a specified set of bounds. The answer is Yes or No, and 
does not indicate a numerical error. Because of this you will see OPER-EVAL in 
the UUT Indicated column of the Test Results window, and the Error and %Tol 
fields will be blank. 

Safety Window 
The safety window is an always-on-top popup display that the Run Time creates 
whenever a potentially dangerous voltage is being generated during procedure 
execution by one of the configured system instruments the procedure is using.  
The word Danger is shown in the window title, and the standard lightning bolt 
danger symbol Y is shown below the title.  
The safety window does not appear when a dangerous voltage is generated by a 
user-configured instrument, or by any instrument being controlled by the IEEE or 
PORT FSCs.  
A dangerous voltage is any DC voltage greater than 60V, or any AC voltage 
greater than 42.4V (peak).  
Operators are cautioned not to rely only on MET/CAL's safety window as an 
indication of a dangerous voltage. There are two reasons for this: 
•  First, instruments not under control by a built-in MET/CAL instrument driver 

do not cause the safety window to appear when a dangerous voltage is present.  
•  Second, it is possible to manually override the setting of a calibrator so that it 

is generating an unsafe voltage without the Run Time�s knowledge.  
Always verify that instruments are in standby before touching the output 
terminals.  
The Run Time application attempts to disable the operation of screen savers 
during procedure execution in order to prevent the safety window from being 
covered up by the screen saver display. However, some screen savers do not 
conform to the guidelines for screen savers, so it can happen that the safety 
window will be covered up by a screen saver.  
Users are advised to disable screen savers when using the MET/CAL Run 
Time application to calibrate instruments.  
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Post Prompt Dialog 
When a calibration is complete or the procedure is terminated, the Run Time 
displays the Post Prompt Dialog. 
You can use the Post Prompt dialog to add administrative information necessary 
for the results. After adding the information, click OK. The following figure 
indicates typical information you can add to the results. Information entered on the 
Post Prompt Dialog can be included in the final calibration report. 

 
zv403s.bmp 

Figure 4-3. Sample Post Prompt Dialog 

Note 
The fields in the form may or may not be filled automatically, 
depending on how you have configured the PASS_DB.TXT and 
FAIL_DB.TXT files.  

Post Run Results  
After you close the Post Prompt dialog, the Run Time displays the Post Run 
Results dialog, as shown in the following figure. 

Note 
The following section describes all possible items in the Post Run 
Results dialog. However, using the Fluke Metrology Software 
Configure menu under the Run Time application, you can configure 
the dialog to exclude use of some of the items or to inhibit the dialog 
box from opening. Also, you can customize which reports are 
available. 
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Figure 4-4. Post Run Results Dialog 

Post Run Reports 
The dialog can be configured to permit selection of up to eight different reports. 
The configuration of the software as shipped has three of the possible eight reports 
already selected. These reports are as follows: 
•  Certificate of Calibration #1: a calibration certificate that lists the standards 

used to calibrate the UUT, the environmental conditions during calibration, 
who signed it, and when they signed it. 

•  Calibration Results Report #1: a test results report with detailed test results 
for each step. 

•  Calibration Summary Report #1: a summary report that summarizes the full 
results report. 
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Print Preview 
With one of the choices selected, click Print Preview to view the certificate or 
report without actually printing it. Use this selection to identify the report you 
want and to verify the information it contains. 

Print 
The Print selection allows you to print calibration results, summaries, and 
certificates. To print, proceed as follows: 
1. Select one of the reports. 

Click Print. The print dialog box opens. If the settings are not correct, make 
the desired changes in the settings. 

2. Click OK when you are satisfied with the settings (otherwise Cancel). 
The Run Time sends the certificate or report to the printer and returns you to 
the Post Run Results dialog. 

Print Setup 
Use Print Setup to select the printer, printing orientation, and other options. 

Macro 
Macros provide an automated method of storing a series of actions for later replay. 
This lets you minimize the number of selections you make after each Calibration 
Procedure. You need to select only the Macro button on the Post Run Results 
dialog to execute all of the actions previously set up in the Run Time application. 
(Configure | PostRun Macro selection). 
For example, you can use the Run Time to set up the macro to preview or print 
several types of reports automatically. Clicking Macro initiates the action. 

Calibration Data on Close 
You have several options for how you choose to handle calibration data when you 
close the application. The options are represented the following buttons: 
Save Calibration Data 
Test results are saved in the database when you close the dialog box. 
Discard Calibration Data 
Test results are not saved in the database when you close the dialog box. 
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Discard All Data for UUT 
Test results are not saved in the database when you close the dialog box. In 
addition, all date for the asset (UUT) is discarded from the database when you 
close the dialog box. This option will fail if the asset in question has prior 
calibration history in the database. If this is the case, an error message is generated 
and the user must select one of the other two choices. 
These buttons are mutually exclusive and the resulting action is permanent. The 
Configure PostRun menu in the Run Time application allows you to control 
availability of these options by selectively enabling or disabling them. 



Fluke Metrology Software 
Users Manual 

4-58 

 



  5-1 

Chapter 5 
Reports 

 Contents Page 

Introduction...................................................................................................... 5-3 
Types of Reports ....................................................................................... 5-3 
Elements of a Report ................................................................................. 5-5 
Running Reports........................................................................................ 5-6 
Adding a Crystal Report to the System..................................................... 5-6 
Report Creation Strategies ........................................................................ 5-7 

Using and Modifying Sample Reports.................................................. 5-7 
Creating Reports from Scratch.............................................................. 5-8 
Other Sources of Information ............................................................... 5-8 

Modifying Sample Reports.............................................................................. 5-9 
Modifying the Basic Inventory Report...................................................... 5-9 

Adding a Table to the Report................................................................ 5-11 
The Linking Expert ............................................................................... 5-12 
Adding Fields to the Report .................................................................. 5-13 
Adding Text Fields to the Report.......................................................... 5-13 
Changing the Record Selection Criteria................................................ 5-15 
Creating a Formula Field ...................................................................... 5-17 

Adding a Graphic ...................................................................................... 5-19 
Adding Boilerplate Text............................................................................ 5-20 
Adding a Page Number with Total Page Count ........................................ 5-21 
Considerations Specific to Run Time Reports .......................................... 5-22 

Configuring Post Run Reports .............................................................. 5-22 
Run Time Report Rules ........................................................................ 5-23 

Creating Reports from Scratch ........................................................................ 5-23 
Report Creation Process Overview ........................................................... 5-23 
How Information Gets Into the Database.................................................. 5-24 
Database Table Structures......................................................................... 5-25 

How to Interpret the Table Structures................................................... 5-25 
How to Interpret the Results Structures ................................................ 5-27 

Crystal Setup ............................................................................................. 5-29 
Configuring a Report From Scratch...................................................... 5-32 



Metrology Software 
Users Manual 

5-2 

Table Linking .......................................................................................  5-34 
Join Types.............................................................................................  5-34 
Inserting Data Fields ............................................................................  5-35 
Changing the Field Formats .................................................................  5-36 
Previewing the Report ..........................................................................  5-36 
Inserting Text Fields.............................................................................  5-36 
Formatting Fields .................................................................................  5-37 

Selecting Records .....................................................................................  5-38 
Record Selection Using the Select Records Expert..............................  5-38 

The Archive Flags.....................................................................................  5-39 
Inserting Groups .......................................................................................  5-40 

To insert a group...................................................................................  5-40 
Record Sort Order.....................................................................................  5-41 
Inserting Summaries .................................................................................  5-42 
Formatting the Sections ............................................................................  5-45 
Inserting Special Fields.............................................................................  5-46 
Inserting Lines and Boxes.........................................................................  5-47 
Modifying your Existing Reports to Run in Crystal Version 8 ................  5-47 

 



 Reports 
 Introduction 5 

  5-3 

Note 
Fluke Metrology Software is supplied with a series of Sample 
Reports that support the general usage philosophy of the product. It 
is impossible for Fluke to provide reports that will satisfy every 
situation. Therefore, the sample reports are provided as examples 
that you can modify as your requirements dictate. If these reports are 
used unmodified, as supplied by Fluke, it is your responsibility to 
verify that they provide the output that your circumstances require. 
They were created and can be modified with Crystal Reports 
Professional, which is supplied with the base software package. 

Introduction 
A fundamental reason for collecting information in a database is so you can 
retrieve it later and view trends and patterns within the data. Fluke MET/BASE 
applications give you a number of ways to see your data, from viewing it on the 
display to printing out multi-page reports. 
Fluke Metrology Software comes with several calibration reports. These reports 
are designed to satisfy the needs of a typical calibration laboratory. You can easily 
accomplish minor changes by editing one of the supplied reports. 
This chapter introduces the report process, and then demonstrates how to modify 
one of the supplied reports. Later sections show how to create a new report from 
scratch. 

Types of Reports 
MET/BASE uses reports that are written using Crystal Reports. You can run 
reports using stored procedures (explained later) or access data tables directly. 
Once you�ve written a report, it is installed into the system. This allows users to 
select them from a list and execute them. The way you install reports determines 
how they can be used in MET/BASE.  

General Reports Many reports fit into this category. The supplied reports that 
print database customization and calibration recall lists are 
examples of general reports. General reports typically provide 
information about more than one asset or history record (i.e. 
the recall report). They may or may not have user prompts. If 
general reports have user prompts, then Crystal Report prompt
should be used. You can run General reports from the 
MET/TRACK Application or from Crystal Reports. 
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Run Time Reports Run Time or Calibration reports are designed to print results 

of a specific calibration event. You can run them at any time 
from the MET/TRACK or the Run Time Applications. Run 
Time reports are written around a CTAG value. In the 
MET/TRACK application, the system will automatically 
prompt the user for the asset number, then for a calibration 
event. From this information, a specific CTAG value can be 
passed to the report. These reports show up in the run report 
window along with other reports. However, on the calibration 
screen, selecting Print will bring up a list of only Run Time 
reports. In the Run Time, since you just completed a 
calibration, the specific CTAG is known. Run Time reports 
typically are written to report off the stored procedure 
MCCALRESULT or MCCALRESLOC. 

Location Reports Location reports are designed to print information about a 
specific location event. You can run these reports at any time 
from the MET/TRACK application. These reports are written 
around a specific LTAG value. In the MET/TRACK 
application, the system will prompt the user for the asset 
number, then for a location event. From this information, a 
specific LTAG value can be passed to the report. These 
reports show up in the Run Report dialog, along with other 
reports. However, on the location screen, selecting Print will 
bring up a list of only location reports. Location reports are 
typically written to report off the stored procedure MCLTAG 
or MCLTAGINVENTORY. In addition, any report may be 
added as a Location Report. 

Maintenance 
Reports 

Maintenance reports are designed to print information about a 
specific maintenance event. You can run these reports at any 
time from the MET/TRACK application. These reports are 
written around a specific RTAG value. In the MET/TRACK 
tool, the system will automatically prompt the user for the 
asset number, and then for a Maintenance event. From this 
information a specific RTAG value can be passed to the 
report. These reports show up in the �run report� window 
along with other reports. However, on the location screen, 
selecting print will bring up a list of only Maintenance 
reports. Location reports are typically written to report off of 
the stored procedure MCRTAG or MCRTAGINVENTORY. 
In addition, any report may be added as a Maintenance 
Report. 
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Inventory Reports Inventory reports are designed to print information about a 

specific Inventory item. You can run these reports at any time 
from the MET/TRACK application. These reports are written 
around a specific MTAG value. In the MET/TRACK tool, the 
system will automatically prompt the user for the asset 
number. From this information a specific MTAG value can be 
passed to the report. These reports show up in the �run report� 
window along with other reports. However, on the Inventory 
screen, selecting print will bring up a list of only Inventory 
reports. Inventory reports are typically written to report off of 
the stored procedure MCMTAG or MCMTAGINVENTORY. 
In addition, any report may be added as an Inventory Report. 

Customer Reports Customer reports are designed to print information about a 
specific Customer. You can run these reports at any time from 
the MET/TRACK application. These reports are written 
around a specific KTAG value. In the MET/TRACK tool, the 
system will automatically prompt the user for customer ID. 
From this information a specific KTAG value can be passed 
to the report. These reports show up in the �run report� 
window along with other reports. However, on the Customer 
screen, selecting print will bring up a list of only customer 
reports. Customer reports are typically written to report off of 
the stored procedure MCKTAG or MCKTAGINVENTORY. 
In addition, any report may be added as a Customer Report. 

All report types use the standard RPT extension.  

Elements of a Report 
Every report must contain the following elements: 

•  The source location of the desired information. Specify the location by naming the 
data source, the table of interest, and the field name. In the Fluke Metrology 
system, field names are actually their field numbers, with a single alphabetic prefix 
identifying the table. For example, the Inventory table stores the Asset Number in 
field 4201, so this field is identified by I4201. 

•  Selection criteria - Crystal Reports lets you specify selection criteria using the 
Select Records Expert. It is not necessary to know SQL (Structured Query 
Language), but it is possible to edit SQL commands directly for record selection in 
complex situations. If you use Crystal, you have all the power of that language for 
specifying the precise information you want included in the report. If you are 
reporting using a stored procedure, no selection criteria are necessary as it is 
embedded in the stored procedure. 
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•  The appearance of the report. Again, Crystal has a friendly interface that lets you 
produce practically any appearance, from the very formal look of a Certificate of 
Calibration, complete with corporate logo and detailed laboratory specifications, 
through informal lists for your own use. 

Running Reports 
Once you have defined a report, you can preview and print it from within Crystal. 
You can also include the new report in the system and start running the report from 
the MET/TRACK Application. 

Adding a Crystal Report to the System 
The Fluke Metrology software provides a way to run reports directly from the 
MET/TRACK application. You must use reports created with Crystal Reports 
Professional.  
1. Copy the report file to your shared MET/CAL directory, and log in as the MT 

level user. This will open the Administrator Mode. 
2. Select Setup, Install Reports and the report selection screen appears. 

 
zv5001s.bmp 

3. All available .RPT files in the will appear for selection. Click the check box of 
the report you wish to add and click the + button. You will be prompted for a 
title of your report. 
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4. Once the report has been installed it must be configured. To configure a report, 
click SETUP, CONFIGURE REPORTS. 

5. Select the report you wish to configure and select where you would like your 
report to run. If you choose Reports, the report will be available in the Run 
Report section of MET/TRACK. If you choose Run Time, the report will be 
available at the end of the Run Time application. If you want to run from any 
of the forms, select each one for which you would like to have the report 
available. You may select one or more of the check boxes. 

 
zv5002s.bmp 

Report Creation Strategies 
To create your own customized reports, you can use a number of different 
approaches. Crystal Reports is a very capable report writing program, and it is the 
program that was used for developing the reports supplied with the Fluke 
Metrology software. 

Using and Modifying Sample Reports 
•  The simplest strategy for generating a report is to use one of the supplied 

reports without modification. For the most part, these samples will cover the 
needs you most frequently encounter.  

•  The next way to approach the process is to modify an existing report. Starting 
with a fully developed report can significantly reduce the time you need to 
spend to get the reports you need. With only minor modifications, you can 
quickly personalize one of the supplied sample reports. 

Note 
Even if you eventually decide to create a report that is not based on a 
supplied report, you should spend a little time in modifying one of the 
supplied reports to familiarize yourself with Crystal Reports, and to 
investigate the features of the sample reports. This is especially 
critical if you have little prior experience with report writing. 
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Creating Reports from Scratch 
•  The next developmental level is to create a report from scratch, making use of 

one of the �stored procedures.� In this method, you use pre-defined database 
requests that are stored in the database itself. As part of the Metrology 
Software package, Fluke provides stored procedures that you can use to 
quickly develop custom reports. A list of these stored procedures and 
information about using them appears later in this chapter. 

•  Finally, you can create an entirely new report by accessing the database tables 
directly. Creating a report from the base tables requires you to be 
knowledgeable about the underlying database structure and may require 
further study. This may be the best option if you have complex reporting 
requirements, as long as you are aware that this approach requires more 
fundamental understanding of the database and may require more effort, 
depending on your experience level. 

Other Sources of Information 
One critical element in your report creation strategy ought to be to familiarize 
yourself with the available sample reports and the report creation process. Besides 
this manual, other sources for more information include the Crystal Reports and 
Sybase manuals, both printed and online. 
Before you spend too much time creating your first report, you should take a few 
moments to become familiar with the process by reading the remainder of this 
chapter, and then look through the other documentation to gain an idea of the 
process and capabilities available. 

What is in the Rest of This Chapter? 

The remainder of this chapter discusses how to modify one of the supplied reports. 
It ends with some background information you will need if you must create a 
report entirely from scratch. 
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Modifying Sample Reports 
The reports that most users create are based on the reports that have been provided 
as part of the base package. Often, you can use these reports just as they come or 
with only slight changes. In either case, the supplied reports can serve as valuable 
templates and examples. Creating a new report is fairly simple if you base it on 
one of the provided reports.  
After you identify the changes you wish to make to a supplied report, open a copy 
of it in Crystal to modify it as needed. Crystal Reports provides a Design mode 
and a Preview mode. This allows you to check the affects of any changes without 
needing to run the report from one of the Fluke Metrology applications. 
The remainder of this section is a tutorial exercise that guides you through the 
steps for modifying one of the reports that has been supplied with the Fluke 
Metrology software.  
The tutorial exercise addresses the major issues faced by users when they want to 
modify one of the supplied reports: 
•  Selecting an existing report and opening it in Crystal�s Design Mode. 
•  Adding a database table. 
•  Adding a text object to print out boilerplate material, such as a legal 

declaration. 
•  Creating the report data select criteria. 
•  Generating a formula field to mark specific data in the report. 

Modifying the Basic Inventory Report 
1. Make sure that the database engine is running. Then, start up Crystal Reports. 

The first time you start up Crystal, it displays an opening screen called the 
Welcome Dialog. This screen provides you the option to create a new blank 
report, open an existing one, or use the report expert. 
At the bottom of the Welcome Dialog, a selection lets you decide whether to 
continue to start Crystal with this dialog or go immediately to the menus. If 
you turn this option OFF, each time you start Crystal subsequently, you must 
use the File menu to select either New or Open. �New� means that you will be 
creating a report from the ground up, while �Open� means that you want to 
start by modifying an existing report.  
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2. Whether you leave the Welcome Dialog active or not, you must first choose 
between creating a new report or opening an existing one. If you select Open 
Report, Crystal presents a standard directory and file-selection dialog for you 
to browse to the RPT file you wish to work on. Note: in order to see the 
reports in the MET/CAL directory, you must first go to File, Options, New 
Report and change the path to the new reports to direct it to the shared 
MET/CAL directory. 
If you have de-activated the Welcome Dialog, go to the File menu and select 
Open. 

3. Browse to C:\METCAL\BASIC INVENTORY V7.RPT. (This is the default 
path and filename. Adjust as needed to conform to your local installation.) 
This report is a very basic report, showing inventory table fields only. You 
will modify this report to provide a basic calibration due report. 
The following illustration shows the calibration due report BASIC 
INVENTORY V7.RPT, as it appears when opened in Crystal Reports Design 
mode.  

 
zv5003s.bmp 

Make note of the following: 
•  This display may differ from that on your computer. Instead of the field 

names, you may see lines of xxxxx�s. Proceed as follows: open the File 
menu, and select Options. A dialog box appears. In the lower right hand 
corner, under �Field Options�, add a check mark to the box labeled �Show 
Field Names.�  
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•  The supplied reports use strict naming conventions. You may see some 
reports with a letter �J� (RTRSLTJ1.RPT for example). These are 
Japanese versions. Open these reports only if you have a Japanese system. 

As you view the display, do not be too concerned just yet with the appearance of 
the viewing area (Crystal calls this the �Design Window�). The next section 
describes the process of creating a completely new report. There, you will find an 
illustration of the Design Window that identifies all the parts and describes their 
use. In this first tutorial, the idea is to leave the basic parts as they are, and just get 
practice with changing some of the details.  
Both selections can be useful, because, at times you may want to work only with 
the layout of the report. By de-activating Field Names, you can avoid being 
distracted by all the text. At other times, you must work with the individual fields, 
so you want to see the field names. 

Adding a Table to the Report 
Using the Basic Inventory V7.rpt report as a starting point, you will learn how to 
add a table to the report to make this report a simple Calibration Due for Next 30 
Days Report. This report uses a table called MT.INVENTORY. Since the 
calibration information is contained in the calibration table, you must also add the 
calibration table to the report. 
1. Click DATABASE, ADD DATABASE TO REPORT. You will be asked to 

log on to the server. Use the default Log In User ID: FLUKE, and the default 
password: FLUKE. 

2. When the Data Explorer window opens, expand the ODBC folder and select 
Calibration Data 8 and expand it. You now have access to the tables in the 
database. 
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3. Select MT.CALIBRATION and click Add then click Close. This added the 
table called mt.calibration to the report. 

 
zv5004s.bmp 

The Linking Expert 
Crystal Reports requires that multiple tables be linked so that data in one table can 
match data in another table. This will be discussed in more detail later. Crystal 
Reports has a feature called Smart Linking. When this feature is turned on in the 
Options, it will link the MTAGs located in each of the tables. The MTAG is a 
unique identifier assigned to an asset when the asset is added to the database. This 
same MTAG is copied into the calibration table when a calibration record is 
created and saved. This is how MET/CAL keeps track of the assets and their 
calibration records. Linking will be covered in more detail later. Click OK to 
accept the default links. 
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zv5005s.bmp 

Adding Fields to the Report 
Modify this report to create a simple calibration due for next 30 days report. 
To create the report, you need to add a new field to the report from the newly 
added calibration table. 
1. To do this, click INSERT, DATABASE FIELD. 
2. Select C2303 (Calibration Due Date) and double-click it. 
3. Your mouse cursor now has a box attached, representing the field we just 

selected. 
4. Drag this field to the details section (D) of the report and drop it next to 

the field I4218 (Owning Department). 
5. At this point, you can format the field or change the font, by clicking on 

the field with your right mouse button and select the appropriate function. 

Adding Text Fields to the Report 
Now you need to add a text header to the column that was just added. Crystal 
Reports has a very nice text object function that allows you to have formatted text 
and/or embedded database fields. 
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1. To add a text object for your header, click INSERT, TEXT OBJECT. 
2. Your cursor now has a box attached representing the text object. Drag the text 

object to the Page Header (PH) and drop it over the column you just added. 
3. Type �Due Date� in the text object box without the quotes. 
4. The text object may be resized by clicking once on the object. The text object 

will now have resizing handles 
5. If you want to edit the text within the object, double-click inside the text 

object. You will now see the cursor flashing inside the text object and a ruler 
now shows at the top of the page. You can now change the font, or otherwise 
format the text. 
The title of the report also needs to be changed. To do this, edit the title text 
object as shown above. Change the title to read, �Basic Calibration Due for 
Next 30 Days Report�. Preview the report by pressing the F5 key. The report 
should look similar to the following: 

 
zv5006s.bmp 

6. Note that all calibration dates are showing on the report. You need to limit the 
dates to just the due dates less than 30 days from today�s date. This is done 
using the Record Selection Expert. 
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Changing the Record Selection Criteria 
Crystal Reports allows you to limit or restrict the records that are to be included in 
the report. In our example, you need to limit the calibration due dates to all dates 
less than 30 days from today�s date. You also need to be certain that only the 
current records are shown. 
1. Open the Select Expert by clicking Report, Select Expert. 
2. The Choose Field box opens. 
3. Select field C2303 from the Calibration Table. 

 
zv5007s.bmp 
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4. The Select Expert opens. 

 
zv5008s.bmp 

5. In the pull down box to the left, select IS LESS THAN. In the pull down box 
to the right, type TODAY + 30. 

6. The only records selected will now be due dates less than 30 days from today�s 
date. You also need to set up the record selection to only show the current 
calibration records. This is done using a field called C2339 (Archive Flag) that 
MET/CAL uses to determine if the record is the current record. If a �1� is 
contained in this field, the data for the asset is the current data. Archive Flags 
are discussed later in this chapter in much more detail. 

7. Click New. Then select field C2339. 
8. In the pull down box to the left, select EQUAL TO. In the pull down box to 

the right, type �1� and click OK. 
9. The report will now ask if you want to refresh the data. Click YES. The 

preview data now only shows the current calibration data. 
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Creating a Formula Field 
In this exercise, you will create a formula to add to the report that will check the 
due date of the asset and print an �*� if the due date is less than today�s date. 
1. To insert a formula field, click INSERT, FORMULA FIELD. 

 
zv5009s.bmp 

2. The Field Explorer window opens. Click the NEW button in the menu bar. 
3. The Formula Name box opens. Type �Overdue� as the formula name and 

click OK. 
4. Type �IF� in the box at the bottom of the Formula Editor, then find field 

Calibration.C2303 in the left box at the top and double-click it. This brings the 
field down to the formula editor and formats it. 
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zv5010s.bmp 

5. Now type �< TODAY THEN �*� �. 
6. Click the X-2 button to check the formula syntax. If it shows no errors, click 

the Save and Close button to the left of the X-2 button. 
7. The Field Explorer window opens again. Click on OVERDUE with the right 

mouse button and click INSERT INTO REPORT. 
8. Drag the formula to the details (D) section of the report and place it to the right 

of the Due Date field and drop it. After refreshing the data, you now have an 
asterisk showing all overdue items. 
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zv5011s.bmp 

Adding a Graphic  
Personalizing a report for your organization or for a particular customer can result in 
a very attractive presentation by the simple addition of a graphic, such as a logo. 
You can add graphics to reports in several different formats, including bitmaps, 
(BMP), graphics interchange format (GIF), PC Paintbrush (PCX), tagged image 
format (TIF), and Targa (TGA). These five formats cover the most commonly 
used graphics formats, and many applications can be used for generating them.  
1. First, be sure that the database engine is running. Then, start up Crystal 

Reports. 
2. If the Welcome Dialog is active, choose Open Report. If it is not, under the 

File menu, select Open. 
3. Browse to the location of the report you wish to change. 
4. When the report opens, go to the Insert menu and select Picture. 

A dialog box opens for you to select or browse to the location of the graphics 
file. 

5. Select the desired graphics file. When you click OK to dismiss the dialog box, 
a rectangle appears in the report that follows the movement of the mouse. 

6. Position the rectangle where you want the graphic to appear, and click the 
mouse button once. The image from the file appears at that location in the 
report. 
You can crop, size or scale the image, or reposition it by dragging it to a 
different location. If you need more powerful graphics capabilities (such as 
rotating an image, or changing some of its colors), perform those operations in 
your graphics editor before bringing the illustration into your report. 
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7. To delete an image, select it and press the DELete or backspace key. If you do 
this, note that Crystal Reports has added space to accommodate the image, so 
you may need to remove that space if you remove the image. Similarly, if you 
insert a very large graphic and size it to be smaller, you may have to delete the 
added space. 
To do that, position the cursor in the middle of the line separating the report 
elements. When the cursor changes to up-and-down arrows, drag and drop the 
horizontal bar to re-size the element. 

As is true of any element you add to a report, if an image is added to the TITLE 
area, it only prints on the first page of any multiple-page reports. If you want the 
image to repeat on every page, you must include it in the page header or page 
footer area. 

Adding Boilerplate Text 
Text objects provide a convenient way to add arbitrary text to the reports you 
create. A common use of a text object is to insert the same text repeatedly. This is 
called boilerplate text. 
For example, you can add a text object to every page of a report to describe what 
type of report it is, or to make some sort of legal declaration, such as a claim 
regarding liability limits, or to explain the traceability of instruments in your lab. 
1. First make sure the database engine is running, then start up Crystal Reports. 

Under the File menu, select Open, and browse to the location of the report you 
wish to change. 

2. When the report opens, go to the Insert menu and select Text Object. 
A rectangle appears in the report that follows the movement of the mouse. 

3. Move the rectangle to the area where you want the text to appear: Title area 
for first page only, Page Header for the top of every page, and so on. When 
the rectangle is in the desired location, click the left mouse button once. This 
sets the location of the text object. 
When you establish the location of the text object, the cursor moves into the 
selected text area, and the text object editor starts up. A ruler line should 
display above the selected text area. 

4. In the text box, type in the text that you want to appear in the text object.  
When you have finished typing in the text, let the text object stay selected. 

5. Click once on the right mouse button and a floating menu appears. 
From this menu, you can elect to change the formatting in many different 
ways. Most of the available selections are self-explanatory and lead to familiar 
dialog boxes. 
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For example, if you select Change Font, you can change the font type, size, 
and various attributes such as bolding, italic, and the displayed color. Explore 
the dialog box selections. You have a high degree of control over the 
appearance of text that appears in the report. 

In addition, when you are editing a Text Object, you ought to explore the options 
available under the Format menu. The Format Text selection provides a large 
variety of options for various needs. For example, under the �Common� tab, the 
Can Grow selection lets text objects grow to fit the size required by the incoming 
information. Crystal Reports provides many such features. You can even do 
conditional formatting. For example, you can print the results of failed tests in red 
and passed tests in blue. 

Adding a Page Number with Total Page Count 
You can easily add page numbering to multi-page reports. The following steps 
result in a simple serial page number added to each page in the report. 
1. First, make sure the database engine is running. Then, start up Crystal Reports. 

If the Welcome Dialog is active, select Open Report. If you have de-activated 
the Welcome Dialog, go to the File menu and select Open. Browse to the 
location of the report you wish to change. 

2. From the Insert menu, select Special Field, Then, continue dragging across to 
the submenu and select Page N of M. 
When you click OK to dismiss the dialog box, a rectangle appears in the 
report that follows the movement of the mouse. 

3. Move the rectangle to the area where you want the page number to appear 
(normally the Page Footer area). 

4. When the rectangle is in the desired location, click the left mouse button once. 
The rectangle changes into a box containing the words �Page N of M.� If you 
have disabled the Show Field Names option, you will see a representative 
number, such as 5,555,555. 

5. With the Page N of M selected, click once on the right mouse button. 
A floating menu appears with formatting options similar to those available for 
text objects. 
•  To format page numbers, proceed just as you do for a text object: highlight 

the field and click the right mouse button to access the floating menu that 
makes the formatting options available. Make sure that the Decimals 
selection is set to �1�. 

•  You can also use the toolbar at the bottom of the window to change fonts, 
paragraph alignment, and so on. 
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Considerations Specific to Run Time Reports 
The following topics apply only to Run Time reports.  
When run immediately following a Calibration Procedure, Run Time reports return 
information about one and only one calibration event, the one just completed. 
When run from the MET/TRACK application, a dialog box asks the user for an 
asset number and then for a calibration event. After you enter the asset number, the 
entire list of calibration events for that asset appears. The list identifies date and 
time of the calibration. Except for this one case in the MET/TRACK application, 
Run Time Reports do not support operator prompts. 

Configuring Post Run Reports 
Up to eight Run Time reports can be set up for selection by the operator to run 
after a calibration. PostRun reports are configured in the Run Time application. 
Proceed as follows: 
1. With the database engine running, start the Run Time application. 
2. When the Run Time application starts, pull down the Configure menu, and 

select PostRun Reports. 
The Run Time presents a dialog box listing all available reports on the left. 
The report you wish to add must exist in the METCAL directory and must 
already be added using the MET/TRACK application. 

3. Select the report from the list on the left, and press the −> button to add it to 
the list of reports available. All the reports that appear in the list on the right 
will be available for operator selection at the conclusion of the calibration. 
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Run Time Report Rules 
•  Must be based on ctag as the only record selection criteria. 
•  Can read database tables directly, or use a stored procedure. 
•  Formula @mt company substitutes the company field from the Configure 

Company dialog box in DB Setup. 
•  Formulas @mt_ user1 through @mt_user5 cause the Run Time application to 

substitute user1 through user5 from the Configure | Company dialog box in 
Administrator Mode. 

Creating Reports from Scratch 
This final section of the chapter about reports provides important background 
material about the overall reporting process. This information is most useful if you 
are creating reports entirely from scratch, although it may be of interest even if you 
are simply modifying supplied reports. 

Report Creation Process Overview 
Creating your own reports can be very simple, or it can be quite complex, 
depending on your needs and the effort you are able to expend. The following are 
the major steps you must take, no matter how you approach the process: 
•  Design the report. 

The first step is to design the report. What information is it to contain? Is it to 
be run only one time, or according to some schedule? Is it a general report 
(one that can run any time), or a Run Time report (one that automatically runs 
at the end of a calibration procedure)? 
Before considering the method you will employ to create the report, first have 
a purpose firmly in mind, asking yourself, �What exactly is this report 
supposed to accomplish?� By designing the report first, you begin to identify 
which database fields contain the information of interest. You also make a 
start in deciding on a plan of attack: whether to duplicate the report from an 
existing one, or to build it entirely from scratch. 

•  Create the report. 
Once you know what you want to do, decide upon a plan of attack for creating 
the report. More than likely, you can modify one of those supplied with the 
Fluke Metrology software. 
In Crystal Reports, this is very straightforward. Open the sample report in 
Crystal, and make any necessary changes as described in the prior section of 
this chapter and resave the report back to the shared MET/CAL directory. 
If you are creating a new report, first open Crystal, and then select File 
Options. Open the SQL tab, and toggle the selection ON that allows reporting 
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on stored procedures. Now, as you begin creating the report, the stored 
procedures are listed and available to the report, just as the database tables are. 

•  Add the report to the system. 
After saving the report from Crystal, the final part of making the report is to 
add it to the system. Note that ONLY Crystal Reports can be added. If you are 
using some other report package, you will not be able to run the reports from 
within any of the applications. 
Reports are added to the system using the Administrator Mode. Use the Run 
Time application to configure Run Time reports for Post Run use if you want 
it to be available to operators upon completion of a Calibration Procedure. 

How Information Gets Into the Database 
The database gets its information from three sources: 
MET/TRACK Information can be explicitly entered into the database by 

manually keying it in or wanding it in with a bar code 
reader. 

Importation Information that pre-exists in a data source can be imported 
into the database. 

Procedure Results Data goes into the database automatically any time you run 
a calibration procedure using the Run Time application. For 
example, the date and time might be retrieved from the 
current system date and time. This method is of interest 
only if you are using MET/CAL or 5500/CAL for 
automating your calibrations. 
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Database Table Structures 
Fluke Metrology software uses a relational database consisting of many tables 
interrelated by key fields. The software uses some of the tables internally, and you 
should rarely, if ever, need to access them. The primary tables for producing 
reports on assets are as follows: 

mt.customers Information about your customers. 
mt.inventory Information about your assets. 
mt.calibration Latest and historical information about all Calibration events. 
mt.calresults Step by step test results for Calibration events. 
mt.standards All of the standards used to perform calibrations. 
mt.location The place where the asset is currently located 
mt.repair Historical information about an asset�s Maintenance events. 

How to Interpret the Table Structures  

One of the sample reports included in the shared MET/CAL directory is called 
TBLDEFS.RPT. This report gives a complete definition of all of the tables used 
in MET/CAL. Print this report and have it handy when creating a report from 
scratch as it has the field descriptions for all of the tables you will be using. If you 
perform any customization, this report will show the customization you have done. 

The report does not describe all the tables in the database. The database engine 
uses system tables, and the software itself creates and maintains a number of tables 
for its own internal uses. Even of the tables shown, only some fields will be of 
interest to you. However, for effective report writing, you need some basic 
information about the position of fields, their contents, and some customization 
information. 
For example, assume that you wanted to produce the report that you just printed, 
showing the current system customization. By looking at the table structure, you 
can see the Customization table contains the kind of information that such a report 
might contain. By knowing such things as the maximum possible length the field, 
you can format your report to present the data clearly. 
The Customization table contains information about field-level customization. The 
column names represent a particular field attribute (not a number.) Attributes 
define each field; the Customization table stores the present settings. Actually, the 
database uses some preset field attributes (e.g., FLDNUM for field number and 
DATALEN for data length). You can only make changes to the attributes via the 
customization interface.  
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The center column of each table has a short description of the intended use for the 
field. The description may be an actual field title or a few words to relay the idea 
behind including the field on the form. The last column gives the data type and 
byte size of the field. The data types are Character, Date, DOUBle, INTeger, and 
TimeStamp. Date fields contain only month, day, and year, while the TS field adds 
hour, minute, and second. 
The arrows show the internal linkages within the relational database. Two fields 
(CTAG and MTAG) carry linking information. The links are not customizable, 
and you cannot affect their action externally. The software maintains the links 
automatically. 

Stored Procedures 
A number of stored procedures are provided as a part of the Fluke Metrology 
Software package. You can find the input and output parameters of these stored 
procedures by running the report PROCPARM.RPT. This will generate the tables 
as they exist when the product is shipped. Not all of the reports supplied with 
Fluke Metrology software access the base tables directly. Instead, a technique has 
been developed to run a �stored procedure.� Stored procedures run within the 
database. They scan the base tables for information, and return this information to 
the report writer program for formatting and printing. 
A stored procedure is a series of SQL commands stored in the database. There are 
several reasons for storing such a series of commands in the database. Following 
are the most important benefits from using this approach: 
•  First, the stored procedure runs in the database itself, so network traffic is 

significantly reduced. After it executes, the stored procedure returns only the 
requested data to the client. This makes the stored procedure run much faster 
than the equivalent request coming from a report searching the base tables. It 
also uses the network bandwidth much more efficiently. 

•  Secondly, the stored procedure pre-processes the information, so the amount 
of data returned is only a subset of the entire body of information contained in 
the Calibration database. As a consequence, the sorting and grouping done by 
the report is minimized, resulting in speedier, more efficient operation. 

•  Finally, Crystal Reports does not perform multiple SELECT statements, so if 
you need multiple records from more than one tables in the database, the best 
solution is to use a stored procedure. 
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Fluke provides the following stored procedures with the software. 

mc_assets Provides information for a specific asset. 
mc_cal_due Provides a list of instruments due for calibration. 
mc_cal_loc_due  Provides a list of instruments due for calibration with 

location included. 
mc_cal_loc_due_range Provides a list of instruments due for calibration with 

location included based on a start and end date. 
mcctagresult Used primarily for run time calibration reports. Uses 

ctag to identify a particular cal event. 

mcresult Prompts for asset number, start date, end date. Returns 
information about one or more cal events. 

mccalresult Gets inventory, cal summary, stds, and results for a 
CTAG. 

mcctagresloc Used primarily for run time calibration reports with 
location information. Uses ctag to identify a particular 
cal event. 

mccalresloc Gets inv, cal summary, stds, results and loc for a 
CTAG. 

mcltag Gets location info for an ltag. 
mcmtag Gets inventory for an mtag. 
mcktag Gets customer info for a ktag. 
mcrtag Gets maintenance info for an rtag. 
mcltaginventory Gets location and inventory info for an ltag. 
mcrtaginventory Gets maintenance and inventory info for an rtag. 
mcmtagcustomer Gets inventory and customer for an mtag. 
rep_tech Returns information about repair events based on repair 

tech and start and end date. 
rep_asset Returns information about repair events based on asset 

number based on start and end date. 
mcktaginventory Gets inventory and customer info for a ktag. (multiple 

rows) 

How to Interpret the Results Structures  
The supplied report PROCPARM.RPT illustrates the structures of the results 
information returned by the stored procedures. You will need this information if 
you wish to use a stored procedure to filter and supply needed information.  
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Note 
After customization, it might be appropriate for you to run 
PROCPARM.RPT to generate a corrected version of the information. 

Run Time reports can be set up to run automatically upon completion of a 
Calibration Procedure. Those reports that are based on the MCCALRESULT 
stored procedure automatically supply the ctag value, since the Run Time has just 
assigned it. 
When a report is designed for use only as a Run Time report, it takes one argument 
(the ctag that the Calibration Procedure has just assigned). If you wish to run a 
Run Time report later (as if it were a General report), it will ask for an asset 
number and a calibration event. This is the only time a Run Time report prompts 
for information, and prompting for the asset number and calibration event is an 
automatic function in this case.  
Another Fluke-supplied stored procedure, MCResult, takes three arguments: the 
asset number of interest, and a beginning and ending date. This procedure is 
intended to be used for General Reports, because only through the report 
prompting mechanism can the dates be supplied to the procedure. 
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Crystal Setup 
The following directions set a number of options in Crystal Reports that some 
report developers have found to be helpful. None of the settings discussed here 
make any permanent alteration of the system, so, if you find you prefer some other 
behavior, it is an easy enough to undo the change. 
1. After you start up Crystal, select File | Options. Open the DATABASE tab and 

select the option report on Tables, Views and Stored Procedures. The tables in 
the Metrology database are SQL tables, so when you create a new report, the 
tables and stored procedures will be available as soon as you specify the 
database.  

 
zv5012s.bmp 
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2. Open the Reporting tab, and make sure the option Convert NULL field value 
to default is de-selected. If selected, this option prevents searching for NULL 
values in the database, which can make generating some reports more difficult. 

 
zv5013s.bmp 
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3. Open the New Report tab, and type the path to your shared METCAL 
directory in the Report Directory box. When opening a report with Crystal, the 
reports in the METCAL directory will now show. 

 
zv5014s.bmp 

1. While the File Options dialog box is opened, another selection can simplify 
your later work with Crystal. 

2. Under the Layout Tab, place a select mark in the option �Show Field Names.� 
With this selection checked, the Design Window shows the names of the fields 
and formulas at the location where they are places, rather than just indicating 
their location by a string of xxxxxx�s. Also, under the Layout Tab, check the 
box for �Show Short Section Names in Design�. This will give you more room 
on the page for your report. 
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Configuring a Report From Scratch 
The first step to creating a new report is to Click  (the New Report button) on the 
Button Bar. The dialog box that appears is known as the Report Gallery. 

 
zv5015s.bmp 

The Report Gallery offers a number of options when building a new report. You 
can choose from various Experts that will help you design your report. To design 
our report you will click on As a Blank Report. Expand the ODBC folder and 
select Calibration Data. 

 
zv5016s.bmp 
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The Log on Server window appears. Log on the Server with ODBC - MET/CAL 
Calibration Database and with the User ID FLUKE and Password FLUKE. 
Double-click on Tables. This allows the report writer to access the MET/CAL 
SQL database tables.  

 
zv5017s.bmp 

Our Report will be a simple ASSETS DUE FOR CALIBRATION Report. In 
order to select the data used in the report it is necessary to understand which 
MET/CAL Tables you will be using for the data. For our report you will need 
fields: 
I4201 Asset Number  mt.Inventory Table  
I4202 Mfg           � 
I4203 Model           � 
I4204 Description          � 
L2801 User Name        mt.Location Table 
C2303  Cal-Due Date  mt.Calibration Table 
Select SQL Table: mt.Inventory and click Add. Then select SQL Table 
mt.calibration and click Add. Finally, select mt.location and click Add. Click 
Close. A Visual Linking Expert window appears. 
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zv5018s.bmp 

Table Linking 
If the report contains data from two or more database tables, they need to be linked 
at this point when creating reports. If the check box for Smart Linking is checked 
in the Options, the MTAG�s will be automatically linked. Database tables are 
linked so records from one database match related records from another. For 
example, if you activate An Inventory table and a Calibration table, the databases 
are linked so that each MTAG (from the Inventory table) can be matched up with 
the calibration records (from the Calibration table). The majority of reports will 
probably require data from two or more tables, so linking will be necessary. The 
process of linking is made easy with the Visual Linking Expert and the Smart 
Linking option. 

Join Types 
Highlight the link between the Inventory Table and the Location Table. The Link 
Options button becomes active. The Link Options sets the table join types. The 
only types normally used in calibration type reports will be Equal Join and Left 
Outer Join. 
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Equal Join 
The result set from an Equal Join includes all the records where the linked field 
value in both tables is an exact match. This is the default join type. For most 
reports, it will not be necessary to change from EqualJjoin. 

Left Outer Join 
The result set from a Left Outer Join includes all the records in which the linked 
field value in both tables is an exact match. It also includes a row for every record 
in the primary (left) table for which the linked field value has no match in the 
lookup table. This join type is useful for reports where you need to show the asset 
number of assets without calibration or location records where an MTAG would 
not exist. 
Click OK to accept the linking. 

Inserting Data Fields 

 
zv5019s.bmp 

A Field Explorer window opens, showing all of the tables you just added. Expand 
the Inventory table. The first data field you want to insert into your report is I4201. 
Double-click field I4201.  
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A box will appear on your cursor when moved out of the Field Explorer window. 
Move your cursor to the Details Section of your report and place it where you 
want the data to show and drop it. We will show you how to add a report page 
heading later. Now do the same with the other data 

 
zv5020s.bmp 

Changing the Field Formats 
It may be necessary to change the size of the data fields. Do this by moving your 
cursor to the data field and click once with the left mouse button. This will 
highlight the box. Then with your mouse cursor, move the cursor to the small 
resizing handle on one of the ends of the highlighted box. The mouse cursor will 
change into a double arrow. Hold down the left mouse button and drag to change 
the size of the field.  

Previewing the Report 
You should now preview what the report will look like at this point. Do this by 
pressing the F5 key to preview the report. The report will appear just the way it 
would be if printed at this point. In the Preview mode, you may also move the data 
around by highlighting the data field and holding down the left mouse button, drag 
the data field to where you wish it and drop it.  

Inserting Text Fields 
Now add the correct titles to each of the fields. Click Insert | Text Object in the 
menu bar. Drag the cursor, which now becomes a box, to the top of the I4201 
column and type Asset Number. Do the same with each of the other Headers. 
Also note that you may also change color, etc. in the same way. Make each of the 
headers Bold by clicking on the text object and click with your right mouse button, 
selecting Change Font then select Bold. 
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Now add a title to the report. Text can be changed in two ways: 
Type the text directly onto the report. 
Insert a text object. For this example, you will insert a text object. 
To insert a text object, Click Insert on the Menu bar and choose Text Object. 
Move the cursor to position the text object in the Report Header section then click. 
Type in ASSETS DUE FOR CALIBRATION. When finished, Click anywhere 
off the edit text object box. It is easier to do this in the Design Window Mode. 

Formatting Fields 
Now you have a basic ASSETS DUE FOR CALIBRATION report. You can now 
format the fields so that they are presentation quality. Begin by formatting the 
report title. The title size needs to be expanded to the width of the report. 
Increase the font size of the title to 14 point by clicking on the font size down 
arrow. 
Click the Report Title field to select it. 
Position your cursor on the right edge of the field box until you get a double-arrow 
resizing cursor. 
Drag the right edge of the field box until it is even with the right edge of the data 
in the right column in the Preview Window. You may need to release the field 
box, scroll the window to the right, then continue expanding the field box until it is 
even with the right edge of the column. 
Scroll to the left edge of the Preview Window when finished. What you have done 
now is created a large field that extends from the left edge to the right edge of your 
report. Now you�re going to center align the title in that field so it will 
automatically be centered above your report date. 
At the bottom of the window is the Format Bar. Click  (the center alignment 
button) to center the report title inside the text field. 
To format a field, Click on the field to select it and then click the right mouse 
button and a pop-up menu will appear. Use Font to change the font, font size, 
style, effects and/or color for selected elements on your report. Select Change 
Border and Colors to change the color of the text, to place a border etc. 
Your Report should look something like this: (Note: your report will differ in 
content) 
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Selecting Records 
The report you just created shows all of the data in the selected fields including 
Cal-Due Dates in the future as well as the past. Generally on a report, you wish to 
limit the information you see, and in order to do that, you need to select the 
records you would like to see on the report. 
Crystal Reports provides two options for selecting records: 
•  Select Records Expert, which you are going to use here, and 
•  Edit Record Selection Formula, which is covered later. 

Record Selection Using the Select Records Expert 
The Select Records Expert is a straightforward way to create a record selection 
expression. It will guide us through the creation process. There are three ways to 
access the Select Records option: 
•  Select a field and Click the right mouse button to reveal a pop-up menu. 

Choose Select Expert from the menu and the Select Records Expert dialog 
box will appear. 

•  Choose Report then Select Expert from the Menu bar. The Select Records 
Expert dialog box will appear. 

•  Click  (the Select Records button) on the button bar. If you have not first 
selected a field, the Choose Field dialog box will become visible and you will 
have to select a field. Select C2303 and click OK.  



 Reports 
 Creating Reports from Scratch 5 

  5-39 
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At this point, you need to tell Crystal Reports our criteria for selection. In this 
case, you only want cal-due dates less than or equal to today�s date. The Select 
Records Expert will have tabs indicating the fields available for selection criteria. 
Click on the Calibration C2303 Tab. Use the down arrows in each box, select IS 
LESS THAN and type Today. You must also set the archive flags in the Record 
Selection Expert.  

The Archive Flags 
The MET/CAL database contains archive flags that are set to denote the most 
recent calibration record and the most recent location record. The fields for these 
flags are C2339 and L2815 respectively. If these fields are set to 1, the record is 
the last entry. They are set to 0 for calibration and location history. Notice that our 
report contains all of the past history. The asset number is repeated with all of the 
past calibration dates. In order to obtain the most recent record only, you must set 
up our record selection criteria to only ask for data with C2339=1 and L2815=1. 
To set up the selection you need to click the New tab. Select C2339 and click OK. 
Click on the C2339 tab and use the down arrows in each box, select IS EQUAL 
TO and type �1� in the next box. Repeat this process for L2815. This will set the 
record selection to only select the current calibration and location records. 

 
zv5023s.bmp 
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Inserting Groups 
So far you have selected specific information for our report using record selection, 
but it is presented to us in the order which it is stored in the database. You can 
group information by report fields or even by fields that are not on the report. You 
would like to group information in this report such as assets owned by a given 
using-department and by due-date.  

To insert a group 
Select the field you want to group on and Click Insert | Group Section.  
The Insert Group dialog box appears. 

 
zv5024s.bmp 

Choose the Location L2801 field and the order in which the groups should be 
displayed. In this case, choose IN ASCENDING ORDER. Click OK. If you are 
in the Design Window, you will see two new sections: the Group Header and the 
Group Footer. These will be identified by a number on the left side of the Report 
Window, and by the field that is controlling the group.  
Now you have the User-name above the group, but it is not pretty. So click on the 
User-name field, using the right mouse button, and change the font to underline 
and bold. You should also add a line between the User-name and the Header titles. 
To do this, move the cursor to the far left gray area in the Header Section and click 
on the right mouse button. Select ADD LINE 
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Record Sort Order 
So far you have selected specific information for your report and grouped like 
information together. The records in each group are not sorted however; they 
appear in the same order as they appear in the database. Sort the report by Model 
and Due-Date. This can be done in two ways: 
•  Click  (Set record sort order button) on the Button Bar, or 
•  Choose Report | Sort Records from the Menu Bar.  
The Record Sort Order dialog box appears. 

 
zv5025s.bmp 

First select the Calibration C2303 field and then the Inventory I4203 field and add 
them to the Sort Fields box. The report is already grouped by Location L2801. If 
you click on OK, the sort will be ascending.  
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Your report should now look similar to: 

 
zv5026s.bmp 

Inserting Summaries 
Now you have a report where you have selected specific information and grouped 
and ordered that information logically. Let us assume that you would like to add 
some summary information (for example a count of assets due for calibration for a 
given user-name). You add summary information into the Grouped Footer, where 
Summaries and Subtotals can be inserted. 

Note 
Crystal Reports allows you to group and summarize in a single step. 
You are using multiple steps to familiarize you with the 
fundamentals. 

First you highlight the field you want to summarize. If the field is a string field, 
like Asset Number, then you are going to be inserting a summary such as a count 
of Asset Number for each user. If you had a numeric field, you would insert a 
subtotal. Having highlighted the Asset Number field, Click the right mouse button. 
Select Insert Summary. The Insert Summary dialog box appears. Select Count by 
clicking on the pull down arrow and highlighting Count.  
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The dialog box will look like this: 

 
zv5027s.bmp 

Select Count from the pull down. Click OK and a number will appear below each 
User-Name group. Now put a text field to tell what this number means by clicking 
on Insert | Text Object and type Subtotal for User: and position it in front of the 
number.  



Metrology Software 
Users Manual 

5-44 

Your report will now look something like this: 

 
zv5028s.bmp 

You now have a summary for each group, but you also would like to have a 
summary for the whole report. This is the Grand Total and will appear at the end 
of the report. When you insert a Grand Total, the grand total is placed in the report 
footer. As with subtotals and summaries, a String field can be summarized 
(counted) and a numeric field can be totaled at the end of the report. To create a 
Grand Total, highlight the Asset Number field again and Click on Insert | Grand 
Total or click the right mouse button and select Insert Grand Total.  
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The Insert Grand Total dialog box appears. 

 
zv5029s.bmp 

Choose Count and Click OK. Again, add a text object in front of the number that 
appears in the Report Footer (Last Page) that says Grand Total:. 

Formatting the Sections 
You now have the information you want presented to us on the report. You have 
selected specific records, grouped records and sorted both records and groups. You 
have also placed some summary information on the report. You will now look at 
the formatting options available for entire sections. For example, you may want to 
insert a page break before each section or hide a section so it doesn�t print. 
You can place the cursor over one of the sections on the left of the Design 
Window and click the right mouse button. Select the Format Section option.  
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The Format section dialog box appears. 

 
zv5030s.bmp 

This is useful if you want to change the report to show one End User on each page. 
To do this, highlight Group Footer #1 Location.L2801 and select the New Page 
After box. Now check the Reset Page Number After box. This will restart the page 
numbers for each User. 

Inserting Special Fields 
There is some information that is not in a database but is useful report information 
such as Report Date and Page Number. Click on Insert | Special Field to insert 
one of these fields. A menu appears listing the different options. The page number 
field is self explanatory. It puts the page number on the page. The Total Page 
Count Field will put the total number of pages on the report. The Print Date field 
puts the date on the report. The default format is MDY, but by selecting the field 
and clicking with the right mouse button you can change the format. The Group 
Number field will number the groups. If you place it in the Page Footer section 
you will see the number of groups on the page. The Record Number field numbers 
the records. If you put it in the Page Footer you shall see the number of records on 
the page. 
Put a page number on your report by Clicking on Insert | Special Field and click 
on the Special Fields expansion box and select Page N of M and drag the special 
field to the Page Footer. 
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Inserting Lines and Boxes 
If you want to make some data stand out or just improve the presentation quality of 
our report you may wish to highlight it with lines and boxes. 
Use one of the following methods to draw a line: 
•  Click  (Draw a line button), or 
•  Choose Insert | Line from the Menu bar. 
Once you have selected one of the above, you will see a pencil cursor on the 
screen. Click the left mouse button where you would like the line to be and 
holding down the mouse button, move to where the line should end and release the 
mouse button. 
Use one of the following methods to draw a box: 
•  Click  (Draw a box button), or 
•  Choose Insert | Box from the menu bar. 
Once you have selected one of the above, you will see a pencil cursor on the 
screen. Click the left mouse button where you would the upper left corner of the 
box to be. Hold the mouse button and drag the pencil cursor to where the lower 
right corner should be placed on the report. 
Using the above method draw a line under your headers and draw a box around 
your report title. 

Modifying your Existing Reports to Run in Crystal Version 8 
If you have reports created with an earlier version of Crystal Reports, these reports 
will need to be modified to work with the Crystal Reports Version 8. To do this, 
open each report in turn in Crystal and: 

1. After logging into the Version 8 Sybase Data Engine, select DATABASE. 



Metrology Software 
Users Manual 

5-48 

2. Then select Set Location. 

 
zv5031.bmp 

3. Select Inventory and click Set Location. 

 
zv5032s.bmp 

4. Open the ODBC folder in the Data Explorer window and double-click on 
Calibration Data 8.  
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5. Double-click Tables 
6. Select the mt.inventory table and click Set. 
7. You will see the following message: 

 
zv5033s.bmp 

8. Click Yes. This will change all of the other tables to use the Crystal Version 8 
drivers.  

9. Click Done. 
10. You will see a dialog box that asks if you want to fix up the report. Click Yes 

for each prompt and save your report back to your shared METCAL directory. 
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Introduction 
The Procedure Editor application is designed for writing MET/CAL or 5500/CAL 
calibration procedures, but it also has a text mode, so you can use it for modifying 
any ASCII files, such as the control files that are discussed in Chapter 7. 
The Editor lets you create new procedures or modify existing procedures. You can 
also compile, debug and test run calibration procedures. 
In addition, the Editor allows you to configure the system instruments: add them 
to the system, assign their IEEE-488 addresses, and so on. The Tools menu 
provides a convenient way to start up other Fluke Metrology applications. 

Logging Into the Editor 

Note 
You must log in at a level sufficient to use the Editor. The required 
level is configurable and is stored in the database. Refer to the 
Database Setup in Chapter 8 for detailed information. 

To log into the Editor, first make sure that the database engine is running, then 
proceed as follows: 
1. In the Fluke Metrology Software program group, double-click the Editor icon. 

(Windows NT and Windows 95: Start Menu, Fluke Metrology Software.) 
2. The editor login dialog box appears. 

In the User Name field, type in your user name, tab to the Password field, and 
type in your password. Click OK. 
If you do not have a password, see the administrator of the system. 

You now have access to the Editor. Figure 6-1 is an example of the Editor window 
with a Calibration Procedure opened.  
Refer to the following list for descriptions of the items labeled in Figure 6-1. 
Title Bar Shows the name of the application. 
Menu Bar Lists the available options in the Editor. 

Click the menu items to see the selections available. 
Error 
Window 

Shows you the error number and describes what the error is in the 
procedure you tried to compile.  

Status Line Describes what is taking place within the Editor. 
In Figure 6-1, the status line indicates that the 43 lines in the 
selected procedure have been loaded into the Editor. 
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Ovr This annunciator indicates the current status of the overwrite/insert 

mode.  
When you press the Insert key, you can write over text in your 
procedure. If Ovr is not on, you can insert text into your procedure. 

Cap This annunciator indicates whether the Caps Lock function is on. 
When you press the Caps Lock key, you can type in all capital 
letters in the procedure. 

Num This annunciator indicates whether the Num Lock function is on. 
When you press the Num Lock key, you can enter numbers from 
the numeric keypad on the keyboard. 

Horizontal A position indicator that shows the cursor�s horizontal position in 
the procedure. 
The numbers indicate the cursor position as the number of 
character positions from the left within the procedure. 

Vertical A position indicator that shows the cursor�s vertical position in the 
procedure. 
The numbers indicate the cursor position as the number of lines 
from the top of the procedure. 
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il601c.eps 

Figure 6-1. Editor Window with a Procedure Opened 
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Checking the User Level 
After logging in, you can easily check your user access level.  
To check your access level, click About in the Menu Bar. The About box show 
the current user name and user level. 
If the user level is too low to allow access to Editor functions, see the 
administrator of the system. 

Security  
The Security menu provides a way to change your password. 
To change your password, click Security in the menu bar, then Password. 
The Change Password dialog box displays. Enter your old password, tab down to 
the New Password field and enter your new password. 
Tab down to the Confirm New Password field and enter your new password again, 
then click OK. 

Exiting the Editor 
To exit the Editor, select File, then Exit. 
If you have any open files that have been modified, you are asked if you want to 
save them before the Editor closes. 

Synopsis of Editor Functions 
The following table lists all the Editor commands in a quick-reference format. 
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Table 6-1. Overview of Editor Functions 

Action Keystrokes Menu 

Navigating 

Move left W  

Move right X  

Move up U  

Move down V  

Move to the beginning of the line !  

Move to the end of line $  

Move to the beginning of the file  C!  

Move to the end of file C$  

Page up Z  

Page down Y  

Editing 

Cut selected text to clipboard C X Edit, Cut 

Copy selected text to clipboard C C Edit, Copy 

Copy to file C W Edit, Copy to 

Paste text after cutting or copying from one 
source to another 

C V Edit, Paste. 

Insert file C G Edit, Insert File 

Delete selected text. D Edit, Delete 

Searching 

Find strings in a file A H Edit, Find 

Find the next string H Edit, Find Next 

Replace strings in a file C H Edit, Replace 

Formatting a procedure file 

Create an adjustment step C A Edit, Adjust 

Break a line at the cursor position C 
E 

Edit, Break 

Continue a message on two or more lines K Edit, Continue 
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Table 6-1. Overview of Editor Functions (cont.) 

Action Keystrokes Menu 

Testing a procedure 

Test run from current line A G Test Run, Go 

Test run from top of procedure G Test Run, Restart 

Make test run top window C G Test Run, Show 

File Handling 

Open a new procedure C N File, New 

Open a previously written procedure C O File, Open Procedure 

Save a procedure to directory from which it 
was opened  

C S File, Save Procedure 

Save a procedure to the default directory  File, Save to Default 
Directory 

Open a text file C F File, Open Text File 

Save a text file C J File, Save Text File 

Save a compiled procedure in a specified 
directory 

 File, Save As, Save As 
Compiled Procedure 

Save a text file with a new file name  File, Save As, Save As 
Text Procedure 

Close a file C I File, Close 

Print a file C P File, Print 

Hide a procedure  File, Hide Procedures 

Delete a procedure  File, Delete Procedures 

Copy a procedure  File, Copy Procedures 

Change default directory  File, Change Default 
Directory 

Exit from the Editor I I File, Exit  

Compiling a Procedure 

Compile the current procedure line M Compile, Check Line 

Compile an entire procedure forwards N Compile, Next Error 

Compile an entire procedure backwards S 
N 

Compile, Previous Error 

Re-enable all warning messages C N Compile, Re-warn 
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Table 6-1. Overview of Editor Functions (cont.) 

Action Keystrokes Menu 

Configure 

Disable the compiler C M Configure, Text Mode 

Select fonts  Configure, Font 
Configure, Default Font 
Configure, Display Font 

Add and edit instrument configuration Q Configure, Instruments 

Add and edit IEEE-488 boards  Configure, IEEE-
488Boards 

Select a default Serial Port  Configure, Default Serial 
Port 

Tools 

Copy procedures, Run Time  Tools, MET/CAL Run 
Time 

Asset Management  Tools, MET/TRACK 

Security 

Change your password without closing the 
application 

 Security, Password 
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Opening, Creating, and Saving Procedures 
The File menu lets you open procedures and text files, save procedures and text 
files, print files, configure the print setup and layout, and exit. 

Creating a New Procedure  
New lets you create a new procedure.  
•  To create a new procedure, from the Editor menu bar, click File, then New. 

You should see a window titled <No Name>.1 at the top.  

 
zv602s.tif 
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Selecting a Procedure  
Selecting Open Procedure on the menu opens a Select Procedure dialog box. 
This box lists the procedures that exist in the MET/CAL procedure directory. 
•  To open a procedure, click File, then Open Procedure. Select the procedure 

you want.  

 
zv603s.tif 

Click OK. A message tells you that the selected procedure is being loaded, then 
the procedure listing appears in the Editor window. 

Note 
The Select Procedure dialog box displays the names of ALL 
procedures, whether they have been compiled or not, including those 
that are marked hidden. 
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Saving a Procedure  
Save Procedure either saves a new Calibration Procedure or saves changes you 
made to the current one. The Save Procedure selection saves a Calibration 
Procedure to the Procedure Directory from which it was opened. If the procedure 
is new or was loaded with Open Text File, it is saved to the default directory. 
You can save compiled or uncompiled procedures. If you save an uncompiled 
procedure, the procedure does not appear in the Procedure Selection dialog box in 
the Run Time application. 
To save a procedure, first make sure the file you want to save is in the active 
window. Select File, then Save Procedure. This selection uses the procedure 
instrument name to save a procedure. In the status line of the Editor, a message 
appears indicating whether you saved an executable or non-executable procedure. 
If a naming conflict arises, you are given the option of either overwriting the 
current name or giving the procedure a new name. 

Saving a Procedure to the Default Directory 
This operation is identical to Save Procedure with the exception that the 
procedure is saved to the default directory unconditionally. 

Opening a Text File  
Open Text File lets you open any text file and view it. 

Note 
If you do not perform Step 1 below, MET/CAL will attempt to 
compile the text file you load, because it assumes the text file is a 
procedure. Step 1 must be performed if you want to use the Editor to 
view or modify non-procedural text files. 

To open a text file, proceed as follows: 
1. From the menu, select Configure, then Text Mode. 
2. From the menu, select File, then Open Text File.  
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The Open dialog box appears. 

 
zv604s.tif 

3. Highlight the file name and select Open. 
The text of the file appears in the Editor window.  

Saving a Text File 
Save Text File lets you save the contents of the active window as a text file. Text 
files are free format and do not have special protection. Except where noted, case 
is not significant. 
To save a text file, open the file and select Save Text File. A prompt appears if 
you have not yet specified a text file name for the procedure.  
In the status line of the Editor, a message appears indicating the file is saved. The 
message indicates the name and location of the procedure. 

Save As 
Save As has two submenus: Save As Compiled Procedure and Save As Text 
Procedure. Save As Compiled Procedure is functionally the same as Save 
Procedure except that you can select the directory to which the compiled 
procedure will be saved. Save As Text Procedure opens a dialog box that lets 
you save a new or changed procedure as a text file under a new name, directory, 
and /or drive.  
To save a procedure, proceed as follows: 
1. Select the procedure you want to save. 
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2. From the File menu, click Save As. 
A dialog box opens. 

3. Type in the new file name in the File Name field. 
4. Select a directory to store the file and click OK. 

In the status line of the Editor, you get a message indicating the full pathname 
of the saved file. 

Printing a Procedure 
Print opens a dialog box that lets you print the current procedure. To print a 
procedure, proceed as follows: 
1. Open the procedure you want to print. 
2. From the File menu, select Print. 

A Print dialog box appears.  
3. Choose the options you want and select OK to print the active procedure. 

Print to File 
Print to File lets you save the contents of the active window to a file with all 
format and printer codes. To print to a file, proceed as follows: 
1. Open the procedure you want to print. 
2. From the File menu, select Print. 
3. Select Print to File, then OK. 

A Print to File dialog box appears. 
4. Type in a name for the file to which you want to print. Enter a name  different 

from the original to avoid overwriting the original file. 
5. Select OK. 

Print Setup Options 
Print Setup lets you change the type of printer used, the page orientation, and the 
paper size. Depending on the printer available in your system, this selection has 
additional options that let you send the file as an encapsulated postscript file, 
remove margins, and create and send a header. Advanced options allow you to 
send particular true type fonts and manipulate graphics in your document. 

Hiding a Procedure 
Hide Procedure allows you to hide procedures in the default procedure directory. 
Hidden procedures are not visible in the Run Time application. 
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Deleting a Procedure 
Delete Procedures allows you to delete procedures from any valid compiled 
procedure directory. 

Copying a Procedure 
Copy Procedures allows you to copy a compiled procedure from one directory to 
another. 

Change the Default Directory for Compiled Procedures 
Change Default Directory sets the directory used by Save Procedure, Save to 
Default Directory, and Hide Procedure. 

Modifying Procedures 
The Edit menu lets you modify procedures by selecting text within a procedure 
and choosing a command to make the desired changes. This section describes how 
to select and edit text within a procedure. 

Using the Basic Edit Functions 
The following paragraphs describe how to manipulate text within a procedure. 
These functions all start from the Edit menu. 

Cut 
Cut lets you cut selected text out of a procedure. Place your cursor at the 
beginning of the text you want to cut. Hold down the left mouse button and drag 
the cursor to highlight the text. Select Cut. The text is removed from the 
procedure and placed into the Windows clipboard, ready to be pasted. 

Copy 
Copy lets you copy selected text from one part of a written procedure to either 
another part of a procedure or a different procedure. To copy text, highlight the 
text you want to copy and select Copy. The text is copied into the Windows 
clipboard, ready to be pasted. 

Copy to 
Copy To lets you copy selected text to a file. Be sure this is what you want to do. 
If you have any data in the file you are copying to, it is overwritten. 
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Paste 
Paste lets you insert the contents of the Windows clipboard at the current cursor 
position. The cursor may be positioned within any document window. To paste 
text after you copied or cut it, place the cursor where you want the text placed. 
From the Edit menu, click Paste. The text is positioned after the cursor. 

Delete 
Delete lets you delete selected data from a document. This selection is different 
than the Cut selection because once you delete information from a document, it 
cannot be recovered. To delete text, highlight the text you want removed and press 
Delete. Pressing Delete when the cursor is on a blank line deletes the line. 

Break 
Break lets you split a line in a procedure at the point the cursor is positioned and 
to start a new line. To break a line, place the cursor where you want the line to 
break and press C + E, or click Break. 

Inserting a File 
Insert File lets you insert the text of an external text file at the cursor position in 
the opened procedure. This is different from cut and paste or copy and paste. 
When you select a file that you want to insert into the new procedure, Insert File 
copies and pastes everything in the source file. To insert a file, proceed as follows: 
1. From the Edit menu, select Insert File. 

 
The Insert dialog box opens. 

2. Select the file you want inserted into the active procedure, the select OK. 
The file is inserted into the active procedure and the dialog box closes. 

Finding Text in a Procedure 
Find lets you search for a text string. The editor searches forward or backward 
until the first occurrence of the text is found. 
To find text, proceed as follows: 
1. From the menu, select Edit, then Find. 

 
The Find dialog box appears. 

2. In the Find What field, type in the text you are looking for. 
3. Choose the options you want to use to control the search. You can specify the 

case sensitivity and direction (up or down in the procedure) of the search. 
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4. To start the search, click Find Next. 
If you find the selection you want to change, click Cancel and make your 
changes. 
To continue with the search, from the Edit menu, click Find. The Find dialog 
box remains available until you click Cancel. 
If the text for which you are searching occurs once in the procedure, the 
following message appears on the status line at the bottom of the screen: 

Search string found at current position. 

Find Next  
Find Next provides an alternate way to continue searching for text that you have 
specified in the Find dialog box. Use Find Next when you want to use the Find 
command without displaying the Find dialog box. You must have previously 
specified text under the Find option for this to work. 
1. From the Edit menu, select Find Next. 

The found text is highlighted in the procedure, but a Find dialog box does not 
appear. 

2. Select Find Next or H to continue searching. 

Replacing Text in a Procedure 
Replace lets you search for a specified text string and replaces each occurrence 
with different text. Replace lets you change text without performing cut and paste. 
To replace text, proceed as follows: 
1. From the Edit menu, select Replace. 

 
The Replace dialog box appears.  

2. In the Find What field, type in the text you want to find. 
 
If you used the Find or Replace options in the current session, the text from 
the previous search is already there. Type over the text to search for a 
different string. 

3. Tab to the Replace With field and type in the replacement text. 
4. Choose whether or not you want to match the case and select Find Next to 

start the search and replace operation. 
When a string is found, the following options become available: 
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•  Find Next goes on to the next occurrence of the string and does not 
perform a replacement. 

•  Replace confirms a replacement. 
•  Replace All replaces all strings without confirmation. 
•  Cancel quits replace. The cursor remains where it was prior to quitting. 

Adjustment Statement 
Adjust indents a procedure line so the FSC is in the RANGE field. It is used only 
if the result of evaluation of the previous regular procedure step resulted in a 
MARGINAL or FAIL condition. For more information about Adjust, refer to the 
section titled �Adjustment Statement� in Chapter 1 of the Reference Manual. 

Continue Statement 
Continue lets you mark the current line as a continuation of the previous line. 
This is useful for certain FSCs that allow multi-line statements. For more 
information about Continue, refer to the section �Continuation� in Chapter 1 of 
the Reference Manual. 

Naming a Procedure 
Name Procedure specifies a procedure name. A procedure can have up to six 
names. The Editor keeps track of all names (instrument lines) and knows that all 
six names belong to one procedure.  
To name a procedure, from the menu bar, select Edit, then Name Procedure. The 
Instrument: line appears. Type in the name you want for the procedure and press 
E. The name appears in the title bar of the active window. 
For more information about naming a procedure, refer to �Naming a Procedure�, 
in Chapter 1 of the Reference Manual. 

Name Conflicts 
A name conflict exists if any of the possible six names of one procedure is the 
same as a name in another procedure. These problems may occur when you 
modify or create new procedures with names already in the Procedure Directory. 

Compiling Procedures  
The Procedure Compiler is integrated with the Procedure Editor. The compiler 
checks the correctness of each procedure statement. Once the FSC is recognized, 
the compiler checks the correctness of individual fields within the line, and then 
the interdependencies of the lines. 
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The Compile menu displays selections that compile procedures forward and 
backwards, and individual lines of procedures. The Compile menu options are the 
following: 
•  Check line 
•  Next Error  
•  Previous Error 
•  Rewarn 
•  TUR Report 

Checking a Procedure Line  
Check Line checks the contents of the current line for errors, and reports errors in 
the error window. Errors must be corrected before you can run the procedure. If 
no errors are present, the line is formatted and fields are lined up under the correct 
columns. If the line contains an instrument evaluation FSC, the Test Uncertainty 
Ratio (T.U.R.) is calculated in most cases. If the T.U.R. is less than the �tur_lim� 
parameter specified in �metcal.ini,� a warning message is generated and presented 
in the Error window. T.U.R. warnings are not considered errors, and so do not 
prevent a procedure from being executable. The procedure writer must verify that 
the new procedure is adequate, and that the standards used are satisfactory for the 
calibration to be performed. 
Automatic Line Check is operating as long as the Editor is not operating in Text 
Mode. The same checking as described above is performed on every procedure 
line as you enter it. When you press E, the line check is triggered. If no 
errors are found, the line is formatted, and the cursor is placed on the next line 
ready for the next procedure statement. 

Checking for the Next Error  
Next Error lets you compile a procedure from the current line forward until an 
error is reached or until the entire procedure is compiled. If the last line is reached 
with no errors found, the compiler jumps to the top of the file and continues 
checking the procedure until the original line is reached or an error is found. 
If the procedure contains no errors, the compiler checks for interline 
dependencies. For example, it checks for missing jump destinations, duplicate 
jump destinations, and incorrect indentation. If no compilation errors are found, 
the following message displays at the bottom of the screen: 

No Errors. Procedure Executable. 
If the procedure contains an error, an error window appears and indicates what the 
error is.  
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The cursor is positioned on the line containing the error in the procedure window. 
If the procedure window is not active, click the title bar to activate it. 

Note 
It is best to position the error window so that it does not overlap the 
procedure window. This allows the procedure window to remain 
active when the error window indicates an error. 

Checking for a Previous Error  
Previous Error is exactly the same as Next Error, except the procedure is 
scanned from the current line backward, rather than forward.  

Rewarn 
Normally, a Test Uncertainty Ratio (T.U.R.) warning is displayed only once. 
Subsequent compilation does not redisplay a warning unless you have modified 
the corresponding procedure statement. To override this, use Rewarn to enable all 
prior warnings in the active procedure.  

T.U.R Report 
T.U.R Report lets you create procedures with special comments that show the 
T.U.R. following each evaluation. A T.U.R. report helps you identify and address 
those tests where the application did not have enough information and either made 
an estimate or did not compute the T.U.R. These comments may indicate that the 
T.U.R. cannot be computed or was estimated based on range information. To 
generate a T.U.R. report, proceed as follows: 
1. Open a procedure or use the one you are creating. 
2. If the procedure is not compiled, compile the procedure. A T.U.R. report 

cannot be generated for a non-executable procedure. 
3. From the Compile menu, select T.U.R. Report. 

 
A message indicates that the report is being generated. Then, a new window 
shows the procedure with the T.U.R. information embedded in it as comment 
lines.  
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4. If you want to save the procedure with TUR information embedded, click 
Save Procedure.  
A message indicating that you have a name conflict appears. Click OK. 

5. Another message appears asking if you want to overwrite the procedure that 
does not have TUR information embedded in it with the procedure that does. 
To overwrite, select Yes. 

Note 
When a new T.U.R.. report is generated, previously generated 
T.U.R. comments are stripped out. 

Test Run Menu 
Test Run lets you execute a procedure and to see how the procedure performs 
while it is being created or modified. You do not need to store a procedure in the 
Procedure Directory to test run it. 
The procedure must be executable before you can perform a Test Run; if not, a 
warning message is shown asking you to check for errors. Check for errors using 
Next Error (F9). 
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When you test run, you are not asked for pre- and post-calibration information, 
and no results are written to the database. To test run a procedure, proceed as 
follows: 
1. Select Test Run from the menu bar. 
The following options are available: 
•  Go. Runs procedure from the line where the cursor is currently positioned 

Does not reset global procedure data. 
When the procedure is completed or terminated, the values of certain parameters 
are remembered, so that the next time you execute the procedure, it is not 
necessary to repeat the test steps that establish those values. 
For example, the ASK flags are typically defined close to the top of most 
procedures. You want to keep those settings even if you do not restart execution 
with the first line in the procedure. Remembering values provides the advantage of 
rerunning procedure segments with the test environment in the same condition 
each time. The first time you test run a procedure, start with those lines that assign 
values to those parameters. 
The system remembers the following parameters: 
•  ASK flags, created using the ASK- and ASK+ FSCs. 
•  Memory variables MEM, MEM1, MEM2, and M1 through M255. 
•  Values created with Instrument Setup FSCs ( For example, MMFC, MCAL, 

and M606 FSCs). 
•  MESS message buffers, created with the MESS FSC. 
•  DRAW parameters, created with the DRAW FSC. 
•  SET settings table, created with SET FSCs. 
•  Restart. Runs a procedure from the top even if the cursor is not positioned at 

the beginning of the procedure. Restart also re-initializes global procedure 
data before the procedure runs. 

•  Show. Brings the Test Run window to the top to resume testing the procedure. 
While operating Test Run, you may need to switch to the Procedure window. 
This action covers the Test Run window. 

1. Select one of the options.  
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The Test Run menu appears.  

 
il606s.tif 

The following describes the function of the buttons and check boxes: 
•  Run executes a procedure. As the procedure runs, it halts only to prompt the 

user for information. 
•  Step executes the current statement and then pauses, waiting for the user to 

choose Step, Run, or Quit. 
•  Stop lets you stop execution when running a closed-loop procedure. 
•  Quit lets you exit Test Run and returns you to the Editor. 
•  Demo lets you run procedures without having instruments connected. 

Ordinarily, if a procedure attempts to communicate with an instrument, and no 
instrument is connected, the Editor generates a warning and the instrument 
will time out waiting for a response. Demo mode runs the procedure as if 
instruments actually are connected, but does not do a real I/O. 

•  ASK displays how the ASK flags are set in the procedure. ASK flags are 
control flags that affect automatic operation and/or messages. If you want 
brief description of what function each ASK flag performs, click the desired 
flag. The information about the selected ASK flag appears in the status line of 
the Editor. For more information about the ASK flags, refer to ASK+ and 
ASK- in Chapter 2 of the Reference Manual. 
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•  N-Reg shows the numeric registers and displays the values for MEM, MEM1, 
and M1-255 registers. For more information about MEM, MEM1, and M1-
255, refer to the MEME and MATH FSCs in Chapter 2 of the Reference 
Manual. 

•  S-Reg shows the MEM2 string registers. For more information about MEM2, 
refer to MEM2 in Chapter 2 of the Reference Manual. 

2. After selecting a Test Run option, follow the instructions. 
3. After you quit Test Run, you return to the Editor. 

Configure Menu 
Selections on the Configure menu let you: 
•  switch between Text mode and Procedure mode 
•  choose the font used in displaying and printing the active Edit window 
•  configure the instruments that make up the workstation 
•  inform MET/CAL of number and type of IEEE-488 boards installed in the PC 
•  configure the defaults serial port for control of serial UUTs 
•  configure humidity and temperature sensor 

Text Mode 
Text Mode lets you make changes to a text file other than a Calibration 
Procedure. In the Text mode, procedure syntax checking and compiling features 
are disabled. You can load, edit, and save text files. When you remove the check 
mark from the Text Mode menu item, full procedure checking is again available. 
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Font 
Font opens a Font dialog box and lets you make changes to the font, font style, 
and font size in the procedure that you are working on. To change a font, proceed 
as follows: 
1. From the Configure menu, click Font. The Font dialog box opens. Refer to 

the following figure. 

 
zv607s.bmp 

2. Select the font, font style, and size, and click OK. The font is changed only 
for the active edit window. 

Instruments 
The Configure menu provides a way to change the system instrument 
configuration. When you select Instruments, a small dialog box appears that 
contains a listing of all the currently configured instruments.  
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The following describes the function of the buttons: 
Add Opens a second dialog box listing all the instrument FSCs available. 

From this, select the instrument you wish to add to the configuration. 
After you select one, you are immediately placed into the Edit Instrument 
dialog box, described next. 

Edit Only available when one of the currently configured instruments is 
selected, (or opens automatically as a result of selecting an instrument to 
add). Opens a dialog box permitting port selection, alias assignment if 
desired, and specification of any options. 

Delete Deletes an instrument from the configured instrument list. 
MET/CAL maintains the list of configured instruments. Associated traceability 
information for configured instruments is stored in the database. 
Before you can use calibration instruments, you must identify which instruments 
are configured in the system. 
A configured instrument is a traceable calibration standard. There are three types 
of configured instruments: 
System Instruments 
A system instrument is an instrument for which the Fluke Metrology software 
provides a built-in instrument driver. For each system instrument there is a 
corresponding FSC in the procedure language. For example, the "5700" FSC is 
used to control the Fluke 5700A. 
Fluke Metrology software supports over 30 different system instruments. 
User-Configured Instruments 
A user-configured instrument is one that is remotely controlled, but has no built-in 
driver. A procedure writer uses the PORT and IEEE FSCs to control user-
configured instruments. 
The PORT FSC is used for instruments with a serial interface (RS-232) and the 
IEEE FSC is used for instruments with an IEEE-488 interface. 
You do not need to make an instrument user-configured in order to communicate 
with the instrument using a Calibration Procedure. There are two advantages in 
using a user-configured instrument: 
•  A user-configured instrument can have an address and an alias. The alias is a 

symbolic name by which a procedure can refer to the instrument. Using an 
alias improves procedure readability and portability. 

•  A user-configured instrument is traceable and can be used in reports. Before 
starting a procedure that uses a user-configured instrument, the software first 
checks to make sure the instrument is in cal. 
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Also note that user-configured instrument specifications are subject to the same 
format and syntax rules as system devices, with the following additional 
restrictions: 
•  A user-configured device cannot have attached secondary devices. 
•  A user-configured device cannot have optional attribute specifiers. 
Manual Instruments 
A manual instrument is one that is not remotely controlled by the system, but is 
used as a calibration standard, so it must be traceable. Manual instruments can 
encompass a wide range of device types. Examples include the Fluke 792A 
AC/DC Transfer Standard, the Fluke A40 Current Shunts, or a manual device such 
as a micrometer. The STD (Standard) FSC is used in a Calibration Procedure to 
require that an instrument be configured as a manual instrument standard. The 
DISP (Display) FSC is then used to inform the operator of setting or connection 
changes required when using the standard during execution of the calibration 
procedure. 

Note 
When configuring a new instrument, remember to also add 
traceability information to the database. 

Modifying the Instrument Configuration 
To add, delete, or change an instrument, the following steps are required: 
1. Physically replace the instrument. 
2. Edit the Configuration. 

To edit the Configuration, use the Editor application. Under the Configure 
Menu, select Instruments. 

3. Update the configuration information. 
4. Use the Manual Entry application to add or modify traceability information in 

the database. 

IEEE-488 Boards 
A dialog displays that allows you to specify the number (0, 1, or 2) and model of 
the IEEE-488 boards installed in your PC. 

Default Serial Port 
A dialog displays that allows you to specify the default port that the PORT FSC 
uses to control UUTs that have a serial interface. 
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Humidity and Temperature Sensor 
This menu item allows you to configure a Fluke 5000A-RH/T Precision Humidity 
and Temperature Data Logger for use with MET/CAL. For further information 
concerning the 5000A-RH/T, refer to the document rht.pdf on the MET/CAL CD. 
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Introduction 
This chapter describes how to customize an individual Calibration Workstation. 
A number of editable files affect the Run Time environment. Changing them 
provides the ability to customize the operation of the MET/CAL and 5500/CAL 
Run Time applications. Table 7-1 lists the files that control the way the software 
operates. 

Table 7-1. Overview of the MET/CAL Control Files 

DEFAULT 
FILENAME 

FUNCTION 
SEE 

PAGE 

METCAL.INI MET/CAL Initialization File 7-5 

PROMPTDB.TXT 

PASS_DB.TXT 

FAIL_DB.TXT 

Contain prompts to the user. The first set of prompts 
displays after selecting but before executing a 
calibration procedure. The PASS and FAIL prompt 
files display prompts upon completion of a 
procedure; which one the software uses depends on 
the result of the procedure. 

7-24 

Note 
The actual names of the prompt file are set in the initialization file, 
METCAL.INI. Except for the initialization file itself, these filenames 
can be changed by editing METCAL.INI. 

MET/CAL Initialization File Parameters 

4xxx Selected Device Clear (Optional) 
4xxx_clr_sdc = yes | no 

4xxx_clr_sdc controls whether the Datron 4000(A)/4200(A)/47xx/4800(A) driver 
clear function sends a Selected Device Clear (SDC) to the instrument. If 
4xxx_clr_sdc is not specified in the initialization file, the default is  
4xxx_clr_sdc = yes. 

525A IEEE-488 Interface (Optional)  
525A_488 = yes | no 

525A_488 controls whether to allow the configuration of the Fluke 525A on an 
IEEE-488 interface. If 525A_488 is not specified in the initialization file, the 
default is 525A_488 = yes. 
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525A IEEE-488 Input Terminator (Optional)  
525A_488_iterm = LF | CR | EOI 

525A_488_iterm specifies the input terminator for the 525A driver when the 
525A is configured as an IEEE-488 device. If 525A_488_iterm is not specified in 
the initialization file, the default is 525A_488_iterm = EOI. If a 525A is 
controlled by an IEEE-488 to RS-232 converter, 525A_488_iterm must be set to 
CR. 

9100 Manufacturer (Optional)  
9100_mfg = string 

In the event that the manufacturer names accepted by the 9100 driver do not 
conform to firmware in the actual 9100 used, the manufacturer names may be 
overridden on a per-workstation basis by specifying 9100_mfg. For example, 
specifying 9100_mfg = Yokogawa-Datron in the [startup] section of the 
MET/CAL initialization file will cause the 9100 driver to accept Yokogawa-
Datron as a valid manufacturer name returned in response to the *IDN? query. 

9500 Manufacturer (Optional)  
9500_mfg = string 

In the event that the manufacturer names accepted by the 9500 driver do not 
conform to firmware in the actual 9500 used, the manufacturer names may be 
overridden on a per-workstation basis by specifying 9500_mfg. 

Accuracy Check (Optional)  
acc_check = yes | no 

acc_check controls whether or not accuracy file headers are read and cross-
checked against the database. 
When acc_check = yes the following steps are performed: 
1. Determine the instrument name associated with the FSC (example FSC: 5700, 

instrument name: Fluke 5700A). 
2. Retrieve the asset number associated with the instrument name from the 

instrument configuration. 
3. Retrieve the calibration interval for the asset from the database. 
4. Search the MET/CAL accuracy file directory for an accuracy file with a 

header which contains the same instrument name and interval. 
When acc_check = no, fsc.acc in the MET/CAL accuracy file directory is 
unconditionally used for accuracy information for the FSC specified. If acc_check 
is not specified in the initialization file, the default is acc_check = yes. 
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ACCF FSC Relative Path (Optional)  
accf_acc_rel = yes | no 

accf_acc_rel which controls whether or not partial path specifications in ACCF 
statements are interpreted as relative to the MET/CAL accuracy directory and 
cross-checked against the database. 
If the initialization file does not contain an accf_acc_rel specification, then, by 
default, a partial path specification in an ACCF statement is taken to be relative to 
the MET/CAL accuracy directory. I.e., omitting the accf_acc_rel specification is 
equivalent to accf_acc_rel = yes. 
Prior to V6.0 prior path specifications in ACCF statements were always taken to 
be relative to the Current Working Directory (CWD). That is, the accuracy file 
was simply opened using the name exactly as specified in the ACCF statement. In 
V6.0, in order to run a system compatible with V5.11 and previous (in this 
respect), it is necessary to explicitly add accf_acc_rel = no to the initialization 
file ([startup] section). 

ASK C-Flag Default (Optional)  
ask_c_default = yes | no 

ask_c_default allows the default state of the ASK C-flag to be set. For MET/CAL 
V4.2 and previous, this initialization file parameter did not exist, and the default 
was ASK+ C. Therefore, for compatibility with previous versions of MET/CAL, 
if ask_c_default is not specified in the initialization file, the default is yes (ASK+ 
C). To change the default to ASK- C, it is necessary to add the line ask_c_default 
= no to the initialization file. 

ASK X-Flag Default  
ask_x_default = yes | no 

This parameter determines the default state of the ASK X-flag. 
•  yes (default is ASK+ X) 
•  no (default is ASK- X) 

Auto Author (Optional)  
auto_author = yes | no 

auto_author controls whether or not the Editor automatically inserts the full 
name of the current user in procedure Author: lines which are automatically 
generated. If auto_author is not specified in the initialization file, the default is 
auto_author = yes. 
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Accuracy File Directory 
accdir = accuracy_file_directory 

This is directory where MET/CAL looks for accuracy files. 

Beep 
beep = beep_delay[,beep_count] | none | off 

beep enables or disables one or more beeps when an operator message or prompt 
is displayed. beep specifies the count and the inter-beep delay (in seconds). If 
none or on is specified, the run time beep is disabled. There is no difference 
between none and off. Otherwise, the delay must be a valid floating-point format 
number between 0.0 and 3600.0. The beep count is optional. If specified, it must 
be a valid integer between 0 and 100. If beep count is not specified, it is set to 1. 
Note that setting the beep count to zero has the same affect as specifying beep = 
off or beep = none.  

CaretWidth (Optional)  
CaretWidth = 1, 2, 3,… 300 

Specifies the caret width. 

Confidence (Optional)  
confidence = 0.0 to 4.0 

confidence specifies the value of the confidence parameter used in the 
measurement uncertainty calculation. The setting of confidence in the 
initialization file may be overriden using the VSET FSC. See VSET FSC in the 
MET/CAL FSC Reference Manual for a full definition of this parameter. 

Configuration File 
config = instrument_configuration_file 

File where MET/CAL stores configured instrument information. 

Correct Exact Match (Optional)  
cor_exact = yes | no 

cor_exact determines what is printed in the corrected column (C) in the test 
results window, when an exact match is obtained for the system actual value in a 
correction file. When cor_exact = yes, X is printed in the corrected column when 
an exact match is obtained. When cor_exact = no, Y is printed in the corrected 
column when an exact match is obtained. If cor_exact is not specified in the 
initialization file, the default is cor_exact = no. 
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Correction File Directory 
correctdir = correction_file_directory | none 

Directory where MET/CAL looks for correction files. 

Coverage Factor (Optional)  
coverage_factor = 0.0 to 4.0 

coverage_factor specifies the value of the coverage factor parameter used in the 
measurement uncertainty calculation. The setting of coverage_factor in the 
initialization file may be overriden using the VSET FSC. See VSET FSC in the 
MET/CAL FSC Reference Manual for a full definition of this parameter. 

Database Procedure (Optional)  
db_proc = yes | no 

db_proc controls where MET/CAL gets the name of the associated procedure 
when a procedure is selected by asset or by workload. When db_proc = yes, if a 
procedure is selected by asset or by workload, the name of the associated 
procedure is fetched from the database. When db_proc = no, the name of the 
associated procedure is looked up in the barcode file (also know as the asset map 
file). If db_proc is not specified in the initialization file, the default is db_proc = 
yes. 

DOS Special Construction Evaluation (Optional)  
dos_sc_eval = yes | no 

dos_sc_eval controls whether or not MET/CAL special constructions should be 
evaluated when they appear in arguments to user programs in DOS/DOSE 
procedure statements. If dos_sc_eval is not specified in the initialization file, the 
default is dos_sc_eval = yes. dos_sc_eval. 

DTR Disable (Optional)  
dtr_disable = yes | no 

dtr_disable controls whether the DTR line is raised or not when DTR 
handshaking has not been selected. 
•  dtr_disable = yes, force DTR low 
•  dtr_disable = no, force DTR high 
If dtr_disable is not specified in the initialization file, the default is dtr_disable = 
no. 
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F (Optional)  
F = 0.0 to 4.0 

F specifies the value of the F parameter used in the measurement uncertainty 
calculation. The setting of F in the initialization file may be overriden using the 
VSET FSC. See VSET FSC in the MET/CAL FSC Reference Manual for a full 
definition of this parameter. 

Fail Prompt File 
fail_prompt = fail_prompt_file 

fail_prompt specifies the name of the post-run prompt file used when the overall 
result is a fail. 

Force Uppercase in Database Fields (Optional)  
forcecase = 1 | 0 

forcecase controls whether or not data written to the SQL database are forced to 
upper case. 
•  forcecase = 1, string data forced to uppercase. 
•  forcecase = 0, string data not forced to uppercase. 
If forcecase is not specified in the initialization file, the default is forcecase = 1. 

Head FSC Font (Optional)  
head_font = system | display 

head_font specifies whether HEAD statements use the System or Display font. If 
head_font is not specified in the initialization file, the default is head_font = 
display. 

Help File Directory 
helpdir = help_file_directory 

Directory where MET/CAL looks for help files. 
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HP 8903 Type (Optional)  
hp8903 = A | B | E 

hp8903 specifies the particular model of the user's HP 8903 (if any). The default 
is HP 8903B. The fact that the default is HP 8903B has no significance when 
there's no HP 8903 at all in the system. The reason it is necessary to have the 
hp8903 parameter is that no method has been determined by which MET/CAL 
can query an HP 8903 to determine it's type (A, B, or E).The real need is simply to 
determine: Is it or is it not an HP 8903A? I.e., the code will not behave differently 
if hp8903 is set to B rather than E. (In the future, this could change, however.) 

IEEE-488 Boards: I/O Address 
ib_ioaddr = i/o_address 

ib_ioaddr specifies the addresses of both the primary and secondary IEEE-488 
boards within the address space of the PC. This parameter is updated by the 
Configure=> IEEE-488 Boards menu selection in the Editor and Run Time 
applications.  

IEEE-488 Boards: Number of Ports 
ib_nport = 0, 1, or 2 

ib_nport specifies the number of IEEE-488 boards configured in the system. This 
parameter is updated by the Configure=>IEEE-488 Boards menu selection in the 
Editor and Run Time applications. 

IEEE-488 Boards: Type 
ib_type = board_type 

ib_type specifies the type of IEEE-488 boards configured in the system. Where 
board_type is: 
•  PC2B(T)    National Instruments GPIB PCII/IIA 
•  PC2A     National Instruments PC2A 
•  PCMCIA-GPIB  National Instruments PCMCIA-GPIB  
•  AT-GPIB/TNT   National Instruments AT-GPIB/TNT 
•  AT-GPIB/TNT(PNP) National Instruments AT-GPIB/TNT(PNP) 
•  PCI-GPIB    National Instruments PCI-GPIB 
•  GPIB-USB-A   National Instruments GPIB-USB-A 
•  none     only allowed when ib_nport = 0 
This parameter is updated by the Configure=> IEEE-488 Boards menu selection 
in the Editor and Run Time applications. 
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IEEE-488 Demo Mode Prompt (Optional)  
ieee_demo_prompt = yes | no 

ieee_demo_prompt determines whether the IEEE FSC should prompt the 
operator (when necessary) for the IEEE-488 address in demo mode. For 
MET/CAL V4.2 and previous, this initialization file parameter did not exist. For 
compatibility with previous versions of MET/CAL, If ieee_demo_prompt is not 
specified in the initialization file, the default is ieee_demo_prompt = yes. 

In Calibration is Required (Optional)  
in_cal_req = yes | no 

in_cal_req determines whether MET/CAL displays a prompt which asks the user 
if he wishes to continue when a required instrument is out-of-cal. If in_cal_req is 
not specified in the initialization file or in_cal_req = no, a prompt is displayed 
which asks the user if he wishes to continue with the out of cal instrument. If 
in_cal_req = yes, an out-of-cal instrument causes no warning or prompt. 

Logo, Editor and Run Time Startup (Optional)  
logo = 0, 1, 2,… 20000 

logo specifies the length time in milliseconds, to display the Editor and Run Time 
startup logo. If logo = 0, the startup logo is not displayed. If logo is not specified 
in the initialization file, the default is logo = 2500 (i.e. the startup logo is 
displayed for 2.5s). 

Measure Only (Optional)  
measure_only = yes | no 

measure_only affects meter drivers in measurement uncertainty mode. If 
measure_only = yes, then on the second and subsequent of a series of 
measurements comprising a test the meter driver will omit the steps required to set 
up the meter. I.e., the driver presumes the meter remains in the correct setup state 
and only triggers the measurement and reads the reading. The setting of 
measure_only in the initialization file may be overriden using the VSET FSC. 
See VSET FSC in the MET/CAL FSC Reference Manual for a full definition of 
this parameter. 

Measurement Uncertainty Output File (Optional)  
mfile = measurement_uncertainty_output_file | none 

mfile specifies the name of the measurement uncertainty output file. The setting 
of mfile in the initialization file may be overriden using the VSET FSC. See 
VSET FSC in the MET/CAL FSC Reference Manual for a full definition of this 
parameter. 
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Measurement Uncertainty Output File Format (Optional)  
mfile_format = delim | delim-q | delim-std | verbose 

mfile_format specifies the format of the measurement uncertainty output file. The 
setting of mfile_format in the initialization file may be overriden using the VSET 
FSC. See VSET FSC in the MET/CAL FSC Reference Manual for a full 
definition of this parameter. 

MEMC Instrument Repeat (Optional)  
memc_irpt = yes | no 

memc_irpt determines whether or not instrument SETUP and NOMSET 
statements are by default repeated on the second and subsequent passes through a 
MEMC or MEMCX test for the measurement uncertainty calculation. For 
MET/CAL V6.0 and previous, this initialization file parameter did not exist. If 
memc_irpt is not specified in the initialization file, the default is memc_irpt = 
yes, and instrument SETUP and NOMSET statements in MEMC and MEMCX 
tests will be repeated. This means that, by default, MET/CAL will work 
differently from V6.00. (Prior to V6.00 there was no measurement uncertainty 
calculation, so the issue did not arise.) In order to cause MET/CAL to skip 
instrument SETUP and NOMSET statements in MEMC and MEMCX tests, 
unless overridden by a procedure level VSET specification of MEMC_IRPT or 
by the addition of a TARGET or TARGET -m statement to the test, it is 
necessary to add memc_irpt = no to the [startup] section of the MET/CAL 
initialization file. 

Number of Measurements to Average (Optional)  
nmeas = 0, 1, 2,… 1000 

nmeas specifies the number of measurements to take for the measurement 
uncertainty calculation. The setting of nmeas in the initialization file may be 
overriden using the VSET FSC. See VSET FSC in the MET/CAL FSC Reference 
Manual for a full definition of this parameter. 

Number of Significant Digits (Optional)  
nsd = 2, 3, 4,… 14 

nsd is used to specify the number of significant digits in the reported values of the 
expanded uncertainty (EXP_UNC), the standard uncertainty (STD_UNC), and 
the coverage factor (COV_FAC). The setting of nsd in the initialization file may 
be overriden using the VSET FSC. See VSET FSC in the MET/CAL FSC 
Reference Manual for a full definition of this parameter. 
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Number of Measurements to Throw Away (Optional)  
nthrow = 1, 2, 3,… 100 

nthrow specifies the number of measurements to be discarded before the 
sequence of measurements to be saved for the measurement uncertainty 
calculation. The setting of nthrow in the initialization file may be overriden using 
the VSET FSC. See VSET FSC in the MET/CAL FSC Reference Manual for a 
full definition of this parameter. 

Out-of-Tolerance Limit 
oot_lim = 99.9 to 500 

oot_lim specifies the Significantly Out-of-Tolerance limit. This limit sets the 
threshold above which a significantly Out-of-Tolerance (OOT) warning is 
generated to notify the user of the UUT about this condition. The most 
conservative value, and the one that Fluke recommends, is 100 (%), to that every 
Out-of-Tolerance condition causes a Notify User warning. 

Pass 100% 
pass100 = yes | no 

pass100 specifies whether a test passes at 100% of tolerance or not. 

Pass Prompt File 
pass_prompt = pass_prompt_file 

pass_prompt specifies the name of the post-run prompt file used when the overall 
result is a pass. 

Picture Directory  
picdir = picture_directory 

Directory where MET/CAL looks for picture files. 
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Port, Default Serial 
port = serial_port 

port specifies the default serial port to be used for RS-232 controlled UUTs. 
Where serial_port is: 
COM1 PC COM1 
COM2 PC COM2 
COM3 PC COM3 
COM4 PC COM4 
COM5500 Fluke 5500A SERIAL 2 TO UUT 
COM5520 Fluke 5520A SERIAL 2 TO UUT 
COM5800 Fluke 5800A SERIAL 2 TO UUT 
COM5820 Fluke 5820A SERIAL 2 TO UUT 
This parameter is updated by the Configure=>Default Serial Port menu 
selection in the Editor and Run Time applications. 

Power On SRQ GPIB Port 0 (Optional)  
power_on_srq0 = error | prompt | clear 

power_on_srq0 controls how MET/CAL handles the situation in which a device 
on IEEE-488 port 0 is requesting service just prior to the start of procedure 
execution. 
When power_on_srq0 = error, MET/CAL does nothing. This means that Post 
Test will report that the first statement in the procedure was terminated by an 
SRQ. This is not very satisfactory when a user-configured system instrument 
always asserts a power-on SRQ and can't be configured otherwise. This option is 
provided for compatibility with previous versions of MET/CAL. It will turn off 
the whole check. 
When power_on_srq0 = prompt, just prior to starting to execute a procedure 
MET/CAL will check to see if there's an SRQ on IEEE-488 board 0. If there is, 
the addresses of all configured instruments listening on port 0 are serial polled 
until a device which acknowledges the SRQ is found. If such a device is found, 
and the SRQ condition was successfully cleared by the serial poll, the operator is 
prompted to see if he wishes to continue or to abort the procedure. 
When power_on_srq0 = clear, MET/CAL does the same thing it does when 
power_on_srq0 = prompt, except there's no prompt to the operator. That is, if 
the serial poll successfully clears the condition, MET/CAL goes forward as if it 
hadn't happened. 
If power_on_srq0 is not specified in the initialization file, the default is 
power_on_srq0 = prompt. 
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Power On SRQ GPIB Port 1 (Optional)  
power_on_srq1 = error | prompt | clear 

power_on_srq1 controls how MET/CAL handles the situation in which a device 
on IEEE-488 port 1 is requesting service just prior to the start of procedure 
execution. 
When power_on_srq1 = error, MET/CAL does nothing. This means that Post 
Test will report that the first statement in the procedure was terminated by an 
SRQ. This is not very satisfactory when the UUT is always assets a power-on 
SRQ and can't be configured otherwise. Some Tek scopes are this way. This 
option is provided for compatibility with previous versions of MET/CAL. It will 
turn off the whole check. 
When power_on_srq1 = prompt, just prior to starting to execute a procedure 
MET/CAL will check to see if there's an SRQ on board 1. If there is, the address 
of the UUT is searched for. When the first listener is found, assuming there is one, 
the search stops. The device is serial polled to see if it acknowledges the SRQ. If it 
does, and the SRQ condition was successful cleared by the serial poll, the operator 
is prompted to see if he wishes to continue or to abort the procedure. 
When power_on_srq1 = clear, MET/CAL does the same thing it does when 
power_on_srq1 = prompt, except there's no prompt to the operator. That is, if 
the serial poll successfully clears the condition, MET/CAL can go forward as if it 
hadn't happened. 
If power_on_srq1 is not specified in the initialization file, the default is 
power_on_srq1 = prompt. 

Procedure Date Format (Optional)  
proc_date_format = string 

proc_date_format specifies the format for the date string in the procedure 
header. 
Example: 
proc_date_format = MM/DD/YYYY 
If anything goes wrong in attempting to format the date using the format string 
specified by proc_date_format, silently revert to the default (YYYY-MM-DD). 
Format descriptors: 
DD day number 
MM month number 
MON 3-letter month name 
MONTH full month name 
YY 2-digit year number (for window 1970 - 2069) 
YYYY 4-digit year number 
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Rules: 
1. No format code may occur twice. 
2. At most one of { MM, MON, MONTH } may occur. 
3. At most one of { YY, YYYY } may occur. 
4. Other characters are copied unchanged. 

Procedure Directory 
procdir = procedure_directory 

Default compiled procedure directory. 

Procedure Directory Window Minimize (Optional)  
pd_min = yes | no 

pd_min enables or disables Minimize on Procedure Directory window. 

Procedure Title (Left)  
ptitle_l = string 

string becomes the left portion of the first line in the header of a procedure. 

Procedure Title (Right)  
ptitle_r = string 

string becomes the right portion of the first line in the header of a procedure. 

Prompt File 
prompt = prompt_file | none 

prompt specifies file used for pre-run prompts. 

Prompt Font (Optional)   
prompt_font = system | prompt | display 

prompt_font specifies the font to be used for prompts. 
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Readonly Database Write (Optional)  
readonly_db_write = yes | no 

readonly_db_write determines whether the Run Time allows readonly prompt 
screen parameter values to be written to the database. For MET/CAL V6.01 and 
previous, this initialization file parameter did not exist. If readonly_db_write is 
not specified in the initialization file, the default is readonly_db_write = yes. 
This means that if the initialization file does not include the readonly_db_write 
parameter, the Run Time will allow readonly prompt screen parameters to be 
written to the database. 

Readonly Variable (Optional)   
readonly_var = yes | no 

readonly_var determines whether the Run Time writes readonly prompt screen 
parameter values to the variable file. For MET/CAL V6.11A and previous, this 
initialization file parameter did not exist. If readonly_var is not specified in the 
initialization file, the default is readonly_var = yes. This means that if the 
initialization file does not include the readonly_var parameter, the Run Time will 
write readonly prompt screen parameters to the variable file. V6.11l and later, are 
different from previous versions in this regard. A user will have to explicitly add 
readonly_var = no to the MET/CAL initialization file in order to retain the 
behavior of V6.11A (actually V6.11k) and earlier. 

Remove All Connections Prompt (Optional)  
remcon = yes | no 

remcon controls whether or not to display the Please Remove All Connections.. 
message at procedure termination. If remcon is not specified in the initialization 
file, the default is remcon = yes. 

Required Standard Prompt (Optional)  
req_std_prompt = yes | no 

req_std_prompt indicates whether or not the Run Time should prompt for the 
asset numbers of required instruments whose asset numbers are not specified in 
the System Configuration File. req_std_prompt = no disables this prompt. If 
req_std_prompt is not specified in the initialization file, the default is 
req_std_prompt = yes. 

Result Column Template File (Optional)   
rslt_col_template = result_column_template | none 

This parameter specifies the format file that determines the data written to legacy 
database mode field 2501. 
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Results Save Mode (Optional)  
ResultSaveMode = All | FirstLast | Last 

ResultSaveMode specifies the mode for saving repeated test results: 
•  All, save all executions 
•  FirstLast, save first and last execution only 
•  Last, save last execution only 
If ResultSaveMode is not specified in the initialization file, the default is 
ResultSaveMode = FirstLast. The setting of ResultsSaveMode in the 
initialization file may be overriden using the VSET FSC. See VSET FSC in the 
MET/CAL FSC Reference Manual for a full definition of this parameter. 

Run Time Demo Prompt (Optional)  
rt_demo_prompt = yes | no 

rt_demo_prompt determines whether the Run Time should display an 
informative prompt when a procedure is executed in demo mode. For MET/CAL 
V5.0 and previous, this initialization file parameter did not exist. If 
rt_demo_prompt is not specified in the initialization file, the default is 
rt_demo_prompt = yes. 

Self Calibration 
self_cal = yes | warn | no 

self_cal specifies the action MET/CAL takes it is determined that UUT asset 
number is the same as that of a required configured instrument. 
If self_cal = yes, the workstation is configured to unconditionally allow self-
calibration. 
If self_cal = no, the workstation is configured to unconditionally disallow self-
calibration. If the UUT asset number is the same as the asset number of a required 
instrument, an error message is generated. 
If self_cal = warn, the workstation is configured to conditionally allow self-
calibration. If the UUT asset number is the same as the asset number of a required 
instrument, the operator is prompted to see if procedure execution should be 
continued or aborted.  
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Serial Poll Slow (Optional)  
serial_poll_slow = 0, 1, 2,… 1000 

serial_poll_slow enables a special slowed down serial poll routine for HP 890x 
instruments. The value of serial_poll_slow specifies the delay, in milliseconds, to 
be inserted into the middle of the serial poll. Legal values are 0 to 1000 ms. The 
default is 500 ms. This means that omitting serial_poll_slow from the 
initialization file is equivalent to specifying serial_poll_slow = 500. Setting 
serial_poll_slow = 0 disables the feature altogether, causing the normal serial poll 
routine to be used. Note that the special slow serial poll routine is in any case 
applied only to HP 890x instruments, and then only if two or more of them are 
configured. 

Show Required Instruments (Optional)  
show_req_instr = yes | no 

show_req_instr determines whether the list of required instruments is shown to 
the operator prior to procedure execution. For MET/CAL V6.0 and previous, this 
initialization file parameter did not exist. If show_req_instr is not specified in the 
initialization file, the default is show_req_instr = yes. To disable the display, it is 
necessary to add the line show_req_instr = no to the initialization file. 

System Type 
systype = meter | oscilloscope 

systype sets a system flag which is used to determine whether automatic range 
messages are generated with the /div (per division) suffix. systype also affects the 
slew message generated by some instrument FSCs. 

Test Run Search IEEE-488 Port 0 (Optional)  
tr_search0 = yes | no 

tr_search determines whether or not IEEE-488 port 0 is always searched prior to 
procedure execution in Test Run. For MET/CAL V6.0 and previous, this 
initialization file parameter did not exist. If tr_search is not specified in the 
initialization file, the default is tr_search = yes. In order to cause Test Run to skip 
the bus search, except the first time and after a change to the instrument 
configuration, it is necessary to add tr_search0 = no to the [startup] section of 
the MET/CAL initialization file. 
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Tolerance Reference 
tol_ref = uut_indicated | nominal 

tol_ref specifies the reference value for the calculation of the test tolerance. The 
default is tol_ref = uut_indicated. tol_ref has no effect unless the TOLERANCE 
field specifies the test tolerance as a percentage or PPM value. The following 
calculated quantities are affected by the tol_ref setting: 
1. Test Tolerance If tol_ref = nominal, the test tolerance is calculated with 

respect to the Nominal value. If tol_ref = uut_indicated, the test tolerance is 
calculated with respect to the UUT Indicated value. Example: 
Suppose you have a MET/CAL test like: 
ASK+ K 
5500 10V 1% 
Suppose also that the UUT (a meter) reads 10.1V. If tol_ref = nominal the 
test tolerance is ±0.1V, because 0.1V is 1% of 10V. If tol_ref = 
uut_indicated the test tolerance is ±0.101, because 0.101 is 1% of 10.1V. 

2. Test Uncertainty Ratio (T.U.R.) 
The test tolerance is the numerator of the T.U.R., so changing the test 
tolerance calculation changes the T.U.R. 

3. Error 
Except in some special cases (like dBm in the NOMINAL field), MET/CAL 
displays the error for a particular test as a percentage. If tol_ref = 
uut_indicated, the error is displayed as a percentage of the UUT Indicated 
value. If tol_ref = nominal, the error is displayed as a percentage of the 
Nominal value. 

4. Error % Tol 
MET/CAL calculates the error for a test as the difference between the System 
Actual and the UUT Indicated. It then displays the error as a percentage of the 
test tolerance. Since the test tolerance is affected by the tol_ref setting as 
described above, the error expressed as a percentage of the test tolerance is 
also affected by tol_ref. 
It is important to remember that tol_ref makes a difference only for tests 
where the UUT Indicated and Nominal values are different. 
If the system instrument is a source instrument (like a 5700A or 5500A), and 
the UUT is a meter, tol_ref makes a difference for keyboard-entry (ASK+ K) 
and closed-loop tests, but does not make a difference for tests where the actual 
output of the calibrator is slewed until the meter reading matches the Nominal 
value. 
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TUR Limit 
tur_lim = 0, 1, 2,… 10 | none 

tur_lim specifies the Test Uncertainty Ratio (TUR) limit. If a TUR in a procedure 
is below the limit set, a warning is displayed when the statement is compiled. If 
this parameter is 0, no TUR warnings are generated. 

Use Student’s T (Optional)  
use_st = yes | 1 | no | 0 

use_st controls whether or not to make use of the Student's T distribution in the 
measurement uncertainty calculation. (Actually, use_st can be set at 3 levels: 
procedure, initialization file, or database, and the precedence is in the order listed 
(highest to lowest).) 
Setting use_st = yes (or, equivalently, use_st = 1) in the initialization file 
indicates that the Student's T distribution should be used in the measurement 
uncertainty calculation, unless an overriding VSET specification exists in the 
procedure. 
Similarly, setting use_st = no (or, equivalently, use_st = 0) in the initialization 
file indicates that the Student's T distribution should not be used in the 
measurement uncertainty calculation, unless an overriding VSET specification 
exists in the procedure. 
Notice that not specifying use_st at all in the initialization file is equivalent to neither 
use_st = yes nor use_st = no. In this respect use_st is unlike most other optional 
initialization file parameters. Thus, in order to have the database use_st specification take 
effect, it is essential that use_st not be specified in the initialization file. 

User Current Working Directory (Optional)  
user_cwd = user_current_working_directory | none 

user_cwd specifies the working directory for user programs. That is, it becomes 
the current directory for an executing user program. Unless otherwise specified 
(see user_prog_dir below), it also becomes the directory where MET/CAL looks 
for user programs (unless a full path or partial path specification is given in the 
procedure), and becomes the directory where the DOS/DOSE data file is created 
and accessed (see user_data_dir below). 

User Data Directory (Optional)  
user_data_dir = user_data_directory | none 

user_data_dir specifies the location of the DOS/DOSE data file. If specified, it 
takes precedence over any user_cwd specification. 
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User Program Directory (Optional)  
user_prog_dir = user_program_directory | none 

user_prog_dir specifies the directory where user programs reside. If specified, it 
takes precedence over any user_cwd specification. 
A user_prog_dir specification has no effect on a DOS or DOSE procedure 
statement which gives a full path specification for the user program. 
For example, 
DOS c:\metcal\myprog.exe 

This DOS statement executes the myprog.exe in c:\metcal regardless of what 
user_prog_dir specifies in the initialization file. 
If the DOS or DOSE statement provides a partial path specification, the partial 
path specification is relative to the user_prog_dir specification (if any). 
For example, 
If the initialization file specifies: 

user_prog_dir = c:\metcal 
and a DOS statement in a procedure specifies: 

DOS exe\myprog.exe 
then MET/CAL executes the program c:\metcal\exe\myprog. 

User Program Exit Code (Optional)  
uexit_code = yes | no 

uexit_code specifies whether MET/CAL should pay attention to the exit code of a 
user program invoked by the DOS or DOSE FSC. 
•  yes, pay attention to exit code 
•  no, ignore exit code 
An individual DOS or DOSE statement may override the setting of uexit_code by 
specifying either �x (pay attention to exit code) or -i (ignore exit code) as an 
argument on the DOS or DOSE procedure line. If uexit_code is not specified in 
the initialization file, the default is uexit_code = no. 

Variable File 
varfile = variable_file 

Variable file. 
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Workstation Directory 
workdir = workstation_directory 

This is the directory where all workstation specific files and temporary files are 
stored. For example the workstation instrument configuration file is typically 
stored in this directory. 

Test Results in the Database 
To appreciate the reporting capability of Fluke Metrology software, you need an 
understanding of how results are stored in the database. With this information, you 
can select a report creation method to best fit your needs and available resources. 
When a calibration procedure is run, the Run Time application stores results 
directly into the database tables. The saved calibration data contains three general 
types of information. 

1. Test Summary 
Examples of summary data include UUT Identification, Cal Date, and 
Pass/Fail. This information is usually printed at the beginning of the report. 
Sometimes, relevant summary data is also included in page headers or footers. 

2. Standards Used 
A list of all the standards used to perform the calibration. 

3. Test Results 
The step-by-step test results of the calibration. 

Each evaluation (test step) in a MET/CAL of 5500/CAL Calibration Procedure 
generates a result. The Run Time application automatically writes the results to 
the database. When you run a report, the test results for the calibration of interest 
are returned. For a detailed description of the database results table see 
ResultsTable.pdb on distribution CD. 

Customizing Prompts for the Operator 
(PROMPTDB.TXT, PASS_DB.TXT, FAIL_DB.TXT) 

You must edit the PROMPTDB.TXT, PASS_DB.TXT, and FAIL_DB.TXT 
files to collect customized information that you want to have included in any type 
of results printout. You can edit the prompt files using the Procedure Editor�s 
�Open Text File� selection (File Menu) or using an external text editor. 
The Run Time application prompts the operator of the calibration system every 
time a calibration procedure is executed, if the system has been so configured. 
Prompts occur in the following instances: 
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•  Pre-run prompt (PROMPTDB.TXT): After selecting a procedure to be 
executed, but before a procedure actually starts up. 

•  Post-run, Pass (PASS_DB.TXT): After completion of a procedure, and the 
UUT passes. 

•  Post-run, Fail (FAIL_DB.TXT): After completion of a procedure, and the 
UUT fails. 

The presence of appropriate prompt files determines if one or more of these 
prompts occurs, and their content determines the type of information for which the 
operator is prompted. 
When the operator enters a response, the text entered is assigned to the name of a 
variable. The variable and the assigned string value are stored in a temporary 
variable file. The values can be recalled when results output is created. The 
temporary file is not erased after a procedure terminates; values can be �recalled� 
automatically when starting up another procedure, using special constructs in the 
prompt files. 
The prompt at the beginning of execution of a calibration procedure is determined 
by the prompt file with default name PROMPTDB.TXT. The default content of the 
PROMPTDB.TXT file is shown below: 
 Temperature in deg C      ::  TEMP$  2311 

 Relative Humidity in %    ::  RH$    2312 

 Calibration Seals Intact? :B: SEALS$ 2322 

 Work Order Number         :B: WO$    2314 

Prompt File Description 
Each line in a prompt file specifies a prompt to the user that appears on a Run 
Time prompt screen. Except for blank lines and comment lines, both of which are 
ignored, each line in a prompt file has 3 or 4 components as follows: 
Prompt 
String 

The prompt string is the text that the user sees when the prompt 
screen appears. The prompt string is everything on the line up to the 
first colon (:). The colon is not included in the prompt string, but it 
must appear in the prompt file, otherwise there is an error. 
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Attribute 
String 

The attribute string includes everything between the first and second 
colons. If there is no second colon, the attribute string is just the 
colon. 
The attribute string can contain the following specifiers: 
R Indicates that the field is read-only 
N Indicates the field must contain a numeric value only 
B Indicates the response buffer is to be initially blank. An 

attribute specifier of :B: is equivalent to just a colon - : 
However, B can be useful in conjunction with other 
specifiers. For example, :BN: specifies an initially blank, but 
numeric-only field. Note that this is not the same as :N:, 
which specifies a numeric-only field initialized with the value 
from the variable file. 

n An integer between 1 and 128 restricts the maximum number 
of characters that can be entered in the response field. 

D Indicates that the response buffer is to be initialized with the 
default database value (NOT the current value of the field). 
Permitted fields: In Version 6.0, Inventory Table fields are 
allowed if they are read-only, calibration table fields, and 
those that are not updated automatically. Specifically, the 
following Calibration table fields cannot be prompted for: 

 2301 

2305 

2315 

2317 

2318 

2319 

2320 

2321 

2323 

2325 

2333 

2335 

2336 

2337 

2338 

2339 

2342 

2343 

2344 

2345 

2346 

2347 

2348 

2349 

2350 

2351 

2352 

2353 

2363 

Variable 
Name 
String 

The variable name string is the name of the variable that will be 
associated with the user�s response. 
The variable name string is everything after the attribute string up to 
the terminating dollar sign ($). The dollar sign is required. Leading 
white space is not included in the variable name string. 

Database 
Field 
Name 
String 
 

The database field name string is optional. If it is included, it 
specifies the field in the Calibration table of the database to which 
the user�s response will be written. 
The database field name string is anything after the dollar sign. It 
does not include any leading or trailing white space. It may be empty 
(since the string is optional). The name can be a field number, or it 
can include a leading C to designate Calibration table fields. 
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Prompt File Rules 
The following rules apply to the Prompt File: 
•  Every line in the prompt file represents one prompt. 
•  The prompt can be any character except colon (:), and is used to provide the 

prompt for the operator. 
•  A variable-name must start with an alpha character (a-z, A-Z) or underscore 

(_), and is optionally followed by more alphanumeric characters or the 
underscore (_) character. 

•  A variable-name must end with a dollar ($) sign. 
•  Upper case and lower case is not significant in variable names. 
•  If the colon is replaced by two colons, the entry is preloaded with the 

currently assigned value stored in the VARIABLE.DAT file. 
 
For example, suppose the temperature and relative humidity in your 
calibration laboratory are closely controlled. The temperature and %RH are 
not expected to change significantly. Also, the name of your calibration 
facility is not changing. The previously entered value is not preloaded if the 
entry in the prompt file has a single colon:  
         Temperature         : TEMP$ 

The operator can override the preloaded entry, speeding up the operation by 
not requiring new entries for values that seldom change. 
The variable name and its value is stored in the VARIABLE.DAT file. The 
variable name and value can be accessed by programs run through the DOS 
and DOSE FSCs, and can be inserted into the results via the RSLT.FRM file. 

Parsing and Validation of Attribute Strings 
The following rules control the parsing and validation of the attribute string: 
1. White space is ignored, except that white space cannot be embedded within 

the maximum response length specifier (n). 
2. No specifier can be used more than once. 
3. Specifiers can occur in any order. 
4. The read-only specifier (R) is mutually exclusive with all other specifiers, 

except the �use database� specifier (D). 
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5. Whenever the attribute string contains two colons, the prompt response buffer 
will be initialized, unless the Blank specifier (B) appears. 
 
The initialization value is taken either from the variable file or from the 
database default value for the field. The database default is used only if (a) the 
prompt file line specifies a database destination field, and (b) the attribute 
specification includes the D specifier. 

6. If the attribute string is simply a colon (:), no attribute specifiers are present. 
In this case, the attribute is really just separating the prompt string from the 
variable name. The response buffer displayed to the user will initially be 
blank. 

Prompt Fonts 
You can select the font to use for prompt screens through the initialization files, 
METCAL.INI. There are three possible selections: SYSTEM, DISPLAY, and 
PROMPT. For details, refer to the heading earlier in this section that describes 
initialization file entries. 

Post-Run Prompts and the As Found / As Left Feature 

The purpose of field 2308, Found/Left, is to permit you to mark each calibration 
event with a tag specifying the point in your process that the event occurred. The 
tags specify whether the calibration results indicate the condition of the instrument 
at the time it arrived, at the time it left, or both. 
The As Found / As Left feature makes use of prompts contained in both the 
FAIL_DB.TXT and PASS_DB.TXT files. The prompts create a validated field on 
the Pass and Fail Post Run prompt screens (assuming that the validation entries 
for 2308 have not been modified). 
Refer to Chapter 8, �Configuring the System� for complete information about how 
to use the As Found / As Left feature. There, you will find a discussion that 
explains how to use the feature in conjunction with the Pass/Fail field to create a 
reliability profile for your assets. 

Description of Accuracy Files (*.ACC) 
Unless TUR checking is turned off, there must be one Accuracy File associated 
with each Instrument FSC. Accuracy files contain information on the specified 
accuracy of the instrument associated with the FSC. 
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Accuracy files may be empty. In this case, the Test Uncertainty Ratio checking 
must be disabled by the following entry in the metcal.ini file: 

    tur_lim = none 

The Procedure Compiler verifies that the requested value of parameters as stated 
in the FSC is possible. It also attempts to compute calibration accuracy ratios and 
issue a warning if the ratio of specified UUT tolerance to tolerance of the 
calibration system at the Nominal value drops below a constant value. This 
constant value is the one assigned to the variable tur_lim in the metcal.ini file. 
The default value is 4. 
The person who is writing your procedures should ensure that TUR warnings are 
not generated by verification steps. 
However, during adjustment steps, warnings are commonplace and generally can 
be ignored. The reason is that calibration adjustments are typically made close to 
the resolution of the UUT, which can be well within the stated accuracy of the 
UUT. In the limit case, the reading is set right on, meaning zero tolerance. Given 
that any calibration instrument has at least some tolerance, a warning of 
insufficient Test Uncertainty Ratio is generated that can be ignored in such a case. 
The TUR is defined as (Test Tolerance / System Accuracy). 
The compile time and run time TUR calculations may not be identical. At compile 
time the Test Tolerance is determined as the distance from the specified Nominal 
to the closest tolerance limit, unless one of the limits is zero. For example, a +3U 
in the tolerance field (implying -0U tolerance) causes the Test Tolerance to be 3U. 
At run time, the Test Tolerance is calculated as the distance from the UUT 
Indicated value to the tolerance limit that falls on the SAME side of the UUT 
Indicated value as the System Actual. 
All accuracy files are located in the directory specified by the �accdir� parameter 
in the metcal.ini file. Accuracy files are named as follows:  
 {FSC}.ACC 

Example: 
    5100.ACC 

Every Fluke calibration software package includes default accuracy files for all 
instruments in the system. These accuracy files reflect the performance of those 
calibration instruments in a systems environment over a period of 90 days. In most 
cases, no changes are needed. 
Certain calibration instruments may have special calibrations, making it possible 
to achieve tighter specifications. By modifying the accuracy files, it is possible to 
inform the calibration system of these tighter specifications. 
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Note that the ACCF FSC modifies how the software handles accuracy files. For 
details, refer to the description of the ACCF FSC in the Procedure Reference 
manual supplement. 

Accuracy File Formats 
•  Accuracy files are ASCII files that can be modified using any text editor. 
•  Each accuracy file must begin with a file header.  
•  Text is case insensitive. 
•  The file format is as follows. Each file is a sequence of sections. Each section 

consists of a MODE line, followed by one or more lines containing numeric 
data. 
 
A MODE line has the format:  
         MODE: <unit specifier> [ <flag> <flag> ....] 

 

•  The list of valid unit specifiers depends on the instrument. For example, valid 
unit specifiers for the 5100 FSC are volts, decibels, and amps. 

•  Flags are also specific to each instrument. For the same 5100 FSC, valid flags 
are E (for accuracy enhancement) and O (for Divider Override). 

•  A mode line may not have extraneous characters. 
•  Mode lines are not user-configurable. 
•  Numeric data lines containing the accuracy information for the stated MODE 

have the following format: 
<nlb> <nub> <mlb> <mub> <tol> <floor> <res> 

 

where: 
<nlb> is the nominal lower bound 
<nub> is the nominal upper bound 
<mlb> is the MOD1 lower bound 
<mub> is the MOD1 upper bound 
<tol> is the tolerance as a percentage of the nominal value (%) 
<flr> is the tolerance in absolute units (floor specification) 
<res> is the resolution of the instrument in absolute units or percent of 

nominal 
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•  The string �NA� may be used to indicate that a particular value is not 
applicable (i.e., not used). 

•  The nominal bounds must always be specified. 
•  The lower and upper bounds for Nominal and MOD1 are the legal lowest and 

highest values at which the instrument can be programmed. The lower and 
upper bounds themselves are legal values. 

•  The tolerance and floor may both contain �NA� to indicate that a range is 
valid, but no accuracy is specified for that range. 

•  If either tolerance or floor is �NA�, both must be �NA.� 
•  The resolution is expressed either in absolute units or percent of the Nominal 

value. If expressed in percent, the resolution is terminated with the percent 
(%) sign. Resolution may be �NA.� 

•  The file may contain any number of blank lines or comment lines. 
•  Comment lines have a pound sign (#) as the first non-white space character. 
•  White space before the beginning of text or after the text of a line is not 

significant. 
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A section of the accuracy file for the 5100 FSC may appear as follows: 
    Mode: Volts 

 

    0   .0199999  NA  NA  0.0038  0.0000052 0.1e-6 

    .02 .199999   NA  NA  0.0038  0.0000066 1e-6 

    .2  1.99999   NA  NA  0.0038  0.000021  .00001 

    2   19.9999   NA  NA  0.0038  0.000165  .0001 

    20  199.999   NA  NA  0.0038  0.0016    .001 

    200 1100      NA  NA  0.0038  0.016     .01 

 

    # Base 5100B accuracy AC Volts with divider for 

    # low values < 20 milliVolts. 

 

    1e-6 .0199999  50    10e3  0.1   0.00001  0.1e-6 

    1e-6 .0199999  20e3  50e3  0.12  0.00001  0.1e-6 

    .02  .199999   50    10e3  0.05  0.00006  1e-6 

    .02  .199999   20e3  50e3  0.08  0.000066 1e-6 

    .2   1.99999   50    0.9e3 0.05  0.00015  .00001 

    .2   1.99999   1e3   10e3  0.05  0.00013  .00001 

    .2   1.99999   20e3  50e3  0.08  0.00021  .00001 

    2    19.9999   50    10e3  0.05  0.001    .0001 

    2    19.9999   20e3  50e3  0.08  0.00165  .0001 

    20   110       50    10e3  0.05  0.01     .001 

    20   110       20e3  20e3  0.08  0.016    .001 

    110  199.999   50    1e3   0.05  0.01     .001 

    200  1100      50    1e3   0.05  0.055    .01 

 

    Mode: Volts E 

    # Enhanced accuracy specification for 7404B 

    # type system 

    # The accuracy enhancement is done with the 8506A from 

    # the output directly. 

 

    0    .0199999  NA   NA   0.0022   0.0000016   0.1e-6 

    .02  .199999   NA   NA   0.0022   0.0000016   1e-6 

    .2   1.99999   NA   NA   0.0014   0.0000062   .00001 

    2    19.9999   NA   NA   0.0010   0.000160    .0001 

    20   127.999   NA   NA   0.0017   0.0006      .001 

    128  199.999   NA   NA   0.0017   0.006       .001 

    200  1100      NA   NA   0.0017   0.006       .01 
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Accuracy File Headers 
Beginning with Version 6, each MET/CAL accuracy file must have a header. All 
accuracy files that are shipped with Version 6 will include valid headers. If you 
have created your own accuracy files you will have to add headers to these files. 
Accuracy file headers allow MET/CAL to automatically associate the correct 
accuracy specifications with an instrument that is used as a calibration standard. 
As in previous versions of MET/CAL, accuracy files are used only with supported 
system instruments. These are remotely-controlled calibration standards for which 
MET/CAL includes a built-in driver. 
Examples of supported system instruments are the Fluke 5700A, Fluke 5500A, 
and the HP 3458A. Accuracy files are not used with user-configured instruments 
or with manual standards. 
The accuracy file header should appear at the beginning of the accuracy file. 
Comments may precede the header. 
The accuracy file header is used to specify the instrument name, calibration 
interval, confidence and asset. 

Instrument Name 
This is the system instrument name that is associated with the accuracy file. The 
name must agree exactly with the name of a supported system instrument. For 
example, Fluke 5700A is valid, but Fluke 5700 is not. 
The syntax for this parameter is: 
instrument = <name> 

Name recognition is case-insensitive. 
The accuracy file header must include an instrument specification. 

Calibration Interval 
This is the calibration interval associated with the accuracy file. For example, if 
the file contains accuracies based on 90-day specs for a 5700A, the interval should 
be 90 days. 
The syntax for this parameter is: 
interval = <interval number><interval units> 

The <interval number> may be any number. Units may be specified in days, 
weeks, or months. For days, <interval units> may be: 
"d", "da", "day", or "days" 
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For weeks, <interval units> may be: 
"w", "wk", "week", or "weeks" 
For months, <interval units> may be: 
"m", "mo", "mon", "month", or "months" 
Calibration interval recognition is case-insensitive. 
The accuracy file header must include a calibration interval specification. 
When MET/CAL compares the calibration interval that is specified in an accuracy 
file header to the calibration interval associated with an asset in the database, it 
considers the two intervals to be the same if they are within approximately 10% of 
one another. This method allows, for example, 365 days to be recognized as 12 
months. 

Confidence 
The confidence parameter specifies a sigma value for use in the measurement 
uncertainty calculation. The syntax for this parameter is: 
confidence = <confidence value> [sigma] 

The confidence must be specified as a sigma value. It cannot be specified as a 
percentage. The word sigma is optional in the specification. If specified, 
recognition is case-insensitive. 
The accuracy file header must include a confidence specification. 

Asset 
The asset parameter specifies an asset number that is associated with the accuracy 
file. The asset specification is optional. If specified, it indicates that the file should 
be used only with the specified asset. 
The syntax for this parameter is: 
asset = <asset number> 

If specified, the <asset number> should be the same one entered in the 
database for the calibration asset. 
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Sample Accuracy File Headers 
Each accuracy file header is delimited by the lines: 
  Begin Header 

  End Header 

Header delimiter line recognition is not case sensitive. 
An example of a complete accuracy file header is: 
  Begin Header 

  instrument = Fluke 5700A 

  interval   = 90 days 

  confidence = 2.58 sigma 

  End Header 

An example of a the same header with an asset number specification is: 
  Begin Header 

  instrument = Fluke 5700A 

  interval   = 90 days 

  confidence = 2.58 sigma 

  asset      = 23-495A 

  End Header 

Adding the asset specification in the example indicates that this accuracy file can 
be used only with asset 23-495A. 

Avoid Accuracy File Header Conflicts 
It is important to avoid accuracy file header conflicts. Two accuracy files in the 
MET/CAL accuracy directory may not specify the same instrument name and 
same calibration interval, unless you have included unique asset number 
specifications in one or both headers. In addition, if the procedure contains ACCF 
statements that refer to accuracy files not in the MET/CAL accuracy directory, the 
headers of those files must not conflict with the headers of any file in the 
MET/CAL accuracy directory, nor with the header of any other ACCF-specified 
file in the same procedure, or any called subprocedure. 
The confidence specification in the accuracy file header cannot be used to 
distinguish two accuracy files which otherwise have the same header. This is 
because, although the confidence value is used in the measurement uncertainty 
calculation, it is not one of the selection criteria used to automatically associate an 
accuracy file to a configured calibration asset. 
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Creating Correction Files (*.COR) 
One Correction File may be associated with any Instrument FSC. These files are 
optional. If used, they are located in the directory specified by the �correctdir=� 
parameter in the metcal.ini file. Correction files must have file names ending with 
.COR . Correction files contain information on special calibration points of the 
instrument associated with the instrument FSC. An electronic instrument is far 
more stable during a limited period of time than its stated accuracy indicates. By 
providing specific calibration points and reducing the calibration interval, the 
uncertainty of the calibration instrument under those conditions can be 
significantly reduced. This is the case in particular with AC voltage functions. 
The presence of correction factors is indicated by the value of the Correction File 
Directory parameter �correctdir� in the metcal.ini file being set to something 
other than �none.� The default is �none.� If the Correction File Directory is 
identified, a search for correction factors is done. If no correction factors are 
known, the files can be blank. 
If there is a directory named CORRECT, the Run Time application attempts to find 
the corrected value for the calibration instrument, and report this corrected value 
in the results. 

Note 
If Correction files are used, the Accuracy file and Calibration 
Interval should also be changed to reflect the improved accuracy 
specifications. 

To indicate that a correction has been applied, the software displays the corrected 
System Actual value in the Post Test Summary dialog, followed by the word 
(corrected) to the right of the System Actual value. 
The Test Results window also indicates corrections. The corrected System Actual 
is shown in the System Actual column, and a Y appears in the C column. 
You can access the correction indication in the formatted results using the C$ 
variable. 

How Correction Files are Found and Named 
The correctdir directory contains all correction files. Correction files are 
named as follows: 

    <FSC>.COR 

Example: 
    5100.COR. 

The Fluke Metrology software package includes no default correction files. An 
example correction file for the 5200A is illustrated later in this chapter. 
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Interpolation Methods to Determine Corrections 
The Correction file first identifies the modes for which corrections are available. 
For example, the corrections apply to the volts mode: 

    Mode: Volts 

Any qualifiers, such as �O�, are included. This is also the case with the mode 
information in the accuracy files: 

    Mode: Volts O 

Within each mode, a number of ranges can be defined over which interpolations 
can be made. This includes the following: 
•  A lower bound for NOMINAL (e.g., voltage)  
•  An upper bound for NOMINAL (e.g., voltage)  
•  A lower bound for MOD1 (e.g., frequency)  
•  An upper bound for MOD1 (e.g., frequency) 
This reflects calibration instruments containing ranges of voltage and frequency. 
Interpolations are generally not valid between different ranges of voltage and 
possibly frequency. Interpolations and extrapolations are generally valid as long as 
ranges do not change. 
Each range lists a number of data points that can be used for interpolation. Data 
points are sorted by MOD1 value. After each MOD1 value, one or more Nominal 
values and their corrections follow. For example: 

    RANGE: 3 19.9999  100  10e3 
     MOD1: 100 
           3  3.0002, 10 9.99998 , 19 18.9997 
     MOD1: 1e3 
           3  3.0002, 10 10.0001 , 19 18.9999 

You may have a single Nominal data point for a given MOD1 value and there may 
not be an identical Nominal data point for another MOD1 value. In that case, the 
NOMINAL and MOD1 values in the correction file must exactly match the values 
in the calibration procedure to determine the corrected value. 
You may have a single Nominal data point for a given MOD1 value, and there 
may be an identical Nominal data point for another MOD1 value. In that case the 
Nominal data point value must exactly match the Nominal value in the calibration 
procedure in order to determine the corrected value. 
You may only have data points for a single value of MOD1. In that case the 
MOD1 value in the correction file must exactly match the MOD1 value in the 
calibration procedure to determine the corrected value. 
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In all other cases, data points must be on a rectangular grid as a function of 
Nominal (voltage) and MOD1 (frequency) value. The data points must also be in 
sorted order: increasing values of nominal with increasing values of MOD1 
values. (Refer to the example later in this chapter.) 
The process of determining corrected values is as follows: 
•  Check to see if there is a range available over which interpolations can be 

done; if not, try the next range. Ranges may be overlapping. If all ranges fail, 
no correction is possible. 
 
The accuracy file should reflect standard instrument accuracy for ranges not 
covered by the correction file. There may be overlapping ranges of correction. 
The most desirable range to be used for interpolation should be shown first in 
the correction file. 

•  Check to see if there is a data point that exactly matches both the Nominal 
value (e.g., voltage) and MOD1 value (e.g., frequency). If found, return the 
correction; if not, continue the interpolation process. 

•  Check to see if there are at least two data points with the same Nominal value 
but different MOD1 values (e.g., frequency) in the list of corrected values in 
the range selected. 
1. Find the MOD1 values that are closest to the desired MOD1 value above 

and below the desired value of MOD1. See Figure 7-1. 

MOD1

NOMINAL

 
IL701F.EPS 

Figure 7-1. Selection of Data Points in a Range of the Correction File 
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If no MOD1 value below or above can be found, find the next MOD1 
value above or below the desired value to be able to extrapolate. See the 
following figure. 

MOD1

NOMINAL

 
il702f.eps 

Figure 7-2. Data Points and Desired Value Requiring Extrapolation 

If extrapolating, find the difference between the closest Nominal value 
and the desired Nominal value, and the difference between the two 
reference Nominal values. If the ratio is more that 0.2, extrapolation is 
disallowed, and the correction within the range is not successful. 

2. When suitable data points are found, compute by linear interpolation the 
corrected value of the nominal at the MOD1 value desired. If conditions 
are not satisfied, continue the interpolation process. 

•  Check to see if there are at least two data points with the same MOD1 value 
but different Nominal values (e.g., voltage), in the list of corrected values in 
the range selected. Find the Nominal values that are closest to the desired 
Nominal value. The data point selection is similar to the previous case where 
the Nominal value was fixed and where two values of MOD1 existed. If 
conditions are not satisfied, continue the interpolation process. 
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•  Data points must be on a rectangular grid when the data points are plotted out 
as a function of Nominal (e.g., voltage) and MOD1 (e.g., frequency), unless 
the range contains just one or two data points. First, you search for two values 
of the MOD1 closest to the desired MOD1 value above and below the desired 
MOD1 value. Next, you search for the Nominal values above and below 
closest to the desired Nominal value. See the following figure. 

MOD1

NOMINAL

 
il703f.eps 

Figure 7-3. Data Point Selection 



 Customizing the Run Time Application 
 Creating Correction Files (*.COR) 7 

 

  7-41 

If you cannot find two values of Nominal and/or two values of MOD1 above 
or below, find the closest values of Nominal and/or MOD1 both above or 
below, and try to extrapolate. See the following figure. 

MOD1

NOMINAL

 
il704f.eps 

Figure 7-4. Data Point Selection and Extrapolation 
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The range of extrapolation is limited to 20% of the difference of Nominal or 
MOD1. If the desired value is not within that range, the extrapolation scheme 
fails, and no correction is applied. The interpolated correction value is 
computed as follows. See the following figure. 

MOD1

NOMINAL

1 1

2

1 1

2

 
il705f.eps 

Figure 7-5. Correction Computation Method 

1. Find the correction factors for the desired Nominal values at the lower 
and higher value of MOD1 (four correction factors). 

2. Compute the two interpolated correction values for the desired 
Nominal value at the lower and higher value of MOD1 (result is two 
new correction factors). 

3. Compute the correction at the desired combination of Nominal and 
MOD1 is found by linear interpolation from the new correction 
factors. 
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Using Correction Files 
Correction values are used in the results reporting and loading MEM or MEM1, 
depending on the type of test (Evaluation, Setup, Nominal Set, Compare) and 
mode (Slew, Keyboard Entry, Go/No-Go).  
The effect on memory locations MEM and MEM1 and the UUT Indicated and 
System Actual values is as follows. 
    Evaluation Test:  MEM : no change 

    (MOD4 = blank)    MEM1: Slew    : last slewed value 

                                      (CORRECTED) 

                            Keyboard: entered value 

                            Go/No-Go: Nominal value 

                                      (CORRECTED) 

                                      Test limits are adjusted 
 
             UUT Indicated: Slew    : Nominal value or MEM 

                                      (Not Ohms) 

                            Slew    : last slew value (Ohms) 

                            Keyboard: entered value 

                            Go/No-Go: OPER-EVAL 
 
             System Actual: Slew    : last slewed value (Not Ohms) 

                                      (CORRECTED) 

                            Slew    : Nominal value or MEM value 

                                      (Ohms) (CORRECTED) 

                            Keyboard: Nominal value 

                                      (CORRECTED) 

                            Go/No-Go: Nominal value 

                                      (CORRECTED) 
 
    Setup Test:       MEM : no change 

    (MOD4 = S)        MEM1: Nominal value or MEM 

                            (CORRECTED) 

                            Calibrator output is not adjusted. 
 
    Nominal Set Test: MEM : Slew    : last slewed value 

    (MOD4 = N)                        (CORRECTED) 

                      MEM1: no change 
 
    Comparison Test:  MEM : no change 

    (MOD4 = C)        MEM1: Slew    : last slewed value 

                                      (CORRECTED) 

             UUT Indicated: Slew    : MEM 
 
             System Actual: Slew    : last slewed value 

                                      (CORRECTED) 
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Rules for Correction Files 
The following are the rules for correction files: 
•  Correction Files are ASCII files that can be modified using any text editor. 
•  Text is not case-sensitive. 
•  The correction file may contain any number of blank lines or comment lines. 
•  Comment lines have a pound sign (�#�) as the first non-white space character. 
•  White space before the beginning of text or after the text of a line is not 

significant. 
•  Each file is a sequence of sections. Each section consists of a MODE line, 

followed by one or more ranges. 
•  The MODE line has the following format: 

•  MODE: <unit specifier> [ <flag> <flag> .....] 

•  The list of valid unit specifiers depends on the instrument. For example, the 
valid unit specifiers for the 5100 FSC are Volts and Amps. 

•  Flags are also specific to each instrument. For the same 5100 FSC, valid flags 
are E (for accuracy enhancement) and O (for Divider Override). 

•  A MODE line may not have extraneous characters. 
•  A range of values is defined by the following format: 

         Range: <nlb> <nub> <mub> <mub> 

where: 
nlb  is the Nominal lower bound  
nub  is the Nominal upper bound  
mlb  is the modifier lower bound  
mub  is the modifier upper bound 

Example: 

         Range: 2 19.99999 40 20 

The string �NA� may be used to indicate that a particular value for the modifier is 
not applicable and is not used. 
•  The lower and upper bounds for Nominal and MOD1 must always be 

specified. They typically coincide with a range of a calibration instrument. 
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•  Data points associated with a range follow the Range definition starting with a 
new line. Data points are listed by increasing MOD1 (frequency) value. The 
MOD1 value for which data points are valid is shown by: 
         MOD1: <mvalue1> 

 

Starting on the next line, Nominal data points and their corrections are 
shown. A comma �,� separates each group of Nominal value and corrected 
value: 

         <nvalue1> <cvalue1> , <nvalue2> <nvalue2> , ... 

A range and data points may be shown as: 
        Range: 2 19.9999 40 2e3 

         Mod1: 100 

          3 3.0002 , 10 9.9998 , 19 18.9997 

         Mod2: 1e3 

          3  3.0002, 10 9.9999 , 19 19.00003 



Metrology Software 
Users Manual 

7-46 

Example Correction File for 5200A 
    # Example Fluke 5200A Correction File (partial) 

    # 5200.COR 

    # 

 

    MODE: VOLTS 

 

    Range: 50e-3 119.9999e-3 50 100e3 

     MOD1: 50 

        50e-3 49.9998e-3, 100e-3 99.9976e-3 

     MOD1: 100 

        50e-3 50.0000e-3, 100e-3 100.0013e-3 

     MOD1: 200 

        50e-3 50.0002e-3, 100e-3 100.0023e-3 

     MOD1: 1e3 

        50e-3 50.0022e-3, 100e-3 100.0023e-3 

     MOD1: 2e3 

        50e-3 50.0023e-3, 100e-3 100.0030e-3 

     MOD1: 10e3 

        50e-3 50.0026e-3, 100e-3 100.0057e-3 

     MOD1: 20e3 

        50e-3 50.0033e-3, 100e-3 100.0033e-3 

     MOD1: 50e3 

        50e-3 50.0040e-3, 100e-3 100.0112e-3 

     MOD1: 100e3 

        50e-3 50.0020e-3, 100e-3 100.0263e-3 

 

    Range: 500e-3 1.99999 50 100e3 

     MOD1: 50 

        0.5 0.499998,  1.0 0.999976 

 

    Range: 3 11.99999 50 100e3 

     MOD1: 50 

        3.0 2.99989,  10 9.99970 

 

    Range: 30 119.9999 50 100e3 

     MOD1: 50 

        30 29.9997,   100 99.9992 

 

    Range: 300 1199.999 50 50e3 

     MOD1: 50 
        300 299.995,  1000 999.980 
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Introduction 
MET/CAL Plus software can be configured to meet companies specific 
requirements. This chapter covers what can be customized and provides 
information on how customization is accomplished. 
The key responsibility for system configuration falls on the System Administrator. 
The MET/TRACK screen used for entering data also serves as the Configuration 
Editor. The difference is the login and password used to open the program. 
MET/TRACK user screens are activity based and will change based on the user 
login. Logging in to MET/TRACK, using the MT password will display the 
necessary menus required for configuration. These menus will allow the System 
Administrator to add users, configure data forms and data fields, set up 
uncertainty, set-up and assign database segregates and add merge tables and other 
user-defined tables. 

Basic Customization Techniques 
All of this customization is discussed later in the chapter. This is a quick overview 
of the mechanics behind customizing the appearance and content of the user 
screens. The user screens include the search screen, any of the browse screens and 
the data entry screens. 
This overview section will cover how to: 
•  Select a Field or Group of Fields. 
•  Reposition Fields. 
•  Edit Basic Fields Properties. 
•  Edit Field Content using Validation. 
•  Customize Fonts and Field Colors on the Desktop. 
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Field Selection 

Select a group of fields to align, or move using the 
mouse to capture an entire group with a dashed line.
A selected group of fields will turn red. Once selected 
the tool bar can be used to reposition or straighten.

Select a field by clicking on it with the 
mouse. A selected field will turn pink.
Once selected it can be moved, formatted
or suppressed.

 
il303f.eps 

Field Selection 

Positioning Selected Fields 
Once the fields are selected, the toolbar can be used to move, hide, align, add or 
format the fields. Shown next is a reference chart of all the tools and their 
functions. All forms are customized using these tools.  
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Formatting Tools 

Editing Field Properties 
Field headings and field lengths are set in the Field Properties of each field. 
Double click in the field to bring up its properties. All fields on all forms are 
edited this way. Field properties for Browse Screens and Entry Screens are 
discussed in more detail later in the chapter, but a map of the Field Properties 
editor is shown in the next two figures. 
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Field Properties Editor  

The Validation Editor 
Validation will be discussed later in the chapter, but validations are added and 
created from the field properties editor. The next figure shows the Field Properties 
editor with the Validation/Merge tab selected. 
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Select the Adding or Editing tab to set 
field properties applicable to a new or
existing entry. (see previous figure.)

Create a list of Required Valid entries, Picklists, 
Linked Validations, and Merge Tables from the
Field Properties Editor

Click here to 
exit the Field 
Properties 
Editor

Edit Validations
or Merger Tables 
by selecting the 
Edit button.

Select the 
Validation/ Merge 
tab access the 
validation editing 
tools.

 
il800f.eps 

Editing Validation 

Setting Fonts and Field Colors on the MET/TRACK Desktop 
Required Fields and fields containing a Default Value will have a different 
background from the other fields on a form. These colors are selected when a user 
Desktop is customized. Desktop settings can be created and edited under the 
Setup menu.  
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The following example screen illustrates the customization possibilities. 

 
zv834s.bmp 

Selecting one of the Font selection buttons will bring up a list of fonts installed in 
the PC. The style selection will be displayed. 

 
zv835s.bmp 
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Selecting a color pallet will bring up the color chart. Choose a color for Required 
fields and for Default fields. Make sure that selected colors are not too dark, or 
the text will not be legible. 

 
zv836s.bmp 

For more information on Desktop customization see �Configuring User Desktops� 
later in this Chapter. 

Starting an Application 
If MET/CAL is set up as a Client/Server installation make sure the Calibration 
Data Engine is running on the server and start the Data Requestor on the client 
machine being accessed by the System Administrator. 
If MET/CAL is set up on a standalone computer, start the Calibration Data Engine 
by double-clicking on the Calibration Data Icon with the mouse. 
Start the MET/TRACK application by clicking on the MET/TRACK icon. Log in 
using user ID MT and Password MT. See the section later in the chapter on 
changing passwords. 

Note 
This is the Administrator password and should be changed as soon 
as possible by the designated Administrator.  

From the File menu, select the desktop to be customized. The name of the active 
desktop will be displayed at the bottom of the screen, on the status bar. If no 
desktop is selected, all changes will be reflected on the Default Desktop.  
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The Customization Process 

Configuration menus 
The menus that appear on the MET/TRACK screen when the MT login is used 
are: 
•  File 
•  Layout 
•  Database 
•  Set-Up 
•  Help 

Using the File Menu 
Use the File menu to Login again using a different user name and password. The 
File item also gives you the option to Log off. 
Use the Select Desktop item to choose a different desktop. The Desktop you 
select will be the one under which customization will reside. Desktop 
customization will be discussed in more detail later in this Chapter. 
Exit closes the program. 

Using the Layout Menu 
The Layout menu allows the System Administrator to change the appearance of 
three main types of user screens: Search Engine, Browse and Entry screens. This 
is where data screens and database fields are accessed for customization. Why 
customize an entry screen? Companies may have a pre-existing form that they 
want to emulate in MET/TRACK. The System Administrator can move fields, 
change field headings and field requirements, add a list of valid entries and change 
the color scheme. Fields are added using the left-arching arrow and suppressed 
using the trash can icon. Moves can be made by dragging and dropping fields to 
the desired location or by drawing a line around a group of fields to be moved and 
using the various position icons on the left side of the toolbar. Format changes 
within a field are made by accessing the Field Properties box. This is 
accomplished with a double-click within the field you want to change  
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An example of a Field Properties box accessed within a Browse Screen is shown 
below. 

 
zv837s.bmp 

The Search Engine 
The Search Engine form is used to find a record in the database. Any field can be 
added to the search screen with the exception of Memo fields. Any field that is on 
the Search Screen can be used in a search. The default form is shown below.  

 
zv838s.bmp 
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Fields can be added or suppressed (hidden). Fields that are used on the screen 
should be those that contain information most readily available to the user and that 
will give the most unique identifying information about an instrument.  
The administrator can move and rearrange fields or groups of fields, using the 
editing buttons on the top of the screen, or by dragging and dropping individual 
fields to another location on the screen..  

Customizing the Search Engine 
1. Suppress any fields not needed on the Search screen by clicking once in the 

field with the mouse and then clicking on the trashcan tool. 
2. Add any fields by first clicking on the Restore a Field tool then selecting the 

field from the pull-down list. Select the field by double-clicking with the 
mouse. 

3. Relocate the field on the screen by dragging them to the new location while 
holding down the left mouse button and then dropping by releasing the left 
mouse button. The field can also be highlighted and the up, down, right and 
left arrow keys used to reposition them. 

4. Reposition several fields at once by using the mouse to capture all fields to re-
position. Once fields are selected, ( remember, selected fields will turn color), 
use one of the Toolbar items to change the position.  

5. Change Field Title or Tool Tip Text, if desired, by highlighting the text to 
select it and typing the new title text to replace the old text.  

6. Adjust the Display Length by sliding the bar to the right or left to increase or 
decrease length. Then close the Field Properties editor. 

7. These customization tools are used the same way to customize all forms. 
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Browse Screens Defined 
Browse Screens are used to edit data already in the database. The screens 
available from the browse screens sub-menu are the Core, Inventory, Calibration, 
Location, Maintenance and Customer screens. Fields can be added to browse 
screens, but field customization is limited to Field Title text, Tool Tip text and 
Display Length. A more thorough discussion on field property customization will 
come later in this chapter. A sample Browse screen is shown below. 

 
zv838s.bmp 

•  Core Browse Screen: The Core screen is a section of all of the browse screens. 
The Core fields chosen remain visible, whether a user is editing the Inventory, 
Calibration or Location records of a particular asset using the Instrument 
Browser. These fields are chosen by the System Administrator as the most 
crucial information that should be shown at a glance. The fields can come 
from any table in the database. 

•  Inventory Browse Screen: This screen contains basic inventory information 
about an asset. These vital statistics include the unique Asset Number, Model 
name, Serial Number, Description, Options, Calibration interval information, 
Status and Acquisition information. It can include any field from the Inventory 
table. 

•  Calibration Browse Screen: The Calibration browse screen contains key 
information about a specific calibration event. This may include cal time, 
whether the unit passed the calibration, the cal technician performing the work 
and the environmental conditions in the lab. It also may contain engineering 
notes and comments or any field from the Calibration Table. 
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•  Location Browse Screen: This screen will give detailed information of the 
current location of the instrument in question. At a glance this screen should 
tell the inquirer the User Name, the user�s Shop and Location information and 
when the instrument was loaned to the current user. It can contain any field 
from the Location Table. 

•  Maintenance Browse Screen: If instruments require regular maintenance or if 
an instrument has ever been repaired a Maintenance Record is created. This 
data is located on the Maintenance Browse Screen. This screen can give 
Maintenance Dates, including Maintenance Due, a Description of the work 
done, Parts Used and Part and Labor Costs. Like the other Browse screens, 
any field from the Maintenance Table can be added to this screen. 

•  Customer Browse Screen: Companies that have external and internal 
customers will use the Customer screen to see and update basic customer 
information. Basic information will include the Customer ID number, Name, 
Address, Contact Names and Phone Numbers. It can also contain Contract and 
Billing information. 

Customizing Browse Screens 
The browse screens are customized in exactly the same way as the Search engine. 
1. Select the Layout menu. 
2. Select the screen to customize. 
3. Follow the steps described earlier to make the necessary changes.  

Entry Screens Defined 
The Entry Screens are built from the same tables as the Browse Screens and can 
display all of the same fields, however the Entry Screens allow more detailed 
customization. All entry screens can be accessed from this menu and they include 
the: 
•  Inventory Screen 
•  Calibration Screen 
•  Location Screen 
•  Maintenance Screen 
•  Customer Screen  
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The Entry Screens can be customized to show any fields from their corresponding 
tables. The System Administrator can move fields, change field headings and edit 
field properties to include a list of valid entries, pick lists, linked or merged data. 
Fields can be set so entry into them is required they are added, suppressed and 
moved as described earlier.  
Like with the Browse Screen, the Inventory Entry/Edit Screen, shown above, is 
the Entry Screen that corresponds with data found in the Inventory Table. The 
Inventory record is the first created for a new asset. If an instrument is not in 
inventory no other information can be entered. The inventory form will be one of 
the most used forms and should be made as efficient and easy to use as possible. 
Data entry can be automated through the use of pick lists, linked validation, 
customized tab order, and screen layout. Using custom colors to designate 
required fields will tell the user what fields must contain data before the record 
can be saved. Unused fields can be suppressed to help simplify and shorten the 
entry time.  
The Calibration Screen is where calibration events are recorded. This form is 
used to manually enter calibration information into the database or is created 
automatically when a calibration is done with the Run Time application. Fields 
on this screen are customized and rearranged the same way. Any field that resides 
in the Calibration Table can be displayed on the Calibration Screen. This is the 
second most used entry screen and should also be kept very simple and user-
friendly. 
The Location Screen is used to track the whereabouts of a company�s equipment. 
It records details like the User Name, Station and Department, when the 
instrument was loaned out and anything else that may be used to keep track of 
valuable instrumentation. Any field that is part of the Location Table can be added 
to the Location screen. 
In many cases equipment must have regular maintenance to maintain maximum 
performance. The Maintenance Screen will track maintenance requirements and 
maintenance and repair events. Complete details of what is done to an instrument 



Metrology Software 
Users Manual 

8-16 

or what needs to be done, the parts involved and the costs associated are tracked 
with the Maintenance and Repair screen. Fields that make up the Maintenance and 
Repair screen are in the Maintenance Table. Like with the previous forms, 
anything from this table can be displayed on the screen. 

 
zv840s.bmp 

The Customer Screen keeps information on customers whose instruments are 
being calibrated, repaired, etc. This is a very useful screen for those users that do 
service external customers. It can also be useful for those in large companies who 
service many other departments or internal customers. This screen can contain any 
information stored in the Customer Table. Like the other entry screens, this screen 
is used to record information about a specific inventory item, or asset. This form 
will allow the user to assign or tie specific asset numbers to a specific customer. 
Data on this screen is usually a Customer ID number, Name, Address, Shipping 
Address, Contact names and accounting information like Tax Status and Billing 
Terms. 
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Customizing Entry Screens 

Defining Database Field Types 
Every field can be customized. However, before doing ANY field customization it 
is important to understand the types of fields located in the various tables. Each 
field is classified as Core, Calculated or Auxiliary 
Core Fields contain certain types of values which are required for the underlying 
database to work properly. Examples are fields like I4201, Asset Number and 
C2301, Calibration Date. Many of these fields can be set up to have default 
values. The operator may not see them, but they exist and are used by the system. 
Calculated Fields are those that have some sort of mathematical relationship to 
other fields. For example, C2303, Due Date, is computed using values from 
C2301, C2302, and C2333, Calibration Date, Calibration Interval, and Calibration 
Pass/Fail, respectively. There is no way to change the way these fields interact. 
Customization allowed for this field type is usually limited to making changes in 
the name of the field heading.  
Auxiliary Fields are all those other fields that are neither core fields nor part of a 
calculated field group. Auxiliary Fields are strictly data fields. They just contain 
information. Reports supplied with the software may expect certain types of 
information in some of these fields but users can change these fields without 
interfering with the basic operation of the software. Reports using some of these 
fields may need to be changed to match the user customizations. Auxiliary fields 
are less sensitive to customization, but changes can still result in confusing reports 
or screens if intended use of the fields is not taken into consideration. 
Memo Fields Memo Fields can take large amounts of text, but differ from a 
comment field because they are formatted to accept Rich Text Format. Word 
document can be copied and pasted into the memo field by the user. Picture files, 
like .bmp files, jpg files and any other type of graphics file can be pasted in using 
the standard Windows CTRLC and CTRLV copy and paste commands. This field 
can be used to store photos of the inventory item, copies of cal certs or scanned 
copies of Manufacturer�s Warranty cards. Store a shortcut to a .pdf file or any 
type of file in the memo field. This field does not require customization. Just add 
the memo field to the Inventory, Calibration, Location and Maintenance Screens. 
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Core Fields: The Minimum Requirements As previously stated, Fluke 
Metrology applications can be used just as they are shipped, without any special 
customization at all. Initial values and defaults have already been established for 
all of the core fields. These fields represent the absolute minimum requirements to 
enable the various programs to interact with the database. Following is an 
illustration of the Calibration Form as seen in the Entry Screen Lay-out function 
of MET/TRACK. 
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The fields necessary for the calibration form to work properly are those labeled 
Cal-Date, Cal-Time, Pass, Interval. These fields represent the minimum amount 
of information that the database needs, and ensures that the date and time the 
calibration was performed, whether the asset passed or failed, and the calibration 
interval will always be recorded. 
Core fields are required only for the proper functioning of the Fluke Metrology 
application programs. During customization of any of the forms, special 
consideration must be made of the core fields.  
A form can be customized as radically as desired; even to the point of having none 
of the core fields visible. As long as the fields are receiving data from somewhere, 
everything will sail along smoothly. 
One customizable field attribute is Source (copy from) This attribute allows 
another field to receive a copy of the data from the field designated as the Source 
field. In order to suppress the core field Cal-Date, you would have to ensure that 
some other field is supplying the data. Otherwise, the system will complain. 
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The underlying design supports efforts to keep every piece of important data for 
every calibration event, whether the information is recorded automatically as a 
result of running a Calibration Procedure, or manually, using MET/TRACK. A 
System Administrator must be aware of the underlying design in order to change it 
without creating costly errors. 
The following table shows the minimal fields on the entry forms: 

Table 8-1. Minimum Field Set 

Calibration Form Core Fields Inventory Form Core Fields 

C2301 Calibration Date 4201 Asset Number 

C2333 Calibration Time 4209 Trace 

C2323 Pass/Fail 4299 State 

C2302 Interval (from 4229) 4240 Segregate Value 

C2331 Interval Type (from 4228) 4228 Interval Type 

C2316 Arrive Date (from 4224) 4229 Interval 

Calculated Fields 
In the database, a calculated field is one that depends on the value in another field 
or one that supplies a value to another field. This value can be a direct copy, as in 
the case of C2302, C2316 and C2331 on the Calibration form, Interval, Interval 
Type and Arrival Date, respectively all of which receive their values from the 
Inventory form. The inter-relationships among the fields also can be more 
complicated, as in the case of Calibration Labor Rate calculation. 
Using the Calibration Labor Rate as an example, the value in field C2309, 
Calibration Labor Cost, is calculated from the values in several other fields, 
namely C2307 ,Cal-Tech, C2313, Calibration Shop, C2310 Shop Rate, C2324, 
Calibration Time,C2327, Second Cal-Technician, and C2328 Second Cal-Tech 
Time. The relationships between these fields are best illustrated by the formulas 
used in deriving the values: 

Table 8-2. Calculated Field Formula 

Tech1cost = 2324/caltime1  X  Labor rate for 2307/caltech 

Tech2cost = 2328/caltime2  X  Labor rate for 2327/caltech2 

ShopCost = 2310/caltime  X  Rate for 2313/calshop 

2309 (CalLaborCost) = Tech1cost + Tech2cost + ShopCost 
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It is imperative that any customization of calculated fields take into account the 
underlying connections between fields that interact. For example, if field number 
C2324 is customized to record some information other than a period of time used 
by the primary calibration technician to calibrate the asset, the result of 
multiplying this time by a labor rate would have to be disregarded which would 
nullify the C2309 total cost. As a general rule, the basic functions of calculated 
fields or those fields that contribute to the data in a calculated field should 
not be changed.  
Following is a list of Calculated fields and the fields in their Calculation Group. 
Due Date Calculation 
2301 Cal Date 2323 Pass/Fail 
2302 Cal Interval 4228 Interval Type 
2303 Cal Due Date 4229 Master Interval 
Calculation Labor Rate 
2307 CalTech1 2327 CalTech2 
2313 CalShop 2328 CalTime2 
2324 CalTime1 2310 CalTime  
Total Calibration Time 
2310 Total Cal Time 2324 Cal Time 
2307 Cal Tech 1 2327 Cal Tech 2  
2313 Cal Shop 2328 Cal Time 2 
 
Repair Labor Rate 
3233 Rep Tech 1 3237 Rep Tech 2 
3236 Rep Shop 3738 Rep Time 2  
3239 Rep Time 1 3229 Rep Time 
3235 Labor Cost 
 
Total Repair Time 
3229 Total Repair Time 3239 Repair Time 
3233 Repair Tech 3237 Repair Tech 2 
3236 Repair Shop 3238 Repair Time 2 
 
Repair Due Date 
3230 Repair Date 3249 Repair Interval 
3247 Repair Due Date 3250 Repair Interval Type  
 
Total Parts Cost 
3209 Cost of Part 1 3218 Cost of Part 4 
3212 Cost of Part 2 3221 Cost of Part 5 
3215 Cost of Part 3 3224 Cost of Part 6 
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Note 
Some fields are considered to be Calculated Fields if they are 
subject to rules enforced by the database. For example, As Found/As 
Left can influence the values recorded in the Reliability field, 
C2304.  

For additional information about how the fields interact and the formulas used in 
the calculations, refer to the online help files. 
Auxiliary Fields 
Fluke Metrology software has the potential to be molded to fit just about any 
metrology lab�s needs. Therefore, many of the fields are neither core nor 
calculated, they�re just there to record data. These include the many user-defined 
fields in the database that are designed to be customized for unique application.  
Auxiliary fields can be customized in almost any way, consistent with maximum 
character length and data type. Like Core and Calculated fields, Auxiliary field 
customization can have an affect on pre-existing reports. If a field title is changed 
on a form, a corresponding change should be made on any report that uses data in 
that field. 
There are many examples of auxiliary fields most of the Inventory Form is made 
up of them. It is not necessary, for example, to use I4202 for the name of an 
asset�s manufacturer. If a 20 character field is required for something else and 12 
characters are sufficient for the list of manufacturers, I4210 can be used for 
manufacturers, and the 20 characters in I4202 for some other purpose. A user-
defined field that meets the required length criteria can also be used. 
When the usage and title of a field is changed simultaneously, customization 
should be documented. It is not strictly necessary, though, since running the 
report, MTCUST7.RPT generates a report that shows current customization 
Memo Fields 
A memo field behaves like any other auxiliary field. It really doesn�t require much 
customization beyond setting display and data length. It is either added to or 
suppressed from the various data forms. The memo field is designed to accept rich 
text format documents, picture files and shortcut links to other programs. 

Editing Basic Field Properties 
Format changes within a field are made by accessing the Field Properties dialog 
box with a double mouse click within the field to be changed. Editing a field from 
the Entry Screens Layout menu will allow additional customization. The System 
Administrator can determine the user access level allowed to add and make 
changes to fields. Refer the Field Properties dialog later in this Chapter to see the 
choices.  
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Note 
The selection of a blank value will default the required user level to 
Manager, or level 5.  

For many fields, user levels can be set differently for initial records (Adding) and 
existing records that are being changed (Updating). A user may be able to add a 
serial number on an initial record, but not allowed to change it after the record has 
been saved. 

 
zv843s.bmp 

Creating and Editing Validated Fields 
Required Validation lists, lists of allowed entries for a specific field and Pick 
Lists, lists of frequently used entries for that field, can be created. Linked 
Validation lists, automated entry links to other fields, are also created here. 
Required Validation lists differ from Pick Lists. A record with a field containing 
a Required Validation cannot be saved unless the field contains an entry that is 
on the list. A Pick List contains frequently-used values but these choices are 
suggested, not required. Linked Validations will enter data into multiple fields 
depending on the entry the user selects in the main field, or Root Field.  
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An example of a Field Properties dialog box accessed within the entry screen is 
shown below. This is what the System Administrator will see when customizing a 
Pick List, within the Manufacturer Field in the Inventory Entry Screen Editor. 

 
zv844s.bmp 

Validation provides a way to restrict the data allowed in a field to a set of 
authorized, or valid, values. Validated lists of entries are created and edited within 
the field by editing the field properties and selecting the Validation tab. 
There are three types of field validations from which to choose, Required 
Validations, Pick Lists and Linked Validations. 
A Required Validation is a single list of entries consisting of approved values for 
a specific field. The operator is required to select from the list or the record can 
not be created. During normal operation, an invalid entry cannot be entered. If the 
user starts to type information into a required validated field the system will find 
the word that starts with the same letters the user is typing. If no match is found 
the only other option for the user is the leave the field blank. However, if the field 
is set-up to be Required, if the field is left blank an error message will be 
displayed saying that the field is required and must contain data before the record 
can be saved. A Required Validation is created by selecting the Req Val radio 
button under the Validation tab and then selecting the edit button. 
To add a new list select the New button and type the list. To save the list select the 
Save button. To exit, select the Close button.  
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To edit an existing list click on any row in the list and press Enter a new blank 
line will appear in which a new item can be typed. To save the changes select the 
Save button. To exit, select the Close button. 
A Pick List is configured in exactly the same way as a Required Validation list, 
except that the Pick List radio button is initially selected. A Pick List is created 
and edited the same way also. The only difference between a Required 
Validation and a Pick List is the Required part. A Pick List contains a list of 
values thought to be appropriate for a particular field. It gives the user frequently 
used choices to help speed up the entry process. However, if the user enters an 
item that is not on the list it is perfectly acceptable to the system and the record 
can be saved with any value in that field. 
A Linked Validation is used to enter data into the database in several fields from 
a single entry. It is used to enter data into Model, Manufacturer and Description, 
for instance by just selecting a Model number. It saves data-entry time. Like a 
Required Validation the field is required to contain a value that is on the 
validation list. A field whose selected value will determine what values the other 
linked fields will get is the Root field. The Root field comes first when creating 
the Linked Validation table. 
Following is an example of a Linked Validation 

 
zv845s.bmp 
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To create a Linked Validation, select the Linked radio button and then select the 
Edit button. The first field title will show the Root field. Click the Add Link 
button and then select a field to be linked with the Root field using the down 
arrow. Once a field is selected press the Enter key. To enter values for each field, 
select the right-facing arrow until the first field is highlighted. Type in the desired 
values and tab to the next field in the link. When all entries are completed, move 
the cursor to the last row, denoted by the *symbol and exit the Linked Validation 
editor. 

Note 
In any large database, valid data entry is very important. The entries 
typed in the Form Layout Application are used for validating the 
field data. Careless editing can result in the applications accepting 
incorrect data or rejecting correct data.  

Try to keep the number of validated fields manageable in size, and do not set up a 
field with too large number of valid entries. Validated fields with too many 
possible entries may take the user a longer time to scroll through than it would 
take to type manually. 

Copying Data Between Fields 
Source Copy/Destination Copy 
Fields can be populated with information from another field. Inventory data 
contains no history, but the Source (copy from) selection can be used to copy the 
value from one of the history forms into the inventory form. 
If there is a company requirement to have the current Due Date appear on the 
inventory window it can be added using a Source copy on the Inventory form. 
1. Use the Restore Field tool to add field I4212, Note Date, to the Inventory 

form. Double-click to access the Field Properties Editor. 
2. Select the Updating tab then click on the arrow in the Source (copy from) 

Field. Locate C2303, Cal Due Date as the Source field from which to copy 
data into the Note-date field.  

3. Click once with the left mouse button to select it.  
Now every time a new calibration record is saved the due date will be copied 
from the calibration record to the Note-date field on the Inventory form. If 
Destination (copy to) has been enabled in any of the History forms, the selected 
field in the Inventory record is updated when the History Record is changed. 
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Copying Data Between Records 
When creating a new Cal, Loc, or Maintenance record, all considered History 
Records, and if Copy Forward was enabled for a field, the previous value in that 
field is inserted into the record being created. Any field can have its value copied 
forward to the next record (of the same type) created. 
Copy Forward takes precedence over Default data. If a field has both default data 
and copy data, the copy data will appear in the field, not the default data. For 
fields that contain historical data, legal values for Copy Forward are ON and OFF. 
MET/TRACK restricts the choice to one of these two values or to use the Source 
(copy from) instead. 
If copy forwarding is set to ON, then the entry from the previous record is brought 
forward when a new record is added to the system. If the lab has only one cal tech 
the C-Tech field can be copied to every new calibration record. By setting the 
copy value to ON, the C-Tech from the previous calibration record will be copied 
to a new calibration record. This value can be changed if the user has sufficient 
authorization to update or add-to the C-Tech field.  
Setting the initial default value to blank and making the field required ensures that 
the field is filled the first time it appears in a record. 

Setting Default Values in Fields 
Default data is that which appears automatically in a field on a data entry window 
or during importation. Default data can be specified for both Insert and Update 
data entry. It is another way to populate fields without the data-entry process. 
Default data may overwrite any data that is currently in the field with the 
exception of data caused by the Copy attribute being active or if. the user has 
authorization to enter or update data in the field.  

Special Default Data Selections 
There are some Specially Configured Selections for Default Data. 
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Table 8-3. Special Default Values 

Current Date Enters the current computer calendar date. 

Current Time Enters the current computer clock time. 

User’s Login Name Enters the name of the user currently logged in. 

User’s Full Name Enters the real name of the user currently logged in (from the user 
configuration. 

User’s Segregate Enters the user’s assigned segregate. 

User’s Workstation Enters the user’s workstation designation. 

Desktop Name Enters the name of the desktop used. 

These selections are already in the Default Value list 
1. Select the desired entry by using the scroll arrow to the right of the Default 

Value entry field and choosing from the list. 
2. If the desired Default Value is not in the list, select the blank entry in the 

drop-down. This will blank the value. The required value can now be typed 
into the empty box. 

Special Rules for Customization 

As Found/As Left  
As Found/As Left represents a calibration philosophy about how calibration is 
performed. MET/BASE supports three basic philosophies. The philosophy you 
choose determines how the Found/Left field, C2308, is configured. 

Philosophies of As Found/As Left 
Philosophy 1 
When an instrument comes in for calibration, the verification procedure is run. If 
it passes, the data is recorded and the instrument returned. If it fails, failed data 
may or may not be recorded, the instrument is re-calibrated or fixed and the 
verification procedure is run again. (It passes this time � it was fixed). 
Following this approach, Field C2308 is left blank (or suppressed), and the user is 
not concerned with As Found/As Left. 
Philosophy 2 
As Found/As Left data is always recorded. When an instrument comes in for 
calibration, the verification procedure is run. Whether it passes or fails, the data 
for the instrument is recorded and C2308 set to AS-FOUND, since this is how the 
instrument came into the lab. If it failed, the instrument is recalibrated or fixed. 
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Now, if it passes, the verification procedure is run again. This time, however, the 
data that gets recorded is AS-LEFT, since the instrument is being sent back to the 
user. 
Philosophy 3 
As Found/As Left data is recorded, but the verification procedure is only run once 
if the AS-FOUND passes. The procedure is followed as in #2 if the instrument 
fails on the AS-FOUND. If the instrument passes on the AS-FOUND, then C2308 
is set to FOUND-LEFT, to indicate that the instrument was FOUND in this 
condition, and it LEFT the lab in the same condition.  
The difference between #2 and #3 may not seem very large, but it becomes 
important when reporting on the data, and if trying to match up As-Found and As-
Left data in Crystal Reports. 
The purpose of field C2308, Found/Left, is to permit tagging of each calibration 
event with information about when the event occurred in the process. The tags 
specify whether the results indicate the condition of the instrument at the time it 
arrived, when it left, or both. The feature can also be disabled so that no such 
tagging takes place. 
However, note that by not using the Found/Left feature, a reliability coefficient for 
each instrument cannot be generated. The Reliability Coefficient is a figure of 
merit that indicates each instrument�s reliability. The coefficient is stored in field 
C2304. Fields C2308 and C2304 make up a Calculation Field Group. Because of 
this relationship, the system enforces the interaction between these two fields in 
the database. 

Constructing a Reliability Coefficient  
The Found/Left field,C2308, stores a single value for each calibration event, and 
the feature works the same way whether the data comes from the Run Time or the 
Manual Entry application. 
The Found/Left field is 10 characters, and it must contain one of the values AS 
FOUND, AS LEFT, FOUND_LEFT, or it must be empty (contain a null value). 

The purpose of field C2308, Found/Left, is to mark a calibration event with a tag 
that specifies the point in the process where the event occurred. These tags specify 
whether the calibration results indicate the condition of the instrument at the time 
it arrived, at the time it left, or both. 

The As Found / As Left feature makes use of prompts that the operator will see 
upon completion of a calibration procedure. The formatting of these prompts is 
contained in two files, Pass_DB.TXT and FAIL_DB.TXT, located in the 
METCAL directory, by default. The prompt is formatted as follows: 

As Found / As Left :: FOUND_LEFT$ 2308 
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The effect of these prompts is to create a validated field on the Pass and Fail Post-
Run prompt screens (assuming that the validation entries for C2308 have not been 
modified). The choices presented are the legal values, including the null value. If 
the validation of C2308 is modified, the automatic loading of the Reliability field 
will not operate. 
A pound sign (#) at the beginning of the line illustrated above causes the Run 
Time application to ignore the entire line. This removes the prompt from the post-
run screen and disables the feature. Open each file in an editor such as Notepad to 
make the changes in both the FAIL_DB.TXT and PASS_DB.TXT files. If the 
feature is disabled the prompts must be removed (or commented out using the # 
sign) from both the FAIL_and PASS_DB.TXT files. If the feature is disabled the 
validation entries for field C2308 can also be edited. 
If the Found / Left feature is used, the contents of the Reliability field, C2362, can 
be affected. The reliability field is a calculated field that receives information 
from two sources: Found/Left, C2308 and Pass/Fail, C2323. 
Providing As Found reports may be a requirement for some customers, but even if 
it is not required, gathering reliability information may be a convenient way to 
determine calibration cycles for certain instruments. If an instrument with a 30-
day calibration interval is always in cal upon arrival, it may be appropriate to 
extend the interval. Conversely, if a critical instrument usually arrives out of 
calibration a shortened interval may be in order. 
The following table shows the effect of As Found/As Left on the reliability field. 

Table 8-4. Effect of As Found/As Left on Reliability Field 

Pass / Fail 
(C2323) 

Found / Left 
(C2308) 

Reliability 
(C2362) 

Pass 
or 
Fail 

Don’t Care 
No Change 

Pass Found_Left 

or 

As Found  

If rel < 0, set to 1 
otherwise set rel=rel +1 

Fail Found_Left 

or 

As Found 

If rel > 0, set to -1 otherwise set 
rel = rel -1 

Pass As Left No Change 

Fail Don’t Care No Change 
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Interval Types 
As assets are entered an interval type is assigned for each one. The interval type is 
recorded on the inventory form and is copied forward to the calibration form when 
calibration data is saved for that asset. The interval type can be changed at any 
time without affecting calibration history. The interval type must be one of the 
following: 

Table 8-5. Interval Types 

Type Units Interval 

d Days 24 hours 

w Weeks 7 days 

m Months Calendar months 

u Uses Number of uses 

n None Never needs calibration 
 

The interval type allows the system to calculate a due date. This method is 
preferred over manually entering a due date.  

How Time Intervals are Calculated 
For TIME interval types (Days, Weeks, Months), the system computes the due 
date using the cal date and the cal interval, calculating in the Non-working Days 
and Non-working dates configured by the System Administrator. If zero is 
entered, no due date is calculated. 

How Use Intervals are Calculated 
For USE interval types, the system computes the due date when the number of 
uses (Field 4230) exceeds or equals the interval. The date this occurs becomes the 
due date. 

How No Cal Instruments are Handled 
For NEVER interval types, the interval is always zero. Use N for assets that never 
need calibration. A due date may still be entered manually, but, if the interval type 
is N, the software ignores the due date in the traceability reports. For purposes of 
forward traceability, an N interval type represents the termination of the 
traceability tree. 
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Understanding Abeyance 
Abeyance is the condition of being temporarily set aside or in suspension. 
MET/CAL provides a way to put a mechanical asset into abeyance when the asset 
is calibrated, but not used right away. Instead, it is placed in a special location 
where it stays until it is used. While it is in this location, it is in a state of 
suspension or abeyance. When it is removed from the abeyance location, the due-
date is then calculated. 

Fields Used in the Abeyance Process 
There are six fields for abeyance, four for data retention. These fields are: 
4258 : Abeyance state. 
4259: Abeyance interval. 
Located in the Inventory Table 
and 
2380: Abeyance date. 
2381: Abeyance time. 
2382: Abeyance state. 
2383: Abeyance interval. 
Located in the Calibration Table 
Field 4258, Abeyance state, can be either Y or N. This flag determines how the 
due-date is calculated during calibration. If the flag is set to Y, then the asset will 
be placed in abeyance after it is calibrated.  
Field 4259 is the abeyance interval. This is an interval to be used to set a due-date 
in case the asset never comes out of abeyance. Fields 2382 and 2383 are copies of 
4258 and 4259 and are stored for historical purposes when the calibration record 
is saved. Fields 2382 and 2383 record the date the item was taken out of 
Abeyance.  

An Example of the Abeyance Feature 
Assume there is a device X. Its calibration interval is three months, and the 
abeyance interval (4259) is set to 24 months. Also assume field 4259 is set to Y.  
Asset X is calibrated on 1999-06-01. Field 2382 will be set to Y, and field 2383 
will be set to 24. The due-date will be computed as 2001-06-01 (24 months out). 
Now, on 1999-08-01 the item is taken out of abeyance.  



 Configuring the System 
 Special Rules for Customization 8 

  8-33 

To take the item out of abeyance, field 4258 on the inventory form is set to N. 
When the inventory record is saved, the due-date for asset X will be recomputed 
to 1999-11-01. Field 2380 will be set to 1999-08-01 and field 2381 will be set to 
the current time. 

Using the Database Menu  

Global Changes 
At times it is necessary to update more than one database record at a time. In the 
Manufacturer field for example, users are all entering the same Manufacturer 
name in different ways. Some are entering it ABC Incorporated, some A.B.C. Inc., 
some ABCInc. Maybe several assets have recently change ownership from one 
department to another. These examples represent a large number of records that 
should be corrected. The easiest way these changes are made is using the Global 
Change menu item. Global changes are made when more than one record has to 
be updated with the same information. Hand typing the new information would be 
time consuming, depending on the number of records to be changed. The figure 
shown below is the Global Change screen. In this example the user is updating 
Manufacturer field on the Inventory Table. The incorrect company name Brown & 
Sha is being replaced with the correct name, Browne and Sharpe. 

 
zv846s.bmp 

Making Global Changes 
1. Select the Table that the field to change resides on. 
2. Select the specific field to change. 
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3. Find the Existing Value to change by clicking on the scroll arrow and 
selecting the correct data. 

4. Enter the desired New Value for the field or fields. 
5. Click the Make Changes button. 
6. A confirmation box appears showing the number of records to be changed if 

the process is completed. 
7. If the change looks valid, and the number of records looks correct, click the 

Commit button to commit changes to the database. 
8. If the changes do not look valid or the number records seems wrong, click the 

Rollback button to undo the changes. 
9. Use the Reset button to start another change process. 

 
zv847s.bmp 

This is a powerful tool to maintain database consistency. It can also cause 
database problems if used incorrectly. The rules established by the Field 
Properties setup must be adhered to when making changes to data in the fields. 

Data Importation 
The Data Importation menu item allows importation from another database. Any 
data file that can be formatted into a delimited source file can be imported into the 
MET/TRACK database. A source file is simply a file with data separated into 
individual fields through the use of commas, semicolons, tabs or other allowed 
delimiters. When selected, the Data Importation menu item will open up a 
program wizard that steps the user through the mapping process.  
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The mapping process allows the user to determine which source data goes into 
which corresponding MET/TRACK data field. The wizard displays the Source 
File Data in Columns and Rows. A listing of all the MET/TRACK Database 
Tables, with their corresponding fields are also displayed. Select the Source Data 
column number with the mouse and, once the column is highlighted, find the 
appropriate MET/TRACK Data Field. Press the Enter key once the correct 
MET/TRACK data field has been selected. The column heading will now show 
the selected field. To make changes in selections clear the headings by selecting 
the Reset button or highlight the desired column and click anywhere in the 
column with the right mouse button and select YES to clear. Not all columns of 
the source file need to be imported. Select only those with crucial information. 
Additional information can always be added at a later time. Clutter-free databases 
are easier to manage.  
All records or just a specified number of records from the Source File can be 
imported. Choose �All� or enter the number of lines to import. Experiment with a 
small number of assets first and test the import. Importing in sections will make 
import failures easier to find and correct and the program will run faster. The 
Begin at Line box sets the point in the source file where importing begins. This is 
useful for delimited files which contain unwanted data in the beginning lines. 
Selecting the start line will ensure that this unwanted data is not imported into 
MET/TRACK. The Begin at Row box is only available with ASCII delimited 
Source Files. 
Once all Source Data Columns have appropriate MET/TRACK data headings 
select the Import button. The import program will total changes to records and 
rejected changes. It will also allow the user to generate an error log.  
Existing databases can be successfully and quickly imported into MET/TRACK if 
the data is clean. Unfortunately, most data needs to be reviewed to see what is 
missing, and what needs changing. The best way to review the data is to use a 
spreadsheet program, like Excel, to view, correct and format data into a file that is 
easier to import. Data importation can be tedious. It may take 3 or 4 attempts to 
get the data successfully installed. After each try, the errors and problems are 
corrected, and another attempt is made. Each time, fewer errors will occur until 
finally all or most of the data is successfully imported.  
For additional information on importing please see the help files under �Results�. 
Or for Portocal users please refer to the application note, �Importing Portocal Data 
into the MET/TRACK Database�. 
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User Tables and Merge Tables 
Additional information that will not fit or is not related to one of the existing 
tables can be added in the form of a User Table or a Merge Table Selecting the 
menu item Create User Table will allow a new table to be created. Select the 
Simple radio button to create a stand-alone User Table or the Field linked 
(merge) radio button to create a Merge Table, linked to an existing database 
field. Select the field on which to create the Merge Table with the down-arrow 
key. 
The User Table feature, new with version 7, will allow the Administrator to 
create a table, including defining field names, field types, lengths and other 
properties, such as default values and required or not required designations. There 
are excellent samples of user defined tables already in the software. 

Adding or Editing a User Table 
1. To access these samples, sign in to MET/TRACK using the MT Administrator 

login and password. 
2. Click on Database and Create User Defined Table. 

 
zv848s.bmp 

3. Look at the tables listed under Samples. Select any of the tables by pointing 
the cursor and clicking once with the left mouse button. 
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4. To add a new table make sure that the Simple table type is selected.  
5. Type in a Table Name to call this new Table. 
6. Type a Name in the Field Name box to start the table. 
7. Select the Data Type from the pull-down list and set the width. 
8. Set the Default Value and determine whether any entry must be unique or 

required or both. 
9. Click the Add button. 
10. Add additional fields the same way. 
11. When All the fields have been added, Click the Add Table button. 
12. Click the Close button when the table has been successfully added to the 

database,.  
These tables can be created in any way the administrator chooses. Note that once 

User Tables are created and defined, they can only be edited from an Entry 
Screen. The Merge Tables can be edited by the System Administrator from the 
Database Menu, as discussed below.  

Dropping User Tables 
The Drop User Table menu item allows the Administrator to quickly delete a 
user table that is no longer necessary. A list of all User Tables displays from 
which the Administrator can select the desired table to delete. 

Adding or Editing Merge Tables 
1. Click on Database and Create User Defined Table. 



Metrology Software 
Users Manual 

8-38 

2. To add a new table, select the Field Linked (merge) radio button. 

 
zv849s.bmp 

3. Select a database field with which to Link the Merge Table. 
4. Type a Name in the Field Name box to start the table. 
5. Select the Data Type from the pull-down list and set the width. 
6. Set the Default Value and determine whether any entry must be unique or 

required or both. 
7. Click on the Add button. 
8. Add additional fields the same way. 
9. When all the fields have been added, Click the Add Table button. 
10. Click the Close button when the table has been successfully added to the 

database. 
If a Merge Table has been created it can be edited from the Edit Merge Table 
menu item. Again, a list of all possible merge tables is displayed. The merge table 
to be edited is selected. From the Merge Table Edit Screen the choices are to Add, 
Delete or Update lines (or records) in the Merge Table. A choice of views is also 
available. 
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View Options for Merge Tables 
•  Normal, or Fields in Columns and Records in Rows. 
•  Pivot, Fields in Rows and Records in Columns. 
•  Group, which will allow the user to group by any of the Field Titles. 
•  Filter, which allows viewing of records that meet filter criteria. 

 
zv850s.bmp 

Dropping Merge Tables 
Merge Tables can be deleted easily as well. The Drop Merge Tables menu item 
will bring up a list of current merge tables when selected. The table to be deleted 
is selected and a dialog box will double-verify that the user really wants to delete 
the Merge Table.  

Using User-Table and Merge Table Data in a Report 
When a User Table or Merge Table is created, the database is expanded. A table 
and a number of fields is added. The table created can be used in reports, just like 
any other table. Besides the rules given at the beginning of this discussion, there 
are a few points to note about the merge tables added: 
•  When a User Table or Merge table is created, a new table is created in the 

database. The name of this table is always mt.mrg<field number>, where 
<field number> is the root field number, in the case of a Merge Table or 
mt.user<name> where <name> is the name or number designator of the table. 
The first field in the merge table is always named �merge.� This field cannot 
be blank, must be unique, and must be the same size as the root field. 

•  When used in a report, the merge table must be specifically linked to the root 
field. This is done using Crystal Report�s Visual Linking Expert.  
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System Customization Using the Set Up Menu 

Adding Users and User Passwords 
The Set Up Menu is used primarily for user, system and report configuration. The 
System Administrator can customize what the individual user will see by logging 
in to the MET/TRACK application. The Users/Passwords selection is where 
users are added or edited , user security levels are configured and passwords are 
maintained. The figure below represents the User tab. 

 
zv851s.bmp 

Selecting the add or modify a user buttons will bring up a User Configuration 
form. This is where users are managed. The radio buttons are used to select the 
user level. The user level will determine what tasks the user can and cannot do, 
what database fields they are allowed to access, what segregate of the database 
they belong to and what hourly labor rate will be calculated for any work that they 
do. 
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Table 8-6. User Access Levels 

Access 
Level Typical User Permissions 

MT 
No permissions for adding or changing data; but MT is the only user 
authorized to configure the database and system. The MT user can delete or 
modify the entire database and all its users. The MT user is the System 
Administrator 

5, 4 

These two levels perform supervisory and error correction functions, and write 
Calibration procedures. They have read and write permission for the entire 
database, including historical records. These two levels have similar security 
clearance, but can be differentiated from each other through Task 
Permissions. These user levels are usually assigned to Sr. 
Technician/Metrologists and Managers. 

3, 2, 1 

Basic data entry/technician. Persons holding these access levels can add new 
Inventory and Calibration records, and in MET/TRACK applications, can add 
Maintenance, and Location records. Level 1, 2, and 3 users cannot alter 
historical data. These levels are appropriate for most users and are usually 
assigned to technicians and data entry personnel. The actions these three 
levels can perform are established through Task Permissions. 

0 
Read only. Users with level 0 access can look at data but have no write 
permission. 

Setting User Permissions for Specific Tasks 
The Task Permission section is where some specific task permissions are 
determined. The choices available are divided into two groups, Procedures and 
Other: 
Edit Procedures allows a user to change Runtime procedures from the Editor 
program. 
Run Procedures grants a technician permission to run an automated calibration 
procedure. 
Delete Procedures gives the user the ability to delete procedures from the 
directory entirely. This permission is best suited for a Cal Lab Manager or 
Metrologist. 
Configure Run Time Instruments allows the user to add and edit standards used 
in Run Time procedures. This includes changing asset numbers, IEEE and port 
addressing and installed option or auxiliary device configuration. A Sr. Technician 
that has some computer system knowledge is a good candidate for this task. 
Edit Other Run Time Configuration allows the user to configure other 
properties of Run Time from the Run Time or Editor programs. This task is best 
assigned to a Manager. 
The Other Task Permissions determined here are general permissions that do not 
fall under a specific program. 
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Edit Validation Files gives the user the ability to add and change entries in a field 
configured with a required validation list. 
Edit Merge Files lets the user add and edit Merge data associated with a 
configured Merge field. 
Run Reports allows the user to Run, Preview and Print Run Time and General 
reports from the Run Time and Manual Entry applications. 
Run Quick Reports allows users to configure and run reports from the Quick 
Reports application. 
Change Password allows a user to change his or her own password. The 
password change frequency and length are set in the Password configuration 
screen and those rules are followed whether a user is allowed to change the 
password or if a system administrator is required to change all passwords. 
Select the user with a single click of the mouse. Check or uncheck the Task 
Permissions to grant permissions for specific tasks. Users can be modified in the 
same way they were added. Task permissions can be granted or taken away.  
The User configuration screen is shown below. 

 
zv852s.bmp 

User Password Configuration 
Configuration of User Passwords is a key System Administrator�s task. The user 
name and password is assigned to a user, who is assigned a user lever, which 
affects how that user accesses the MET/TRACK program. Many companies have 
internal quality requirements that mandate a certain password expiration period. 
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That period may be 30 days, 1 year, 7 days, or the password may never expire. 
This expiration period and other password attributes are configured in the 
Password tab of the Users/Passwords set-up screen. This screen allows the 
System Administrator to set the Maximum age, or maximum length of time in 
days a password can be used, the Minimum age, or minimum length of time in 
days a password is in effect before it is changed, the minimum character length 
and whether the change will be forced or optional. Passwords should be short 
enough to be remembered easily, but long enough to be secure and not easily 
decoded. Once user passwords are assigned they cannot be recovered. The only 
way to recover a lost password is to create a new user and password. Users and 
Administrators should write down passwords in a secure place. 

Note  
This is also the screen where the MT password can be changed. 
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Deleting a User 
Selecting the Delete button will allow the System Administrator to delete a user, 
However, a user that has created records will have associated history and 
should not be deleted. Setting a user to look only and changing the user password 
will guarantee no access to the program, but will keep all historic database records 
intact.  
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Creating and Assigning Segregates 
The Segregate button allows the creation of new database segregates. Once 
created, users and assets can be added to these segregates. Segregates are 
segments of the database. A company may have a mechanical and an electrical lab 
that have separate employees, assets and workload. Segmenting the database will 
allow the company to track these two labs individually, while maintaining the 
same database and database administrator. The segregate feature allows the 
division of the database into separate, mini-databases for some users while 
keeping all of the data together.  
Data may also be segregated based on customers. Each customer is assigned a 
segregate value. This allows customers to log into the system and view the status 
of their assets, but prevents them from seeing what other customers have. It allows 
the service lab to keep track of which assets belong to which customers. 
The add user screen, add asset screen, and add customer screen all have a 
segregate field that can be assigned to one of the values created in the Segregate 
configuration. Note that it is possible for a user to add an item to a segregate other 
than their own, but they will never be able to view the item again. The record 
being added will default to the user�s segregate, but can be changed by the user. 
However if the user tries to search for the asset later a Notice box will open that 
displays the following error message: �The asset is in a segregate you do not have 
permission to view�. Reports can also be assigned to a segregate. This means that 
if a report is assigned to a specific segregate, only a user in that segregate can 
execute that report.  

Segregates and Their Effect on Reports 
Most reports will be assigned to the <any> segregate, which allows any user to 
run the report. A report that is written using table linking must be created for a 
specific segregate. So, in addition to assigning it to a segregate in the add reports 
dialog, The report must be written for that segregate in Crystal Reports. 
Reports written to run off stored procedure output can be assigned to the <any> 
segregate, or to a specific segregate. Because the report works off a stored 
procedure, any user can execute it. 

Special Segregates 
There are two special segregates, MT and STD. The MT segregate contains all of 
the data in the database. Any user who is assigned to the MT segregate can access 
all of the data. Typically, users in the cal lab are assigned to the MT segregate. 
The STD is a special segregate intended to be used for standards. Since one 
segregate does not have access to data in another segregate all of the standards in 
a segregate would have to be duplicated in every other segregate. This can be 
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overcome by putting standards in the STD segregate. Assets in the STD segregate 
can be accessed by other segregates as standards in calibration events. 

Changing the MT Password 
Every copy of MET/BASE is shipped with the same Administrator password. 
When the software arrives at your site, the administrator�s User Name and 
Password are both MT. The administrator�s User Name is set, but for security 
reasons, the password should be changed once the System Administrator is 
satisfied that the software is installed and communicating properly. 
Change the MT password as soon as possible after verifying a reliable log on. The 
MT user has full authority within the database, and the MT password should be 
treated with care. 
To change the password of the MT user, proceed as follows: 
1. Make certain that the database engine is running. 
2. On a client workstation, start the Data Requester.  
3. Log in to the MET/TRACK application with the user ID MT and the 

password MT. 
4. When the application starts, open the Set-Up menu and choose 

Users/Passwords.  
5. Select the Passwords tab then select the Change MT Password button. 
6. Type in the new password carefully, avoiding typographical errors and then 

type it in again, for confirmation. Select Assign to save the changes. 
7. Record the password in a secure place.  

WCaution 
Do not forget the password for the MT user. Without this 
password, it is impossible to access the configuration 
application required for managing the database. 

Fluke cannot recover any data lost due to a forgotten 
password.  
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Configuring User Desktops 
New with version 7 MET/TRACK is the ability to customize User Desktops. 
After setting up a new user, the System Administrator can customize how the 
entry screens will look according to the tasks the user performs. Title and Data 
Field font types are configurable by selecting the Font and Color buttons. The 
Required field and Default field colors can be changed by selecting their 
associated buttons. The Asset Number field will display the selections made so 
some experimentation can be done. Customize the appearance of like desktops for 
users with like tasks or let the individual users choose fonts and color schemes. 
In addition to appearance customization the System Administrator can add 
database customization unique to each desktop. Fields can be added or suppressed 
for different desktops, security levels for adding and updating can also vary from 
desktop to desktop. The system administrator can create a custom user interface 
for each different department, segregate, user type or individual.  
1. To Customize a Desktop go to the File menu. Go to Select Desktop and 

choose the correct desktop from the list. 
2. Proceed with any database customization as described earlier in the chapter. 
3. Note that Validation is universal and cannot carry from desktop to desktop. 

This includes Simple and Linked Validation, Picklists, Merge Tables and 
User-Defined Tables.  

WCaution 
Make certain the desired desktop is selected under the 
File menu , Select desktop item prior to making any 
customizations. Form and Field Customization done while 
one desktop is selected will not be reflected on an 
unselected desktop. 

General Configuration 
As a rule, the system configuration options only need to be set up one time 
because the settings are not likely to change from day to day and are more 
permanent in nature. 
From the server or a stand-alone installation start the data engine, or from a client 
machine, start the data requestor. Log in to the MET/TRACK application using 
the MT user and the applicable Administrator password (MT or the new MT 
password assigned by the administrator).  
1. Log in as MT, and provide the MT or System Administrator password. Only 

the MT user is permitted to Set Up System Configuration. 
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2. Select the Set-Up heading and choose Configuration from the menu. A 
configuration screen with 4 tabs, System, Company, Holidays and 
Uncertainty appears as shown below.  

 
zv854s.bmp 

Configuring the System 
The options configured in the System Configuration screen are explained in the 
following paragraphs. 
Blank Status when Cal saved 
Blank Status when Maintenance saved 
Blank Arrival Date when Cal saved 
Blank Arrival Date when Cal saved 
Field 4225 (Status) of the Inventory table is intended to store the temporary status 
of an asset. In larger installations, this field can be used to indicate that the asset 
has arrived for calibration, is on a bench, is undergoing testing, or other process 
milestones. 
Field 4224 (Arrive Date) is intended to store the date the asset arrived. 
If assets move through the process rather quickly, These fields can be disregarded. 
To do so, configure the field to be blanked. The status or date is blanked each time 
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a new calibration or Maintenance event is recorded in the database. By checking 
these boxes a null value is stored in the field, signifying that temporary status or 
arrival date information is not stored. If instruments that do not pass the initial 
calibration need to be flagged in some way, selecting to blank only when 
Calibration passes will maintain the Arrival date. 
If Status is not blanked, eight characters are available to record the temporary 
status of the assets; by not blanking I4224, the date field can be used to store the 
date of arrival of the asset. Any query or report that checks the value of these 
fields can show the whereabouts of the asset at a glance. 
Level 3 and below can extend Due-Date 
Users having access level 3 and below are not usually permitted to extend the Due 
Date past the date calculated by the software. Levels 4 and 5 can always extend 
the Due Date. Checking this box permits levels 3 and below to enter dates after 
the calculated due date. The Administrator should make this determination based 
on the established practices at the user site. 

Note 
Customization can restrict which lower level users can access this 
field. 

Maximum days old a calibration date can be 
Every time a calibration date is entered, the system checks to be sure it is not too 
old. Each calibration date is checked against the system date. Operators with 
access levels 1, 2, and 3 can only enter cal dates of today�s date minus the number 
of days you set here. For example, the default is seven days; if today is the 18th, 
these operators can not enter a date earlier than the 11th. To relax this check, enter 
a larger number. A setting of 30 days may be more realistic in some situations. 
This would let all operators input any calibration date up to one month old. 
Traceability Code Difference Without Warning 
The traceability code difference is not enforced because a standard for one 
procedure may not be considered a standard for other procedures. The difference 
is simply a check to warn of possible traceability violations. 
The difference can range between 15 and -15. Normally, a difference of 1 would 
be an appropriate and useful setting. This would mean that a warning would occur 
if a standard�s code was not at least one code higher than the asset being 
calibrated. If standards are fairly well defined and a strong check is required, a 
larger difference, like 2 or 3 can be selected. 
A very weak check can be achieved by setting the difference to 0 or -1. Zero 
means that a standard with the same code as the calibrated asset could be used, 
and negative one (-1) indicates that an asset could be used to calibrate a standard 
one level higher than itself. 
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To completely disable the warning, enter -15 (negative 15). This setting allows 
any asset to be entered as a standard without a warning. 
Ordered list of traceability codes 
Traceability codes are an ordered sequence of single characters that define the 
traceability hierarchy for asset inventory. They represent classes of standards, and 
are therefore loosely related to accuracy. 
The codes come into play when standards are selected for a calibration event. If 
the difference between the positions of the codes in the ordered sequence is less 
than a pre-set value, the software displays a warning.  
In this selection, the traceability codes are defined that will be used by the system 
to check hierarchy. 15 codes can be specified. The order descends from left to 
right. For example, the letters RCTWPN could be the ordered list with the letters 
carrying the following meaning: 

R Reference standard 
C Consensus standard 
T Transfer standard 
W Working standard 
P Production standard 
N No calibration required 
Or the default sequence 12345 can be used, or some other alpha or numeric 
scheme invented that can be easily remembered. 
Ordered list of maintenance codes 

As with Traceability Codes, Maintenance Type Codes are open to user definition. 
32 different maintenance codes can be established. 

The database can cover ALL assets, even those that are not directly involved in 
calibration, like bar code readers or CD recorders or players. Maintenance type 
codes are selected at the Maintenance Type field (3251) on the Maintenance form. 
The numbers 1 through 32, may be used with a particular meaning assigned to each 
code for all laser printers and an entirely different meaning for bar code readers. 
Since asset Maintenance history records also include an interval specification field, 
each of 32 different types of events can be scheduled for each asset. There is one 
active due date for each Maintenance code. 
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New Assets require a Location Record and/or a Calibration Record 
This option will prompt the system to display an error message if an attempt is 
made to save a new inventory record without a new Location and/or Calibration 
Record. This will ensure that a new asset can be located and is currently 
calibrated. For smaller installations tracking instruments by Location Record may 
not be necessary. For third-party calibration labs that only receive new assets 
when they are due for calibration, the Calibration Record requirement may not be 
necessary either. Checking the selection boxes makes the record creations required 
for new asset entry, leaving them blank makes the record creations optional for 
new asset entry. 

Configure the Company 
When MET/BASE is installed, the installation program prompts for company 
name. This entry is specific to each work station and is used for the header of any 
calibration created by the user at that workstation. 
Company name for report purposes is configured under the Company tab of the 
Configuration item under the Set-Up Menu. Company name and up to 5 
additional lines of string data can be added to be displayed on calibration reports. 
This will allow the System Administrator to configure Company Name, Company 
Division, Lab Manager�s Name, Address, Phone, e-mail address, etc. 

Configure Holidays and Non-working Days 
When configured, Non-working Days or Holidays will never be calculated by the 
system as a due date for any type of scheduled event. Determine which weekdays 
are Non-working Days, such as Saturdays and Sundays. Select the days chosen by 
checking the adjacent box. Select additional dates, that occur on regular working 
days, by browsing through the calendar with the arrow keys and selecting the 
appropriate dates by double clicking the date with the mouse. Like Non-working 
Days, Non-working Dates selected will not be calculated as a due-date by the 
system.  

Note 
Because calibration and maintenance events have specific intervals 
the system will never allow a due date to occur after the specified 
interval. The due date will fall before the required date calculated 
by the interval and interval type if the calculated due date falls on a 
non-working day or date.  
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Configure Uncertainty 
MET/CAL allows the System Administrator to specify the uncertainty 
configuration for the entire site. Select the Uncertainty tab of the configuration 
menu item under the Set-Up menu. The Uncertainty Configuration screen is 
shown below. 

 
zv856s.bmp 

Parameters configured here can be overridden at the workstation by setting them 
up in the metcal.ini file, or in the procedure by using the VSET FSC. See the 
MET/CAL Help files and the MET/CAL Reference Manual PDF file for more 
information. 
Coverage Factor 
The coverage factor is the value multiplied by the standard uncertainty to get the 
expanded uncertainty. 
Number of Measurements 
The number of measurements that are taken in a calibration procedure can be set 
by configuring it here. Enter any number, other than zero, to enable measurement 
uncertainty.  
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Note that the number of measurements can be set to one. However, with one 
measurement, the standard deviation of the readings cannot be computed. This can 
only be used if the metrologist has some prior information about the test being 
performed. This is rarely, if ever, used. 

Note 
If number of measurements is entered as zero, measurement 
uncertainty is disabled and the run time works as it did in prior 
versions. See the MET/CAL Help files for more information. 

Use Student�s T 
This can be set to either Y to enable it or N to disable it. If set to Y, then the 
standard deviation of the measurements are multiplied by a factor relating to the 
degrees of freedom in the test. See the MET/CAL Help files for more information. 

Adding and Removing Licenses 
Licenses are added to or removed from the database in the MET/TRACK 
program, regardless of the type of license being applied. This is done initially, 
when a system is being installed and then if additional licenses are added later. 
This selection in the Set-Up menu also shows the System Administrator how 
many licenses are applied to the database (or how many and what types of licenses 
the company owns) and which users are connected to which applications. It also 
gives the System Administrator control over user connections in case of a sudden 
need to log all the users off of the system. Selecting the Licenses tab will allow 
the addition or removal of a license by following the system prompts. See the 
installation and upgrade guide for more details on license installation. The 
Connections tab will show the Logged-in User ID, the Applications being used, 
the Workstation Number, the Connection Number and the Connection time. The 
Drop Connections button is used to quickly log all users off of the system in case 
of a system emergency. 

Choosing Titles/Languages 
This selection will show field titles in the language specified here. The choices are 
English, German, Spanish, French and Italian.  
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Installing Reports 
This menu selection will allow the System Administrator to manage reports. 
Reports can be installed to run in the MET/TRACK and Run Time applications. 
From the Report Installation menu item the Administrator can also, Preview, to 
get an idea of what the report looks like, Print a hard copy and view Report 
Properties. The report properties available for viewing are General things like the 
file type, size and location, Security permissions for the file, Summary Data like 
the Title, Subject, Author and Synopsis and Statistical information like create, 
access and modify dates. This gives the System Administrator the vital statistics 
about the report. 

Configuring Reports 

 
zv855s.bmp 
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For a summary list of available reports select Configure Reports. At a glance the 
System Administrator can view information about each report in the list, such as 
the Description, Filename, special Comments, Author, what Tables the report 
uses, whether the report is a General report or a Run Time report and if there are 
any user prompts. Reports can also be added from the Report Configuration 
screen. See Chapter 5 for additional information on MET/CAL reports. 

Using the Help Menu 

Searching the Contents of the Help Files 
Help files are accessible for MET/TRACK using either the Contents or the 
Search for Help On menu items. This file operates in the same manner the 
Windows help files operate and contain much valuable information. 

Getting Technical Support 
To contact the Met/Support group select the MET/TRACK Support menu item. 
This screen contains live links to Hardware, Software, Training and Literature for 
all Fluke Precision Measurement and Hart Scientific products. 

About MET/TRACK 
When calling or e-mailing Met/Support look for software version under the About 
MET/TRACK menu item. Have the version and the operating system information 
available when contacting the Met/Support Help Desk. 
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Appendix A 
How to Access MET/SUPPORT™

Introduction 
Fluke Metrology Software is supported by a highly skilled and conscientious team 
of professionals who are available to answer questions, help solve unique 
problems, and assist in troubleshooting in the event you run into difficulties. 

Telephone Support 
Some free telephone support is available, but only to registered users of Fluke 
software. Be sure to register your software as soon as possible so you can make 
use of this service should the need arise. 
Within the United States, toll free telephone support is available from 8:00 AM to 
4:30 PM, Pacific Standard Time at 1-800-825-7411. 
Priority support is available to any current Met/Support Gold customer.  A 
special-access line is included in the Gold program information pamphlet. 

To call Fluke from anywhere in the world, call 1-425-446-5400. 

Mail, E-mail, and FAX 
You may also contact us by mail, E-mail, and FAX. 

 FLUKE Corporation E-mail metsupport@fluke.com 
 PO Box 9090 FAX 1-425-446-5992 
 Everett, WA 98206-9090 
 Attention: MET/SUPPORT, M/S 275G 
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Before Calling Technical Support 
You may be able to discover the answer for yourself, so take the following steps 
before calling for support: 
•  Check the manual 
•  Check the online help 

Please Have the Following Information Available 
If you do find it necessary to call for assistance, take a few moments to jot down 
some information. If this information is readily available, the support person can 
more quickly get to the exact details of the difficulty you are having, and will be 
able to resolve the issue more efficiently. 
•  Product name, applicable licenses, version and serial numbers 
•  Manual title, part number and version 
•  Operating system and version 
•  Network information if applicable 
•  List of steps necessary to recreate the problem 
•  Version of Crystal Reports 

Worldwide Support 
For more information on worldwide MET/SUPPORT , please contact the Fluke office 
nearest you or your local representative. 

LOCATION TELEPHONE  FAX  

Canada 1-905-890-7600 1-905-890-6866 

China 86-10-6-512-3435 86-10-6-516-3437 

UK/Europe 44 1603-256600 44-1603-256688 

Japan 81-3-3434-0181 81-3-3434-0170 

Singapore 65-276-5161 65-276-5759 

United States 1-800-825-7411 1-425-446-5992 

All other locations  1-425-446-6476 1-425-446-5992 
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Web Support 
Fluke provides a web site exclusively for the Metrology Software user. This site 
provides the most current phone numbers, downloadable procedures, reports, 
application notes, and other pertinent information. To access this support site: 
1. Enter http://support.fluke.com/register in your browser's URL address input 

box. 
2. Enter met-support in the "Name of the Site where you want to go:" box. 
3. Click Register. 
4. Complete the registration questionnaire. 
Approval of your registration should be complete within one or two days. You 
will receive an email notice of your Web/Support user name, password and the 
Web/Support site address. 
 

http://support.fluke.com/register
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Appendix B 
Computing Test Uncertainty Ratio

Computing Test Uncertainty Ratio 

The Test Uncertainty Ratio (TUR) is computed only after compilation or 
execution of a result-generating instrument FSC and the MEMC FSC. This 
computation is done both during the final pass of compilation and while executing 
the procedure. At compilation, the Test Tolerance is determined as the distance to 
the closest tolerance limit (unless one of the limits is zero.) For example, a +3U in 
the TOLERANCE field (implying -0U tolerance) will cause the Test Tolerance to 
be 3U. At execution, the TUR is calculated as the distance from the specified 
Nominal to the tolerance limit which falls on the same side of the Nominal as the 
System Actual. 

Note 
MET/CAL gives a warning when the TUR drops below tur_lim. The 
compilation still succeeds. For example, a test can specify that a 1% 
meter should be perfect. The test tolerance is therefore zero. Even a 
10 ppm calibrator is not good enough to avoid the creation of a 
warning, since the TUR is also zero. 
All accuracies of calibration instruments are symmetrical around 
the programmed nominal value. However, the tolerance of the test 
can specify different tolerances in the positive and negative 
directions. In that case, for the purposes of computing the TUR, the 
tightest tolerance is used. This means specifying the tolerance as 
+0.1% implies the negative tolerance is 0. This always results in a 
TUR warning of 0 that normally can be ignored. 
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Example TUR Calculation  

 UUT Indicated = 100V 
 Tolerance     = -2U +1U 
 System Actual = 99V 

The test tolerance on the lower side of the UUT Indicated is used because the 
System Actual is less than the Nominal. The test tolerance on the lower side of 
100V is 2V, so the ERROR%TOL is 50%. 

Instrument Evaluation Test with Known Nominal Value 

The calibration system uncertainty is obtained from the information in the 
calibration instrument related Accuracy File. 
The allowed tolerance for the test is derived from the procedure line. In the most 
common situation, the evaluation step appears in a fully defined test; for example: 

 STEP  FSC   RANGE NOMINAL   TOLERANCE   MOD1   MOD2  3  4 CON 
2.001     5700       10          10V                  0.1%                    0.1%                                  2W 

The allowed tolerance is 0.1% of nominal (10V) and 0.1% of range (10), so the 
total tolerance is 0.02V. The TUR is: 

 test tolerance / calibration system uncertainty 
 

If the TUR drops below tur_lim, the calibration system reports the following as a 
warning during compilation: 
•  The absolute value of the test tolerance. 
•  The absolute value of the calibration system uncertainty. 
•  The Test Uncertainty Ratio. 
If the TUR drops below tur_lim, the calibration system adds to the test result the 
value of the TUR. 

Note 
All TURs are computed in linear scale units. Any nominal values or 
Accuracy File information expressed in dBm are first converted to 
volts. A warning includes the linear values. 
The Test Uncertainty Ratio of a Comparison Test is computed using 
the stated Nominal value. It is possible for erroneous warnings to 
result from this assumption if the value stored in MEM and the 
NOMINAL field differ substantially. 
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Instrument Evaluation Test with Unknown Nominal Value 

If the nominal value is not defined in the procedure, it is difficult or impossible to 
determine the TUR when the procedure is compiled. However, during calibration 
procedure execution, the TUR can be defined since the nominal value is known. 
Therefore, the reporting of the TUR being too low is the same as previously 
described. 
During procedure compilation, the system attempts to estimate a worst case TUR 
for the test. The worst case occurs with the worst tolerance of the calibration 
system instrument and the minimum tolerance of the test. It is not possible to 
verify that the conditions assumed are indeed worst case, although they typically 
are. Some estimate can be made if at least the range is specified. Without that 
information, no TUR estimate is possible. 
The allowed tolerance for the test cannot be totally derived from the procedure 
line. For example: 

 STEP    FSC   RANGE NOMINAL    TOLERANCE     MOD1    MOD2  3  4 CON 

 2.001   5700   10    V         0.1% 0.1/                        2W 

The allowed tolerance is 0.1% of nominal (the nominal value to be taken from 
memory register MEM) plus 0.1% of range (10), which amounts to 0.01V. In this 
case, the TUR is computed as follows: 
  test tolerance with Nominal set to the Range value 

    The TUR =  ------------------------------------------------------------------ 
                  calibration system uncertainty with Nominal set to Range value 

 
If this TUR value drops below tur_lim, the calibration system reports the 
following as a warning: 
•  Estimated absolute value of the test tolerance at the Range value. 
•  Estimated absolute value of the calibration system accuracy at the Range 

value. 
•  Estimated Test Uncertainty Ratio. 
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MEMCX FSC with Known Nominal Value 

The MEMC FSC is used most often in closed loop calibration using a Setup FSC, 
followed by an IEEE FSC, a MEME, and a MEMC to determine the outcome of 
the test. For example: 

 STEP   FSC   RANGE NOMINAL  TOLERANCE   MOD1   MOD2  3  4 CON 
 2.001  IEEE        F1R3 
 2.002  5700        10.00V                              S  2W 
 2.003  IEEE        ?[I] 
  
  

2.004  MEMCX 10    V        0.1% 0.1/ 

 3.001  .... 

The calibration system uncertainty is therefore generally determined by the last 
instrument Setup FSC preceding the MEMCX FSC. In this example it is step 
2.001: the Setup test of the 5700 FSC. Whenever a Setup FSC is encountered, the 
MET/CAL compiler stores the calibration system uncertainty of this Setup test 
using the information of the Accuracy File of the related instrument, in this case 
the 5700A. This accuracy is used for computing the TUR when the MEMCX FSC 
line is being verified during compilation or executed during procedure execution. 
The allowed tolerance for the test is derived from the MEMCX procedure line. 
According to the example, the allowed tolerance of the test is 0.01% of the 
nominal value (MEM1) plus 0.001% of the range (10) so that the total tolerance is 
0.011. In this case  

 The TUR = test tolerance/stored calibration system uncertainty 

If the TUR drops below tur_lim during procedure compilation, the calibration 
system reports the following as a warning: 
•  The absolute value of the test tolerance. 
•  The absolute value of the calibration system accuracy. 
•  The Test Uncertainty Ratio. 
During test execution, if the TUR drops below tur_lim, the calibration system 
reports the value of the TUR. 

Note 
Erroneous warning messages can be generated when the last Setup 
test is not the one that represents the calibration system accuracy. 



 Appendices 
 Computing Test Uncertainty Ratio B 

  B-5 

MEMC FSC with Unknown Nominal Value 

A MEMC FSC with an unknown nominal value is similar to the case of an 
instrument FSC with an unknown value. When you execute the procedure, the 
nominal value is known, and the TUR is reported, if it is below the tur_lim value. 
During procedure compilation, a TUR may be estimated or an estimate may not be 
possible.  
If no range information is provided, an estimate of the TUR cannot be defined 
during compilation and no estimate is made. Some estimate could be made if at 
least range information were present. The MEMC line in the previous example 
now appears as follows: 
STEP   FSC  RANGE NOMINAL    TOLERANCE     MOD1     MOD2  3  4 CON 

2.004  MEMC 10    V          0.1% 0.1/     01/ 

The calibration system accuracy is determined again by the last Setup test in the 
procedure, as was described earlier where the Nominal value of the MEMC FSC 
was defined. It is assumed that the nominal value is set to the range value. 
The allowed tolerance for the test is 0.1% of nominal (the nominal value to be 
taken from memory register MEM) plus 0.1% of range (10), which amounts to 
0.01V. In this case: 

  test tolerance with Nominal set to the Range value 
     The TUR = ------------------------------------------------------------------- 
                 system uncertainty with Nominal set at the Range value 

If this TUR value drops below tur_lim, the calibration system reports the 
following as a warning: 
•  Estimated absolute value of the test tolerance at the range value. 
•  Estimated absolute value of the stored calibration system uncertainty at the 

Range value. 
•  Estimated Test Uncertainty Ratio. 

Note 
Erroneous warning messages can be generated when the last Setup 
test is not the one that represents the calibration system accuracy. 
Warnings are given only when the TUR drops below tur_lim. The 
compilation is still successful. For example, a test can specify that a 
1% meter should be right on. The test tolerance is therefore zero. 
Even a 10-ppm calibrator is not good enough to avoid the creation 
of a warning, since the TUR is also zero. 
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Note 
The variable tol_ref in the MET/CAL initialization file determines if 
the relative test tolerance computations are based on the 
UUT_Indicated value (as currently implemented) or the Nominal 
value (as requested by some MET/CAL users).Most specifications of 
DMMs are based on their reading, i.e., their UUT Indicated value. 
In many situations (closed-loop calibrations), this leads to the 
unexpected result that the tolerance band is not symmetrical around 
the fixed Nominal value. The tol_ref variable allows symmetrical 
tolerances around the Nominal value. The tol_ref variable can 
assume one of two values: tol_ref = UUT_INDICATED or tol_ref = 
NOMINAL, but only affects the portion of TOL that is % or PPM. 
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Appendix C 
Table Definitions for Reports

Introduction 
This appendix contains information about the database tables and fields for help in 
creating your own reports, or to add fields to the supplied reports. The illustration 
in Figure E-1 shows all the tables that you will be concerned with as you create 
reports.  
Run Field_Properties.rpt to get field information on tables. 

Inventory

Mtag

Ktag

Customers

Ktag

Calibration

Mtag

Ctag

Location

Mtag

Results

Ctag

Standards

Ctag

C2340

Mtag

Inventory

Mtag

Repair

Mtag
UserList

Mtuser

Auxiliary

User
Tables

AssetHistory

Mtag

CalResults

Ctag

(Legacy)

 
tablstru.eps 

Figure C-1. Tables Used in Writing Reports
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Contents of the Tables 

The following list describes table contents.  
•  The Inventory table contains information that describes every asset being 

tracked. 
•  The Calibration table contains summary information about each calibration 

event performed. 
•  The Results table contains full results data for each calibration event. 
•  The CalResults table contains individual test results for each calibration if 

available. 
•  The Standards table can contain mtag values in field C2340 for each of the 

standards used during a calibration event. 
•  The Location table contains information about where the asset can be found 

when it is in-use. 
•  The Repair table contains information about repairs made to the asset. 
•  The AssetHistory table tracks all changes made to asset number in the 

Inventory table. 
•  The UserList table contains information about every user ever allowed into 

the system. 
•  The Customers table contains information about every customer ever entered 

into the system. 
MET/CAL makes automatic entries in Inventory, Calibration, Results, 
CalResults and Standards. 

Rules for Linking Tables when Designing Reports 

•  Every asset record in the Inventory table has a unique mtag value. 
•  Link Inventory to Calibration history records using the mtag field. 
•  Link Inventory to Location history records using the mtag field. 
•  Link Inventory to Repair history records using the mtag field. 
•  Every cal event record in the Calibration table has a unique ctag value. 
•  Link Calibration to Results records using the ctag field. 
•  Link Calibration to CalResults records using the ctag field. 
•  Link Calibration to Standards records using the ctag field. 
•  Link Standards to another instance of Inventory using C2340 and mtag 



 Appendices 
 Table Definitions for Reports C 

  C-3 

•  Link Customers to Inventory using ktag. 
Various tables can be linked to UserList to find the real name of the person who 
made entries and changes to the database. For example, link Inventory.I4239 to 
UserList.mtuser to find out who created an inventory record. 
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Appendix D 
Glossary

-A- 
Accuracy File 

An Accuracy File contains information about the accuracy specification of an 
instrument associated with an FSC. Unless TUR checking is disabled, there must be 
one Accuracy File associated with each instrument FSC that is being used in a 
calibration procedure. 
 

As Found/As Left 
As Found/As Left represents a calibration philosophy about how calibration is 
performed. MET/BASE supports three basic philosophies. Which philosophy you 
choose determines how the Found/Left field (2308) is used.  

 
asset 

A single piece of equipment; each asset is numbered, and the number is used for 
identifying the asset throughout the database. 
 

-B- 
backend data  

Any data residing on a server. 
 
backup 

It is important to make regular backups of your database files in case of media failure. 
A backup is a copy of the database file (mtrack.db) and may also include a copy of the 
transaction log file (mtrack.log). You can make backups using the SQL Anywhere 
backup utility or other archiving software of your choice. 
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-C- 
client 

The term client is widely-used to mean several different things. Without modification, 
it may mean for example, "client application", or "client workstation".  
Just as with the term "server", the word requires modification, otherwise if may be 
ambiguous whether it refers to a program or to the computer on which the program is 
running. 

 
client application 

An application that executes on the workstation and interacts with the user. 
client computer, client workstation 

A computer that accesses shared network resources provided by another computer 
(called a server). Also referred to as a workstation or client machine. 

 
client/server 

A term generally applied to a software architecture in which processing functions are 
segmented into independent collections of services and requesters on a single machine 
or segmented among several machines. 
One or more processing servers provide a set of services to other clients on the same 
or across multiple platforms. A server completely encapsulates its processing and 
presents a well-defined interface for client applications. 
For example, MET/BASE is a client/server program. It always runs over some type of 
network. In a standalone installation, it makes use of a loopback network; the client 
and server are running on the same computer. 

 
client/server computing 

A mode of distributed network computing in which an  
application is executed cooperatively by two computers. The client application (the 
front end) executes on a workstation, while the data engine (the back end or data 
server) runs on a second computer. (Note that in a MET/BASE standalone installation, 
both would run on the same computer.) 
Client/server computing allows more effective use of computing resources, higher 
performance, greater flexibility, simpler upgrades, greater reliability and data 
integrity. 

 
confirm password 

Passwords never display, so when you get a new password, you must type it twice. 
This is a safety measure, and it helps you to remember the new password. 
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copy data   

A configurable attribute of a field that specifies whether the data in the field is to be 
copied forward to the next record. This field attribute can be used in many different 
ways to simplify data entry; for example, when first setting up a system, you might set 
field 4202 (manufacturer) to copy forward while you key in all the assets made by a 
particular manufacturer. 

 
Correction File 

A file that contains information on special calibration  
points of the instrument associated with the instrument FSC. An electronic instrument 
is far more stable during a limited period of time than its stated accuracy indicates. By 
providing specific calibration points and reducing the calibration interval, the 
uncertainty of the calibration instrument under those conditions can be significantly 
reduced.  

 
CTAG 

A special field in the database that serves to link tables to one another so that all the 
information about a particular calibration event can be retrieved. 
The ctag links a calibration event to test results generated during the event and to the 
standards used. 
The ctag is the unique identifier that the software assigns to each calibration event. 
Also see mtag and rtag. 

 
customization 

The process of selecting operating parameters and defaults to personalize the system 
for a particular site. For example, the default name of a field may not be the same 
words as you generally use, so field titles can be changed (customized) to something 
more familiar to the personnel at the site. 
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-D-E- 

Database Administrator 
The database administrator is a person responsible for maintaining the database. The 
database administrator is generally responsible for all changes to customization, for 
managing users and their access levels, and for backing up the database.  
Also see System Administrator. 

 
database engine 

Software such as Watcom or Sybase SQL Anywhere Server that provides high-
performance database access to requests for data. Part of the server software package. 

 
data server 

Also called a database server; a computer for storing programs and data shared by 
users on a network. A database server provides database intelligence such as 
transaction processing, indexing, transaction logging and security, while a file server 
offers operating system-type file and print capabilities. 

 
default data 

A configurable attribute of a field that specifies what text is to appear in the field 
when the form is opened. 

 

directory 
A computer term denoting a subdivision of media that can contain other directories or 
files. Also called a folder. 
 

-F-G- 
field types  

Fields are one of the following types: 
Decimal A real number, generally one or two decimal places. 
Integer A whole number. 
Alphanumeric Any sequence of ASCII characters, except for leading or trailing white 

space characters (e.g., Space, Tab). 
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Date Always eight characters, two each for day, month, and year, plus two 

slashes for separating the numbers. 
The style is configurable in the Database Setup application. The three 
selections available are: 

MM/DD/YYYY 

DD/MM/YYYY 

YYYY/MM/DD 

 
Time Always eight characters, two each for hours, minutes, and seconds, plus 

two colons for separating the numbers. Times can range from 00:00:00 
through 23:59:59. 

Boolean Boolean type fields accept a Y or an N meaning YES or NO. 
 
file server 

A computer for storing programs and data shared by users on a network. A file server 
offers operating system-type file and print capabilities, while a database server 
provide database intelligence such as transaction processing, indexing, logging and 
security. 
Also see server, client. 

 
focus 

In working with forms and tables, a field is said to have focus if it is currently the field 
that can be edited, or have information placed into it. Focus is always on one of the 
fields of a form, and there is usually some visual indication of the field having the 
focus, such as the location of a cursor, or sometimes the field with focus has a small 
dashed border in addition to its regular border. Most Windows applications make use 
of this device. 

 

folder 
A computer term denoting a subdivision of media that can contain other folders or 
files. Also called a directory. 

forward traceability 
The term �traceability� or �forward Traceability� refers to the ability of a calibration 
laboratory to trace an instrument's calibration credibility back to a national, 
recognized, legal standard. 



MET/CAL 
Users Manual 

D-6 

The first listing in a traceability report shows the standards against which the subject 
asset was calibrated. The next level are the assets that participated in the calibration of 
those assets, and so on. 
A forward traceability report (also called a "trace up" report), shows the traceability 
tree of an asset to any given depth, up to the software's maximum. 
Also see traceability and reverse traceability. 

 
FSC 

Function Selection Code, a keyword in the MET/CAL procedure language. The FSC 
instructs the Run Time system to perform a task requested by a procedure. 
For example, the 5700 FSC instructs the system to provide a stimulus output from the 
Fluke 5700A Calibrator. The DISP FSC directs the system to display a message to the 
operator during the execution of a calibration procedure. 
See the MET/CAL Reference Manual for details. 
 

-H- 
history 

A database contains information about an asset that changes over time. There is only 
one Inventory record per asset, but there may be any number of history records. The 
three types of history records are the Calibration, Location, and Maintenance (Repair). 
 

-I-J-K- 
import, importation, importing 

In a general sense, the word "import" means to bring something from one environment 
into the current environment. Used in relation to Fluke Metrology Software, the word 
refers to the process and the specific steps one must take to move data from some 
other system into the Fluke MET/BASE database. 
Contrast to migration, which is the one time operation of bringing DOS MET/TRACK 
data into MET/BASE. The importing of data may occur any number of times, and may 
even be a scheduled activity at the site. ASCII delimited data from other sources can 
be brought into MET/BASE at any time. 
If your data exists in another database, i.e., not gathered using a Fluke database 
product such as MET/CAL or MET/TRACK, you must import the data into the 
database. Importing data is not complicated, but it may require close attention to 
detail, since metrological traceability is at stake. 
Also see migration. 
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initial data entry, initial access 
Initial access or initial data entry refers to the first time that the Inventory data is 
entered (a new asset), or the first time that Calibration, Location, or Repair data is 
entered (the first calibration). 
 

-L- 
length 

The horizontal dimension. In MET/CAL and MET/TRACK forms, the number of 
characters that a value can contain. 

 
License 

A software license is the proof of your agreement with Fluke regarding your proper 
use of our Software. 
A software license constitutes a legal agreement between a purchaser and a software 
provider. This agreement typically covers such topics as the number of copies you can 
legitimately make, onto how many systems you can load the software, as well as other 
issues concerning the legal usage of the software. 
Fluke Metrology Software is licensed. It is the purchaser's responsibility to understand 
and comply with the terms under which the software was purchased. 

 
linked validation 

Feature allowing multiple fields to be entered simultaneously. Validation data is 
associated with a base field and is entered into the linked fields automatically. In the 
customization editor, the validation entry is the name of the base field. Linked fields 
are indicated by the name of the base field, a colon, and the number of the column 
from which data is to be taken. See the printed manual for complete information. 

 
Local Area Network (LAN) 

Two or more computers connected to a network that is limited to an area such as a 
single office building and does not extend across public rights-of-way. 
 

-M- 
migration 

Migrating data is similar to importing it, but with significant differences. 
Importing data implies bringing it from a source other than Fluke Metrology Software. 
On the other hand, migrating data just means bringing in data from a DOS or Legacy 
version of MET/CAL or MET/TRACK.  
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If you gathered your current data using DOS MET/CAL or Version 4 in Legacy Mode, 
or DOS MET/TRACK, you bring it into the new database by migration. 
Also see importation. 

 
MTAG 

A special field in the database that serves to link tables to one another so that all the 
information about a particular calibration event can be retrieved. 
The mtag links an asset to the Calibration, Location, and History tables. Any time you 
create a new asset in the Inventory table, the software automatically assigns a new 
mtag link so that reports can locate other information about that asset. 
Also see ctag and rtag. 

-N- 
network driver 

A network driver is the software logically located between the operating system and 
the network card, which allows applications to communicate to the network card. 

 
network operating system  

An operating system optimized for server deployment, such as Microsoft Windows 
NT Server Edition. Typically used on the file server and/or data server. 

 
normal data entry, normal access 

Normal access or normal data entry occurs any time the Inventory data is changed, or 
any time (after the first time) the operator accesses Calibration, Location, or Repair 
data. 

 
network operating system 

An operating system optimized for server deployment, such as Microsoft Windows 
NT Server Edition. 

 
NULL 

The NULL value is a special value for a database entry, different from any other valid 
value for any data type. The NULL value represents missing or inapplicable 
information. 
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-O- 
old password  

Changing a password requires you to know the original password. This is a security 
measure to protect the data that you put into the system. If you have forgotten your 
password, you cannot get a new one using this menu. You must have a new password 
assigned by your Administrator. 

 
Open Database Connectivity (ODBC) 

The Open Database Connectivity (ODBC) interface, defined by Microsoft 
Corporation, is a standard interface to database management systems in the Windows 
and Windows NT environments. 

 
ODBC driver  

A dynamic link library (DLL) used to connect a specific Open Database Connectivity 
data source with a client application. 

 
ODBC driver manager 

Provides the interface from the host language to the specific back-end data source 
driver. 

 
operator access level 

A number in the range 0 - 5 that designates the tasks the operator is authorized to 
perform. There must be at least one level 5 operator. This level has full permissions to 
customize the system, set up other operators, assign their permission levels, and so on. 
 

-P- 
password 

Your password is a word or set of characters that confirms your identity. The 
password is never displayed or printed for anyone. 
At your first login, enter the password that the Administrator assigned to you, then 
change your password using the SECURITY | PASSWORD menu. Otherwise, simply 
enter the password you selected at your first login.  
A password can be up to 16 alphanumeric characters. MET/BASE ignores the case of 
the username and password. The password is NOT optional. 

purge 
To delete an asset from the database. Only level 4 and 5 operators can purge assets. 
When purged, the entire history of the asset is removed. Standards cannot be purged. 
Purging is done on the Inventory form. 
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-Q- 
query 

Commonly, a formalized instruction to a database to either return a set of records or 
perform a specified action on a set of records as specified in the query. 
Also, the name of one of the MET/BASE applications, so called because it provides 
an interface for users to seek information from the database. 
 

-R- 
replication 

For databases, a process by which the changes to data in one database (including 
creation, updating, and deletion of records) are also applied to the corresponding 
records in other databases. 

 
RTAG 

A special field in the database that serves to link tables to one another so that all the 
information about a particular maintenance event ("repair" event) can be retrieved. 
The rtag links a maintenance event to the results generated during the event and to the 
standards used. The rtag is the unique identifier that the software assigns to each 
maintenance or repair event. Also see ctag and mtag. 

reverse traceability 
To trace those instruments that a subject instrument calibrated directly, or indirectly.  
Also see traceability and forward traceability. 

 

-S- 
segregate 

A subdivision of the database that permits restricting user access to a particular subset 
of data. 

 
server 

The term server is widely used to mean several different things. 
Just as with the term "client", the word requires modification, otherwise it may be 
ambiguous whether it refers to a program or to the computer on which the program is 
running. 
Whenever the word "server" is used without modification, it means the system 
designed to share data with client applications; servers and clients are often connected 
over a network. A server can simply share files or resources (such as printers), or it  
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can act as host for a database management system designed to provide logical access 
to a database. A database server usually contains and manages a central repository of 
data that remote client applications can retrieve and manipulate. 

 

Standard (1) (Measurement Standard) 
An object, artifact, instrument, system, or experiment that stores, embodies, or 
otherwise provides a physical quantity that serves as the basis for measurements of 
that quantity. In the context of MET/BASE, a standard is the next object in the 
traceability tree above the current level. For example, If we are calibrating a Fluke 87 
(the UUT) in the RunTime, a standard could be a Fluke 5700. 
See forward traceability. 

 
Standard (2) (Paper Standard or Protocol) 

A document that describes the operations and processes that must be performed in 
order for a particular end to be achieved. In Europe, the term "protocol" is preferred to 
avoid confusion with a physical (measurement) standard. For example, ISO Guide 25 
describes the requirements for a calibration laboratory. 

 
standard security 

Uses SQL Server�s own login validation process for all connections. To log into a 
SQL Server, each user must provide a valid login ID and password. 

 
Stored Procedure (SP) 

Stored procedures are programs kept in the database itself. They can be called from 
client applications. Stored procedures provide a way of providing uniform access to 
important functions automatically, as the procedure is held in the database, not in each 
client application. 

 
Structured Query Language (SQL) 

A database query and programming language.  
SQL is commonly pronounced �sequel� and was originally developed for IBM 
mainframe computers. There is an ANSI-standard for SQL. 

SQL Server 
A relational database management system that is capable of supporting hundreds of 
simultaneous users, depending on your application and hardware environment. 

 
System Administrator 

The system administrator (SA) is the person responsible for the administrative and 
operational functions that are independent of any particular application, and is likely 
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to be a person with a comprehensive overview of the environment. Not to be confused 
with the Database Administrator. 
System administration tasks typically include such things as installing software; 
configuring servers and clients; managing and monitoring the use of disk space, 
memory, and connections; creating devices and databases; authorizing users and 
granting them permissions; transferring data in and out of SQL Server databases; 
backing up and restoring databases; and diagnosing system problems.  
The system administrator operates outside the protection system, which means that the 
Server does no permission checking for the system administrator. The system 
administrator is also treated as the owner of whatever database he or she is using. 
Anyone who knows the SA password can log in and act as system administrator. 
Contrast with Database Administrator. 
 

-T- 
table 

The basic unit of data storage in a relational database. A table stores data in records 
(rows) and fields (columns) and usually contains information on a particular category 
of things, such as employees or parts. Also called a base table. 

 
TCP/IP 

Transmission Control Protocol/Internet Protocol (TCP/IP) is a network protocol 
supported by SQL Anywhere. 

 
tool  

One of the programs that make up the application. MET/CAL features the following 
tools: Runtime, Editor, Manual Entry, Database Setup, and Workstation. 
MET/TRACK has these tools: Manual Entry, Import Data, and Database Setup. 

 
traceability 

Traceability represents an unbroken chain of comparisons from the measurement 
being made, to a recognized, national, legal standard.  
Also see forward traceability and reverse traceability. 

trace report  
A report that establishes an instrument�s traceability. MET/TRACK provides forward 
and reverse traceability for an asset to a selectable depth. 
Also see forward traceability and reverse traceability. 
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transaction log 
A log storing all changes made to a database, in the order in which they are made. In 
the event of a media failure on a database file, the transaction log is essential for 
database recovery. Therefore for optimal security, the transaction log should be kept 
on a different device from the database files. 

 
transaction log mirror 

An identical copy of the transaction log file, maintained at the same time. Every time a 
database change is written to the transaction log file, it is also written to the 
transaction log mirror file. 
A mirror file should be kept on a separate device from the transaction log, so that if 
either device fails, the other copy of the log keeps the data safe for recovery. 

 
TUR 

Test Uncertainty Ratio, the specified uncertainty of the test instrument divided by the 
uncertainty of the calibrating instrument. A reliable TUR is obtained only when the 
specifications for the two instruments are correlated according to their respective 
uncertainty specifications and confidence intervals. 
See Appendix D for details and example calculations. 
 

-U- 
user name 

A user name is a name assigned to a login ID for the purpose of allowing a user to 
have access to a database. The abilities a user has within a database depend on the 
permissions granted to the user name. 
User names are assigned by the Administrator. A user name is a unique, single word 
that may be as short as a single letter, but contains no more than 16 alphanumeric 
characters. The software enforces upper-case only user names. 
 

-V-W-X-Y-Z- 
uncertainty 

An estimate of the possible error in a measurement. More precisely, an estimate of the 
range of values which contains the true value of a measured quantity. Uncertainty is 
usually reported in terms of the probability that the true value lies within a stated 
range of values.  
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validation 
Validation restricts the data allowed in a field to a set of authorized, or valid, values. 
The software uses validation files to store the allowed values. These files are specified 
on a field-per-field basis as a part of customization; each field's validation file has a 
unique name, by default, the field number. 
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Default login, Administrator, 8-9 
Delete, 6-17 
deleting. Also see purging 

record, 3-21 
deleting a record, 3-21 
deleting record 

restricted to levels 4 and 5, 3-21 
Description of accuracy files, 7-28 
due date 

calculation, 8-21 

—E— 
Edit configuration menu 

Add button, 6-28 
Delete button, 6-28 
Edit button, 6-28 

Edit functions, 6-16 
Editing Records 

from Browse Screens, 3-21 
Editor 

cap enunciator, 6-5 
error window, 6-3 
horizontal indicator, 6-5 
menu bar, 6-3 
overview of, 6-3 
ovr enunciator, 6-5 
procedure printing, 6-15 
security, 6-7 
status line, 6-3 
title bar, 6-3 
vertical indicator, 6-5 

Editor file menu, 6-11 
Editor functions 

overview, 6-7 
Editor text file 

opening of, 6-13 
saving of, 6-14 

Editor user level, checking of, 6-7 
Entry Screens 

Calibration, 8-15 
Customer, 8-16 
Inventory, 8-15 
Location, 8-15 
Maintenance, 8-15 
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event 
requirement for uniqueness, 3-11 

Example correction file for 5200A, 7-47 
Example TUR calculation, B-2 
Exiting the Editor, 6-7 

—F— 
FAX 

MET/SUPPORT, A-1 
field 

interaction, 8-17 
Field Properties 

Editing, 8-22 
User Level Defaults, 8-23 

field types 
core, 8-18 

Field Types 
Memo, 8-17 

Field Types, definition of, 8-17 
File insertion, 6-17 
File Menu,Met/Track, 8-10 
Find next in a procedure, 6-19 
Find text in a procedure, 6-17 

—H— 
Help 

Contacting Fluke MetSupport, 8-55 
How to access help, 8-55 

History Records, definition of, 8-27 
history, changing 

access level 4, 8-41 
How are correction files found and named, 

7-37 

—I— 
Inserting a file, 6-17 
Instrument configuration 

modifying, 6-29 
Instrument evaluation test 

known nominal value, B-2 
unknown nominal value, B-3 

interaction between fields, 8-17 
Interpolation methods, 7-38 

Interval Types, explanation of calibration 
intervals, 8-31 

ISO-9000, 1-7 

—L— 
Layout Menu, Met/Track, 8-10 
levels permitted to extend due date 
Licenses 

Adding, 8-53 
Dropping Connections, 8-53 
Removing, 8-53 
Viewing Connections, 8-53 

Linking, 5-34 
join types, 5-34 

location event 
recording, 3-10 

Logging in to applications 
MET/TRACK, 3-3 

Logging into the Editor, 6-3 

—M— 
Mail, A-1 
Maintenance Codes 

Configuration, 8-50 
Manager, definition of, 1-21 
Measurement Uncertainty 

Configuration in the Database, 8-52 
Coverage Factor, 8-52 
Disabling, 8-53 
Number of Measurements, 8-52 
Using Student's T, 8-53 

media 
for backups, 2-5 

media failure, 2-3 
MEMC FSC 

known nominal value, B-4 
unknown nominal value, B-5 

menu 
tools, 6-27 

Merge Tables 
Views, 8-39 

MET/CAL 
description, 1-10 
intended use, 1-7 
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purpose, 1-7 
MET/SUPPORT 

information to have available when you 
call, A-2 

international telephone numbers, A-2 
toll-free phone number in US, A-1 

MET/TRACK Configuration 
restricted to MT user, 8-47 

MET/TRACK License 
description, 1-10 

metcal directory, backing up, 2-9 
minimal field set, 8-20 
minimum field requirements, 8-18 
Modifying procedures, 6-16 
MT password 

changing, 8-45 
how to change MT password, 8-45 
importance of changing, 8-45 

MT user 
no permissions for data, 8-41 

—N— 
Name conflicts, resolving, 6-20 
Name procedure, 6-20 
Next error, checking for, 6-21 

—O— 
Operator Prompts 

customizing, 7-24 
Operator/Data Entry, definition of, 1-20 
Operator/Technician, definition of, 1-20 
Options menu 

font style, 6-27 
text mode, 6-26 

—P— 
Parameters, MET/CAL Initialization 

9500 Manufacturer, 7-6 
ACCF FSC Relative Path, 7-7 
Accuracy Check, 7-6 
Accuracy File Directory, 7-8 
ASK C-Flag Default, 7-7 
ASK X-Flag Default, 7-7 

Auto Author, 7-7 
Beep, 7-8 
CaretWidth, 7-8 
Confidence, 7-8 
Configuration File, 7-8 
Correct Exact Match, 7-8 
Correction File Directory, 7-9 
Coverage Factor, 7-9 
Database Procedure, 7-9 
DOX Special Construction Evaluation, 

7-9 
DTR Disable, 7-9 
F, 7-10 
Fail Prompt File, 7-10 
Force Uppercase in Database Fields, 7-10 
Head FXC Font, 7-10 
Help File Directory, 7-10 
HP 8903 Type, 7-11 
IEEE-488 Boards I/O Address, 7-11 
IEEE-488 Boards, Type, 7-11 
IEEE-488 Demo Mode Prompt, 7-12 
IEEE-Boards, Number of Ports, 7-11 
In Calibration is Required, 7-12 
Logo, Editor and Run Time Startup, 7-12 
Measure Only, 7-12 
Measurement Uncertainty Output File, 

7-12 
Measurement Uncertainty Output File 

Format, 7-13 
MEMC Instrument Repeat, 7-13 
Number of Measurement to Average, 7-13 
Number of Measurements to Throw 

Away, 7-14 
Number of Significant Digits, 7-13 
Out-of-Tolerance Limit, 7-14 
Pass 100%, 7-14 
Pass Prompt File, 7-14 
Picture Directory, 7-14 
Port, Default Serial, 7-15 
Power On SRQ GPIB Port 0, 7-15 
Power On SRQ GPIB Port 1, 7-16 
Procedure Date Format, 7-16 
Procedure Directory, 7-17 
Procedure Directory Window Minimize, 

7-17 
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Procedure Title (Left), 7-17 
Procedure Title (Right), 7-17 
Prompt File, 7-17 
Prompt Font, 7-17 
Readonly Database Write, 7-18 
Readonly Variable, 7-18 
Remove All Connections Prompt, 7-18 
Required Standard Prompt, 7-18 
Result Column Template File, 7-18 
Results Save Mode, 7-19 
Run Time Demo Prompt, 7-19 
Self Calibration, 7-19 
Serial Poll Slow, 7-20 
Show Required Instruments, 7-20 
System Type, 7-20 
Test Run Search IEEE-488 Port 0, 7-20 
Tolerance Reference, 7-21 
TUR Limit, 7-22 
Use Student�s T, 7-22 
User Current Working Directory, 7-22 
User Data Directory, 7-22 
User Program Directory, 7-23 
User Program Exit Code, 7-23 
Variable File, 7-23 
Workstation Directory, 7-24 

Parameters, MET/CAL Initialization 525A 
IEEE-488 Interface, 7-5 

Parameters, MET/CAL Initialization File, 7-5 
4xxx Selected Device Clear, 7-5, 7-6 
525A IEEE-488 Input Terminator, 7-6 

password, 3-3 
MT, 8-45 

paste, 6-17 
permanent record 

full name of user, 8-40 
permissions 

supervisory functions. See access levels 
Phone numbers 

Fluke Corporation, A-1 
Pick Lists, definition of, 8-23 
Post Run Results, 4-54 

Print, 4-56 
Previous error, checking for, 6-22 
Print setup options, 6-15 
Print to file, 6-15 

Printing a procedure, 6-15 
Procedure 

selecting in Editor, 6-12 
Procedure line 

checking a, 6-21 
Procedure naming, 6-20 
Procedure, modification of 

Break, 6-17 
Copy, 6-16 
Copy to, 6-17 
Cut, 6-16 
Delete, 6-17 
Paste, 6-17 

Procedures, creating of, 6-11 
process flow, 1-10 

asset recalled for calibration, 1-13 
asset recalled for maintenance, 1-16 

Prompt file syntax, 7-25 
Prompt files, 7-25 
Prompting text files 

Disabling Reliability Coefficient, 8-29 
purging. Also see deleting 

asset, 3-22 
purging a asset, 3-22 
purging asset 

restricted to levels 4 and 5, 3-22 

—R— 
RCTWPN 

traceability codes, 8-50 
read only 

access level 0, 8-41 
access level 0, 8-41 

record 
deleting, 3-21 

recording 
events, 3-10, 3-11 

repair due date 
calculation, 8-21 

repair event 
recording, 3-10 

repair labor rate 
calculation, 8-21 

Replacing text in a procedure, 6-19 
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report 
running in Met/Track application, 3-36 

Report 
adding text fields, 5-13 

Reports 
adding a graphic, 5-19 
adding a table, 5-11 
adding boilerplate text, 5-20 
adding database fields, 5-13 
adding page number with total page count, 

5-21 
adding to system, 5-6 
changing record selection criteria, 5-15 
Configuring, 8-54 
Configuring Reports, 5-7 
creating a formula field, 5-17 
creating from scratch, 5-8, 5-23 
data field, inserting, 5-35 
elements of, 5-5 
field format, changing, 5-36 
fields, formatting, 5-37 
flags, archive, 5-39 
groups, inserting, 5-40 
Installing, 8-54 
join types, 5-34 
lines and boxes, inserting, 5-47 
linking expert, 5-12 
modifying existing, 5-47 
modifying sample reports, 5-7, 5-9 
modifying the basic inventory report, 5-9 
post run, 5-22 
previewing, 5-36 
records, selecting, 5-38 
rules, run type, 5-23 
run time, 5-22 
running, 5-6 
sections, formatting, 5-45 
Select Records Expert, 5-38 
sort order, record, 5-41 
special fields, inserting, 5-46 
stored procedures, 5-26 
summaries, inserting, 5-42 
table linking, 5-34 
table structures, 5-25 
text fields, inserting, 5-36 

The Reports Menu in MET/TRACK, 3-36 
types, 5-3 
updating database, 5-24 

Required Records 
Setting Requirements, 8-51 

Resolving name conflicts, 6-20 
Result format 

Certificate, 4-55 
Results, 4-55 
Summary, 4-55 

Results, 4-55 
Results form 

tied to events, 3-15 
Rewarn, 6-22 
Root Field 

definition, 3-10 
RSLT_DB.FRM file, 7-24 
Rules for correction files, 7-45 
Run Time, 4-5 

dialog, post prompt, 4-54 
dialogs, configurable, 4-20 
events, sequence of, 4-6 
Menu, 4-11 
module, post test, 4-44 
overview of, 4-5 
procedures, running, 4-23 
prompt, asset number, 4-19 
results, post run, 4-54 
window, safety, 4-53 
window, test results, 4-51 
window, top level, 4-16 

Run Time Reports, 5-22 
Configuring Post Run Report, 5-22 
Rules, 5-23 

running a report, 3-36 
Running Reports 

from MET/TRACK, 3-36 

—S— 
Safety considerations, 4-3 
Safety Information, 1-3 
Save as (Editor), 6-14 
Save procedures, 6-13 
Saving current procedure, 6-13 
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Search Engine, modifying, 8-11 
Search for asset 

how to, 3-8 
security 

MT password, 8-45 
Segregates 

Configuring, 8-44 
Definition, 8-44 
Special, 8-45 
Special Uses, 3-13 
Use, 8-44 

Set-Up Menu, 8-40 
software 

backup, 2-5 
Source 

copy from, 8-19 
Special Constructions 

As Found/As Left, Philosophies, 8-28 
Constructing a Reliability Coefficient, 

8-29 
Special Customization 

As Found/As Left, 8-28 
Sr. Technician/Metrologist, definition of, 

1-20 
standard 

validation of, 3-15 
standards 

when recording cal events, 3-15 
Standards Table 

definition, 3-13 
Standards Used 

Use of Calibration Service provider name 
as Standard, 3-13 

starting an application, 3-3, 8-9 
structure 

table, 5-25 
Summary, 4-55 
supervisory functions 

and access levels, 8-41 
system 

configuring, 8-47 
System administrator, definition of, 1-20 
system failure, 2-3 
System instruments, configuration of, 6-28 

—T— 
T.U.R. REPORT, 6-22 
table 

list, 5-25 
mt.calibration, 5-25 
mt.calresults, 5-25 
mt.inventory, 5-25 
mt.standards, 5-25 
structures, 5-25 

Task Permissions 
configuring, 8-41 

Telephone Support, A-1 
Test Results 

storing, 7-24 
Test run functions 

ASK, 6-25 
DEMO, 6-25 
N-Reg, 6-26 
quit, 6-25 
run, 6-25 
S-Reg, 6-26 
step, 6-25 
stop, 6-25 

Test run menu, 6-23 
Test run options 

go, 6-24 
restart, 6-24 

Test Run Options 
show, 6-24 

Test uncertainty ratio, computation of, B-1 
Titles and Languages 

Configuration, 8-53 
total calibration time 

calculation, 8-21 
total parts cost 

calculation, 8-21 
total repair time 

calculation, 8-21 
Trace Codes 

Disabling Warning, 8-50 
List Configuration, 8-50 
System Warnings, 8-49 

traceability codes 
configuration option, 8-50 
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TUR calculation, example, B-2 
Types 

Calibration, 5-4 
Customer, 5-5 
General, 5-3 
Inventory, 5-5 
Maintenance, 5-4 
Run Time, 5-4 

—U— 
user 

and access levels, 8-41 
User Desktops, Customizing, 8-47 
user ID, 3-3 
User Levels 

Definition Table, 8-40 
user model, 1-19 
User Permissions 

Editing Validated Fields, 3-17 
Max days old a calibration can be, 3-14 

User Tables 
Creating, 8-36 
Creating Merge Tabls, 8-36 
Deleting, 8-37 
Editing, 8-37 
Using Data in Reports, 8-39 

User-configured instruments, configuration 
of, 6-28 

username 
as permanent record, 8-40 

Users 
Deleting, warning, 8-44 

Users of MET/CAL 
manager, 1-19 
operator/data entry, 1-19 
operator/technician, 1-19 
senior technician/metrologist, 1-19 
system administrator, 1-19 

Users of Metcal, System Administrator, 8-3 
Using the basic edit functions, 6-16 
Using the Editor, 6-3 

—V— 
Validated Fields 

editing, 3-17 
Editing, 3-17 

Validated Fields, definition of, 8-23 
validation 

definition, 8-24 
Validation 

Linked, 8-25 
Pick List, 8-25 
Required, 8-24 
Types, 8-24 

validation of standard, 3-15 
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